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Введение

Эта книга вышла в серии «Самоучитель» издательства «Питер», ориентирован-
ной на начинающих пользователе]!. Книги этой серии знакомят вас с операцион-
ными системами, применяемыми на современных компьютерах, а также с отдель-
ными программами (приложениями), которые используются для выполнения
различных задач. Например, прилэжения из пакета Microsoft Office используют-
ся для выполнения тех или иных офисных задач. Программа Word предназначе-
на преимущественно для работ с текстом и называется текстовым редактором или
текстовым процессором, то есть программой обработки текстов. Excel позволяет
выполнять сложные расчеты и представлять данные в виде электронных таблиц.
PowerPoint помогает готовить электронные презентации, предназначенные для
демонстрации в виде слайдов, «прозрачен» или для распечатки. С помощью сис-
темы управления базами данных Access можно работать с большими объемами
данных, организованных в базы. Персональный информационный менеджер
Outlook объединяет в себе почтовую программу, электронное расписание, кален-
дарь и адресную книгу. Все вместе они составляют достаточно мощный пакет,
предназначенный для решения практически любой задачи, которая может воз-
никнуть перед офисным работником.

Что такое Microsoft Word?

Microsoft Word — это текстовый редактор, то есть программа, предназначенная
для подготовки документов, состсящих преимущественно из текста. Она позво-
ляет выполнять ввод, форматирование, проверку текста и выводить его на печать.
Кроме текста, документы могут включать графику, звуковые файлы и видеокли-
пы, рисунки, диаграммы, формулы, таблицы и многое другое. С помощью новой
версии Word можно не только выводить документы на печать, но и отправлять их
по факсу или электронной почте прямо из окна программы, а также сохранять на
веб-сервере в виде веб-страниц.
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Прежде чем начинать работу с любой программой, ее следует установить на сво-
ем компьютере. Вопросы установки программы в этой книге не рассматривают-
ся, поэтому сначала обратитесь к своему системному администратору, чтобы он
установил вам программу Microsoft Word 2003 одну или в составе пакета Mic-
rosoft Office 2003. Параметры установки можно оставить такими, какими они
были выбраны разработчиками программы, то есть провести так называемую
«стандартную» установку. Впоследствии состав установленных компонентов
можно менять.

Для кого написана эта книга?

Если вы только начали работать с компьютером и немного знакомы с операцион-
ной системой Windows, но пока что не очень хорошо владеете текстовыми редак-
торами типа Microsoft; Word, то эта книга — для вас! Предполагается, что вы зна-
ете, как включить компьютер, умеете отличить мышь от клавиатуры и знаете
разницу между щелчками правой и левой кнопками мыши. Все упражнения из-
ложены в виде пошаговых инструкций, и поэтому их будет несложно выполнить
даже начинающему пользователю.

Если вы уже работали с Word, то сможете выбрать, какие из глав и разделов сле-
дует читать, а какие — пропустить. Возможно, вы найдете полезные для себя све-
дения даже по тем темам, названия которых покажутся вам знакомыми.

Основные элементы оформления книги

Все книги серии включают одинаковые элементы оформления, призванные по-
мочь читателю ориентироваться и работать с изданием более эффективно. Любое
занятие организовано в соответствии с определенной структурой.

• Секундомер в начале занятия покажет, сколько времени вам нужно отвести на
выполнение включенных в занятие упражнений.

• В начале каждого занятия в виде краткого содержания перечислены основные
цели занятия.

• В конце каждого занятия имеется контрольное занятие, призванное помочь
закрепить приобретенные навыки.

• В тексте контрольных занятий располагаются контрольные вопросы, для от-
ветов на которые вам придется вспомнить кое-что из пройденного материала
и затем проверить себя, заглянув в приложение Б.

• Раздел «Возможные проблемы* поможет ответить на некоторые вопросы, воз-
никшие при работе над материалом занятия.

• В разделе «Подведение итогов* подводятся итоги текущего занятия и дается
краткий анонс следующего.
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В приложении А содержатся упражнения, которые я советую вам выполнить уже
после окончания работы над книгой. Кроме того, это приложение можно исполь-
зовать в качестве наглядного справочника по основным возможностям Word. На
приведенных в нем рисунках показаны образцы документов, созданных средства-
ми Word, и краткие описания необходимых для этого операций. Взгляните на ри-
сунок, разберитесь в том, как создан документ, изучите описание и попробуйте
сделать то же самостоятельно!

Кроме того, в тексте книги будут встречаться небольшие врезки.

Как известно, в любой современной программе одна и та же задача обычно ре-
шается несколькими разными способами. В такой рубрике автор предложит вам
иной, может быть, не вполне очевидный подход.

Такой значок означает примечание к рассматриваемой теме. Здесь вы найдете
важную, на взгляд автора, информацию, но лежащую вне контекста обсуждае-
мого вопроса.

В этих рубриках описываются те возможности программы, которые появились
только в последней .версии Word.

От издательства

Ваши замечания, предложения, вопросы отправляйте по адресу электронной поч-
ты comp@piter.com (издательство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!

Подробную информацию о наших книгах вы найдете на веб-сайте издательства
http://www.pitercom.



Быстрый старт

Тема занятия

На этом мини-занятии мы познакомимся с основными операциями, необходимы-
ми при работе над любыми документами Microsoft Word. Мы научимся:

• запускать Microsoft Word;

• вводить и править текст;

• форматировать текст;

• сохранять документ;

• печатать документ;

• открывать и закрывать документ;

• выходить из программы Word.

Подготовка к работе

Вы приступаете к изучению одного из самых мощных и популярных текстовых
редакторов (процессоров) — Microsoft Word 2003. Прежде всего нужно познако-
миться с основными возможностями этой программы. Поэтому мы включили
в книгу раздел «Быстрый старт». Познакомившись с ним, вы, во-первых, освои-
тесь с принятой в книге манерой изложения, во-вторых, в общих чертах предста-
вите себе работу с программой Word.

Не старайтесь запомнить все процедуры, приведенные в этом разделе. Мы обяза-
тельно вернемся к каждой из них позднее. Главное, что требуется на этом этапе, —
освоиться в рабочей среде Word 2003 и «почувствовать» эту программу.
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Сначала включите свой компьютер и загрузите систему Windows (скорее всего,
это произойдет автоматически).

Запуск Microsoft Word

Прежде всего нужно запустить программу Microsoft Word.

1. Щелкните на кнопке Пуск на панели задач Windows.

2. Выберите команду Программы.

3. Выберите команду Microsoft Word.

Теперь программа Word открыта.

Ввод текста

Основной составляющей документов Word: писем, записок, плакатов, деловых
бумаг — обычно является текст. Давайте введем какой-нибудь текст в новый до-
кумент Word, который открывается при запуске программы.

1 . Введите слова Мой опыт работы в Word.

2. Нажмите клавишу Enter.

На рис. 0.1 показано, как выглядит введенный текст в окне программы.

Мой опыт работы в Word

I

. !

Ш\Ч s Э 1Д <j_j

? .*" ?*• * V.! м ^4™ Ln г Со1 ' •" - '" • '"' "'' ^чя^л#

Рис. 0.1. Ввод текста
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Чтобы переключиться с русской раскладки клавиатуры на английскую, нужно
нажать клавиши Ctrl+Shift или Alt+Shift — в зависимости от настроек Windows. Ин-
дикатор клавиатуры отображается в панели задач рядом с часами. Вы можете пе-
реключить раскладку также с помощью мыши. Для этого щелкните левой кноп-
кой мыши на индикаторе и выберите нужную раскладку в появившемся меню.

Чтобы удалить символ слева от курсора (мерцающая вертикальная черта), нажми-
те клавишу Backspace. Чтобы удалить символ справа от курсора, нажмите клави-
шу Delete.

Правка текста

После первоначального ввода текста вам наверняка потребуется изменять его. Да-
вайте попробуем добавить и затем удалить текст в документе. Курсор показывает,
в каком месте документа будут появляться символы, вводимые с клавиатуры.

Один раз щелкните левой кнопкой мыши в документе, чтобы изменить положе-
ние курсора. Курсор также можно переместить с помощью клавиш со стрелками.

1. Щелкните после слова Мой.

2. Введите пробел.

3. Введите слова первый самостоятельный.

По умолчанию Word работает в режиме вставки. Это значит, что при вводе весь
текст справа от курсора сдвигается, чтобы освободить место для нового текста.

Мой первый огпЬт работы в Word

;" ;"At?Crri In I СЫ IS " :t--:~. '~\ fa™?^ ' Ш "

Рис. О.2. Документ с введенным текстом



18 Быстрый старт

4. Дважды щелкните на слове самостоятельный.

5. Нажмите клавишу Delete.

Существующий текст сдвинется эбратно и заполнит освободившееся место. Те-
перь текст на экране должен выгхядеть так, как показано на рис. 0.2.

Форматирование текста

Теперь давайте попробуем применить к тексту какое-нибудь форматирование.
При этом мы узнаем, как изменять тип, начертание и размер шрифта, а также до-
бавлять различные текстовые эффекты.

1. Щелкните левой кнопкой мыши на поле страницы слева от строки Мой первый
опыт работы в Word (перед щелчком указатель мыши должен превратиться в
стрелку, указывающую вправо), чтобы выделить эту строку.

2. Щелкните на пункте Формат (Format) в строке меню.

3. Выберите команду Шрифт (Font). На экране появится окно диалога Шрифт
(Font), показанное на рис. 0.3.
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Рис. 0.3. Окно диалога Шрифт

4. В списке Шрифт (Font) выберите шрифт с названием Arial.

5. Б списке Начертание (Font style) выберите пункт Полужирный (Bold).
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6. Прокрутите список Размер (Size) с помощью полосы прокрутки и выберите
значение 24.

7. В области Видоизменение (Effects) установите флажок С тенью (Shadow).

8. Щелкните на кнопке ОК.

9. Щелкните в любом месте документа, чтобы снять выделение с текста.

10. Теперь ваш документ должен выглядеть так, как показано на рис. 0.4.

Мой первый опыт работы в Word

м

2У"И & 3

1 5« 1 1/i « г,9ш Ln г Col 1 I .-'-- - 1 ':• RussianfRu" - £3

Рис. 0.4. Форматирование текста

Сохранение документа

Документы обязательно нужно сохранять. Частота сохранения документа соот-
ветствует времени, которое вам не жалко тратить на восстановление данных, по-
терянных в случае сбоя компьютера. Давайте не будем рисковать вашим шедев-
ром и сохраним его.

1. Выберите в строке меню пункт Файл (File),

2. Выберите команду Сохранить (Save). На экране появится окно диалога Сохра-
нение документа (Save As), показанное на рис. 0.5.

Word автоматически предлагает имя для документа (обычно на основе его
первых слов). Мы введем другое имя.
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Рис. О.5. Сохранение документа

3. В текстовом иоле Имя файла (File name) введите слово Шедевр.

Вводимый вами текст заменит текст, выделенный в поле Имя файла (File name).
Кроме того, для удаления текста здесь также можно использовать клавиши
Backspace и Delete.

4. Раскройте список Папка (Save in) в верхней части окна диалога.

5. Выберите диск С:. 1

6. Щелкните на кнопке Создать пепку (Create New Folder). Это пятая кнопка слева,
считая от списка Папка (Save in). Чтобы убедиться, что это именно та кнопка,
которая нужна, установите на н ей указатель, не щелкая мышью. Через некото-
рое время появится всплывающая подсказка с именем кнопки.

7. Введите свое имя в окне диалога Создание папки (New Folder).

8. Щелкните на кнопке ОК. Новая папка будет открыта в окне диалога Сохране-
ние документа (Save as).

9. Щелкните на кнопке Сохранить (Save).

Печать документа

Документы обычно выводятся на печать. Чтобы распечатать документ с парамет-
рами принтера, заданными по умолчанию, достаточно просто щелкнуть на кноп-
ке Печать (Print). Вы также можете изменить некоторые параметры печати. На-
пример, распечатать только некоторые страницы документа, сделать несколько
копий или распечатать документ и цветном или, наоборот, черно-белом режиме.

1. Выберите в строке меню пункт Файл (File).

2. Выберите команду Печать (Prin:).
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3. Проверьте, что в списке Имя (Name) открывшегося окна диалога указан ваш
текущий принтер (рис. 0.6).

Printer

; ijlarpie:

: Status:

Where:

fH? HPLaserJet 6MF

HP LaserJet SMP

;•?age range- •

• Currgnt page

Enter page гдаЬег* andfcr page ranges
separated by commas, ft* szampla, 1,3,5-12

Prihtwhat: Document

i.'i Pagespershart; I[ page

Scale to рас*' see: jNo Scaling

Рис. О.6. Печать документа

4. Введите число 2 в поле Число копий (Number of copies).

5. Щелкните на кнопке ОК.

Закрытие документа

Чтобы закрыть документ, выберите команду Файл > Закрыть (File > Close) или щелк-
ните на кнопке Закрыть окно (х) для документа. Она расположена в строке меню.

Кнопка Закрыть (х)
для окна приложения Word

x-j—Кнопка Закрыть (х)
для документа

Z »-:Arial • ш
I • 13 • I • 14 • I • 15 • I • 16

Word
Рис. 0.7. Окно диалога с кнопками закрытия

Не путайте кнопку Закрыть (х) для документа с кнопкой Закрыть (х) для окна при-
ложения Word (обе эти кнопки видны в окне приложения, если открыт только
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один документ). Кнопка закрытия документа расположена в строке меню, а кноп-
ка закрытия окна приложения - в строке заголовка окна. Они различаются по
оформлению (рис. 0.7).

Открытие документа

Предположим, что вы решили добавить еще пару слов в свой шедевр. Как снова
его открыть?

1. Выберите в строке меню пункт Файл (File).

2. Выберите команду Открыть (Open).

3. Раскройте список Папка (Save in) в верхней части открывшегося окна диалога.

4. Выберите диск С:.

5. Дважды щелкните на значке своей папки.

6. Выделите значок своего документа (рис. 0.8).

Look jn!

My Recent
Dowments

Desktop

My Document*

MyCorreDuter

Шедевр, doc

1

Рис. 0.8. Открытие документа

7. Щелкните на кнопке Открыть (Open).

Выход из Word

После напряженной работы пора и отдохнуть. Чтобы выйти из Word, выберите
команду Файл >• Выход (File > Exit) или щелкните на кнопке Закрыть (х) окна прило-
жения. Она расположена в строке заголовка окна рядом с кнопками Свернуть и
Свернуть в окно (рис. 0.9).
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Кнопка
Свернуть

Кнопка
Свернуть в окно

Кнопка
Закрыть (х)

Рис. 0.9. Выход из Word

Возможные проблемы

Проблема Решение

Панель задач
автоматически
убирается с экрана

Кто-то случайно
уменьшил ширину
панель задач до пуля

Вы забыли, какими
клавишами переключать
раскладки клавиатуры

Вам не удается
переключить раскладку
клавиатуры, поскольку
нужная раскладка
не установлена

При щелчке на кнопке
Печать документ
печатается
не на том принтере

При щелчке на кнопке
Печать появляется окно
диалога Печать в файл

Подведите указатель мыши к нижнему краю экрана
или нажмите клавиши Ctrl+Esc. Когда панель задач
появится на экране, щелкните на свободном месте панели
правой кнопкой мыши и в появившемся контекстном меню
выберите команду Свойства. В открывмгемся окне диалога
снимите флажок Автоматически убирать с экрана

Подведите указатель мыши к нижнему краю экрана.
Указатель мыши должен превратиться в двунаправленную
стрелку. Удерживая нажатой левую кнопку мыши,
перетащите видимый на экране край панели задач вверх
до желаемой ш и р и н ы

Щелкните правой кнопкой мыши на индикаторе клавиатуры
па панели задач и выберите команду Свойства.
На вкладке Языки и раскладки в области Переключение
раскладок выберите нужное сочетание клавиш

Щелкните правой кнопкой мыши на индикаторе клавиатуры
на панели задач и выберите команду Параметры.
Если в списке установленных языков и раскладок нет
русской или английской раскладки, щелкните на кнопке
Добавить. Вставьте в привод компакт-диск с дистрибутивом
Windows, выберите в списке добавляемый язык
и щелкните на кнопке ОК

У вас по умолчанию выбран не тот принтер. В окне диалога
Печать раскройте список Имя и выберите нужный принтер

Возможно, у нас не установлен принтер. Попросите своего
системного администратора установить нужный принтер
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Подведение итого»

На этом занятии вы узнали, как запускать программу Microsoft Word, выходить
из нее, открывать, сохранять, закрывать документы и выводить их на печать.

Во время изучения данных задач вы познакомились с рабочей областью програм-
мы Word, с ее меню, окнами диалога и панелями инструментов. На следующих
занятиях мы рассмотрим эти элементы интерфейса Word более внимательно.



Занятие 1

Знакомство с Word

Тема занятия

Подготовка к работе с программой Word. Необходимая настройка. На этом заня-
тии мы научимся:

• создавать папки для работы;

• запускать и закрывать программу Word;

• работать с меню и панелями инструментов;

• получать справочную информацию.

Подготовка к занятию

Для подготовки к занятию вам нужен свой компьютер с установленной системой
Windows и пакетом Office XP. Включите компьютер.

Прежде всего необходимо определить, где вы будете хранить свои файлы. По
умолчанию Word сохраняет документы в папке с очень оригинальным названием
Мои документы. Если вас устраивает такой вариант, то переходите к следующему
разделу занятия. Если вам нужна другая персональная папка, создайте ее либо
в папке Мои документы, либо в другом удобном для вас месте.

Упражнение 1.1. Создание вложенной папки
в папке Мои документы

Для создания вложенной папки в папке Мои документы выполните следующие шаги:

1. Запустите программу Word.
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2. Выберите команду Файл > Сохранить (File * Save).

3. В открывшемся окне диалога Сохранение документа (Save as), показанном на
рис. 1.1, щелкните на кнопке Создать папку (Create New Folder).

Кнопка
Создать папку

My Recent"
Documents

examples

Э Мои доку иенты

Работа

My Computer

My NetWOfk
"taces • 5aveastype: jword Document f, doc)

Рис. 1.1. Окно диалога сохранения документа

4. В открывшемся окне введите имя для новой папки.

5. Щелкните на кнопке ОК.

6. Закройте Word.

Теперь у вас есть собственная папка для работы с документами, расположенная
внутри папки Мои документы.

Упражнение 1.2. Создание собственной папки для документов

Если вам почему-то не хочется доверять свои файлы папке Мои документы или
одной из ее вложенных папок, создайте свою папку в другом месте. Для этого вы-
полните следующие шаги.

1. Щелкните правой кнопкой мыши на значке Мой компьютер на рабочем столе и
выберите команду Проводник.

В левой части окна Проводника (рис. 1.2) отображается дерево дисков и
папок вашего компьютера. Щелкая на значках (+) и (-) рядом с названием
диска или папки, можно разворачивать и сворачивать ветви этого дерева, то
есть просматривать внутреннюю структуру папок. Чтобы отобразить содер-
жимое папки в правой части окна Проводника, нужно один раз щелкнуть на
ее значке в левой части окна или дважды — в правой части окна,
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Рис. 1.2. Окно программы Проводник

2. Перейдите на нужный диск.

3. Выберите команду Файл * Создать > Папка. На экране появится значок новой
папки, ее название будет выделено,

4. Просто введите новое название, например, свое имя, набрав его вместо старо-
го.

Для создания папки можно щелкнуть в окне Проводника правой кнопкой мыши и
выбрать в контекстном меню команду Создать ^ Папка.

Чтобы переименовать файл или папку в окне Проводника, можно щелкнуть один
раз, а затем после небольшой паузы еще раз на названии файла или папки и
ввести новое имя вместо старого.

Итак, теперь у вас есть собственная папка для хранения любых файлов, с которы-
ми вы захотите работать.

Упражнение 1.3. Создание ярлыка к папке на Рабочем столе

Теперь предположим, что вы только что включили компьютер и хотите найти свои
файлы. Как быстро это сделать? Для облегчения доступа к программам, файлам
и папкам в Windows существуют такие объекты, как ярлыки.

Ярлык — это «указатель» на папку, файл или диск. Обычно ярлык помещают куда-
нибудь на видное место, например, на Рабочий стол, в Главное меню, на панель
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быстрого запуска в Windows 98/2000/ХР и т. д. Значок ярлыка можно отличить
по небольшой стрелке в левом нижнем углу. Ярлык можно копировать, переме-
щать, удалять, переименовывать; при этом с исходным файлом, на который ука-
зывает ярлык, ничего происходить не будет.

Давайте создадим ярлык для вашей рабочей папки на Рабочем столе.

1. Щелкните на значке Мой компьютер.

2. Перейдите к диску с вашей рабочей папкой.

3. Выделите папку (щелкните один раз на значке папки).

Если вместо выделения значка папки у вас оказалось выделенным ее название,
нажмите клавишу Esc.

4. Щелкните правой кнопкой мыши на выделенном значке и выберите в контек-
стном меню команду Создать ярлык, как показано на рис. 1.3.
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Ж 5^1 QCOF200D
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Вьриать

Котировать

•̂!ЙЩЙ , .̂ ». -

Удалить

Свойства

Рис. 1.3. Команды контекстного меню

5. Перетащите созданный значок ярлыка на Рабочий стол.

Если Рабочий стол не виден на экране, щелкните на кнопке Восстановить в окне
Проводника или на кнопке Свернуть все окна на панели быстрого запуска
в Windows 98/2000/ХР.

Для создания ярлыка можно также перетащить значок самой папки на Рабочий
стол с помощью правой кнопки мыши и затем выбрать команду Создать ярлыки
в появившемся контекстном меню.
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Упражнение 1.4. Создание ярлыка к папке
в Главном меню

Очень удобно, если ярлык личной рабочей папки будет находиться в Главном
меню. Часто все пространство экрана бывает занято окнами программных прило-
жений. Б этом случае для открытия папок, документов и запуска программ мож-
но использовать ярлык, находящийся в Главном меню. Чтобы вывести Главное
меню на экран, можно:

• щелкнуть на кнопке Пуск;

• нажать клавишу Windows;

• нажать клавиши Ctrl+Esc.

Давайте посмотрим, как поместить ярлык к файлу или папке в Главное меню. Вы-
полните следующие шаги:

1. Щелкните на значке Мой компьютер.

2. Перейдите к значку нужной папки.

3. Перетащите ее на кнопку Пуск.

Если вы перетащили в Главное меню значок папки, то ее содержимое (вложен-
ные папки и файлы) будет отображаться в виде подменю, и вы сразу сможете
перейти к нужному файлу.

Во время перетаскивания будьте внимательны. Когда значок перетаскиваемого
файла попадет на кнопку Пуск, он должен превратиться в значок ярлыка (со
стрелкой).

Упражнение 1.5. Ручной и автоматический запуск Word

Для запуска Word достаточно выбрать команду Пуск > Программы > Microsoft Offi-
ce > Microsoft Word.

Если вы хотите, чтобы программа Word запускалась автоматически при включе-
нии компьютера, поместите ее ярлык в папку Автозагрузка. Для этого выполните
следующие шаги:

1. Щелкните на кнопке Пуск.

2. Выберите команду Программы.

3. Наведите указатель мыши на ярлык программы Word (рис. 1.4), затем нажми-
те и не отпускайте кнопку мыши.

4. Теперь просто перетащите значок ярлыка сначала на команду Автозагрузка,
а затем, когда откроется содержимое папки Автозагрузка, на нужное место. При
перетаскивании я-рлыка будущее место вставки будет обозначено черной чер-
той, как показано на рис. 1.4.

Теперь Word будет открываться при каждом запуске системы. Таким же образом
можно работать с любыми ярлыками в Главном меню.
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Рис. 1.4. Копирование ярлыка Microsoft Word

Для копирования (а не перемещения) любого обьекта можно держать нажатой
клавишу Ctrl. При этом к указателю мыши добавится небольшой знак плюс (+}.

Чтобы удалить ярлык из папки Автозагрузка, наведите указатель мыши на нуж-
ный ярлык (название программы), щелкните правой кнопкой мыши и выберите
команду Удалить.

Давайте познакомимся с основными элементами окна программы Word, После
открытия это окно содержит новый документ, похожий на чистый лист бумаги
(рис. 1.5). Б заголовке окна отображается его называние. Word именует новые
документы Документ 1 (Document!), Документ 2 (Document2) и т. д.

Под строкой заголовка окна располагается строка меню. Меню содержат команды,
организованные в группы. Названия меню соответствуют определенной глобаль-
ной задаче, например, Правка (Edit), Сервис (Tools), Вставка (Insert). Чтобы раскрыть
меню, поместите на его название указатель мыши и щелкните левой кнопкой. Ме-
ню раскроется, и вы увидите его содержимое. Если поместить указатель мыши на
значок в виде направленной вниз двойной стрелки в нижней части раскрытого
меню, вы увидите дополнительные, реже используемые команды этого меню.

Б строке меню располагается особое поле для ввода вопроса и получения справ-
ки. Введите в это поле, например, олова печать документа и нажмите клавишу Enter.
На экране появится список разделов справки, содержащих данные слова. Эту воз-
можность удобно использовать, если вы не хотите детально разбираться в струк-
туре организации справочной системы Office 2003.
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Строка
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Кнопки переключения Строка Полосы Область задач
режимов просмотра состояния прокрутки
документа

Рис. 1.5. Основное окно программы Word

Под меню располагаются панели инструментов. Они состоят из кнопок, каждая
из которых предназначена для выполнения какой-нибудь команды. Обычно на
панели инструментов выносят самые нужные команды, чтобы не тратить время
на их поиски в меню. Если вы щелкнете на кнопке с двойной стрелкой в правой
части панели инструментов, то также увидите дополнительные кнопки. По умол-
чанию две самые необходимые панели инструментов — Стандартная (Standard)
и Форматирование (Formatting) — размещаются в одной строке, поэтому кнопки
с двойной стрелкой придется немного поискать. Та, что справа, относится к пане-
ли форматирования, та, что примерно в середине строки кнопок, — к стандартной
панели.

Еще ниже располагается линейка. Если ее не видно на экране, поверьте, что она
все равно там есть. Поместите указатель мыши на тонкую серую черту под
панелью инструментов и задержите его на пару секунд. На экран «выплывет» кра-
сивая линейка. На ней отображаются параметры полей страницы, отступов абза-
цев и столбцов таблицы, а также другие полезные сведения, которые вы» несом-
ненно, оцените немного позже.

Под линейкой располагается рабочая область программы. В ней вы вводите текст,
вставляете рисунки и вообще делаете все, что придет в голову и что позволяют
возможности программы.
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Мерцающая вертикальная черта — это курсор. Он обозначает точку, в которую в
данный момент будет производиться вставка символов, изображений и т. д. Гори-
зонтальная черта рядом с ним обозначает конец файла. В этом режиме просмотра
документа текст можно вводить только в область выше отметки конца документа.
Для того чтобы переместить курсор в другое место, достаточно щелкнуть мышью
в соответствующем месте текста.

В правой части экрана видна Область задам (Task Pane). Для вывода ее на экран
используются команда Вид > Облссть задач (View > Task Pane) или клавиши Ctrl+Fl.
Она «многолика» — если щелкнуть на заголовке этой области, то на экран можно
вывести другие панели задач. Их удобно использовать для создания и открытия
документов, для работы с буфером обмена, форматирования текста, вставки кар-
тинок и для других более сложных задач.

Справа и снизу от рабочей области располагаются полосы прокрутки. Они служат
для перемещения в многостраничных документах.

Кнопки переключения режимов просмотра документа располагаются в левом
конце горизонтальной полосы прокрутки. Они пригодятся вам для того, чтобы
наиболее оптимально отображать документ на экране при работе над разными
задачами.

Ниже расположена строка состояния. В ее левой части вы видите номер текущей
страницы, текущего раздела, номер страницы и общее число страниц в докумен-
те, текущие координаты курсора; расстояние от верхней части страницы, номер
строки и номер позиции. Кроме ЕТОГО, в строке состояния расположены несколь-
ко полезных индикаторов, в частности, индикатор текущей раскладки клавиату-
ры. О них мы будем говорить по мере надобности.

Работа с меню

Итак, перед вами — окно программы Word. По умолчанию стандартная панель ин-
струментов, а также панель инструментов форматирования занимают одну строку,
на экране отображаются только самые нужные кнопки. Если щелкнуть на неболь-
шой стрелке справа на одной из панелей инструментов, вы увидите недостающие
кнопки. Более того, если вы воспользуетесь одной из скрытых изначально кнопок,
с этого момента она будет отображаться на панели.

Развернутые меню содержат только наиболее часто употребляемые команды. Ос-
тальные команды «спрятаны» от пользователя. Чтобы вывести их на экран, поме-
стите указатель мыши на двойную стрелку в нижней части развернутого меню,
либо некоторое время подождите открытия сокращенной версии меню. Оно рас-
кроется шире, и вы увидите все доступные команды.

Пункты меню, выделенные более темным серым цветом, принадлежат к полно-
му варианту меню, а остальные образуют сокращенный набор команд. Если вы
используете «скрытую» команду, далее она будет изображаться на экране как
«видимая».
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Рядом с командами меню выводятся сочетания клавиш, которые можно исполь-
зовать для выполнения тех же команд. Некоторые сочетания зависят от того,
какая раскладка клавиатуры используется по умолчанию. Например, если по
умолчанию при загрузке машины установлена английская раскладка, то для ко-
пирования фрагмента используется сочетание Ctrl+C, а если русская — Ctrl+lns,
Помните об этих различиях. Далее в книге предполагается, что по умолчанию
используется английская раскладка.

Упражнение 1.6. Открытие окон диалога в окне программы Word

Рядом с некоторыми командами меню расположены значки. Они призваны пока-
зать соответствие команд меню кнопкам на панели инструментов. Если команда
меню заканчивается многоточием, значит, ее выполнение приводит к появлению
на экране окна диалога.

1. Выберите, например, команду Файл > Открыть (File > Open).

В появившемся окне диалога (рис. 1.6) видны документы, расположенные
в папке Мои документы.

;Д Andrew, гаг

|f|fax02-0l-2001 .*Х

-& jfiri5h.doc

^ index, htm

g2index.html

Ж Ink

jgWinZip File.lip

; §; j в еб-приве т. htm

'^Декларация ZtMO.dsf

'•л!.1"1и" Microsoft excel,xls

:'Щпримеры для вас.doc

10 Текстовый дскунент.Сх

My Network '-
Pieces • . File

-

Рис. 1.6. Окно диалога открытия документа

Из окна диалога Открытие документа (Open) можно сразу перейти к папкам Мои
документы (My Documents), Мой компьютер (My Computer), Сетевое окружение
(My Network Places) или Рабочий стол (Desktop), а также просмотреть список
недавно открывавшихся документов с помощью кнопки Журнал (My Recent Docu-
ments). Точный список папок зависит от установленной операционной системы
и конфигурации вашего компьютера.

2. Щелкните на кнопке Отмена (Cancel), чтобы закрыть окно диалога.

Для закрытия окна диалога без внесения изменений можно использовать кноп-
ку закрытия или клавишу Esc.

2 3-иг. 481
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3. Если вместо мыши вы предпочитаете работать с клавишами, то для активиза-
ции строки меню нажмите клавишу Alt. Теперь с помощью клавиш со стрелка-
ми вы сможете перемещаться между меню. Чтобы раскрыть меню, нажмите
клавишу I или клавишу, соответствующую подчеркнутой букве в нужном
меню, например, Ф в слове Фай п.

4. Чтобы выбрать команду в раскрытом меню, используйте клавишу Т или I и
после выбора нужной команды — клавишу Enter либо сразу нажмите клавишу,
соответствующую подчеркнутой букве в нужной команде, например, О в слове
Открыть.

5. Чтобы вернуться в документ, если вы раздумали работать с меню, еще раз на-
жмите клавишу Alt или Esc. Можно также просто щелкнуть мышью в любом
месте документа.

Упражнение 1.7. Использование контекстных меню

Кроме обычных меню вы можете пользоваться так называемыми контекстными
меню. Эти меню содержат команды, которые применимы в данном месте в данное
время.

Для вывода на экран контекстного меню нужно щелкнуть правой кнопкой мыши
в нужном месте или нажать клавишу КОНТЕКСТ, если она есть у вас на клавиатуре.

Для вызова контекстного меню можно также воспользоваться клавишами
Shift+F10.

Давайте попробуем использовать контекстные меню для простейших операций
над текстом.

1. Введите в открытый документ текст: Добрый день, дорогие друзья!

2. Выделите слово день.

3. Щелкните правой кнопкой мыши на этом слове.

4. Выберите в контекстном меню команду Копировать (Сору), как показано на
рис. 1.7.

5. Нажмите клавиши Ctr+End, чтобы переместиться в конец документа.

6. Щелкните правой кнопкой мы ши.

7. Выберите в контекстном меню команду Вставить (Paste).

Обратите внимание на то, что рядом с вновь вставленным фрагментом появляет-
ся небольшая кнопка Параметры вставки (Paste Options). Если поместить на нее ука-
затель мыши и развернуть ПОЯВИЕ шееся меню, то можно выбрать вариант форма-
тирования вставленного текста (рис. 1.8). Эта возможность помогает избежать
путаницы с форматированием пр i объединении фрагментов разных документов.
Часто требуется взять из исходного документа только текст, но убрать его исход-
ное форматирование. Чтобы облегчить такую задачу для начинающих пользова-
телей, и была введена эта возможность.
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Панели инструментов

Панели инструментов предоставляй^ доступ к некоторым наиболее часто исполь-
зуемым командам меню. Если вы владеете мышью лучше, чем клавиатурой, вам
будет удобнее работать с панелями инструментов.

Упражнение 1.8. Вывод панели инструментов на экран

Word содержит множество панелей инструментов, которые обычно объединяют
кнопки, относящиеся к какой-нибудь большой теме, например, Таблицы и границы
(Tables and Borders), Рисование (Drawing), Базы данных (Database) и Веб-узел (Web).
Их можно выводить на экран и убирать с него по мере необходимости.

1. Щелкните правой кнопкой мыши на любой панели инструментов или строке
меню.

На экране появится список всех панелей инструментов, причем флажками
будут помечены те панели, которые в данный момент отображаются на экране
(рис. 1.9).

Sew "insert.. Fa-mal LOO'S Тфа Button

Добрый день, дорогие друзья

|я в я ш *i j -• _>< • |
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Рис. 1.9. Список панелей инструментов

Панели Стандартная (Standard) н Форматирование (Formatting) занимают одну
строку. Панель Рисование (Drawing) закреплена в нижней части экрана, Панель
Таблицы и границы (Tables and Borders) «плавает» на экране. Для вывода списка
панелей достаточно щелкнуть правой кнопкой на любой из них или на строке
меню.
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2. Щелкните на строке с именем необходимой панели инструментов, например,
на строке Рисование (Drawing).

На экране появится еще одна панель инструментов.

Упражнение 1.9. Использование панелей инструментов

Давайте посмотрим, как создать, сохранить, закрыть, а затем снова открыть доку-
мент и отправить его по электронной почте, пользуясь кнопками панелей инстру-
ментов (рис. 1.10). Названия кнопок отображаются на экране, если ненадолго за-
держать на них указатель мыши.

•Кнопка Создать (New Blank Document)
Кнопка Открыть (Open)
Кнопка Сохранить (Save)

•Кнопка Печать (Print)

Кнопка Полужирный (Bold)
Кнопка Курсив (Italic)

Рис. 1.10. Некоторые кнопки на панелях инструментов Word

1. Щелкните на кнопке Создать (New Blank Document).

Word создаст новый документ. Его название появится в строке заголовка окна.

2. Введите слово Пример.

3. Щелкните на кнопке Сохранить (Save).

На экране появится окно диалога сохранения документа. В поле Имя файла
(File name) Word предлагает свой вариант имени для файла.

4. Щелкните на кнопке Сохранить (Save) в окне диалога Сохранение документа
(Save As).

5. Выберите команду Файл > Закрыть (File > Close).

Только что созданный нами документ будет закрыт.

6. Щелкните на кнопке Открыть (Open).

7. В окне диалога Открытие документа (Open) выделите последний сохраненный
документ и щелкните на кнопке Открыть (Open).

Для открытия файла в большинстве окон диалога достаточно просто дважды
^/ щелкнуть на его значке.

8. Введите слова Мой первый и щелкните на кнопке Сохранить (Save). Теперь до-
кумент будет автоматически сохранен.
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9. Выберите команду Файл ^ Закрыть1 (File > Close).

Для закрытия документа можно щелкнуть на кнопке Закрыть (х) в правом верх-
нем углу окна.

Упражнение 1.10. Добавление и удаление кнопок

Вам не кажется, что на панели инструментов не хватает парочки кнопок? Здесь
есть кнопки Создать (New Blank Document), Открыть (Open), Сохранить (Save), а кноп-
ки Закрыть (Close) почему-то нет. Давайте изменим панель инструментов.

1. Щелкните на кнопке с двойной стрелкой в правой части стандартной панели
инструментов.

2. Поместите указатель мыши на слова Добавить или удалить кнопки (Add or Remo-
ve Buttons).

3. Выберите строку Стандартная (Standard). На экране появится список кнопок,
которые можно таким образом поместить на панель инструментов. Уже ото-
бражаемые кнопки помечены флажками. Поместите указатель мыши на не-
большую стрелку в нижней части меню, если оно не помещается на экране.

4. Щелкните на кнопке Закрыть (Close) и затем в любом месте экрана.

Теперь кнопка для закрытия текущего документа видна на панели инструмен-
тов. Если вы хотите, чтобы она располагалась рядом с другими кнопками,
предназначенными для работы с файлами: Создать (New Blank Document), От-
крыть (Open), Сохранить (Save), — продолжим выполнение упражнения.

5. Нажмите и удерживайте нажатой клавишу Alt.

6. Поместите указатель мыши на кнопку Закрыть (Close). Теперь, удерживая кноп-
ку мыши нажатой, перетащите кнопку Закрыть (Close) на панель инструментов
рядом с кнопкой Сохранить (Save), Как показано на рис. 1.11, при перетаскива-
нии вы будете видеть серое изображение кнопки и вертикальную черту, обо-
значающую место вставки.

Давайте добавим еще несколько полезных кнопок. Начнем с кнопки Под-
гонка страниц (Shrink One Page). Она понадобится на тот случай, если в вашем
многостраничном документе несколько строк или небольших абзацев
окажутся на почти пустой последней странице документа. Данная команда
«поджимает» документ, чтобы уместить «остаток» на предпоследнюю стра-
ницу, если это возможно. При этом Word может немного уменьшить размер
шрифта или «поиграть» с межстрочными интервалами, таким образом выиг-
рывая нужное место на странице.

Чтобы найти кнопку Подгонка страниц (Shrink One Page), нужно перейти в ре-
жим настройки. В режиме наст ройки вы можете вносить практически любые
изменения в панели инструментов и меню (включая контекстные). Вы можете
создать собственную панель инструментов и собрать на нее самые нужные
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кнопки, можете удалить кнопки с панелей и добавить на них любую команду
Word, а не только те, что есть на данных панелях или в меню.

Добрый день, дорогие друзья
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Рис. 1.11. Перетаскивание кнопки Закрыть

7. Щелкните правой кнопкой мыши на любой панели инструментов.

8. Выберите команду Настройка (Customize).

9. Щелкните на вкладке Команды (Commands).

10. В списке категорий слева выберите пункт Сервис (Tools).

11. Смело прокрутите список команд справа. Почти в самом конце, рядом с очень
нужной командой Преобразование хагыль-ханджа (Hagul Hanja Conversion) и на-
ходится наша команда Подгонка страниц (Shrink One Page).

12. Перетащите ее на панель инструментов, разместив рядом с кнопкой Печать
(Print), на которой находится значок принтера.

13. Щелкните на кнопке Закрыть (Close) в окне диалога Настройка (Customize).

Теперь если вы щелкнете на кнопке Подгонка страниц (Shrink One Page), доку-
мент сократится на одну страницу. Если результат вас почему-либо не удов-
летворит, воспользуйтесь командой Правка > Отменить (Edit » Undo).

Для отмены последней операции можно использовать клавиши Ctrl+Z.

Следующая пара кнопок, которая вам наверняка понадобится, — это кнопки
Надстрочный знак (Superscript) и Подстрочный знак (Subscript). Они соответству-



40 Занятие 1. Знакомство с Word

ют верхнему и нижнему индексам. Давайте добавим их на панель форматиро-
вания.

14. Щелкните на кнопке с двойной стрелкой в правой части панели форматирова-
ния.

15. Поместите указатель мыши на слова Добавить или удалить кнопки (Add or remove
buttons). На экране появится'список кнопок, которые можно таким образом
поместить на панель инструментов. Уже отображаемые кнопки помечены га-
лочками.

16.Выберите строку Форматирование (Formatting) и затем поместите указатель
мыши на небольшую стрелку в нижней части меню, если оно не помещается на
экране.

17. Щелкните на кнопке Надстрочный знак (Superscript).

18. Щелкните на кнопке Подстрочный знак (Subscript).

Советую вам на досуге изучить спис ки команд для разных категорий в окне диа-
лога Настройка (Customize). Возможно, вы найдете команды, которые вас заинте-
ресуют.

Параметры Word

По умолчанию все параметры Wore- настроены так, что любой пользователь мо-
жет работать с программой. Однако при этом пользователь наверняка столкнется
с проблемами, в которых будет совсем непросто разобраться, Например, пред-
ставьте, что вы вставили в титульный лист документа поле для автоматического
подсчета количества страниц, потом добавили или удалили несколько страниц,
а на печать после этого выводится старое значение. Другой пример: при открытии
документа, полученного от коллег и з-за границы, на экране отображаются какие-
то непонятные символы, а нормального текста не видно. Решение такого рода про-
блем нужно искать в окне параметров Word.

Упражнение 1.11. Изменение параметров, заданных по
умолчанию

1. Выберите команду Сервис * Параметры (Tools > Options).

2. В открывшемся окне диалога (рис. 1.12) щелкните на вкладке Общие (General).

3. Установите флажок Подтверждать преобразование при открытии (Confirm con-
version at Open).

Теперь при открытии файла, сохраненного в формате, отличном от формата
Word 2003, на экране будет появляться окно диалога с предложением указать
нужный формат файла. Чаще всего будет достаточно просто щелкнуть на
кнопке ОК. Однако если Word не сможет самостоятельно распознать формат
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файла, у вас будет возможность открыть документ, указав нужный формат.
Обычно, если случай не слишком сложный, документ удастся открыть или, по
крайней мере, извлечь из него текст.

т
.l&Ktmtr Spelling 1

:"User inft*BKitiOrt 1 " i

View - ' Sene'al

«Grammar

urnpatfolity

" Edit . "

I TiatkCTanges

j -'Ffe Location*!,
Prfnt - - \ :- save

Seneral onions - .•• • •• - • •

• ̂  gackgfound repegiiatton "

Г" аце background, wWe text

i Provide feedback Vr'^ sound

'? Prowd* Feedback with ««mel

X'ftllow starring In Ktartnj la/Out

1 AjtornaO;dly create drawing comas when inserting Au

Service Options,,. ! WebOetlow

Рис. 1.12. Окно параметров Word

4. Щелкните на вкладке Сохранение (Save).

5. Снимите флажок Разрешить быстрое сохранение (Allow fast saves).

Этот флажок по странной идее разработчиков из Microsoft должен облегчать
жизнь пользователям, записывая на диск в процессе работы над документом не
сам документ, а вносимые в него изменения. На первый взгляд, такая схема дол-
жна ускорять процесс сохранения файла (вы, конечно, помните, что сохранять
файлы нужно как можно чаще). Однако, как написано даже в справочной систе-
ме Word, при этом перед выходом из Word все равно нужно сохранять доку-
мент уже по-настоящеыу. Не сомневаюсь, что вы об этом уже знали. В наше
время, когда вычислительные возможности компьютера просто избыточны, та-
кая экономия в подавляющем большинстве случаев не нужна. Этот флажок
имеет смысл устанавливать только на время работы с очень объемными доку-
ментами, насыщенными графикой и внедренными объектами.

6. Щелкните на вкладке Общие (General).

7. Увеличьте значение в поле Помнить список из (Recently used file list) до 9 (макси-
мальное значение).

Этот параметр определяет, сколько имен недавно открытых в Word файлов
будет отображаться в конце меню Файл (File). Чем больше этот список, тем
лучше: вы сможете быстро открывать документы, с которыми недавно рабо-
тали.
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8. В списке Единицы измерения (Measurements units) выберите пункт Сантиметры
(Centimeters). Снимите флажок Отображать пикселы для средств HTML (Show
pixels for HTML features).

Этот последний флажок определяет, в каких единицах будут измеряться рас-
стояния в окнах диалога.

9. Щелкните на вкладке Печать (Print).

10. Установите флажок Обновлять пэля перед печатью (Update fields).

Поля — это специальные коды, которые можно вставлять в документ с по-
мощью команды Вставка > Поле (Insert > Field), чтобы в нем отображалась ин-
формация типа даты, количества страниц, номера страницы, имени пользовате-
ля и т. д. Обычно поля обновляются при открытии документа. Если же внести
в документ некоторые изменения и потом вывести его на печать, они могут не
отразиться в итоговом документе. Для борьбы с этой небольшой проблемой
и применяют флажок Обновлять поля перед печатью (Update fields).

11. Щелкните на вкладке Правка (Edit).

12. Установите флажок Использовать клавишу INS для вставки (Use the INS key for
paste).

Теперь для вставки последнего фрагмента, скопированного в буфер обмена,
вам будет достаточно нажать клавишу Insert.

Пожалуй, этого достаточно для начального знакомства с параметрами Word. Не-
сомненно, что нам еще придется вернуться к окну диалога Параметры (Options), но
общая процедура изменения настроек Word уже будет вам знакома,

Выход из программы

Упражнение 1.12. Закрытие документа и выход из программы

Перед выходом из программы сохраните изменения в документе. Для этого выбе-
рите команду Файл * Сохранить (File * Save) или щелкните на кнопке Сохранить
(Save). Затем выполните следующие шаги:

1. Откройте меню Файл (File).

2. Выберите команду Выход (Exit).

3. Если вы забыли сохранить измен ения, программа напомнит вам об этом. Щел-
кните на кнопке Да (Yes) в появившемся окне диалога.

Программа Word закроется, и вы вернетесь в Windows.

Чтобы закрыть окно программы, можно дважды щелкнуть на значке в левом кон-
це заголовка окна программы или щелкнуть один раз на кнопке закрытия в верх-
нем правом углу окна программы. Для закрытия окна можно также использовать
клавиши AK+F4.
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Получение справочной информации

Очень сложно ориентироваться в новой программе без помощи со стороны. Не
стесняйтесь задавать коллегам и знакомым свои вопросы; их советы могут ока-
заться очень ценными. Однако прежде чем беспокоить других, побеспокойте про-
грамму Word. Она предоставляет некоторые полезные возможности в части по-
лучения справочной информации. Ниже перечислены способы для получения
справки в Word 2003.

• Клавиша F1. При нажатии на эту клавишу открывается панель Справка по Mic-
rosoft Word (Microsoft Word Help), в которой, как и в строке меню, можно вести
поиск нужного раздела справки по ключевым словам, а также найти советы и
указания, относящиеся к выполняемой вами задаче.

• Команда Office on Microsoft.com. Данная команда позволяет получать справку
непосредственно с веб-узла Microsoft.

Упражнение 1.13. Работа с Помощником

Если при выполнении какой-то задачи у вас возник вопрос, а ответить на него
некому, то на помощь тем, кто знает английский язык, придет Помощник по Office.
Давайте посмотрим, как это обычно делается.

Эти кнопки помогут перейти вперед
и назад к другим частям
области задач Word

Добрый день,

-Office Online

Щелчок на этой кнопке
инициирует поиск

В это попе вводятся
ключевые слова
для поиска

Щелкните здесь,
чтобы просмотреть
один из предлагаемых
разделов справки

Рис. 1.13. Получение справки в Word
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1. Щелкните на кнопке Справка по Microsoft Word (Microsoft Office Word Help) или
нажмите клавишу Fl. На экране появится область задач с панелью справки
(рис. 1.13).

2. Введите слова print document в текстовое поле и щелкните на кнопке поиска.

3. Щелкните на разделе справки Печать сведений о документе (Print property infor-
mation or other details).

4. На экране отобразится окно справки Word (рис. 1.14).

5. Щелкните на кнопке Закрыть (х) в окне диалога Справочная система: Microsoft
Word (Microsoft Office Word Help).

1

<= =>

Print property informatiorror
other details

You can print <) document's properties and
other information—such as hidden to tor fG'ld
codes— either with the document or by
themselves,

fr Print property inwrtvution With ttia document

fr Pr^t property hforrnaCion witfioutprlntrig
the active doQiment

Рис. 1.14. Справку можно прочитать в отдельном окне

Контрольное занятие

Сейчас мы проверим, чему вы научились на этом занятии. Выполните следующие
действия и попробуйте ответить на вопросы.

1. Запустите программу Word.

1,1. Что означают три кнопки в Е.ерхнем правом углу окна программы?

2. Откройте документ Пример.dot:.

3. Выделите слово первый.

4. Скопируйте его.

5. Создайте новый документ.
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1.2. Что делать, если вы забыли назначение какой-либо кнопки на панели инстру-
ментов?

6. Вставьте скопированное слово в новый документ.

7. Сохраните документ в папке Мои документы. Согласитесь с именем, предло-
женным программой.

8. Просмотрите один из разделов справки.

9. Закройте оба документа.

10. Закройте программу Word.

1.3, Сколько имеется способов для выхода из программы Word и какие это способы?

Возможные проблемы

Проблема Решение

Я щелкаю па команде
меню, но ничего
не происходит

Я пытаюсь выделить
файл в окне папки,
а вместо этого
выделяется подпись
к его значку

Я случайно
открыл меню

Я случайно открыл
окно диалога

Я поместил указатель
мыши на кнопку
панели инструментов,
но подсказка
не появилась

Указатель мыши и момент щелчка должен находиться точно
на команде, которая при этом выделяется; щелкать нужно
левой кнопкой мыши

Старайтесь щелкать именно на значке файла.
Чтобы выделить файл, достаточно одного щелчка

Нажмите клавишу Esc или щелкните в любом
другом месте экрана

Нажмите клавишу Esc или щелкните на кнопке закрытия
в правом верхнем углу окна диалога

Заново наведите указатель на кнопку и подождите
несколько секунд. Если это не помогает, выберите команду
Вид К Панели имструмсптои » Настройка
(View > Toolbars > Customize), щелкните на вкладке
Параметры (Options) и установите флажок Отображать
подсказки для кнопок (Show screentips on toolbars)

Подведение итогов

На этом занятии мы научились:

• работать с папками и файлами на диске;

• запускать и закрывать программу Word;



46 Занятие 1. Знакомство с Word

• работать с командами меню, панелями инструментов и контекстными меню;

• изменять настройки программы Word;

• общаться с Помощником по Office и получать справку по интересующему нас
разделу.

Теперь попробуйте самостоятельно просмотреть все меню и панели инструментов.



Занятие 2

Создание и сохранение
документов

Тема занятия

Создание, сохранение, закрытие и открытие документов. Ввод текста. Работа с
мастером. На этом занятии вы научитесь;

• создавать, сохранять, закрывать и открывать документы;

• вводить и изменять текст документов;

• работать с абзацами;

• создавать документы с помощью мастера.

Подготовка к занятию

На этом занятии вы создадите свой первый настоящий документ. Чтобы предста-
вить себе, что должно получиться в результате, взгляните на рис. 2.1. Включите
свой компьютер и запустите Word.

Для создания нового документа можно воспользоваться кнопкой Создать (New
Blank Document) на панели инструментов. Можно также создать новый документ,
щелкнув На строке Новый документ (Blank Document) в области задач Создание доку-
мента (New Document). Эту область задач выводит на экран команда Файл > Создать
(File > New). Раздел Создание с помощью шаблона (Templates) в области задач поз-
воляет выбрать для документа так называемый щаблои (рис. 2.2). На основе
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шаблонов создаются документы, содержащие готовые отформатированные образ-
цы текста, нужные команды, иногда даже напели инструментов и меню. Среди
шаблонов вы найдете полезные и профессионально выглядящие заготовки для
большого числа деловых бумаг разных типов. На занятии 10 вы узнаете, как орга-
низовать свои документы с помощью шаблонов. По умолчанию новый документ
создается на основе шаблона Обычный (Normal.dot). Именно этот шаблон исполь-
зуется при создании документа с помощью кнопки Создать (New Blank Document).
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26 октября 2003г.

Г-жа Елена Цветке в а
Референт-пер сводчик
Трамвайный пр 2-212
191457, Санкт-Петербург

Уважае маяг-жа Цветжова'

Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книга»,
проведенного нашим магазином, лучшей бьимпризнана книга «Русские народные
сказин». Все читатели, которые подали свои г злоса за эту книгу, награждаются ценными
призами от нашего магазина. Вы можете зайти к нам в удобное для Вас время и получить
свой приз.

Кроме того, предъявив зто письмо, вы можете приобрести Б нашем магазине любое
количество изданий с 40% скидкой

Искренне Ваш

Андрей Быстрое
„,„ ЛПП-РТПИ M?r»W9 «VlIlIT-ua

•je ш j ад £[_>j
Page 1 Sec I : : Ijfl . № lB,Jtm In 19 . Ctt 13

Рис. 2.1. Документ Word, который мы будем создавать

< Leg^ Иеас*Ч5 \ Letters & Faxes \ MaS Merge f Meirios j Othef DoOiliarts ] RJblitaSDnS ] Report!;

XML Document Web Page

Рис. 2.2. Окно диалога Templates
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В разделе Создание (New) области задач Создание документа (New Document)
также можно создать веб-страницу и XML-документ.

Кроме того, для создания документов используются так называемые мастера (wi-
zards). Нужный мастер можно запустить из окна диалога Шаблоны (Templates).
Чтобы вывести на экран это окно диалога, щелкните па строке Общие шаблоны (Оп
my computer) в разделе Создание с помощью шаблона (Templates) в области задач
Создание документа (New Document). Далее мастер поможет вам задать нужные па-
раметры для документа указанного типа. Работать с мастерами очень просто.
Выясните, какие мастера установлены на вашем компьютере, и почаще прибегай-
те к их помощи. Например, на рис. 2.3 показаны значки шаблонов и мастеров,
предназначенных для создания писем и факсов.

• • - - . . . - - - • - - . - . , . - - . . . - . . .s
General UegaiFleadngt Letters &Fa*(e !мав Merge ; Memo* j «hsr Document! \ Piikatwis] RepHW j 1

"',

-Preview -'••-•!•
messFa* Contemporary Contemporary Elegant Fax

Fax Letter

jant Letter Envelope Fax Wizard Letter Wizard Select en кап lo
see e preview.

Hailing Label Personal Fax Professional Profeisior
Wfcard Fax Letter

Create Меи - - у - -

•• Document (" Template

Рис. 2.3. Значки шаблонов и мастеров

Многие компоненты Office устанавливаются в варианте «по требованию». Это зна-
чит, что при начальной установке соответствующие файлы не копируются на жест-
кий диск, но при первом обращении к такому компоненту программа установки
Office автоматически добавит недостающие компоненты. Вам потребуется толь-
ко вставить компакт-диск с дистрибутивом Office 2003 в устройство чтения.

Создание вашего первого документа

Давайте предположим, что вам нужно создать письмо от сотрудника книжного ма-
газина покупателю, заполнившему отрывную карточку в приобретенной им книге.

Упражнение 2.1. Ввод текущей даты

В документы Word можно вставлять дату и время. При этом Word использует
информацию системных часов. Вставка даты или времени в документ поможет
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лучше организовать работу и избавит вас от необходимости вводить и обновлять
эту информацию вручную.

1. Запустите Microsoft Word.

Word открывается и создает новый документ (на основе шаблона Normal.dot) с
именем Документ 1 (Document!). Это имя сохраняется до тех пор, пока вы его
не измените при первом сохранении документа на диске.

2. Раскройте меню Вставка (Insert).

3. Выберите команду Дата и время (Date and Time), как показано на рис. 2.4,

'';Т>«> iBnciil'l • &it.iaH'fl Kofi l

i gte Edt - Vteiu : Ifiset -i Format Jpott Tjbfe WxKM не.в

;.§? ^raak... i 100% .* •$*' - .̂ î esd .̂ 1 £g ii *-'

%atBmdp«,t, .ТГТ^Г.^^ГГГТ','^Г
1 Symbol...

jj Picture t j

CliltIC I

Рис. 2.4. Выбор команды для вставки текущей даты

На экране появится окно диалога Дата и время (Date and Time). В нем пред-
ставлены доступные форматы для вставки текущих даты и времени
(рис. 2.5).

4. Выделите формат, показанный в третьей строке сверху.

5. Щелкните на кнопке ОК.

Если установить флажзк Обновлять автоматически (Update automatically), то
вставленные дата или время будут автоматически обновляться при открытии до-
кумента или перед печатью.

Word вставит в документ дату, как показано на рис. 2.6.

6. Выберите пункт Русский (Россия) (Russian (Russia)) в раскрывающемся списке
Язык (Language) справа.
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language;

ШШШ i £ •
зоскресемье, 26 октября 2003 г""
26 октября 2003 г.
26.10.03
2003-10-26
26-окт-ОЗ

26 окт. 03 г.
26/10/03
октябрь 03
скт-03
26.10.200321:52
26.10.200321:52:08
21:52:03
9:52:08
21:52

Russian (Russia)

Г" Update automatic.

Рис. 2.5. Окно диалога Date and Time

Рис. 2.6. В документ вставлена текущая дата

Чтобы быстро вставить в документ дату в формате по умолчанию (26.10.2003),
нажмите клавиши Alt+Shift+D. Для вставки текущего времени используются кла-
виши Alt+Shift+T.

7. Если вам понадобится удалить дату, выделите ее с помощью мыши и нажмите
клавишу Delete.

Так как Word использует системные дату и время, убедитесь, что они выставле-
ны верно. Для изменения настроек даты и времени можно щелкнуть правой кноп-
кой мыши на часах на панели задач и выбрать в контекстном меню команду На-
стройка даты/времени.

Упражнение 2.2. Ввод текста

Текст вводится в текущей позиции курсора (мерцающая вертикальная черта).
Текст справа от курсора, если он есть, при вводе сдвигается вправо. Вводимый
текст автоматически переносится по строкам, таким образом, вам не нужно
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нажимать клавишу Enter в конце каждой строки. Сейчас мы введем адрес, обраще-
ние, текст письма и заключительную фразу.

1. Нажмите клавишу Enter 4 раза.

2. Введите слова Г-жа Елена ЦЕ1еткова и снова нажмите Enter.

3. Введите Референт-переводчик и нажмите Enter.

4. Введите Трамвайный пр. 2-2:.2 и нажмите Enter.

5. Введите 191457, Санкт-Петербург и нажмите Enter дважды.

6. Введите Уважаемая г-жа Цветкова! и нажмите Enter дважды.

7. На экране может появиться Помощник и предложить вам свою помощь. Пока
что откажитесь от нее.

8. Введите следующий текст:

Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книга», прове-
денного нашим магазином, лучшей была признана книга «Русские народные
сказки». Все читатели, которые подали свои голоса за эту книгу, награждаются
ценными призами от нашего магазина. Вы можете зайти к нам в удобное для Вас
время и получить свой приз.

9. Обратите внимание еще раз на то, что для перехода между строками вам не
нужно нажимать клавишу Enter, Программа Word сама разбивает текст на
строки, вам нужно лишь разделять абзацы.

Чтобы исправить небольшие ошибки в тексте, используются клавиши Backspace
(удаляет текст слева от курсора) и Delete (удаляет текст справа от курсора).

10. Нажмите Enter.

11. Введите следующий текст:

Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине лю-
бое количество изданий с 40% скидкой.

12. Нажмите Enter дважды.

13. Введите Искренне ваш и нажмите Enter 4 раза (этот интервал необходим для
подписи).

14. Введите Андрей Быстрое и нажмите Enter.

15. Наконец, введите Директор магазина «Книги» и снова нажмите Enter.

Обратите внимание на то, <;то фамилия Быстров подчеркнута волнистой крас-
ной линией. Эта «змейка» означает, что в данном слове может быть орфогра-
фическая ошибка. (Если Word не знает какого-либо слова, программа сразу
предполагает наличие в нем ошибки.) На занятии 6 мы узнаем, как проверять
орфографию и грамматику в тексте документа.

Теперь у нас есть законченное письмо с датой, адресом, обращением, текстом
и заключением (рис. 2.7).
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Г-жа Елена Цветков а
Р ефер е [гг - пер f Б о дчик
Трамвайный Dp 2 - 2 1 2
191457, Саша--Петер бург

Уважаемая г-жа. Цветаова!

Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книга,*), приведенного
нашим магазином, лучшей была признана книга «Русские народные скаэкии Все
чнтатели. которые подали свои голоса за эту книгу, награждаются ценными призами 01
нашего магазина Вы можете зайти к нами удобное для Вас Еремяи получить свой приз
Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине любое
калнчгстеа издании с -ТО11/» скидкой.

Искренне Ваш

Андрей Быстрое
Директор магазйнааКннгив

•в и з Ф *|__]

аде I Sec 1: - 1/J

Рис. 2.7. Введенный текст письма

Упражнение 2.3. Создание абзацев

Как мы видели при работе над предыдущим упражнением, нажатие клавиши Enter
нужно только для завершения абзаца или вставки пустой строки, но не для раз-
рыва строк. Давайте разобьем первый абзац на два.

1. Щелкните в первом текстовом абзаце после слов нашего магазина., при этом
курсор должен оказаться после точки.

2. Нажмите клавишу Enter.

Мы разделили абзацы с помощью знака конца абзаца. По умолчанию знаки
конца абзаца не отображаются на экране. Иногда эти невидимые (непечатае-
мые) служебные символы полезно выводить на экран. Они впоследствии бу-
дут очень вам помогать разбираться с форматированием сложных докумен-
тов.

3. Щелкните на кнопке Непечатаемые знаки (Show/Hide) на стандартной панели
инструментов — это кнопка со значком конца абзаца (f). Возможно, для этого
вам потребуется сначала щелкнуть на кнопке с двойной стрелкой, располо-
женной в правой части панели. После этого кнопка Непечатаемые знаки (Show/
Hide) появится на панели инструментов.

Чтобы вывести на экран непечатаемые символы, можно нажать клавиши Ctrl+Shift+8.

На экране появятся символы конца абзаца и точки, соответствующие пробе-
лам. Нам нужно удалить лишний пробел в начале второго абзаца.
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Рис. 2.8. Кнопка Show/Hide позволяет увидеть на экране служебные символы

4. Щелкните перед пробелом в начале второго абзаца.

5. Нажмите клавишу Delete.

6. Чтобы убрать с экрана непечатаемые символы, еще раз щелкните на кнопке
Непечатаемые знаки на панели инструментов.

Упражнение 2.4. Создание красной строки в абзацах

Абзацы должны как-то отделяться друг от друга. Существует два способа зри-
тельного разделения абзацев: красная строка и увеличенный интервал между
строками абзацев. В печатных материалах, подготовленных в соответствии с рос-
сийской практикой, чаще используется красная строка — увеличенный отступ
первой строки абзаца (помните, как нас учили в школе: два пальца в начале стро-
ки?). В западной практике приня го разделять абзацы, увеличивая интервал меж-
ду ними, но не изменяя отступ первой строки. Вы можете сами выбрать стиль,
подходящий для вас, только не используйте оба приема сразу, —'это выглядит
очень непрофессионально.

Для изменения интервапа между абзацами можно использовать окно диалога,
открываемое командой Формат > Абзац (Format > Paragraph). Кроме того, это же
окно диалога можно вызнать, если вывести на экран область задач Показать фор-
матирование (Reveal Formatting) с помощью одноименной команды меню Фор-
мат (Format) или сочет£;ния клавиш Shift+F1 и щелкнуть на строке Отступ (In-
dentation) в разделе Абзац (Paragraph).
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Для разделения абзацев можно просто вставить между ними пустой абзац. Чтобы
создать красную строку, достаточно изменить отступ первой строки.

1. Щелкните в начале абзаца перед словами Мы рады сообщить.

2. Нажмите клавишу Tab.

Теперь у первой строки абзаца появился отступ. Не обращайте внимания на
небольшую кнопку, появившуюся в месте вставки табуляции. Эта кнопка поз-
воляет менять параметры автозамены, путем которой, собственно, и создается
отступ первой строки абзаца. Вы можете сделать то же самое с другими абза-
цами. Давайте попробуем вставить пустой абзац перед следующим до слов Вы
можете зайти.

3. Щелкните перед словами Вы можете зайти.

4. Нажмите клавишу Enter.

5. Щелкните на кнопке Непечатаемые знаки (Show/Hide).

Видно, что перед вторым абзацем появился еще один, пустой, абзац (рис. 2.9).
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Рис. 2.9. В первом абзаце создана красная строка, а перед вторым
вставлен пустой абзац

Упражнение 2.5. Объединение абзацев

Чтобы объединить два абзаца вместе, нужно удалить знаки абзаца, которые их
разделяют. Эту операцию удобно выполнять, если на экране отображаются непе-
чатаемые символы.

1. Щелкните в конце абзаца после слов нашего магазина, и перед знаком конца
абзаца.
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2. Дважды нажмите клавишу delete.

Абзацы объединятся в один.

3. Нажмите клавишу пробела, чтобы разделить два предложения.

Нам осталось только создат;, красную строку перед вторым абзацем.

4. Щелкните перед словами Кроме того.

5. Нажмите клавишу Tab.

6. Щелкните на кнопке Непечатаемые знаки (Show/Hide).

Теперь документ выглядит законченным (рис. 2.10).

Г-жа Елена Цветкова
Р t ф ере иг- пер ев о дч и к
Трамвайный пр. 2-212
191457, Санкт-Петербург

Уеажаемаяг-жа ЦветкоЕа!

Мы рады сообщить Вам, что по итогам опроса ((Лучшая детская книгам,
проведенного нашим магазином, лучше! была признана книга «Русские народные
сказш" Все читатели, которые подали (еоигслоса за эту книгу, награждаются ценными
призами ог нашего магазина Вы может? зайти к нам в удобно» для Вас время и получить
свой приз

|Кроме т о г и , предъявив это письм i. вы можете приобрести в нашем магазине любое
количество изданий с 40% скидкой

I
Искрение Ваш

Андрей Быстрой
Директор магазина « К ни гнн

Рис. 2.10. Теперь абзацы оформлены в едином стиле

Сохранение, закрытие и открытие
документов Word

Представьте, что вам нужно ненадолго (или надолго) отойти от компьютера.
А что, если в ваше отсутствие что-то (или кто-то) испортит созданные докумен-
ты? Пока вы работаете над документом, он отображается на экране и хранится в
оперативной, то есть временно]], памяти компьютера. Если в работе компьюте-
ра произойдет какой-либо сбой (возможные причины: шаловливые руки това-
рища, сбой в работе какого-либо приложения, отключение питания), то содер-
жимое оперативной памяти будет потеряно. Иногда потерянную информацию
можно восстановить, но рассмотрение этой задачи выходит за рамки тематики
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данной книги. Лучше не искушать судьбу, а вовремя сохранять все документы
на жестком диске. Для этого как можно чаще используйте в процессе работы
команду Файл К Сохранить (File > Save) или сочетание клавиш Ctrl+S. Кроме того;
стоит почаще делать резервные копии самых важных файлов на дискетах или
других внешних носителях.

Чтобы убрать с экрана документ, с которым закончили работать, выберите коман-
ду Файл > Закрыть (File V Close) или щелкните мытью на кнопке Закрыть (Close),
если вы добавили ее на панель инструментов. В случае, когда последние измене-
ния, внесенные в файл, не были сохранены, программа напомнит вам об этом пе-
ред закрытием.

Чтобы снова начать работу над сохраненным документом, его нужно открыть, то
есть снова вывести на экран. Для этого необходимо выбрать команду Файл ¥ От-
крыть (File * Open) или щелкнуть на кнопке Открыть (Open) на стандартной напели
инструментов.

Вы можете открыть сразу несколько документов в Word. Количество документов,
которые можно открыть одновременно, зависит от ресурсов вашего компьютера.
Word создает для каждого документа кнопку на панели задач Windows, поэтому
для переключения между документами можно просто щелкать па соответствую-
щих кнопках.

В следующих упражнениях мы сохраним, закроем и снова откроем созданное нами
письмо.

Упражнение 2.6. Сохранение документов

При сохранении документа вы можете выбрать имя файла, тип файла и папку для
этого документа, чтобы впоследствии его можно было легко найти. Кроме того,
в случае аварийной ситуации или сбоя в операционной системе Word сумеет вос-
становить последнюю сохраненную копию файла. Если часто сохранять документ,
вам не придется переделывать работу заново в случае неприятностей с компьюте-
ром. Команда Файл > Сохранить (File > Save) заменяет существующую копию фай-
ла на диске очередной копией с сохраненными изменениями. Если вы попробуете
закрыть документ, не сохраняя изменений, Word спросит вас, как поступить. Да-
вайте сохраним наш документ.

Если вы хотите, чтобы на диске хранилась не только самая последняя, но и пред-
последняя копия файла, установите флажок Всегда создавать резервную копию
(Always create backup copy) на вкладке Сохранение (Save) в окне диалога Пара-
метры (Options). После этого при выполнении команды Файл t Сохранить (File >
Save) будут перезаписываться одновременно две копии файла.

1. Щелкните на кнопке Сохранить (Save).

На экране появится окно диалога Сохранение документа (Save As), показанное на
рис. 2.11. Оно появляется при сохранении нового документа в первый раз.
В этом окне видны текущая папка, текущий тип файла и текущее имя файла.
В основном поле окна вы также увидите содержимое текущей папки (вложен-
ные папки и файлы). Ее название отображается в списке Папка (Save in).
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Desktop

My Network
Fife [anie: - Письмо победителю.doc

-Pisces " ---- Save as We:"Jwad Document ('.dec) Cancel

Рис. 2.11. Окно диалога сохранения документа

С помощью кнопок в левой части окна вы сможете быстро переходить к неко-
торым особо нужным папкам, таким как Мои документы, а также просматри-
вать список файлов и папок, с которыми недавно работали.

Кнопка Переход на одлн уровень вверх (Up One Level) открывает окно папки пре-
дыдущего уровня. Чтобы увидеть содержимое вложенной папки, дважды щелк-
ните на ее значке.

2. Щелкните на кнопке Создать новую папку (Create New Folder). На экране появит-
ся окно диалога Создание папки (New Folder). Введите имя для вашей новой пап-
ки (рис. 2.12).

Рис. 2.11!. Окно диалога создания папки
/

3. Введите название Работа в голе Имя (Name).

4. Щелкните на кнопке ОК, чтобы вернуться в окно диалога Сохранить как (Save
As). Значок новой папки появится в окне текущей папки.

5. В поле Имя файла (File name:) выделите имя, предложенное программой, если
программа еще не выделила, его. Для этого нажмите левую кнопку мыши в на-
чале имени и, не отпуская кнопки, перетащите указатель к его концу, после
чего отпустите кнопку мьпги.

6. В поле Имя файла (File name) введите слова Письмо победителю.
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Новое имя файла заменит предложенное программой. Имя может быть любой
длины и содержать символы верхнего и нижнего регистров, пробелы, запятые и
русские буквы.

По умолчанию файл сохраняется как документ Word (с расширением .doc),
Тип файла выбирается в списке Тип файла (Save as type). Вы можете указать
тип файла, отличный от предлагаемого по умолчанию, если нужно сохранить
его для использования другим приложением или передать коллегам, работаю-
щим с другими версиями Word. Можно сохранить файл как текст (в кодиров-
ках Windows или DOS), в формате RTF (Rich Text Format), который понима-
ется подавляющим большинством текстовых и графических редакторов и
других приложений, в различных форматах HTML (формат веб-страниц или
файлов для Интернета), в любом из форматов предыдущих версий Word (для
DOS, Windows и Macintosh). Кроме того, документ Word можно сохранить
как шаблон (с расширением .dot) и потом использовать в качестве основы для
создания новых документов.

Теперь Word работает с дополнительными форматами HTML— веб-архивами
и т. д.

При выборе определенного типа файлов в списке Тип файла (Save as type) в окне
текущей папки будут отображаться только файлы соответствующего типа.

Если вы вводите имя уже существующего файла, Word спросит вас, хотите ли вы
переписать существующий файл (рис. 2.13). Если установить первый переклю-
чатель и щелкнуть на кнопке ОК, содержимое существующего файла будет за-
менено вашим документом. Если существующий файл вам еще нужен, щелкни-
те на кнопке Отмена (Cancel) и введите другое имя файла.

iowtt Off ire Word

! The fife Письмо победителю, do

; Do уем want to;

save фапд

Цегде chan

С* |

Рис. 2.13. Word интересуется, следует ли ему переписать существующий файл

7. Щелкните на кнопке Сохранить (Save) или нажмите клавишу Enter.

Word сохранит документ в указанной папке под указанным именем. Имя фай-
ла появится в строке заголовка документа,

После того как вы в первый раз сохранили текущий файл, в дальнейшем можно
сохранять его двумя способами:

• Команда Файл > Сохранить (File К Save) сохраняет очередные внесенные изме-
нения в файле с тем же именем. Аналогичное действие производит кнопка Со-
хранить (Save) на панели инструментов.
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• Команда Файл > Сохранить как (File > Save As) позволяет сохранить файл с оче-
редными изменениями под другим именем. При выборе этой команды на экра-
не появляется уже знакомое вам окно диалога Сохранение документа (Save As).
Вы опять можете изменить имя документа, его тип и расположение.

Упражнение 2.7. Закрытие документов

После того как вы закончили работу с документом, можно закрыть документ и
освободить место на экране. Если последние изменения в документе не были со-
хранены, Word спросит, нужно ли сделать это перед закрытием (рис. 2.14). Если
несохраненных изменений нет, Word просто закроет документ.

f Ч - -Ооуоу «act to S&.E the changes to •щк

{_ jes " jj.. - - №> Г C

Рис. 2.14. Если щелкнуть на кнопке Yes, Word сохранит
изменения и закроет документ

Давайте закроем сохраненный нами документ. Для этого подходит любой из сле-
дующих вариантов действий:

• выберите команду Файл > Закрыть (File > Close);

• щелкните правой кнопкой мыши на кнопке документа, расположенной на па-
нели задач, и выберите в контекстном меню команду Закрыть (Close);

• щелкните на кнопке Закрыть (Close window) в правом конце строки меню;

• щелкните на кнопке Закрыть (Close) на панели инструментов (если вы помес-
тили ее на стандартную панель инструментов);

• нажмите клавиши Ctrl+W.

В результате Word закроет текущий документ. На экране останутся только стро-
ка заголовка программы Word, панели инструментов и пустое окно, если в дан-
ный момент у вас не открыты другие документы. Из этого пустого окна вы може-
те открывать существующие файлы, создавать файлы или шаблоны и обращаться
к справочной системе Word.

Если вы не сохраните последние изменения в файле и попытаетесь закрыть его,
Word напомнит вам об этом. Давайте снова откроем документ Письмо победителю
с помощью меню Файл. В конце этого меню отображаются имена последних четы-
рех (или девяти, если вы изменили соответствующий параметр на предыдущем
занятии) файлов, с которыми вы работали. Мы внесем исправления в документ и
закроем его.

1. Раскройте меню Файл (File).

2. Выберите в списке файлов в конце меню Файл (File) имя Письмо победителю.doc
(рис. 2.15).
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Рис. 2.15. Выбор имени файла в списке последних открывавшихся файлов
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Трамвайный пр. 2-212
1S14SU, Санкт-Петербург

Уважаемалг-жа Цветова'

Мы рады сообщить Взм. что по итог,
помеленного нашим магазином, лучшей 5ы
сказки» Все читатели, которые подали свои
призами от нашего магазина Бы можете за*
свой приз.

Кроме того, предьявнв это письмо, ш
количество изданий с 40% скидкой.

Искренне Ваш

Андрей Быстрое
.. тт,.-,..~ ,, т-.,

а и з V • \

П-

_*_i Microsoft ОЯке Word
Do уаи want to Hvt Ihc changes 10
"Письмо победите nnj.doc"7

: тк_' I : Цо • Cwicel

>сдные
этся цен
мя и по:

Maraiiiiw

Office OnSne

Рис. 2.16. Word спрашивает, нужно ли сохранять последние внесенные изменения

3. Щелкните после слова переводчик в адресе.

4. Нажмите клавишу Enter и введите текст НИИМЕХМАШ.
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5. Теперь дважды щелкните НЕ. индикаторе ЗАМ (OVR) в строке состояния. Word
перейдет в режим замены, а индикатор ЗАМ (OVR) будет выделен.

6. Щелкните в начале почтового индекса.

7. Введите текст 191456.

8. Снова дважды щелкните на индикаторе ЗАМ (OVR) в строке состояния, чтобы
отключить режим замены.

9. Выберите команду Файл > Закрыть (File > Close).

На экране появится сообщение Word (возможно, что сообщение будет произ-
несено от лица Помощника по Office, как показано на рис. 2.16).

10. Щелкните на кнопке Да (Ye:;). Word сохранит изменения и закроет документ.

Если вы считаете, что изменения сохранять не надо, щелкните на кнопке Нет
(No). Изменения будут проигнорированы. Если вы обнаружили, что вам нужно
внести еще кое-какие изменения, щелкните на кнопке Отмена (Cancel), чтобы
вернуться в документ и продолжить редактирование.

Упражнение 2.8. Открытие документов

Чтобы снова начать работу нал файлом, его нужно открыть. Мы уже открывали
файл с помощью меню Файл (Rle). Ниже перечислено еще несколько способов
открытия документов Word.

• Если вы не очень давно работали с документом, то его можно найти в подменю
Документы главного меню Windows. В это подменю помещаются ярлыки к пос-
ледним открывавшимся фаллам. Щелкните на кнопке Пуск на панели задач
Windows, раскройте подменю Документы и выберите в нем имя нужного фай-
ла.

_в_
Чтобы очистить меню Документы (тогда никто так просто не узнает, с какими
документами вы работали), выберите команду Пуск > Настройка * Панель задач
и меню «Пуск». В открывшемся окне диалога щелкните на вкладке Меню «Пуск»,
затем — на кнопке Настроить и Очистить. Теперь конкуренты, дети, коллеги, да
и вы сами не сможете посмотреть, чем же вы на самом деле занимались.

Если вы открыли папку, содержащую нужный документ, в Проводнике или
окне Мой компьютер, то для открытия документа достаточно просто дважды
щелкнуть на значке этого файла. При этом запустится соответствующее при-
ложение, которое откроет выбранный вами документ.

Если вы уже запустили программу Word, то можно открыть один из послед-
них документов, выбрав его имя в списке в конце меню Файл (File).

Если на экране отображается область задач Начало работы (Getting Started), то в
разделе Открытие документа (Open) также видны имена последних открывав-
шихся файлов.

Наконец, можно использовать команду Файл > Открыть (File > Open) или кноп-
ку Открыть (Open) на панели инструментов.
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Давайте подробнее рассмотрим последний вариант. При выборе команды Файл >
Открыть (File * Open) или щелчке на кнопке Открыть (Open) на экране появляется
окно диалога Открытие документа (Open).

В списке Папка (Look in) вы можете выбрать папку на локальном или сетевом дис-
ке, в которой может находиться открываемый документ.

Кнопка Переход на один уровень вверх (Up One Level) позволяет переходить к папке
или диску, расположенным уровнем выше текущей папки.

Для перехода к предыдущей папке в окнах открытия и сохранения документов,
а также в Проводнике или окне Мой компьютер можно использовать клавишу
Backspace.

Кроме того, кнопка со списком, расположенная рядом со списком Папка (Look in),
позволяет перемещаться по нескольким папкам, которые вы недавно открывали.

По умолчанию Word выводит на экран содержимое последней папки, которая
была открыта для сохранения или открытия документов. В первый раз после оче-
редного запуска Word будет открывать папку Мои документы.

Давайте посмотрим, какие файлы находятся в папке, и изучим их параметры;

1. Щелкните на кнопке Открыть (Open) на панели инструментов

2. В списке Тип файла (Files of type) открывшегося окна диалога (рис. 2.17) выбе-
рите пункт Все файлы (All files).
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Рис. 2.17. В окне диалога открытия документа отображаются все файлы

Выбирая разные типы файлов в этом списке, можно выводить на экран инте-
ресующие вас разные группы файлов. Сейчас в папке видны все файлы.

3. Выберите пункт Все документы Word (All Word documents). На экране появятся
значки документов Word. Обратите внимание на то, что в списке кроме
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документов с расширениями .doc и .rtf есть документ с расширением .htm
(рис. 2.18). Теперь Word умеет работать с документами Интернета..
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1 CO СПИСКОМ. Of Л

Jj&r^ :̂ упнсьчо со списком.him
' Computer ^Проверка прлеолиса i™.doc

| Рисование, doc

Стандартный факс.Ьос

^- *j Таблицы, оо

Рис. 2.18. Документы, котоэые можно редактировать в программе Word

Теперь предположим, что вы хотите увидеть дополнительную информацию о
файлах.

4. Раскройте список кнопки Представления (Views) и выберите пункт Таблица
(Details). На экране появятся данные о размерах, типах и времени последнего
изменения документов (рис. 2.19).

LookfiL :. . jjj Работа

!. ': -у . "• Имя '- Разнер

v; — . ;£ЭМой Веб-документ, files
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; . DOCUmentS - jv i
и .- . . - .. ^lart.aoc jo к&

: : . jsT^t ^ .̂ ееб-прчвет.Ыгп 186 КБ

' i,ii* - • '̂ rHn^pccbumn.doc 24 КБ
Desktop . " ^Записка. doc 20 КБ

-Щкннжнов o6ojpeHHB.dot 28 КБ
-И] Колонтитулы, doc 31 КБ

ж~-^ ' Шмсй Веб-локумгнт htm 9 КБ
| j MyDmjments . ]̂печать.во; 31 КБ

: ^Письно о выставке, doc 24 К5

^Пнсьио победителю, doc 21 КБ

1 : -ЩПнсьно со crncKO4.doc 30 КБ
; ': Wv CoMlUtfir : J^ ~i 'ggnncbuo со списком. htm 25 Kt

Т &;"•"! ! ^Проверив правописания. doc 21КБ

"^ -̂ )Рисовлнне.с(ос 27КБ
; My'Netwarf. ; ^Стандартный tpaKC.doc 47КБ

Л Иа«5 '^ICTHnH.doc 33Кб

! ™j Таблицы. doc 26КБ

\ ^Титульный пнет. doc 30 КБ
^форнат.пР 186 КБ

Fitenaffis: . |

] Fltes * type: All Word Docunen:s (*.doc; *.dot; *.htm
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1ип
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Папка с файлами

Microsoft Word Doc,
HTMl Document
MxrasoFt Word Doc,

Microsoft Word Doc.
Mwosoft Word Doc,

Mfcrosoft Word Doc.
HTML Document

Moosoft Word Doc.
[•Scmsoft Word Doc.

Mkrosoft Word Doc.
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Рис. 2.19. Параметры документов отображаются в виде таблицы
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Если щелкнуть на заголовке столбца, то файлы в списке будут отсортированы
по соответствующему параметру. Сейчас давайте вернемся обратно к обычно-
му списку файлов.

5. Раскройте список кнопки Представления (Views) и выберите пункт Список (List).

6. Выделите нужный файл.

7. Щелкните на к?топке Открыть (Open).

Файл откроется в программе Word. Если вам нужно сразу открыть несколько
файлов, вы можете выделить их и потом щелкнуть на кнопке Открыть (Open).
Для выделения нескольких смежных файлов щелкните на первом в группе,
затем на последнем, удерживая нажатой клавишу Shift. Для выделения не-
скольких несмежных файлов по очереди щелкайте на их значках, удерживая
нажатой клавишу Ctrl (рис. 2.20).

Spi
jf-гт

Looki/i:

My Recent
Documents

i™jMoM беб-документ. Files ^Рисование, doc

Л'Щ веб- привет, htm

• =Щ Гиперссылки,с)ос

:̂ j Записка, doc

!:-Ш^нижное обозрение, doc

;̂ J Колонтитулы, doc
Desktop

My Documents

i-Ш ^Письмо со cnncKOM.htm

My Computer ^проверка правописания, do с

Cancel
... . ;;̂

Рис. 2.20. На рисунке выделены несколько несмежных файлов

Для открытия одного файла достаточно просто дважды щелкнуть на его значке.

Мастера

Мастера — это специальные программы, которые руководят вами при создании
документа того или иного типа. С помощью разных мастеров вы можете созда-
вать письма, факсы, резюме, бюллетени, служебные записки, почтовые наклейки
и т. д. При создании документа вам останется только выбирать подходящий тип
оформления, не делая вручную всю черновую работу.

3 Зак. 481
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Упражнение 2.9. Создание документов с помощью мастера

При работе с мастером вы будете выбирать нужные варианты оформления в соот-
ветствующих окнах диалога. Давайте попробуем воспользоваться мастером для
создания факса.

1. Раскройте меню Файл (File).

2. Выберите команду Создать (New).

На экране появится область задач Создание документа (New Document).

3. Щелкните на строке Общие иаблоны (On my computer), чтобы открыть окно
Шаблоны (Templates).

Окно Шаблоны (Templates) содержит несколько вкладок, в том числе вкладки
Общие (General), Письма и факсы (Letters & Faxes), Записки (Memos), Веб-страницы
(Web Pages), Отчеты (Reports), Другие документы (Other Documents). Возможно,
ваше окно может немного отличаться от приведенного в книге (рис. 2.21).

letters Ь Fares |Ма:!Мвгд»| l̂ omos | Other Documents | PufcfetfiWM) Reports |

. Pravia» ;
Business Fax Conterrporaiy Contemporary Elegant Fax

Fax Le:ter

1

Elegant Letter Envelope Fax Wizard Letter Wizard
Wizard

| Mailing Label Personal Fax Ptpf esiiorial Prof eisional
i Wijard Fai Letter

on Office

- . Create Maw -

v • ?• Document '"' TampWe

Рис. 2.2:1, Окно диалога Templates

Если вы не видите некоторых вкладок в окне диалога Шаблоны (Templates), воз-
можно, вам придется установить шаблоны и мастера с компакт-диска Microsoft
Office 2003. Если при первоначальной установке вы задали для этих компонен-
тов Office параметр Установка по первому требованию, то при первом обраще-
нии программа устаноЕ ки сама установит их с компакт-диска Office.

4. Щелкните на вкладке Письма и факсы (Letters & Faxes).

На этой вкладке вы увидите значки шаблонов и мастеров для создания раз-
личных писем, факсов и почтовых наклеек.

5. Щелкните на значке Мастер факсов (Fax Wizard).

В области Просмотр (Preview) вы увидите миниатюрное изображение страницы
документа, созданного с помощью мастера.
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6. Щелкните на кнопке ОК.

Word откроет первое окно диалога мастера факсов. В его левой части отобража-
ются названия этапов создания факса.

Ж*Л.

/Л/г Если вы хорошо знакомы с возможностями мастера факсов, то можете сразу
•>./ щелкнуть на названии нужного этапа в левой части любого из окон мастера фак-

сов.

7. Щелкните на кнопке Далее (Next).

На экране появится окно диалога Документ для отправки по факсу (Document to
Fax).

8. Б раскрывающемся списке выберите документ, который нужно отправить.

9. Укажите, как следует отправлять документ (рис. 2.22): С титульным листом (With
a cover sheet) или Без титульного листа (Without a cover sheet).

Which document do you want to send?

" £"" Without a cover sheet

lust a raver sheet with з note

Brash

Рис. 2.22. Мы собираемся отправлять документ Письмо победителю-doc
по факсу с приложением титульного листа

10. Щелкните на кнопке Далее (Next). На экране появится окно диалога Программ-
ное обеспечение факса (Fax software).

Кнопка Назад (Back) вернет вас в предыдущее окно диалога. Кнопка Отмена
(Cancel) позволяет отказаться от создания документа с помощью мастера. Кноп-
ка Готово (Finish) создает документ с текущими параметрами.

11. Выберите тип программного обеспечения, которое используется на вашем ком-
пьютере для создания и отправки факсов, или выберите вариант простой печа-
ти документа и титульного листа и отправки их по обычному факс-аппарату.
Щелкните на кнопке Далее (Next).
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12. В появившемся окне диалога нведите имя получателя и номер факса (рис. 2.23).
Щелкните на кнопке Далее (№xt),

nflЩ Document to Fax

i
Щ f a x Software

W ю should receive this fax?

Oiter redpiants' names and numbers betew, exactly as they shiM
Ы; dated, O, if you have the recipients'Fax numbers h your :

: address bock, ckk the Address Soo^buttontc select the names-

.-.

Cancel <gack | "Next >

Рис. 2.23. Ввод имени получателя и номера факса

13. В окне диалога Титульный лист (Cover sheet) выберите тип оформления для ти-
тульного листа факса: Профессиональный (Professional), Современный (Con-
temporary) или Изысканный (Eiegant).

14. В окне диалога Отправитель (Sender) введите данные о себе и/или своей орга-
низации (рис. 2.24).

Who is the fax from?

Warre: .[Андрей Быстрое

Corrpany: : Магазин "Книги"

. Энтузиастов, 2
|1Э05566С.Петербург

Рис. 2.24. Эти данныэ будут включены в титульный лист факса
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15. Щелкните на кнопке Готово (Finish), чтобы закрыть последнее окно мастера.

Созданный титульный лист факса появится в отдельном окне документа
Word (рис. 2.25). На экране также может появиться Помощник.

FACSIMILE THAN5MITTAL SHEET

Андрей

TAX NUUIEIL-

(812)322-12-14

Mte:

October 27, 2003

COMPANY;

[Clids here and type company name]

TOTAL NO.OF PACES INCLUDING COVER:

[Clidi here and type number of pages]

PHONE NUftlUK
[Clidt here and type phone number]

SENBEB-S REFERENCE NUMBER

[Clidt here and type reference number]

[Clidi here and type subjea of fax]

YOUR REFERENCE NUMBER:

[Clidt here and type reference number]

т a ijji И -j
Щ

Рис. 2.25. Готовый титульный лист для факса

16. Выберите команду Файл > Сохранить как (File > Save As).

17. Введите имя файла Мой факс и нажмите клавишу Enter, чтобы сохранить доку-
мент.

Теперь вы можете внести некоторые изменения в титульный лист, например, до-
бавить нужные номера телефонов, ввести свои комментарии в предлагаемые поля,
указать тему сообщения, ввести имена получателей, которым будут отправлены
копии факса, задать число страниц отправляемого документа, включая титуль-
ный лист.

Контрольное занятие

Сейчас мы закрепим навыки, приобретенные на этом занятии. Ответы на конт-
рольные вопросы помогут вам проверить себя.

1. Запустите Microsoft Word.

2. Вставьте текущую дату с помощью команды Вставка * Время и Дата (Insert >
Date and Time).

3. Введите адрес и приветствие.
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2.1. В чем разница между клавишами Backspace и Delete?

4. Введите пару абзацев текста и заключительную фразу.

2.2. Как создать красную строку абзаца?

2.3. Как отображать и скрывать значки абзацев и пробелов?

5. Сохраните файл с каким-нибудь именем.

2.4. Что нужно сделать, чтобы сохранить файл в формате Word 6.0/95?

6. Закройте файл.

2.5. Как быстрее всего закрыть документ?

7. Снова откройте файл.

2.6. Как можно открыть документ, с которым вы недавно работали?

2.7. Как отобразить информацию о документе в окне диалога Открытие документа
(Open)?

8. Вставьте постскриптум в письмо.

9. Замените одно из слов в режиме замены.

2.8. Как узнать, в каком режиме ввода в данный момент работает Word?

10. Закройте файл, сохранив изменения.

11. Снова откройте последний документ.

12. Создайте для него титульный лист факса с помощью мастера факсов.

Возможные проблемы

Проблема Решение

Я вставил в документ Установите флажок Обновлять автоматически
дату, но она не обновляется (Upda;e automatically) в окне диалога Дата и время
автоматически при печати (Date ,ind Time), чтобы предусмотреть возможность

обновления даты в документе. Для обновления даты
вручную можно щелкнуть правой кнопкой мыши на дате
и выбрать команду Обновить поле (Update Field)

Я не могу найти Если вы работали с файлом не очень давно, попробуйте
сохраненный найти его в списке файлов в нижней части меню Файл
и закрытый файл (File) в окне программы Word или в подменю Документы

меню кнопки Пуск
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Проблема Решение

Я не вижу нужного файла в
окне диалога Открытие
документа (Open)

Я не могу изменить
название новой панки

Я пытаюсь перейти
к предыдущей папке
с помощью клавиши
Backspace, но у меня
ничего не получается

Я не могу найти значок
мастера факсов

Выберите пункт Все файлы (All files) в списке Тип файла
(Files of type). Если нужный файл псе равно не виден,
проверьте другие папки

Щелкните правой кнопкой мыши на названии папки,
выберите команду Переименовать (Rename)
и введите другое имя

Сначала щелкните в основном окне папки,
а затем используйте клавишу Backspace

Если этого значка нет на вкладке Письма и факсы
(Letters and Faxes) окна диалога Шаблоны (Templates),
попробуйте повторить установку Office XP и установить
этот компонент

Подведение итогов

Итак, мы научились работать с документами, создавать, открывать, сохранять и
закрывать их. Кроме того, познакомились с одним из мастеров Word — мастером
факсов — и создали документ с его помощью. На следующем занятии мы узнаем,
как ориентироваться в длинных документах и максимально эффективно выби-
рать режим работы с документами в зависимости от того, какие текущие задачи

вы решаете.
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Перемещение
в документе

Тема занятия

Для уверенной работы с документами в программе Word нужно уметь перехо-
дить к нужным фрагментам. На этом занятии вы познакомитесь с разными спосо-
бами перемещения в документах Word. Вы научитесь:

• перемещаться между документами;

• перемещаться в пределах документа;

• вставлять символы разрыва страниц;

• удалять символы разрыва страниц;

• переходить к нужным страницам.

Подготовка к занятию

Скорее всего, вам придется работать с документами, все содержание которых не
умещается в одном окне программы Word. Документы могут содержать много
страниц, разные разделы, включать в себя рисунки, таблицы, видеоклипы, звуко-
вые файлы и многое другое. Как же ориентироваться в таких сложных докумен-
тах? Конечно, никто не захочет просто прокручивать документ из ста страниц с
помощью клавиши со стрелкой, чтобы найти нужный абзац. Для этого существу-
ют более эффективные способь. О них мы и будем говорить в этой главе.
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Кроме того, часто приходится работать с несколькими документами одновремен-
но. Как наилучшим образом расположить их на экране? Читайте дальше, и вы
узнаете, как Word позволяет обращаться с окнами документов.

Перемещение между документами

Если вы откроете несколько документов Word, то программа создаст для каждого
документа отдельное окно. Как вы, наверное, уже знаете, в Windows каждому от-
крытому приложению соответствует кнопка на панели задач. Для переключения
между ними используют мышь или клавиши Alt+Tab. Office 2003 не запускает оче-
редную копию своего приложения для каждого документа, а просто создает для
него отдельное окно, выглядящее совсем как окно приложения.

Упражнение 3.1. Использование разных способов
перемещения между документами

Давайте попробуем открыть сразу несколько документов и попробовать переклю-
читься между ними.

1. Запустите Word. Программа создаст документ с названием Документ 1 (Docu-
mentl).

2. Щелкните на кнопке Создать (New Blank Document). Вы увидите второй доку-
мент, названный Документ 2 (Documents).

3. Еще несколько раз щелкните на1 кнопке Создать (New Blank Document).

Теперь на панели задач располагается несколько кнопок с «фирменным» значком
Word (рис. 3.1). Если на пару секунд поместить указатель мыши на кнопку, не
нажимая ее, то в появившейся подсказке отобразится название документа —
в нашем случае Документ 1 (Documentl), Документ 2 (Document2) и т. д.

4. Щелкните на одной из кнопок документа Word. Вы увидите такое же окно
программы Word, только с другим названием документа в заголовке окна.

Теперь давайте попробуем переключиться между документами с помощью
клавиш.

5. Нажмите (и удерживайте нажатой) клавишу Alt.

6. Не отпуская клавишу Alt, нажмите клавишу Tab.

На экране появится небольшая панель с набором значков, соответствующих
запущенным приложениям (или существующим кнопкам на панели задач).
В нижней части панели отобразится название приложения (и название доку-
мента, открытого в нем).

7. Удерживая нажатой клавишу Alt, несколько раз нажмите клавишу Tab. Вы уви-
дите, как значки открытых приложений (или документов Office) будут пооче-
редно выделяться рамкой (рис. 3.2). Когда она окажется на нужном значке,
отпустите клавишу Alt. На экране появится выбранное окно приложения или
документа.
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Рис. 3.2. Переключение между окнами с помощью клавиш Alt+Tab

Обратите внимание на то, что для управления окнами документов в Word исполь-
зуются те же приемы, что и для работы с окнами приложений. Чтобы свернуть
окно документа, щелкните на кнопке свертывания в строке заголовка окна. Для
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закрытия окна применяется кнопка закрытия. Вы также можете щелкнуть пра-
вой кнопкой мыши на кнопке нужного документа на панели задач и выбрать под-
ходящую команду в контекстном меню (рис. 3.3).

.:•

Рис. 3.3. Выбор в контекстном меню команды для управления окном приложения

Перемещения в документе

Что делать, если в вашем документе целых двадцать страниц, а текст, который
нужно исправить, находится где-то на восемнадцатой? Как ориентироваться в
сложных документах? Сейчас мы узнаем, что поможет легко находить нужный
фрагмент,

Полосы прокрутки

Полосы прокрутки располагаются справа и снизу от рабочей области окна про-
граммы (рис. 3.4). Это действительно полосы, которые заканчиваются неболь-
шими кнопками со стрелками. Кроме того, по полосе прокрутки перемешается
бегунок — небольшой прямоугольник. Его положение на полосе прокрутки со-
ответствует тому фрагменту документа, который выводится на экран. Перетас-
кивая бегунок с помощью мыши, вы прокручиваете видимую часть документа.
Если щелкать на кнопках со стрелочками, то документ будет перемещаться вверх
или вниз на одну строку. Если щелкать на полосе прокрутки выше или ниже
бегунка, видимая часть переместится вверх или вниз на один экран соответ-
ственно.
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Бегунок —*

Прокрутка документа
на одну строку вверх
Вертикальная
полоса прокрутки

— Прокрутка документа
на один экран вверх

— Прокрутка документа
на один экран вниз

• Прокрутка документа
на одну строку вниз

Прокрутка документа
на один экран влево

Горизонтальная Прокрутка документа
полоса прокрутки на один экран вправо

Рис. 3.4. Полосы прокрутки

При прокручивании документа курсор остается на месте. Чтобы переместить его,
нужно щелкнуть мышью в нужном месте.

Если этого не сделать, при нажатии любой клавиши вы снова увидите курсор
в исходном месте документа.

Горизонтальная полоса прокрутки используется реже, но принцип ее действия
тот же самый.

В современных манипуляторах типа «мышь» часто можно встретить третью кноп-
ку в виде колесика, которая облегчает просмотр документов. Если ваш компью-
тер оборудован такой мышью, обратитесь к системному администратору, что-
бы он объяснил вам, как лучше ее использовать,

Клавиши

Бесспорно, полосы прокрутки удобны для работы, когда вы, развалившись в ком-
фортном кресле, лениво двигаете мышкой по коврику. А если вы очень быстро
печатаете, и каждая .операция мышью воспринимается вами как досадная поме-
ха? Для таких пользователей (и особенно для тех, кто при работе с клавиатурой
использует более двух пальцев) существует много сочетаний клавиш.

Прежде всего это клавиши со стрелками, Еще вам понадобятся клавиши PageUp,
PageDown, End, Home, а также клавиша Ctrl.

Возможные сочетания клавиш приведены ниже.

Чтобы переместиться... Нажмите клавишу.

На одни символ вправо
На один символ влево

•
i
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Чтобы переместиться... Нажмите клавишу...

На одну строку вверх
На одну строку вниз i
На одно слово вправо Ctrl+->
На одно слово влево Ctrl+<—
В начало строки Ноте
В конец строки End
В начало документа Ctrl+Home
В конец документа Ctrl+End
На один экран вверх PageUp
На один экран вниз PageDown
К предыдущему объекту поиска Ctrl+PageUp (по умолчанию к предыдущей странице)
К следующему объекту поиска Ctrl+PagcDown (но умолчанию к следующей

странице)

Работа с несколькими страницами

По правилам хорошего тона, деловое письмо должно умещаться на одной страни-
це. Однако есть документы, которым совсем не обязательно быть такими кратки-
ми. Что делать, если вы работаете с длинным документом, не помещающимся на
одной странице? Ничего страшного, просто продолжайте печатать, и Word авто-
матически разобьет текст на страницы.

Это разбиение выполняется, исходя из заданных параметров страницы Word.
Если объем текста или его форматирование изменятся, то и разбивка на страни-
цы тоже может измениться.

Чтобы начать новую страницу в определенном месте, можно вставить в документ
символ принудительного разрыва страницы. Обычно это имеет смысл делать пе-
ред таблицами (чтобы не разрывать их), перед заголовками, после рисунков
и т. д. Такие вставленные вручную символы разрыва страниц уже не будут изме-
нять своего положения при изменении текста или форматировании документа.

Автоматические разрывы страниц обозначаются на экране горизонтальной пунк-
тирной линией. Символы принудительного разрыва выглядят как сплошные ли-
нии со словами Разрыв страницы (Page Break). Эти символы, как и любые другие
символы в документе, можно удалять. Обращайтесь с ними так же, как с символа-
ми конца абзаца. Их можно выделять, копировать, перемещать, удалять и т. д.

Для перехода к нужной странице можно использовать разные способы. О них мы
поговорим в одном из следующих разделов этого занятия.

Упражнение 3.2. Вставка символа разрыва страницы

Если вы просто вводите большое количество текста, Word автоматически разби-
вает его на страницы. Эти разрывы страниц обозначаются пунктирными горизон-
тальными линиями. Автоматическая разбивка может изменяться в зависимости
от объема текста и его форматирования. Зачастую она вас устраивать не будет,
поэтому придется часть разрывов страниц формировать вручную, например,
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вставлять символы разрывов страниц перед большими таблицами или рисунка-
ми. Давайте представим, как это делается.

1. Создайте новый документ.

2. Введите цифру 1 и нажмите клавишу Enter.

3. Выберите команду Вставка > Разрыв (Insert > Break), как показано на рис. 3.5.

• '• /- •

i S-:s-W 11 j - Jjj

Рис. З.5. Выбор команды для вставки символа разрыва страницы

4. В окне диалога Разрыв (Break) убедитесь, что установлен переключатель Раз-
рыв страницы (Page break), и щелкните на кнопке ОК (рис. 3.6).

Eteak types - -

..>' ..Column break

<'', ted wapping break

" С Цех; page -

Even page (̂

Рис. З.6. Окно диалога Break
•

Word вставит в документ символ разрыва страницы в виде сплошной гори-
зонтальной линии со словами Разрыв страницы (Page Break), как показано на
рис. 3.7. Курсор окажется на следующей странице, что будет отражено
в строке состояния.
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Рис. З.7. В документ вставлен символ разрыва страницы

5. Введите цифру 2 и нажмите Enter.

6. Нажмите клавиши Ctr+Enter.

Вы увидите, что Word вставит в документ еще один символ разрыва страницы.
Сочетание клавиш Ctrl+Enter — это быстрый способ вставки символов разрыва
страниц в документ Word.

7. Введите цифру 3 и нажмите Enter.

8. Нажмите клавиши Ctrl+Enter.

9. Введите цифру 4 и нажмите Enter.

Итак, теперь у нас есть документ с четырьмя страницами.

Упражнение 3.3. Удаление символа разрыва страницы

Для удаления символа разрыва страницы достаточно выделить его и нажать кла-
вишу Delete. Существуют и другие способы удаления.

1. Нажмите клавиши Ctrl+End, чтобы перейти в конец документа.

2. Поместите курсор перед цифрой 4.

3. Нажмите клавишу Backspace. Предыдущий символ разрыва страницы будет
удален.

4. Нажмите клавиши Ctrl+Home, чтобы перейти в начало документа.

5. Щелкните на символе разрыва страницы после цифры 1.

6. Нажмите клавишу Delete.
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Упражнение 3.4. Переход к нужной странице

Для перехода к нужной странице Word предоставляет несколько способов, пере-
численных ниже:

• Команда Правка > Перейти (Edit > Go To) или клавиши Ctrl+G и F5.

• Кнопки перехода на вертикальной полосе прокрутки или клавиши Ctrl+PageUp
и Ctrl+PageDown.

• Полоса прокрутки.

Кроме того, в режимах просмотра документа Разметка страницы (Print Layout) и
Предварительный просмотр (Print Preview) на экран можно вывести несколько стра-
ниц сразу и перемещаться между ними, просто щелкая на нужной странице.

1. Создайте еще несколько страниц в документе, как описано ранее.

2. Нажмите клавиши Ctrl+Home, чтобы перейти в начало документа.

3. Нажмите клавишу F5. На экраге появится окно диалога Найти и заменить (Find
and Replace), показанное на рис 3.8.

4. Перейдите на вкладку Перейти (Go To).

5. В поле Введите номер страницы (Enter page number) введите число 3 и нажмите
клавишу Enter или щелкните на кнопке Перейти (Go To).

Курсор переместится на страницу 3.

Section
Line
Bookmark
Comment
:ootnote
Endnote

Enter + end -to move relative to theturrent
location, Exancte: -и WB mow forward fw*
Items.

Рис. З.8. Окно диалога поиска и замены предназначено для задания условий перехода

Если не вводить конкретного числа в поле Введите номер страницы (Enter page
number), то переход по страницам или другим объектам документа может произво-
диться с помощью кнопок Назад (Previous) и Далее (Next). Объект перехода можно
выбрать в списке слева. Доступные варианты: Страница (Page), Раздел (Section), Стро-
ка (Line), Закладка (Bookmark), Примечание (Comment), Сноска (Footnote), Концевая снос-
ка (Endnote), Поле (Field), Таблица (Table), Рисунок (Graphic), Формула (Equation), Объект
(Object), Заголовок (Heading). Просто выберите нужный объект документа в этом
списке и щелкните на кнопке Далее (Next). Если ввести номер соответствующего
объекта, то название кнопки Далее (Next) изменится на Перейти (Go To).

Если нажать клавиши Shift+F5, то курсор переместится в точку последнего из-
менения документа. Повторное нажатие переместит курсор в предпоследнюю
точку и так далее по циклу до трех раз.
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Полоса прокрутки тоже помогает быстро найти нужную страницу. При перетас-
кивании бегунка на вертикальной полосе прокрутки рядом с ним отображается
номер текущей страницы.

Упражнение 3.5. Выбор объекта перехода

Представьте, что вам нужно изменить все подписи к рисункам в одном большом
файле. Конечно, можно потихоньку прокрутить документ с помощью полос про-
крутки, но в данном случае это будет не очень разумным решением. Специально
для поиска однотипных объектов в больших (и небольших) документах применя-
ется кнопка Выбор объекта перехода (Select Browse Object). Она располагается в ниж-
ней части вертикальной полосы прокрутки. Эта кнопка является аналогом окна
Найти и заменить (Find and Replace). Сверху и снизу от нее находятся кнопки с двой-
ными стрелками. Они служат для быстрого перемещения между объектами ука-
занного типа и являются аналогами кнопок Назад (Previous) и Далее (Next) в окне
Найти и заменить (Find and Replace). Давайте посмотрим, как работать с этим инст-
рументом.

1. Нажмите клавишу PrintScreen. Обычно она располагается в верхнем ряду слу-
жебных клавиш на стандартной клавиатуре. Эта клавиша «фотографирует »
текущее изображение на экране и помещает его в буфер обмена.

2. Нажмите клавиши Ctrl+Home и клавиши Ctrl+V, чтобы вставить изображение
перед цифрой 1.

3. Щелкните перед цифрой 2 и снова нажмите Ctrl+V, чтобы вставить изображе-
ние перед цифрой 2.

4. Вставьте рисунки перед всеми цифрами.

5. Нажмите клавиши Ctrl+Home.

6. Щелкните на кнопке Выбор объекта перехода (Select Browse Object).

На экране появится несколько кнопок, соответствующих различным типам
объектов документа (рис. 3.9). Перечислим названия кнопок: Перейти (Go To),
Найти (Find), Исправления (Edits), Заголовки (Heading), Рисунки (Graphic), Таблицы
(Table), Поля (Field), Концевые сноски (Endnote), Сноски (Footnote), Примечания
(Comment), Разделы (Section), Страницы (Page). После щелчка на нужной кнопке
названия кнопок Назад (Previous) и Далее (Next) будут соответствовать выбран-
ному объекту, например, Предыдущий раздел (Previous Section) и Следующий раз-
дел (Next Section). Теперь для перехода между объектами указанного типа можно
просто щелкать на этих кнопках.

Для перемещения между объектами выбранного типа используются также кла-
виши Ctrl+PageUp и Ctrl+PageDown.

7. Щелкните на кнопке Рисунки (Browse by Graphic), чтобы выбрать тип объекта
перехода.

8. Щелкните на кнопке Следующий рисунок (Next Graphic).

Курсор переместится в точку перед рисунком на странице 2.
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Рис. 3.9. Кнопка выбора объекта перехода позволяет
указать нужный тип объектов документа

9. Нажмите клавиши Ctr+PageDown.

Курсор переместится в точку перед рисунком на странице 3.

10. Нажмите клавиши Ctrl+PageUp.

Курсор переместится обратно в точку перед рисунком на странице 2.

11. Сохраните и закройте докуме нт.

Аналогичным образом можно «перепрыгивать» от таблицы к таблице, от заголов-
ка к заголовку и т. д.

Контрольное занятие

Сейчас мы закрепим навыки, приобретенные,на этом занятии. Ответы на конт-
рольные вопросы помогут вам проверить себя.

1. Запустите Microsoft Word.

2. Откройте документ, созданный вами в ходе выполнения упражнений преды-
дущего раздела.

3. С помощью вертикальной полосы прокрутки прокрутите документ на несколь-
ко строк вниз.

3.1. Как увидеть крайнюю правую границу документа?

4. Прокрутите документ на несколько экранов вниз.

5. Прокрутите документ на несколько экранов вверх.

6. Прокрутите документ до конца.

3.2. Какое сочетание клавиш используется для перемещения в конец документа?

7. Вставьте символ разрыва страницы.

3.3. Чем различаются автоматический и принудительный разрывы страницы?

8. Перейдите к странице 3 с помощью окна Найти и заменить.



Подведение итогов S3

9. Перейдите к страницам 4 и 5 с помощью кнопок Назад (Previous) и Далее (Next).

10. Сохраните файл.

11. Закройте Microsoft Word.

Возможные проблемы

Проблема Решение

Я прокрутил документ
с помощью полос
прокрутки, но когда
попытался ввести текст,
курсор оказался
на прежнем месте

Я хочу вставить поиую
страницу в середину
документа

Мне нужно быстро
перейти на страницу 23

Как удалить пустую
страницу в документе?

Я не могу перейти
от одного рисунка
к другому е помощью
клавиш Ctrl+PageUp
и Ctrl+PageDown

Перед тем как вводить текст после прокрутки документа,
щелкните в нужной точке ввода

Поместите курсор в точку начала ноши страницы
и нажмите клавиши Ctrl+Enter

Нажмите клавишу F5, введите 23 в поле Введите номер
страницы (Enter page number) вкладки Перейти (Go To)
окна диалога Найти и заменить (Find and Replace)
и нажмите клавишу Enter

Поместите курсор точно после символа разрыва страницы
и нажмите клавишу Backspace

Сначала выберите объект Рисунок (Graphic) с помощью
кнопки Выбор объекта перехода (Select Browse Object)
на полосе прокрутки

Подведение итогов

На этом занятии вы научились:

• перемещаться между документами Office и Windows-приложениями;

• перемещаться в пределах документа с помощью клавиш и полос прокрутки;

• вставлять символы разрыва страниц;

• удалять символы разрыва страниц;

• переходить к нужным страницам.

Необходимые навыки закрепятся у вас очень быстро, если вы будете часто рабо-
тать с многостраничными документами. Не стесняйтесь экспериментировать с

разрывами страниц.

На следующем занятии мы познакомимся с редактированием документов.



Занятие 4

Редактирование текста

Тема занятия

На первых занятиях вы приобрели начальные навыки работы с программой Word.
Теперь ваша задача — научиться работать с текстом документов более уверенно.
На этом занятии вы научитесь:

• выделять текст;

• удалять текст;

• копировать и перемещать текст;

• работать с командами повторения и отмены;

• изменять регистр символов;

• вставлять в документ нестандартные символы.

Подготовка к занятию

Вы работаете над документом. Поскольку очень немногие люди умеют с первого
раза точно выразить нужную мысль, документ, создаваемый вами, скорее всего,
придется корректировать уже в процессе ввода текста. Вам захочется что-то доба-
вить, убрать, перефразировать, снова добавить и так далее до бесконечности.

Чтобы выполнить эти операции над текстом создаваемого документа, нужно
знать, как они реализуются в программе Word. До массового производства про-
грамм с голосовым интерфейсом еще довольно далеко, поэтому придется все де-
лать по старинке: с помощью мыши, клавиатуры и стандартного набора команд.
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Итак, на этом занятии мы познакомимся с командами Word для копирования,
удаления, перемещения, вставки, поиска и замены текста, а также с другими по-
лезными командами.

Нам понадобится деловое письмо, созданное вами на одном из предыдущих за-
нятий (рис. 4.1). Мы будем вносить изменения в текст и оформление этого до-
кумента.

26 мстября2003г

Г-жа Елена Цветков а
Референт-переводчик
Трамвайный пр 2 - 2 1 2
191457. Саюст-Петербург

Ув а* ас мая г-жа Цветкова'

Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книгам,
проведенного нашим магазином, лучшей была признана книга «Русские народны?
сказки» Все читатели, которые подали свои голоса за эту книгу, награждаются ценными
призами от нашего магазина Вы можете зайти к нам в удобное для Вас время и получить
свой приз.

Кроме того, предъявив зто письмо, вы можете приобрести в нашем магазине любое
количество изданий с 10% скидкой

I
Искренне Ваш

Андрей Быстрое
Директор магазина «Книги»

Рис. 4.1. Документ с подготовленным текстом

Приемы выделения текста

Прежде чем выполнить какую-либо операцию с текстом, нужно указать програм-
ме Word, какой именно фрагмент (часть слова, слово, абзац или весь текст) вы
хотите изменить. Для этого существуют средства выделения текста. Текст можно
выделять с помощью клавиш и с помощью мыши. Основные сочетания клавиш и
другие приемы для выделения текста перечислены ниже.

Чтобы выделить... Сочетание клавиш или прием.

Один символ справа от курсора

Один символ слева от курсора

Одно слово справа от курсора

Одно слово слева от курсора

Одну строку выше курсора

Одну строку ниже курсора

Shift+<-

Shift+Ctrl+->

Shift+Ctrl+<-

Shift+t

Shift+J.
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Чтобы выделить... Сочетание клавиш или прием...

Весь текст от курсора до конца строк!-:

Весь текст от курсора до начала строки

Весь текст от курсора до конца документа

Весь текст от курсора до начала документа

Весь текст от курсора до точки щелчка

Одно слово

Одно предложение

Одну строку

Один абзац

Документ целиком

Любой фрагмент

Shift+End

Shift+Home

Shift+Ctrl+End

Shift+Ctrl+Home

Shift+щслчок мышью

Двойной щелчок на слове

Ctrl+щелчок на предложении

Один щелчок на левом поле
в этой строке

Тройной щелчок в абзаце или
Ctrl+щелчок на левом поле
в этом абзаце

Тройной щелчок на левом поле или
Ctrl+щелчок на леном поле или Ctrl+A

Щелчок при нажатой клавише Shift —
выделяется фрагмент от текущей
позиции курсора до места щелчка

Упражнение 4.1. Выделение текста

Выделив текст, вы определяете -(область поражения» для очередной команды.
Текст выделяется с помощью клавиш и мыши. Мы откроем документ, созданный
вами на одном из предыдущих занятий, и попробуем выделять в нем разные фраг-
менты.

1. Откройте файл Письмо победителю.doc,

2. Нажмите левую кнопку мыши в начале первого абзаца письма и удерживайте
ее нажатой. Перетащите указатель мыши поверх текста. Подсветка покажет
текущие размеры выделенного фрагмента (рис. 4.2). Таким способом можно
выделять фрагменты любого размера, начиная от одного символа и заканчи-
вая целым документом. Однако советую вам выделять с помощью мыши толь-
ко небольшие фрагменты (в пределах одного экрана).

3. Дважды щелкните на слове сообщить. Двойной щелчок на слове выделяет толь-
ко это слово.

4. Щелкните на левом поле напротив первой строки. Строка окажется выделен-
ной. Когда указатель мыши оказывается в левом поле, он принимает вид стрел-
ки, направленной вправо и вверх.

5. Нажмите левую кнопку мыши на левом поле напротив второй строки. Не от-
пуская кнопку мыши, перетащите указатель по левому полю вниз. Вы увиди-
те, что по мере перемещения указателя строки по очереди будут выделяться
(рис. 4.3).

6. Удерживая нажатой клавишу Ctrl, щелкните в любом месте в третьем предло-
жении первого абзаца. Такой щелчок выделит предложение целиком.
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Г-жа Елена Цветкова
Референт-переводчик
Трамвайный пр. 2-212
191457, Санкт-Петербург

Уважаемая г-жа Цветкова!

Мы рады сообщить Вам, что по итогам опроса ((Лучшая детская книг-аи.
доведенного нашим магазином, луч щей была признана книга «Рус^гнг наред
сразмп1 Bet чнтагелн. которые подали свои гчлосаза ЭТУ книг- г награждаются ценными
призами от нашего магазина Вы можете зайти v. нам в удобное Для Вас время и получить
свой приз

Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине любое
КОЛИЧЕСТВО издании с 40% скидкой.

Искренне Ваш

Андрей Быстрое
Директор магазина «Книги»

.э« 1 аи 1 j / i ' м ii2cm w is Coi l •-• r. > .- ' •• Busseoiftu Ш " -"- ."

Рис. 4.2. Выделение фрагмента текста с помощью мыши

26 октября 2003г.

Г-жа Елена Цветков а
Референт-переводчик
Трамвайный пр 2-212
191457, Санкт-Петербург

Уважаемая г-жа Цветкова!

Мы рады сообщить Вам. что по итогам опроса «Лучшая детская книга».
1роведеиного нашим магазинсм, лучшей Была признана ккнгл «Русские народные
:казм!ч Все читатели, которые подали СБОИ голоса за эту книгу, награждаются ценными

ризами от нашего магазина Вы можете зэйтп г нам в удобное для Вас вяемя и получить

Кроме того, предъявив это письмо, эы можете приобрести в нашем магазине любое
количество изданий с 40% скидкой

Искренне Ваш

Андрей Быстрое
Директор магазина «Книгнв

-- ;-• '.- ••-.- RussmfPii ' Ш.

•:

Рис. 4.3. Выделение по строкам

7. Дважды щелкните на левом поле рядом со вторым абзацем, чтобы выделить его.

8. Щелкните в начале первого абзаца. Затем, удерживая нажатой клавишу
Shift, щелкните в конце второго абзаца. Весь текст между первоначальной
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позицией курсора и точкой щелчка мышью будет выделен. Такой способ удо-
бен для точного выделения фрагмента текста.

9. Трижды щелкните на левом поле документа. Вы увидите, как выделится весь
документ.

10. Щелкните в любом месте документа. Одиночный щелчок в любом месте сни-
мает текущее выделение.

Удаление, копирование и вставка текста

Упражнение 4.2. Удаление текста

До сих пор для удаления текста мы пользовались клавишами Backspace и Delete.
Возможно, вам придется столкнуться с ситуацией, когда нужно будет удалять це-
лые фрагменты уже введенного текста. Согласитесь, что посимвольное удаление
текста с помощью названных клавиш не слишком рационально. Можно просто
выделить ненужный фрагмент и нажать клавишу Delete (или Backspace). Давайте
попробуем удалить последний абзац письма.

1. Трижды щелкните в последнем абзаце, чтобы выделить его (рис, 4.4).

2. Нажмите клавишу Delete.

Word удалит текст. Оставшийся текст сдвинется вверх.

Г-жа Елена Цвгткова
Референт-переводчик
Трамвайный пр. 2-212
1914 57, Санкт-Петербург

Уважаемая г-жа Цветова!

Мы рады сообщить Вам. что по итогам опроса «Лучшая детская книга»,
проведенного нашим магазином, лучшей был;, признана книга ((Русские народные
сказки» Все читатели, которые подали свои голоса за эту книгу, награждаются ценными
призами от нашего магазина Вы можете зайти к нам в удобное для Вас время и получить
свой приз

гСроме того, предъявив зто письмо, вы мсжет!" приобрести F н-шитл кнзчтк як>6с

Андрей Быстрое
Директор магазина «Кингк»

Рис. 4.4. Если нажать клавишу Delete, выделенный фрагмент будет удален
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V£ При удалении текста с помощью клавиши Backspace или Delete удаленный текст
•V но ПОХПЯНЯРТПЯ я fivrfipnp оймяня nnrvrriMv РГП wonk^a fiunpr пгтяпмти. R nrwrnoне сохраняется в буфере обмена, поэтому его нельзя будет вставить в другое

место.

Упражнение 4.3. Восстановление удаленного текста

Теперь давайте представим, что нам все-таки нужен удаленный абзац. Чтобы вос-
становить его, можно воспользоваться командой отмены. Word снисходительно
относится к тем, кто часто «берет свои ходы» обратно. Сейчас мы восстановим
удаленный абзац.

1. Щелкните на кнопке Отменить (Undo) на стандартной панели инструментов
(рис. 4.5), Ура! Удаленный абзац восстановлен,

2. Щелкните в любом месте документа, чтобы снять выделение фрагмента.

J;i!.f. |,мл rif-'чмит-ш (i

*J» £dr Vie* inswt Fotmat look

..: ,. Л i : Ш . " > -! *!
---. , -̂ ^ .- , :- . ' т-ь .-.

26 октябоя 20D3 г.
Undo I Лисп

Г-*а Елена Цветков а
Референт-переводчик
Трамвайный пр. 2-212
191457. Санкт-Петербург

Уважаемая г-жа Мвпкоеа!

Мы рады сообщить Вам. чти по итсгаи опроса «Лучшая детская книга),
проведенного нашим магазином, лучшей была признана книга «Русские народные
сказки». ВСЕ читатели, которые подали свои голоса за эту книгу, награждаются ценными
призами от нашего магазина. Вы можете «айтн к нам в удобное для Вас время н получить
сЕсЛ приз

Искренне Ваш

Андрей Быстрое
Директор магазина «Книги» -:

i f« at 9,Jcm " 1л 16 Co(

Рис. 4.5. Отмена последнего действия — удаления

В одном из следующих упражнений мы познакомимся с этой полезной командой
поближе.

Упражнение 4.4. Вырезание и вставка текста

Операцию вырезания с последующей вставкой текста по-другому можно назвать
перемещением текста. Например, может потребоваться поменять местами несколь-
ко абзацев или переместить какой-нибудь фрагмент из одного документа в другой.
Вам не придется заново вводить текст в новом месте и потом удалять исходный
фрагмент. Сейчас мы переместим несколько слов в пределах документа.
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1. Во втором абзаце нажмите левую кнопку мыши и перетащите указатель по-
верх слов в нашем магазине.

2. Щелкните на кнопке. Вырезать (Cut). Возможно, что на сокращенном варианте
стандартной панели инструментов ее видно не будет, так что вам придется сна-
чала щелкнуть на кнопке с двойной стрелкой в правом конце панели инстру-
ментов. На кнопке Вырезать (Cut) помещено миниатюрное изображение нож-
ниц (рис. 4.6). Вы также можетэ воспользоваться командой Правка > Вырезать
(EditKIut).

Ы4 Noimal * Fn« lin ..iroesh

Г-*а Елена Цветкова
Р с ф ер ент- пер № о дчнк
Трамвайный пр 2-212
19 [457. Саша-Петербург

Уважаемая г-жа Цветова

Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книга»,
проведенного нашим магазином, лучшей быта признана книга «Русские народные
сказки» Все читатели, которые подали свош олоса за эту книгу, награждаются ценными
призами от нашего магазина Вы можете эанпик нам в удобное для Вас время и получать
свой приз

Кроме того, предъявив это письмо, вы можете приобрести
количество изданий с 40% скидкой

Андрей Быстрое
Директор магазина «Книгни

Рис. 4.6. Вырезание выделенного фрагмента текста

3. Во втором абзаце щелкните пэред словом скидкой.

4. Щелкните на кнопке Вставить (Paste) на стандартной панели инструментов.
Вырезанный текст будет вставлен в новое место. Вы также можете воспользо-
ваться командой Правка > Вставить (Edit t Paste).

Для вырезания и вставки текста можно применять сочетания клавиш Ctrl+X и
Ctrl+V соответственно.

Теперь давайте восстановим исходный вариант текста в последнем предложе-
нии письма.

5. Дважды щелкните на кнопке Отменить (Undo). Word отменит две последние
операции: вставку и вырезание.

Для отмены последнего действия можно использовать клавиши Ctrl+Z.
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Упражнение 4.5. Копирование и вставка текста

Как известно, не только мысли, но и точные слова часто кочуют из документа в
документ, поэтому вам нужно научиться копировать текст. Обычно проще най-
ти похожий фрагмент текста, скопировать его в нужное место и затем, если по-
требуется, внести в него некоторые изменения, чем вводить этот фрагмент зано-
во. Давайте создадим в нашем документе еще одну страницу и скопируем на нее
один из абзацев.

1. Нажмите клавиши Ctrl+End, чтобы переместиться в конец документа.

2. Нажмите клавишу Enter.

3. Нажмите клавиши Ctrl+Enter, чтобы начать новую страницу. На экране появит-
ся горизонтальная разделительная полоса со словами Разрыв страницы (Page
Break). Курсор переместится на вторую страницу. Обратите внимание на то,
что в строке состояния теперь указано другое число страниц (2).

4. Перейдите обратно на первую страницу.

5. Дважды щелкните на левом поле напротив абзаца, который нужно скопиро-
вать (например, первого).

6. Нажмите клавиши Ctrl+C. Вы также можете воспользоваться командой Прав-
ка > Копировать (Edit > Сору) или кнопкой Копировать (Сору) на стандартной
панели инструментов.

7. Нажмите клавиши Ctrl+End, чтобы переместиться в конец документа.

Мы рады сообщить Вам, что по итогам о проса «Лучшая детская книга»,
проведенного нашим магазином, лучшей бьша признана книга "Русские народные
сказки». Все читатели, которые подали своя голоса за эту книгу, награждаются ценными
призами от нашего магазина Бы можете зайти к нам в удобное для Вас время и получить
свой с риз

Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине любое
количество изданий с 40% скидкой.

Искрение Ваш

Андрей Быстрое
Директор магазина «Книги»

Мы рады сообщить Вам, что по итогам опроса иЛучшая детская книга»,
проведенного нашим магазином, лучшей быяэ признана книга «Русские народные
сказки». Все читатели, которые подали свои голоса за эту хнигу, награждаются ценными
призами от нашего магазина. Вы можете зайти к вам в удобное для Вас время н получить
СБОЙ приз.

I ' № ^ ̂

Рис. 4.7. Скопированный фрагмент вставлен в конец документа
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8. Нажмите клавиши Ctrl+V, Вы также можете воспользоваться командой Прав-
ка » Вставить (Edit >• Paste) или кнопкой Вставить (Paste) на стандартной панели
инструментов.

Скопированный фрагмент будет вставлен в конец документа (рис. 4.7).

После того как скопированный текст оказывается в буфере обмена, он может быть
легко вставлен в нужные места Е документе.

Упражнение 4.6. Копирование и вставка нескольких
фрагментов текста

В пакете Office имеется возможность размещения в буфере обмена нескольких
фрагментов текста (и не только текста). Ранее любители эффективной работы с
текстовыми процессорами вынуждены были довольствоваться утилитами от не-
зависимых производителей. Теперь же буфер обмена Office стал неотъемлемой
частью программных продуктов Microsoft со всеми их достоинствами (и недо-
статками). Для работы с этим многоуровневым буфером обмена в приложениях
пакета Microsoft Office 2003 предлагается специальная область задач Буфер обме-
на (Clipboard). Давайте попробуем поработать с ней.

1. Выделите второй абзац и скопируйте его в буфер обмена (нажмите клавиши
Ctrl+C).

2. Выберите команду Правка > Буфер обмена Office (Edit ^Office Clipboard), На экра-
не появится область задач Буфер обмена (Clipboard), показанная на рис. 4.8.
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Рис. 4.8. Область задач Clipboard позволяет работать сразу с несколькими объектами
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Рис. 4.9. Если буфер обмена Office вам мешает, отключите его

Рис. 4.10. Вставка объекта из буфера обмена Office

В области задач Буфер обмена (Clipboard) условными значками показаны фраг-
менты, находящиеся в буфере обмена. Видны также начала этих фрагментов.
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Значки соответствуют разным типам данных фрагмента. Всего в такой буфер
можно поместить до двадцати четырех фрагментов. В области задач есть
кнопки Вставить все (Paste All) и Очистить все (Clear Al l ) и список скопирован-
ных фрагментов. Кнопка Встазить все (Paste Al l ) позволяет последовательно
вставить все фрагменты в текущий документ. Если же просто поместить ука-
затель мыши на нужный фрагмент и щелкнуть на нем, он будет вставлен в до-
кумент в текущую позицию курсора. Если щелкнуть на стрелке рядом с фраг-
ментом, можно либо вставить его в документ, либо совсем удалить из буфера.

Значок буфера обмена Office отображается в панели задач Windows. Если
щелкнуть на нем правой кнопкой мыши, то можно получить доступ к коман-
дам управления буфером обмена Office (рис. 4.9).

3. Создайте новый документ. Для этого щелкните на кнопке Создать (New Blank
Document) на панели инструментов или нажмите клавиши Ctrl+N.

Word создаст новый документ и откроет для него отдельное окно.

4. Выберите команду Правка >• Буфер обмена Office (Edit > Office Clipboard).

5. Щелкните на первом фрагменте в списке (рис. 4.10).

Первый из скопированных фрагментов будет вставлен в документ.

Работа с несколькими приложениями Office

С помощью буфера обмена Office вы можете копировать и перемещать данные
между приложениями Office и другими приложениями, поддерживающими этот
стандарт. Если же вам вдруг не хватит 24-возможных фрагментов, помните, что
вы всегда можете положиться на старый добрый буфер обмена Windows. Буферы
обмена Office и Windows различаются. В буфере обмена Windows хранится толь-
ко последний скопированный обьект, причем он попадает туда вне зависимости
от того, есть ли свободное место в буфере обмена Office. С буфером обмена
Windows могут работать все Windows-приложения. Буфер обмена Office, в свою
очередь, позволяет хранить более одного объекта, но сфера его применения огра-
ничена только приложениями Office и совместимыми с ними. Естественно, что
обычный буфер обмена Windows будет работать и в новых приложениях Office,
Какой из вариантов выбрать — решать вам. Как к любому новому инструменту,
к буферу обмена Office нужно сначала немного привыкнуть.

Упражнение 4.7. Копирование и перемещение данных между
приложениями Office

Итак, для копирования и перемещения данных между Windows-приложениями
(в частности, приложениями из пакета Office) можно использовать буфер обме-
на. Это упражнение вам не обязательно повторять на своем компьютере, оно при-
ведено здесь только для иллюстрации возможностей нового буфера обмена.
В конце концов, никто не заставляет вас держать на своей машине какие-то еще
приложения кроме Word, книгу по которому вы сейчас читаете.
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Предположим, что вы работаете с приложением Office (или, например, графиче-
ским приложением) и хотите скопировать фрагмент, например, таблицу или ри-
сунок, в документ Word.

1. Выделите нужный фрагмент средствами исходного приложения.

2. Нажмите клавиши Ctrl+C или выберите команду Правка > Копировать (Edit >
Сору). Эти сочетания клавиш и команды сейчас стали практически стандарт-
ными для всех Windows-приложений.

3. Перейдите в программу Word. (Для этого можно использовать клавиши Alt+Tab.)

4. Щелкните в точке вставки фрагмента или рисунка.

5. Нажмите клавиши Ctr+V или выберите команду Правка > Вставить (Edit > Paste),
как показано на рис. 4.11.

5*-; offeecn*pwd...

|Й- tMte - Ensert к!;

•;;| ParteSpeoal,..

I Replace... СЫ+Н i

Г" HJd 13

Рис. 4.11. Вставка объекта из буфера обмена Windows

Скопированный в буфер обмена объект будет вставлен в документ Word.

Отмена ошибочных действий пользователя

Ранее в этом занятии мы уже использовали команду отмены, чтобы отменить уда-
ление фрагмента текста. Эта команда может использоваться практически для всех
операций Word (за исключением действий типа сохранения файла). Давайте по-
смотрим, как работает эта команда.
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Рис. 4.13. Повторение последнего отмененного действия
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Упражнение 4.8. Использование команд отмены и повторения

1. Перейдите в документ Письмо победителю.doc.

2. Трижды щелкните в абзаце на странице 2.

3. Щелкните на кнопке Вырезать (Cut) на стандартной панели инструментов или
нажмите клавиши Ctrl+X.

4. Щелкните на кнопке Отменить (Undo) на стандартной панели инструментов.

Word восстановит удаленный текст.

5. Вы также можете отменить несколько последних операций. Для этого развер-
ните список последних действий, щелкнув на кнопке со стрелкой вниз рядом с
кнопкой Отменить (Undo), выделите мышью нужное число действий и щелкни-
те на самом раннем действии, которое нужно отменить (рис. 4.12). Word вер-
нет документ в одно из предыдущих состояний.

6. Если вы снова передумали, щелкните на кнопке Повторить (Redo). Word снова
удалит выделенный текст (рис. 4.13).

Регистр символов

Буквы бывают строчные и прописные. С прописной буквы, как известно, начина-
ются самые важные слова, а также предложения. Чтобы ввести прописную букву,
нажимается клавиша с соответствующей буквой и клавиша Shift. Если вам нужно
ввести слово, состоящее из одних прописных букв, нажимается клавиша Caps Lock:
она фиксирует ввод символов в верхнем регистре. Одна из самых распространен-
ных ошибок при вводе текста — это случайное нажатие этой клавиши. Кроме того,
довольно часто случается, что пользователи забывают нажать клавишу Shift и при-
ходится заново вводить неправильно введенную букву слова. А что делать, если
нужно набрать прописными буквами целый заголовок или абзац?

Word может автоматически исправлять строчную букву в начале предложения на
прописную. Программа также умеет определять, когда пользователь случайно на-
жал клавишу Caps Lock, и исправлять последствия такой ошибки. Но Word не смо-
жет вместо вас набрать слова ПОЯСНИТЕЛЬНАЯ ЗАПИСКА прописными буквами. Да-
вайте познакомимся с возможностями Word по выбору регистра символов текста.

Упражнение 4.9. Изменение регистра символов

1. Снова перейдите в документ Письмо победителю.doc.

2. Выделите слова рады сообщить.

3. Выберите команду Формат > Регистр (Format > Change Case). На экране появит-
ся окно диалога Регистр (Change Case), показанное на рис. 4.14.

В этом окне диалога имеется безымянная группа из пяти переключателей.
Первый переключатель оставляет прописной только первую букву выделен-
ного фрагмента (как и положено в предложениях). Второй и третий нужны

4 Зак. 48]
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для оформления выделенного фрагмента в нижнем или верхнем регистре со-
ответственно. Четвертый переключатель часто применяется в случае печати
заголовков материалов на английском языке. По правилам английской ор-
фографии все слова в заголовках (кроме служебных) пишутся с прописной
буквы. В материалах на русском языке этот параметр имеет смысл устанавли-
вать для выделения имен и фамилий, при перечислении названий городов
и т. д. Последний переключатель позволяет исправить последствия случайно-
го нажатия клавиши Caps Lock.

Рис. 4.14. Окно диалога Change Case

4. Установите переключатель ВСЕ ПРОПИСНЫЕ (UPPERCASE) и щелкните на кноп-
ке ОК. Word изменит регистр выделенных символов.

5. Теперь, удерживая нажатой клавишу Shift, несколько раз нажмите клавишу F3
(не снимая выделения со ело в рады сообщить), пока выделенный фрагмент не
будет оформлен строчными буквами.

Нажатие клавиш Shift+F3 поззоляет поочередно в цикле переключать вариан-
ты, перечисленные в окне диалога Регистр (Change Case). Набор вариантов за-
висит от выделенного фрагмента. Если вы выделили просто несколько слов,
то нажатие клавиш Shift+F3 будет равнозначно поочередной установке пере-
ключателей: все строчные (lowercase), ВСЕ ПРОПИСНЫЕ (UPPERCASE) и Начинать
С Прописных (Title Case). Если выделить целое предложение, то варианты бу-
дут такими: Как в предложениях (Sentence case.), все строчные (lowercase) и ВСЕ
ПРОПИСНЫЕ (UPPERCASE). Давайте посмотрим, как работает этот инструмент.

6. Трижды щелкните на первом абзаце письма.

7. Нажмите клавиши Shift+F3. lice буквы абзаца станут прописными (рис. 4.15).

8. Еще раз нажмите клавиши Shift+F3. Все буквы абзаца станут строчными.

9. Последний раз нажмите клавиши Shift+F3. В начале всех предложений абзаца
появятся прописные буквы.

Обратите внимание на то, что теперь слова вам, вас, лучшая и русские начинают-
ся со строчной буквы. Давайте снова сделаем первые буквы этих слов пропис-
ными.

10. Щелкните на слове вам в первом предложении первого абзаца. Нажмите кла-
виши Shift+F3.

11. Дважды щелкните на слове лучшая. Нажмите клавиши Shift+F3.

12. Щелкните перед буквой р в слове русские. Нажмите клавиши Shift+F3.
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Г-жа Епгна Цветкова
Ре ф ер ент-ire р ев одчи к
Трамвайный пр 2-212
151457. Санкт-Петербург

Уважаемая r-sa Цветкова!

МЫ РАДЫ СООБЩИТЬ ВАМ, ЧТО ПО ИТОГАМ ОПРОСА «ЛУЧШАЯ
цЕТСКАЯ КНИГА», ПРОВЕДЕННОГО НАШИМ МАГАЗИНОМ. ЛУЧШЕЙ БЫЛА Н
ПРИЗНАНА КНИГА «РУССКИЕ НАРОДНЫЕ СКАЗКИ-) ВСЕ ЧИТАТЕЛИ. КОТОРЫЕ
ПОДАЛИ СВОИ ГОЛОСА ЗА ЭТУ КНИ1У. НАГРАЖДАЮТСЯ ЦЕННЫМИ ПРИЗАМИ
DT НАШЕГО МАГАЗИНА ВЫ МОЖЕТЕ ГАИТИ К НАМ Р УДОБНОЕ ДЛЯ ВАС Г"™
В Р Е М Я И ПОЛУЧИТЬ СРПЙ ПРИ'

Кроне гого. предъявив это письма, Еы нонете приобрести в машем магазине любо:
количество изданий с 40% скидкой.

Искренне Ваш

ы
Андрей Быстрое т

.«„ *
?» a 3t'wijQ_j "• "- "•' " " Л : _; : : - " : : . : :.-; •- '" " Р. •" "• jj I

'аэв 1 Зяс-i Ifl м б,в™ Lnii Cd i =.F :!• - > - - ' " : •

Рис. 4.15. Смена регистра в целом абзаце

13. Выделите букву в в слове вас в последнем предложении первого абзаца. На-
жмите клавиши Shift+F3.

Теперь все нужные слова начинаются с прописной буквы. Обратите внимание на
то, что в разных случаях мы по-разному выделяли нужный фрагмент текста. Все
эти варианты в данном случае были равноправными. В дальнейшей работе вы
будет сами выбирать более удобный способ выделения текста.

Нестандартные символы

Документы довольно часто включают нестандартные символы. Их нельзя найти
на клавиатуре среди букв английского и русского алфавитов. Например, науч-
ным работникам могут потребоваться буквы греческого алфавита (альфа, бета,
гамма, пи и т. д.) и математические символы, финансистам — символы нацио-
нальных валют (включая евро), лингвистам — символы национальных алфави-
тов, а всем остальным — оригинальные значки. Для вставки символов вам не при-
дется устанавливать дополнительные раскладки клавиатуры. Все символы такого
рода теперь можно вставлять средствами программы Word. Давайте попробуем
поэкспериментировать с этими средствами.

Упражнение 4.10. Вставка символов

1. Закройте документ Письмо победител Ю-doc. Если хотите, сохраните в нем изме-
нения.
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2. Создайте новый документ.

3. Выберите команду Вставка > Символ (Insert > Symbol).

На экране появится окно диалога Символ (Symbol). В списке Шрифт (Font)
отображается название шрифта, символы которого представлены в основ-
ном окне (рис. 4.16).

4. Щелкните на символе знака умножения (х) в основном окне (рис. 4.17). Для
выделения других символов можно пользоваться как мышью, так и клавиша-
ми перемещения курсора.

Symbols I SfjedalCharacters

font: .[(normal text) Street: Matnematicd Operators

-
1

№
г

—
"

ты

a

—
<

Q
A

>

e
n

*
i t

Уз

V

t

-

-/?

,

i

.-S

- .'

•

1J

4.'
'S

'•

F

%

"-•

£
7/.

00

1»

Pis

«-
L

t
mi
T
П

|
A

~*

j

*

€

1
S3

%
<->

^

%0

e
I
=

mbols!

t> € £ ¥ © ! M
Cf.' J.I

ЕШ.ЕТ OP-ERATOR .= ^QTaactErciKlt: 2219 Ртогц; jUracode (hex)

.,Йи1(ЗСоггвсС.„ I Siortcut Key... j Shortcut key: 22W, ftft+X

--• -: -- -

Рис. 4.16. Выбор символа из шрифта Symbol для вставки в документ

Fort; |( normal text) Subset: JLdtin-l

±
A

N

a

-

A
О

a

э

A

О

a

A
О
a

Ц
A
о
и

11
,Б

О

, ' . •

?
•Я

E
0
e

i

E
U

e

о

E

U

e

»

Ё

U

e

i/

I
U

i

i/,.

I

Y

i

•a ,
~'4

I

E>
i

6
I

В

I

A
D
a
d

Recently usect symbols:

€ £

MULTIPLICAHON aGN ^haractei code: CICO? frOffl.: Unicode (hex)

AiJtoCortert... | Shortcotgey... | Shortcuthsf: AIH-021S

Рис. 4.17. Выбор набора символов текущего шрифта для вставки



Нестандартные символы 101

5. Щелкните на кнопке Вставить (Insert). Символ будет вставлен в документ. Окно
останется открытым, позволяя вам вводить другие символы. Обратите внима-
ние на то, что последние вставленные символы отображаются в нижней части
окна диалога, где их легко найти. Нажмите клавишу Esc, чтобы закрыть окно
диалога.

Давайте найдем символ новой общеевропейской валюты.

6. Выберите команду Вставка > Символ (Insert > Symbol).

7. В списке Шрифт (Font) выберите шрифт Times New Roman.

Для этого шрифта в окне диалога есть еще один список Набор (Subset). Шриф-
ты, соответствующие формату Unicode, позволяют работать с несколькими
десятками тысяч (!) символов. Для удобства ориентирования в таком обилии
символов они разбиваются на наборы. Наши запросы сейчас довольно скром-
ные, так что давайте выберем набор Денежные единицы (Currency Symbols).

8. Раскройте список Набор (Subset), прокрутите его и щелкните на строке Денеж-
ные единицы (Currency Symbols), как показано на рис. 4.18.
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Рис. 4.18. Вставка символа в документ

9. Рядом с символами франков и фунтов вы увидите уже знакомый вам символ
евровалюты. Дважды щелкните на нем, чтобы вставить его в документ.

Для вставки символов в документ можно использовать сочетания клавиш и эле-
менты автозамены. Для выбора этих сочетаний и создания элементов автозаме-
ны существуют кнопки Сочетание клавиш (Shortcut Key) и Автозамена (Autocorrect)
в окне диалога Символ (Symbol).

В свободное от работы время изучите доступные наборы символов, они могут при-
годиться при создании интересных, сложных и эффектных документов.
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Контрольное занятие

Сейчас мы закрепим навыки, приобретенные на этом занятии. Ответы на конт-
рольные вопросы помогут вам проверить себя.

1. Запустите Microsoft Word.

2. Откройте документ Письмо победителю.doc.

3. Выделите первое предложение первого абзаца.

4.1. Как выделить только одну строку документа?

4. Скопируйте предложение в буфер обмена.

5. Выделите второй абзац.

6. Удалите его в буфер обмена

4.2. Какое сочетание клавиш и ^пользуется для перемещения фрагмента в буфер об-
мена?

7. Создайте новый документ,

4.3. Как вывести на экран область задач Буфер обмена (Clipboard)?

8. Вставьте первый из скопированных фрагментов в новый документ.

9. Вставьте в документ знак разрыва страницы.

10. Вставьте в документ второй фрагмент.

11. Выделите последнее слово текста.

12. Перетащите его в начало абзаца.

13. Выделите две последние строки документа.

14. Удалите их.

15. Отмените три последние команды.

4.4. Какое сочетание клавиш используется для отмены последнего действия?

16. Выделите три первых слова текста.

17. Измените регистр символов на нижний.

4.5. Какое сочетание клавиш используется для изменения регистра символов выделен-
ного фрагмента?

18. Вставьте в документ символы градусов (°) и умножения (х), а также плюс-
минус (±).

19. Закройте Microsoft Word, не сохраняя изменений в документе.
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Возможные проблемы

Проблема Решение

Я выделил
неправильный
фрагмент

Я случайно скопировал
фрагмент
в неправильное место.
Что делать?

Щелкните в любом месте документа
и снова выделите нужный текст

Нажмите клавиши Ctrl+Z, чтобы отменить последнее
действие, и попробуйте снова

На этом занятии вы научились основным приемам работы с текстом документов.
Однако о качестве документа судят в первую очередь по отсутствию в нем оши-
бок. О том, как проверять орфографию и грамматику средствами Word, мы пого-
ворим на следующем занятии.



Занятие 5

Проверка правописания

Тема занятия

Освоение средств Word 2003, относящихся к проверке орфографии и граммати-
ки. Работа с тезаурусом (словарем синонимов). На этом занятии мы научимся:

• проверять орфографию;

• проверять грамматику;

• находить синонимы с помощью тезауруса.

Подготовка к занятию

Чтобы выполнить упражнения этого занятия, мы создадим новый документ и про-
верим его текст, чтобы в нем не осталось орфографических, грамматических и
стилистических ошибок.

Проверка орфографии и грамматики

Как вы думаете, может быть что-нибудь хуже, чем опечатка или грамматическая
ошибка, красующаяся на самом зидном месте важного документа? О тщательно-
сти подготовки документа в первую очередь говорит не красивое форматирова-
ние или эффектные картинки, а правильный язык. Только если основная мысль
документа выражена в нем точно и правильно, можно задумываться о различных
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украшениях. Word предоставляет вам помощников для проверки орфографии и
грамматики, а также словарь синонимов (тезаурус). Помните, что это только по-
мощники (причем автоматические), и выполнить за вас работу по литературной
обработке текста они не в состоянии.

В Word есть специальный инструмент автозамепы. Этот инструмент позволяет
вносить изменения в текст в процессе ввода. Он может исправлять распростра-
ненные опечатки, кроме того, правильно реагировать на некоторые ошибки при
вводе. Например, если вы введете две прописные буквы в начале слова, инстру-
мент автозамсны изменит регистр второй буквы на нижний. При вводе текста
после точки (в конце предложения) Word автоматически сделает первую букву
следующего предложения прописной. Кроме того, инструмент автозамены реаги-
рует на случайное нажатие клавиши Caps Lock и исправляет ошибку типа НЕПРА-
ВИЛЬНО ВВЕДЕННАЯ ФРАЗА.

При вводе текста Word автоматически проверяет орфографию, сравнивая вводи-
мые слова со словами во встроенном словаре Word. Кроме того, проверяется и
грамматика; при этом анализируются грамматические конструкции предложений.
Слова с предполагаемыми орфографическими ошибками подчеркиваются крас-
ной волнистой линией, а предложения с грамматическими ошибкам — зеленой.
Если щелкнуть на подчеркнутом слове или предложении правой кнопкой мыши,
то Word сразу предоставит возможность исправить ошибку.

Кроме собственно ошибок и опечаток, система проверки орфографии Word 2003
отслеживает повторение слов (например, приходите к нам нам) и неправильное
употребление строчных и прописных букв (например, москва). Если слово с опе-
чаткой близко к одному или нескольким словам из встроенного словаря Word, то
программа предложит варианты для замены ошибочного слова. Вы можете по-
полнять особый словарь, содержащий слова, которые будут игнорироваться Word
при проверке орфографии. Обычно так поступают со специализированной лек-
сикой (слова типа экфонетический, диэлектронный, антикенома и энтальпия), кото-
рая отсутствует в основном словаре Word.

Следует иметь в виду, что проверка орфографии в Word не производит смысло-
вой анализ сочетаемости слов в предложении, поэтому ошибки в предлогах типа
мы вышли не улицу обнаруживаться не будут, так как Word посчитает слово не
введенным правильно. Поэтому перед выводом документа на печать или отправ-
кой адресату обязательно нужно внимательно прочитать его текст.

Система проверки грамматики в Word отмечает возможные грамматические
и стилистические ошибки. Word анализирует структуру предложений и опреде-
ляет, совместимы ли они с выбранным стилем документа. Для проверки грамма-
тики можно выбрать стандартный, разговорный, формальный, технический и де-
ловой стили переписки. Кроме того, можно создать собственный стиль, исключив
часть правил для проверки из общего полного набора.

Предложения и их фрагменты, которые, по мнению Word, содержат ошибки, под-
черкиваются зеленой волнистой линией. Кроме того, в некоторых случаях Word
будет пре;1лагать варианты для изменения предложения. Вы можете согласиться
с предложенным изменением, переписать предложение, игнорировать ошибку или
просмотреть комментарий.
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Помните, все эти средства Word — это ваши помощники. Обязательно проверяй-
те их работу и старайтесь не принимать бездумно все их предложения.

Упражнение 5.1. Проверка орфографии

Чтобы посмотреть, как работает система проверки орфографии, давайте наберем
текст, специально сделав в нем несколько ошибок.

1. Создайте новый документ и введите в него следующий текст:

Jackdaws loves my my bigg sphinxx of quartz

Little broun fox jumps over laz\ dog.

В результате документ будет выглядеть так, как показано на рис. 5.1.

Jackdaw: loves my my bigg sphinx* of quail!
Litlle bggan (ox jumpi over lily dogj

Uf

Рис. 5.1. Документ с орфографическими и грамматическими ошибками

2. Сохраните документ под именем Проверка правописания.doc.

Теперь давайте посмотрим, как Word помогает исправлять такие ошибки.
Начнем со слов, подчеркнутых красной линией.

3. Щелкните правой кнопкой мыши на слове bigg. Контекстное меню состоит из
перечисленных ниже команд (рис. 5.2).

Q Варианты для замены слона. Для замены ошибочного варианта слова од-
ним из предложенных просто щелкните на нужном слове.

Q Команда Пропустить все (Ignore All). После выбора этой команды Word не
будет помечать указанное слово во всем документе. Если оно встретится в
другом документе, Word снова пометит его как неправильное.

Q Команда Добавить в словарь (Add to dictionary). Если отмеченное слово не
содержит ошибок и часто встречается в документах, которые вы готовите,
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выберите эту команду, чтобы добавить слово в словарь Word. После этого
текущее слово больше не будет восприниматься Word как неправильное.

а Подменю Автозамена (Autocorrect) содержит варианты замены слова, анало-
гичные перечисленным в контекстном меню. При выборе одного из вари-
антов пара слово с ошибкой — правильное слово помещается в список вари-
антов автозамены. Если вы повторите данную ошибку в этом или другом
документе, Word автоматически исправит ее и подставит вместо ошибоч-
ного варианта слово, указанное вами.

а Подменю Язык (Language). Часть ошибок может возникать, если Word бу-
дет принимать слова одного языка за слова другого языка. Системы про-
верки орфографии и грамматики используют словари для разных языков.
Данное подменю позволяет переключаться между доступными языками.

Q Команда Орфография (Spelling) открывает окно проверки орфографии. (Вы
обратили внимание на многоточие после названия команды? Оно указыва-
ет на то, что данная команда вызывает соответствующее окно диалога.)
В этом окне можно выполнять все перечисленные выше команды, а кроме
того, автоматически переходить от одного слова с ошибкой к следующему.
Оно также позволяет отменять исправления и возвращаться к уже про-
смотренным словам. Немного позже мы посмотрим, как работать с этим
окном диалога. Обычно его используют для проверки больших документов
целиком.

4. Выберите в контекстном меню вариант big.

5. Щелкните правой кнопкой мыши на слове sphinxx.

s d . ;i|Notmd ».TMs New Roman *]г .',..» '. ГЛ -

Jackdaws loves ту ту big; ajhuiKjiof quaU
Little brouiv fox jumps

щ]я ш •» oj j
Рад 1 5ec 1

Рис. 5.2. Один из вариантов контекстного меню для слова с ошибкой
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6. Выберите команду Автозамена (Autocorrect) и затем щелкните на слове sphinx.

После этого пара слов sphinxx — sphinx будет добавлена в список автозамены.
Если создать новый документ и ввести в него слово sphinxx, вы увидите, как
Word автоматически заменит его словом sphinx.

В список автоэамены удобно добавлять часто встречающиеся слова, а которых
легко допустить ошибку. Особенно полезно делать это для слов с ошибками,
допускающих только один вариант замены. Размер списка автозамены не влия-
ет существенно на скорость работы Word, поэтому в него можно добавлять прак-
тически любое количество слов.

7. Щелкните правой кнопкой мыши на слове ту, подчеркнутом красной линией,

8. Выберите команду Удалить повторяющееся слово (Delete Repeated Word), как по-
казано на рис. 5.3. Повторяющееся слово будет удалено.

>i>*l*;' nftawfi* .ти- «lei - Ци r*R-i(t W,,i ,1

U» YHSW Insert Fanwt ImS TaUe - и»осл Ц* ' - i : :'

',?•_?.;; ! il.! «9 « ".• i J.i ;3n-.'o - ! £.£iao '& '• fJop™i ».. Times New ЙМЫП ?•' 12
. .

1 • i -1

Jackdaws loves my gw big sphinx of quartz

Little ferojin fox ju

•IB • i • 11 • • 12 • P • IJ ' < • l«- i -IS • i '16

Efi_g*sb(US fljf

Рис. 5.З. Удаление повторяющегося слова

9. Щелкните правой кнопкой мыши на слове broun и выберите вариант brown.

Обратите внимание па то, что Word выделяет часть собственных имен. Некото-
рые распространенные имена и фамилии есть в его словаре, и они не выделяются
красными линиями. Кроме того, в словаре Word есть многие географические на-
звания, например Тегусигальпа,

Выберите команду Прогустить все (Ignore All), чтобы программа больше не от-
мечала слово в течение данного сеанса работы. После того как закроете и сно-
ва запустите Word, это слово снова будет выделяться как ошибочное. Если еы
этого не хотите, добавьте слово в словарь Word с помощью команды Добавить
(Add to dictionary) контекстного меню.
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Упражнение 5.2. Проверка грамматики

Теперь давайте займемся словами и предложениями, подчеркнутыми зелеными
волнистыми линиями.

1. Перейдите в начало документа.

2. Щелкните правой кнопкой мыши на змейке под словами Jackdaws loves.

Word пытается сообщить нам о несогласованности подлежащего и сказу-
емого.

3. Щелкните на первой команде в меню, как показано на рис. 5.4.

ladcdaws Ijves my big sphinjr of quarti

fegfs 1 Sec 1 111 «2.«<« U; г Col i:. j • • ;' ?;..W(Mj.<W ^

Рис. 5.4. Сейчас в документе будет исправлено грамматическое несоответствие

Итак, мы проверили все ошибки, которые заметила программа Word. Пропущен-
ную точку в конце второго абзаца придется вставить самостоятельно.

Тезаурус

С помощью тезауруса можно подбирать синонимы (а также антонимы) к словам
документа. Это позволит избежать повторения терминов в документах и создаст
впечатление обширного словарного запаса. Когда вы будете в напряженных раз-
думьях подбирать синоним для слова приобрести, вспомните про словарь синони-
мов, и он поможет вам превратить ваш документ в произведение изящного стиля,
достойное пера великого Флобера.

Давайте посмотрим, как работает этот инструмент Word.
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Упражнение 5.3. Поиск синонимов

1. Нажмите клавиши Ctrl+Home, чтобы перейти в начало документа.

2. Нажмите клавиши Ctrl+F, чтоб ы ввести на экран окно диалога Найти и заменить
(Find and Replace), показанное на рис. 5.5. Можно использовать команду Прав-
ка » Найти (Edit > Find).

3. Введите слово love в поле Найти (Find what).

4. Щелкните на кнопке Найти далее (Find Next).

5. После того как Word найдет слово, нажмите клавишу Esc, чтобы закрыть окно
диалога.

Sfjjd rifab

Рис. 5.5. Поиск слова в документе

6. Нажмите клавиши Shift+F7. На экране появится область задач Поиск (Research).

Команда Тезаурус (Synonyms/Thesaurus) находится в контекстном меню текста
документа, если текст не содержит ошибок.

Чтобы выделить слово, для которого нужно подобрать синоним, достаточно
просто щелкнуть перед ним, после него или в середине слова. После нажатия
клавиш Shift+F7 Word автоматически выделит слово и откроет область задач
Поиск (Research), как показано на рис. 5.6.

Разные значения исходного слова показаны в списке жирным шрифтом. Со-
ответствующие синонимы перечислены в раскрывающемся списке. В поле,
расположенном под надписью Поиск (Search for), можно также вводить слова
вручную.

7. Раскройте список рядом со словом like в списке синонимов и выберите коман-
ду Вставить (Insert). Новое слоно будет вставлено в документ.

Работая с областью задач Поиск (Research), вы можете осуществлять поиск
синонимов в тезаурусе, поочередно щелкая на нужных словах в списке сино-
нимов.

8. Щелкните на кнопке Отменить (Undo) на стандартной панели инструментов или
нажмите клавиши Ctrl+Z, чтобы отменить замену слова.

9. Теперь щелкните правой кнопкой мыши на слове love и раскройте подменю
Синонимы (Synonyms), как показано на рис. 5.7. Вы увидите некоторые синони-
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мы, уже встречавшиеся в области задач Поиск (Research). Здесь они перечисле-
ны без разбивки по значениям.

10. Выберите слово find irresistible.

11. Сохраните изменения и закройте документ.

В это поле можно вводить слова,
для которых требуется найти синоним

Iickdawg Love my bi£ sphifiK of quartz
Little brown foxjump; over lary dog

Pflift* f' -" 3*C a. air 1л i

Данный список
содержит слова,
для которых велся
поиск синонимов

Щелчок на этой кнопке
запускает поиск
в тезаурусе

Здесь перечислены
значения выбранного
слова

Рис. 5.6. Область задач Research

tjl AtZtm in I • Col К

Рис. 5.7. Выбор синонима в контекстном меню



112 Занятие 5. Проверка правописания

Контрольное занятие

Сейчас мы введем несколько нозых предложений в документ Письмо победи-
телю.doc, сохраним его под другим именем и проверим в нем орфографию и грам-
матику.

1. Откройте документ Письмо победителю.doc.

2. Нажмите клавиши Ctrl+Home, чтобы перейти в начало документа.

3. Введите следующий текст:

Магазин «Книги»

пр. Жемчужниковых, 12

191390, Санкт-Петербург

(812) 554-23-09

5.1. Как лучше поступить, если система проверки орфографии выделяет имя собствен-
ное?

4. Щелкните в конце второго абзаца и введите в него следующий текст (вклю-
чая слова с ошибками):

Среди изданий на которые мы особеннпо хотели бы обратит Ваше внимание,
назовем сборник детских стишков «Шалтай-Болтай и его друзья», а также
Детскую историческую энциклопедию. Надеемся, что Вам полнравятся эти
книги.

5. Нажмите клавишу Enter и введите следующий абзац:

В этом месяце м проводим высавку-продажу книг по искусству «Крастоа и
мир». Журнал «Искусство» носвятидл этому событию такие строки:

6. Нажмите клавишу Enter и введите следующий абзац:

В век технологического и информационного бума особенно приятно видеть
неослабевающий интерес мысчлящей части общества к вечные ценностям.
Мы считаем что настоящая выставка поможет заинтересовать итех людей ко-
торые до этого не уделяли особого внимания вопросам изящых искусств,

7. Сохраните документ с именем Письмо о выставке-doc.

8. Исправьте все ошибки, отмеченные красными волнистыми линями.

5.2. Как можно исправить ошибки сразу во всем документе?

9. Исправьте все ошибки, отмеченные зелеными волнистыми линями.

10. Замените слово век синонимом эпоха.

5.3. Как можно пометить слово, для которого требуется найти синоним?

11. Просмотрите документ еще ра*, чтобы найти ошибки, не помеченные програм-
мой (в частности, взгляните на слова обратит внимание).
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12. Сохраните документ.

13. Закройте документ.

Возможные проблемы

Проблема Решение

Я выбрал неправильное
слово для замены
в контекстном меню

Мне кажется,
что система проверки
грамматики пропускает
некоторые ошибки

Я произвел поиск
синонимов в окне
диалога Тезаурус,
но не нашел
нужного слова.
Как вернуться к слову,
с которого
я начал поиск?

Word сообщает мне,
что не может проверить
текст, написанный
на русском языке

Нажмите клавиши Ctr]+Z, чтобы отменить замену слова.
Теперь можно выбирать другой вариант

Чтобы изменить набор правил, применяемых при проверке
грамматики, выберите команду Сервис > Параметры
(Tools ^ Options), щелкните па вкладке Правописание
(Spelling and Grammar) и выберите нужный стиль
в списке Стиль (Writing Style)

Можно щелкнуть на кнопке Предыдущее (Back) в области
задач Поиск (Research). Кроме того, можно раскрыть список
синонимов и выбрать нужное слово в списке

Дождитесь выхода версии Word с поддержкой функции
проверки орфографии и грамматики для русского языка

Подведение итогов

На этом занятии мы научились проверять орфографию и грамматику в докумен-
те, а также работать со словарем синонимов.

На следующем занятии мы узнаем, как украсить документ оригинальным форма-

тированием.



Занятие 6

Форматирование символов
и абзацев

Тема занятия

Работа со средствами форматирования Word. Форматирование символов и абза-
цев. На этом занятии вы научитесь:

• использовать полужирное и курсивное начертания, а также подчеркивание;

• изменять шрифт;

• изменять размер шрифта;

• изменять параметры полей страниды;

• задавать отступы и интервалы для абзацев;

• выравнивать текст.

Подготовка к занятию

На этом занятии нам понадобится файл Письмо о выставке.doc, который мы созда-
вали на предыдущих занятиях.

После завершения занятия этот документ будет выглядеть так, как показано на
рис. 6.1.
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Магазин «Книги»
пр. Жемчужниковых, 12
191390, Санкт-Петербург

(812)554-23-09

26 октября 2003 г

Г-жа Елена Цветкова
Референт-переводчик
НИИМЕХМАШ
Трамвайный пр. 2-212
1Э1457, Санкт-Петербург

Уважав маяг-жа Цветова!

Мы рады сообщить Вам. что по итогам опросакЛучшая детская книга»,
проведенного нашим магазином, лучшей бъшапризнанакниганРусскиенародные
скагккя Все читатели, которые подали свои голоса за эту HI игу. награждаются цеаиыми
призами от нашего магазина. Вы можете зайти к нам в удобное для Вас время и получить
свой приз

Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине любое
количество изданий с 4 Р% скидкой Среди изданий, на которые мы особенна хотели бы
обратить Ваше внимание, назовем сборник детских стишков «Шаптзй-Болтай и его
друзья», а также Детскую историческую энциклопедию Надеемся что Вам понравятся
эти книги

В этом месяце мы проводим выставку-продажу хниг по искусству «Красотаи мире.
Журнал «Искусство" посвятил этому событию такие строки1

В эпоху технологического и информационного бума особенно приятно

видеть неослабевающий интерес мысгмщей части общества к вечным

ценностям Мы считаем, что настоящая выставка яоможе/п

заинтересовать и тех людей, которые да этого не убеляли особого

внимания вопроса» изящны* искусств.

Искренне Ваш

Андрей Быстров
Директор магазинааКнигн»

Рис. 6.1. Отформатированный документ

Форматирование символов

После того как ваш текст отредактирован и проверен, следует заняться внешним
видом документа. Советую вам взять за правило сначала выполнять всю работу
по подготовке собственно текста, а только потом возиться с его оформлением,
Если ваше внимание не будет рассеиваться между двумя (или несколькими) за-
дачами одновременно, вы добьетесь лучших результатов. Итак — сначала содер-
жание, потом форма.

Word предоставляет очень много средств форматирования. Вы можете использо-
вать разные шрифты для текста, применять различные начертания символов
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(полужирное и курсивное), работать с цветами, изменять интервалы между сим-
волами и размеры символов. Существуют и более экзотические возможности, при-
меняемые чаще для электронных документов, которые никогда не выводятся на
печать и предназначены для чтения в электронном виде, например в Интернете.
О них мы также вкратце поговорим.

Шрифт определяет вид символен (букв) текста. В издательском деле чаще при-
меняется термин гарнитура. Гарнитура задает вид символов текста вне зависи-
мости от их размера (высоты символов). Для одной гарнитуры существуют не-
сколько шрифтов разных размеров. Сейчас термины гарнитура и шрифт часто
употребляются как синонимы. Рашые шрифты могут использоваться, например,
для заголовков и для основного текста документа. Шрифты имеют разные назва-
ния, порой очень интересные. Шрифтом по умолчанию в шаблоне Обычный (Nor-
mal.dot) является шрифт Times New Roman размером 10 пунктов.

' Пункт — это полиграфическая единица измерения. В Европе пункт равен 0,376 мм,
J-. в Америке — 0,353 мм. .Пля деловых бумаг обычно используется шрифт высотой

12 пунктов. Этот размер ближе всего к высоте литер пишущих машинок.

Для выбора шрифта и его размера можно использовать кнопки на панели формати-
рования. На ней также присутствуют кнопки для применения полужирного и кур-
сивного начертаний, а также для подчеркивания текста. Кнопки на панели форма-
тирования соответствуют лишь небольшой части всех средств форматирования,
доступных через меню Формат (Format). В частности, для изменения всех парамет-
ров форматирования символов можно использовать окно диалога Шрифт (Font).

В этом окне диалога можно изменить одновременно несколько параметров, а не
щелкать на разных кнопках панели форматирования по очереди. Кроме того, воз-
можные результаты форматирования можно видеть заранее. Большая часть пара-
метров, которые можно изменить с помощью этого окна диалога, на панелях ин-
струментов недоступна.

Некоторые шрифты поставляются с системой Windows, другие — с пакетом Of-
fice 2003. Кроме того, шрифты можно приобретать и отдельно. Выбирая шрифты
для документа, обращайте внимание на то, чтобы они корректно отображали рус-
ские буквы. В Windows есть три шрифта, которые всегда корректно работают с
символами русского алфавита, — это шрифты Arial , Courier New и Times New Roman.
Примеры применения других шрифтов (включая IT поставляемые с Office 2003)
показаны на рис. 6.2.

Так называемые шрифты TrueType отображаются одинаково как на экране, так и
при вводе на печать. Шрифты принтера будут правильно отображаться только
на печати, а на экране вместо них будет использоваться шрифт, наиболее близкий
по параметрам.

Шрифт можно изменять в любом фрагменте текста, достаточно выделить его и
затем выбрать нужный шрифт. Для изменения цвета шрифта можно использо-
вать кнопку Цвет шрифта (Font Color) на панели форматирования или соответству-
ющий элемент управления в окне диалога Шрифт (Font). Особенно эффектно такие
шрифты будут выглядеть при печати на цветном принтере или на веб-страницах.
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Arial

Arlal Black
Лпа! Narrow

Biiub Anliqita

Bookman Old Styfe

Century Gothic
Comic Sons MS
Courier New

Gtrunond

Haettenichiveiier
iMpact
Lucida Console
Luticla Sans Unicode
Monotype Со«ял1

Tahoma
Thames
Tunes New Romau
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Это русснл* буквы]
Это русские буквы.
Это русские буквы
'5го I>VCCI,TO Су*, вы.
Это русские буквы.
Это русские буквы.
Это русские (Тукам,
Это русские буквы.

Это русские Буквы.

Jri русские буквы.
3TD IVCCKHt 6УНВЫ.
Это русские Ьуквм.
>то русские буквы.
Эпю русские Syrgoi

Это русские буквы.
Это русские QV-KBU.
3rojgy_c£ia«6^rab|

г.воц- -Ш--Е - Се* 19 . -•. '-

jj^t Ptomal + Ar«J я. A"J -т iMB-t* -̂

t- l'- 11' 1 • |J • 1 • 13 'V'». 1 • 15 • 1 "• 11 . 1 • 17 • i;

Ант лннпаш
These are English characters.
These are English characters.
These are English characlers
Tlî se juc Eiigbs'Ii chiiincteiri.
These are English characters.
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Рис. 6.2. Шрифты Office 2003, которые корректно работают с русскими буквами

Упражнение 6.1. Выделение текста полужирным,
курсивным и подчеркнутым начертаниями

Полужирное и курсивное начертания, подчеркивание текста, а также их сочета-
ния относятся к самым распространенным приемам выделения текста. Для их
применения нет необходимости изменять сам шрифт, поэтому в документе со-
храняется единство оформления.

Сейчас мы будем работать с файлом Письмо о BbicraBKe.doc, который мы создавали
на предыдущих занятиях. Мы выделим некоторые фрагменты текста с помощью
полужирного и курсивного начертаний, а для части текста используем подчерки-
вание.

1. Откройте файл Письмо о выставке.doc.

2. Выделите в первом абзаце слова ценными призами.

3. Щелкните на кнопке Полужирный (Bold) на панели форматирования или на-
жмите клавиши Ctrl+B.

4. Выделите последний абзац.

5. Щелкните на кнопке Курсив (Italic) или нажмите клавиши Ctrl+I.

6. Во втором абзаце выделите слова 40% скидкой.

7. Щелкните на кнопке Подчеркнутый (Underline) или нажмите клавиши Ctrl+U,

8. Щелкните в любом месте документа, чтобы снять выделение.

После выполнения упражнения документ должен выглядеть так, как показано на
рис. 6.3.
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Р t ф ерент- пер ев одчик
НИИМЕХМАШ
Трамвайный пр. 2-212
!9145"7. Санкт-Петербург

Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книга»,
проведенного нашим магазином, лучшей 6ыж1 признана книга «Русские народные
сказки». Все читатели, которые подали свои г таоса за эту книгу, награждаются ценным»
пршлии or нашего магазина. Вы можете эати к нам в удобное для Вас время и получить
СБОЙ ПрК!

Кроне того, предъявив это письмо, вы можете приобрести в нашей магазине любое
количество изданий с 4И% скидкой Среди изданий, на которые мы особенно хотели бы
обратить Ваше внимание, назовем сборник дгтскня стишков аШалтзй- Болтай н его
друзья», а также Детскую историческую энциклопедию. Надеемся, что Вам понравятся
эти книги.

В .этом месяце мы проводим выставку- продажу книг по искусству «Красота и мир».
Журнал а Искус ствол посвятил этому событию такие строкиТ

В эпоху технологическою и инфоржщ\юнного бума особенно приятна видетъ
неослабевающий интерес мыслящей часта аяцеспма к вечным ценностям Мы считаем,
что настоящая выставка поможет Jaumafffcoeafii, ижеяпюде% которые до этого не
удаляли особою внимания вопросам изящных искусств.

s*t i

Рис. 6.З. Форматирование с помощью кнопок панели форматирования

Кнопки Полужирный (Bold), Курсив (Italic) и Подчеркнутый (Underline) действуют
как флажки. Чтобы отменить форматирование, нужно второй раз выделить фраг-
мент текста и снова щелкнуть на кнопке.

Упражнение 6.2. Смена шрифта

Шрифт, как мы уже отмечали, определяет внешний символ текста. Шрифты мож-
но условно разделить на пять групп.

• Рубленые шрифты. Символы этих шрифтов не имеют засечек (небольших
«хвостиков» на концах букв). Среди распространенных рубленых шрифтов
можно назвать шрифты Arial, Helvetica, Tahoma и Verdana.

По-английски рубленые шрифты называются «sans serif», что в переводе с фран-
цузского значит «без засечек».

Обыкновенные шрифты. Это шрифты с засечками. Считается, что такие шриф-
ты легче воспринимаются читателем. Среди распространенных обыкновенных
шрифтов можно назвать шрифты Times, Century, Garamond,

Моноширинные шрифты. Символы таких шрифтов имеют одинаковую шири-
ну, по аналогии с литерами пишущей машинки. Пример моноширинного
шрифта — Courier.

Рукописные шрифты. В названиях таких шрифтов часто присутствует слово
«script». Они имитируют рукописный стиль текста. Примеры рукописных
шрифтов — Brushscript, Lucida Handwriting.
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Декоративные шрифты. Эти шрифты обычно используются для оформления
заголовков и других выделяющихся фрагментов текста. Основной текст, на-
бранный таким шрифтом, обычно трудно читать. Примеры декоративных
шрифтов — Comic Sans MS, Impact и Algerian.

:jî W Рукописные и декоративные шрифты, корректно работающие с русскими бук-
ь/_ вами, обычно приходится приобретать у независимых производителей. Суще-

ствует большое число оригинальных и красивых шрифтов, созданных отече-
ственными дизайнерами.

В этом упражнении мы изменим форматирование заголовка письма с адресом от-
правителя.

1. Нажмите клавиши Ctrl+Home и выделите название магазина в заголовке пись-
ма (самая первая строка).

2. Щелкните на кнопке раскрывающегося списка Шрифт (Font) на панели форма-
тирования. В нем должно отображаться название текущего шрифта— Times
New Roman.

3. Прокрутите список с помощью полосы прокрутки. Обратите внимание на то,
что названия шрифтов в списке оформлены соответствующим шрифтом, так
что вы сразу увидите, как будут выглядеть выделенные символы.

4. Выберите в списке шрифт Verdana (или Arial, если шрифт Verdana у вас не уста-
новлен). Эти шрифты часто используются для заголовков. Они выглядят дос-
таточно стильно (рис. 6.4).

5. Щелкните в любом месте документа, чтобы снять выделение фрагмента.

=* VOH insert Forreat £oofc Тф\е Window hefc

26 октября 2003 г

Г-жа Елена Цветаева
Референт-переводчик
НИИМЕХМАШ
Трамвайный пр 2-212
191457, Санкт-Петербург

Уважаемая г-жа Цвикова!

Мы рады сообщить Вам, что по игогам опроса «Лучшая детская кннгая,
проведенного нашим магазином, лучшей была признана книга «Русские народные
сказки» Все читатели, которые подали свои голоса за эту книгу, награждаются н*нны мы

В;"Э S J У J<J_J
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Рис. 6.4. Первая строка документа теперь оформлена другим шрифтом
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Давайте изменим шрифт в остааъной части адреса. На этот раз воспользуемся
окном диалога Шрифт (Font).

6. Выделите адрес и телефон (вторую, третью и четвертую строки документа).

7. Выберите команду Формат К Шрифт (Format > Font).

8. В открывшемся окне диалога Шрифт (Font) прокрутите список шрифтов до
конца.

9. Выберите шрифт Verdana (или Arial, если шрифт Verdana у вас не установлен —
в этом случае название шрифта будет, естественно, в начале списка).

10. В области Образец (Preview) можно увидеть, как будет выглядеть текст, офор-
мленный выбранным шрифтом (рис. 6.5).

Вкладка
для задания

межбуквенных
интервалов

Шрифт

Цвет
текста

Вкладка для задания
гффектов анимации

Размер
шрифта

Начертание '

Рис. 6.5. Окно диалога Font позволяет изменять шрифт и его параметры

11. Щелкните на кнопке ОК.

12. Добавьте три пустых абзаца перед датой письма.

Теперь весь заголовок письма оформлен одним шрифтом.

Упражнение 6.3. Изменение размера шрифта

Размер шрифта определяет высоту его символов. По умолчанию в документах,
созданных на основе шаблона Обычный (Normal.dot), используется шрифт высо-
той 10 пунктов. Давайте изменим размер шрифта в названии магазина.
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Если вы ранее работали с предыдущими версиями Office и изменили шрифт по
умолчанию, то эти параметры сохранятся и в новой версии.

1. Выделите первую строку документа.

2. Выберите команду Формат > Шрифт (Format > Font).

3. В списке Размер (Size) открывшегося окна диалога (рис. 6.6) выберите значе-
ние 14.

4. В списке Начертание (Font style) выберите пункт Полужирный (Bold),

Набор значений в списках Шрифт (Font), Размер (Size) и Начертание (Font style)
может зависеть от шрифтов, установленных в системе.

Магазин «Книги»
пр. Жемчужниковых, 12
191390, Санкт-Петербург
(812) 554-23-09

26 октября 2003 г

Г-жа Ел?наЦветкова

Референт-переводчик

НИИМЕХМАШ

Трамвайный пр. 2-212

191457. Санкт-Петербург

Уважаемая г-жа Цветкова!

frebudiet MS
runga

color;

. „ Г Doit: rtrw
Г 5lEH3r;rct

Магазин «Книги»

Мы рады сообщить Вам. ч *~

проведанного нашим магазином, [_~
сказки» Вс с читатели, которые подали свои голоса за эту квиту, награждаютсл ценными

; Page 1- 5ес 1 I» At 3cm in .1 . Col I

Рис. 6.6. Выбор новых размера и начертания для шрифта

5. Щелкните на кнопке ОК, чтобы принять оба изменения. Окно диалога закроет-
ся, но текст останется выделенным.

Снимите выделение, щелкнув в любом месте документа. Письмо должно вы-
глядеть так, как показано на рис. 6.7.

Теперь изменим размер шрифта с помощью панели форматирования.

6. Выделите первую строку документа.

7. Раскройте список Размер шрифта (Font Size) на панели форматирования и вы-
берите значение 16.

8. Щелкните в любом месте документа, чтобы снять выделение.
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Рис. 6.7. Первая строка оформлена полужирным начертанием и имеет размер 14 пунктов

Теперь давайте оформим символы названия капителью (малыми прописны-
ми буквами, small caps). В этом случае и прописные, и строчные буквы выгля-
дят одинаково, а различаются только размером. Этот прием часто использу-
ется для заголовков.

9. Выделите первую строку документа.

10. Нажмите клавиши Ctrl+Shift+<.

11. Щелкните в любом месте документа, чтобы снять выделение.

Теперь название магазина хорошо выделяется.

В окне диалога Шрифт (Font), устанавливая перечисленные ниже флажки, можно
менять и другие параметры шрифта.

• Зачеркнутый (Strikethrough). Текст перечеркивается одинарной чертой.

• Двойное зачеркивание (Double Strikethrough). Текст перечеркивается двойной
чертой.

• Надстрочный (Superscipt). Используется для оформления знаков степени и ин-
дексов. Сочетание клавиш Ctrl+Shift+=.

• Подстрочный (Subscript). Используется для оформления нижних индексов. Со-
четание клавиш Ctrl+=.

• С тенью (Shadow). Хорошо подходит для оформления заголовков, набранных
шрифтом крупного размера.
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Контур (Outline). Позволяет обрисовать только контур символов. Обычно при-
меняется в заголовках.

Приподнятый (Emboss). Создает эффект рельефного текста. Хорошо смотрится
на фоне того же цвета, что и сам шрифт.

Утопленный (Engrave). Создает эффект рельефного текста. Хорошо смотрится
на фоне того же цвета, что и сам шрифт.

Малые прописные (Small caps). Сочетание клавиш Ctrl+Shift+K.

Все прописные (All caps). Сочетание клавиш Ctrl+Shift+A.

Скрытый (Hidden). Скрывает текст. Для отображения скрытого текста исполь-
зуется кнопка Непечатаемые знаки (Show/Hide) на панели форматирования.

Параметры полей страницы

Поля — это пустые области по краям страницы. Они требуются не только для того,
чтобы писать на них мудрые заметки, но также для того, чтобы документ выгля-
дел аккуратно. Поля с левого края страницы обычно делают шире, чтобы доку-
мент можно было переплести или подшить в папку.

Чтобы изменить единицы измерения, используемые е программе, выберите ко-
манду Сервис > Параметры (Tools > Options), в открывшемся окне диалога щелк-
ните на вкладке Общие (General) и выберите нужную единицу в списке Единицы
измерения (Measurement units).

Заданные для документа поля не должны быть слишком маленькими, чтобы
текст не выходил за пределы области печати принтера (увы, пока что не все
принтеры умеют печатать вплотную к краю бумаги...). Если вы случайно зада-
дите слишком маленькие поля, возможно, ваш принтер выдаст соответствую-
щее предупреждение.

Если вы измените параметры полей страницы, они сохранятся только в текущем
документе. Чтобы задать собственные параметры страницы для всех документов,
с которыми вы работаете, следует внести изменения в шаблон документа. О рабо-
те с шаблонами мы будем говорить на одном из следующих занятий.

Упражнение 6.4. Задание полей страницы

По умолчанию в документах Word, созданных на основе шаблона Обычный
(Normal.dot), верхнее и нижнее поля равны 2 см, левое поле — 3 см и правое поле —
1,5 см. Их можно изменить в любое время. Давайте изменим величину верхнего
поля страницы.

1. Нажмите клавиши Ctrl+Home, чтобы перейти в начало документа.

Обратите внимание на четвертый слева индикатор в строке состояния. Он чи-
тается как На 2 см (At 2 cm). Этот индикатор показывает расстояние курсора от
верхнего края страницы. Давайте уменьшим это значение.
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ЗдеСЬ ЗаДаЮТСЯ I-Margin,

поля страницы

Здесь задается
поле под переплет

Этот список позволяет
печатать по две страницы
на одном листе бумаги,
а также создавать
симметричные страницы
для переплета

Рис. 6.8. Окнэ диалога параметров страницы

Серые области
обозначают поля страницы
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Рис. 6.Э. Вид страницы в режиме разметки

2. Выберите команду Файл > Параметры страницы (File » Page Setup). Эта команда
может быть не видна в сокращенном варианте меню. В этом случае сначала
раскройте меню полностью.

На экране появится окно ди;июга Параметры страницы (Page Setup), показанное
на рис. 6.8.



Отступы текста, выравнивание и интервалы 125

3. В поле Верхнее (Тор) введите число 3.

4. Щелкните на кнопке ОК.

Теперь индикатор в строке состояния выглядит как На 3 см (At 3 cm).

5. Поля страницы наиболее наглядно отображаются на экране в режиме размет-
ки страницы. Для быстрого просмотра страницы в режиме разметки выберите
команду Вид > Разметка страницы (View > Print Layout).

6. На стандартной напели инструментов в списке Масштаб (Zoom) выберите пункт
Страница целиком (Whole Page), как показано на рис. 6.9.

Серые поля на вертикальной и горизонтальной линейках соответствуют полям
страницы (см. рис. 6.9). В этом режиме их даже можно перетаскивать с помощью
мыши, хотя я советую вам всегда пользоваться окном диалога Параметры страни-
цы (Page Setup).

Отступы текста, выравнивание и интервалы

Вы можете изменять не только поля на всей странице, но и «поля» (или так назы-
ваемые отступы} для отдельных абзацев. Отступы определяют расстояние от кра-
ев абзаца до краев страницы. Для изменения отступов можно использовать сле-
дующие инструменты:

• команду Формат > Абзац (Format > Paragraph);

• метки отступа на линейке;

• кнопки для изменения отступа на панели форматирования.

Выравнивание (alignment) абзаца определяет, какой край абзаца окажется ров-
ным, а какой — «рваным».

• При выравнивании по левому краю (вариант по умолчанию) слова в абзаце
выравниваются по левому краю, при переносе слов по строкам ширина пробе-
лов между словами не изменяется. Это самый распространенный вариант вы-
равнивания.

• При выравнивании по правому краю слова в абзаце выравниваются по право-
му краю. Такое выравнивание можно применять для оформления адресов, под-
писей и т. д. в письмах.

• При выравнивании по ширине слова в абзаце выравниваются по обоим краям,
а при переносе слов по строкам ширина пробелов между словами изменяется
так, чтобы немного растянуть или ужать строки. В этом варианте выравнива-
ния обычно рекомендуется расставлять переносы в словах, чтобы скомпенси-
ровать несимметричные пробелы между словами.

• При выравнивании по центру слова в абзаце выравниваются по середине стро-
ки. Этот вариант чаще всего используется для заголовков.

При оформлении документов, особенно предназначенных для вывода на печать,
часто приходится изменять межстрочный интервал (spacing) в абзаце. Например,
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двойной интервал особенно часто применяется редакторами при распечатке до-
кументов для внесения правки в печатную копию и студентами, которым требу-
ется растянуть свой скромный курсовик до размеров солидного научного труда.

Ниже перечислены некоторые из вариантов межстрочных интервалов, доступных
в окне диалога Абзац (Paragraph).

• Одинарный (Single). Вариант по умолчанию. Интервал равен размеру текущего
основного шрифта абзаца и может автоматически изменяться при необходи-
мости.

• Полуторный (1.5 lines). Межстрочный интервал равен 150% высоты строки (раз-
меру шрифта). Лучше, чем одинарный интервал, если вы студент...

• Двойной (Double). Межстрочны л интервал равен удвоенной высоте строки. Для
студентов этот интервал еще лучше.

• Минимум (At least). Межстрочный интервал фиксируется на минимальном зна-
чении (высоте строки) и не меняется.

• Точно (Exactly). Позволяет задат^ величину межстрочного интервала в пунктах.

• Множитель (Multiply), Позволяет задать отношение межстрочного интервала к
высоте строки. В издательской практике самым распространенным является
интервал, составляющий 120% от высоты строки. Это соответствует множите-
лю 1,2.

Выравнивание, отступы абзаца и межстрочный интервал можно изменять по оче-
реди с помощью кнопок на панел i инструментов или сочетаний клавиш. Однако
проще и логичнее изменить сразу все необходимые параметры форматирования
абзаца в окне диалога Абзац (Paragraph).

Упражнение 6.5. Задание отступов

Отступы определяют расстояние между краями абзаца и полями страницы. Что-
бы разобраться с ними, лучше всего взглянуть на линейку.

Если линейка не видна ни экране, выберите команду Вид > Линейка {View > Ruler).

Отступ/Выступ первой строки

Отступ слева Отступ справа

Рис. 6.10. Маркеры отступа на линейке показывают параметры форматирования
текущего абзаца (в данном случае с красной строкой)

На линейке имеются небольшие подвижные маркеры отступа. Они напоминают
риски на логарифмической линейке (если вы еще помните, что это такое). Всего
на линейке присутствуют 4 маркера. Их можно перемещать с помощью мыши, но
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делать это нужно очень аккуратно. Белая область линейки показывает ту часть
страницы, на которой можно вводить текст. Серые области обозначают поля стра-
ницы (рис. 6.10).

• Отступ первой строки (First Line Indent). Изменяя положение этого маркера, вы
изменяете величину «красной строки» в абзаце.

• Выступ (Hanging Indent). Этот маркер позволяет сдвинуть все строки абзаца,
кроме первой. Вариант, в котором начало первой строки расположено левее
остальных строк абзаца, часто используется при создании заголовков и спис-
ков (нумерованных и маркированных). Обратите внимание на то, что марке-
ры 2 и 3 могут перемещаться только вместе. В полиграфии выступ иногда на-
зывают отрицательным отступом.

• Отступ слева (Left Indent). Этот маркер позволяет сдвинуть сразу все строки
абзаца. Если перед перемещением этого маркера вы измените положение двух
предыдущих, то их относительное расположение будет сохранено и для ново-
го отступа.

• Отступ справа (Right Indent). Этот маркер задает расстояние от правого края
абзаца до правого поля страницы.

Давайте изменим отступы в одном из абзацев и посмотрим, как это отразится на
линейке.

1. Щелкните в абзаце, начинающемся со слов В эпоху технологического и информа-
ционного бума.

В этом списке можно
выбрать вариант оформления
первой строки

Indent s and Spacing j I me end Page Breaks |

General - - • • : - - -' •• •• :•

Значение в этом поле
определяет величину
отступа первой строки

Рис. 6.11. Окно диалога Paragraph позволяет менять
параметры форматирования абзаца
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2. Выберите команду Формат > Абзац (Format > Paragraph).

3. В поле Слева (Left) в области Отступ (Indentation) введите значение 2.

4. В поле Справа (Right) в области Отступ (Indentation) введите значение 1.

Обратите внимание «а список Первая строка (Special). Выбрав в нем пункт От-
ступ (First line) или Выступ (Hanging), вы можете создать в абзаце, соответственно,
красную строку или выступ (рис. 6.11).

5. Выберите в списке Первая строка (Special) пункт (нет) ((попе)).

6. Щелкните на кнопке ОК.

Теперь метки отступа на линейке отражают вариант форматирования текущего
абзаца (рис, 6.12).

Чтобы быстро задать отступ слева для целого абзаца, применяются кнопки Уве-
личить отступ (Increase Indent) и Уменьшить отступ (Decrease Indent} на панели
форматирования. Щелкните на кнопке Увеличить отступ (Increase Indent) или
нажмите клавиши Ctrl+M, чтобы увеличить на один шаг отступ абзаца слева.
Кнопка Уменьшить отступ (Decrease Indent) или сочетание клавиш Ctrl+Shift+M
позволяет сдвинуть абзац на один шаг влево,

Рис. 6.12. Метки отступа в абзаце с отступом слева 2 см, отступом справа 1 см

Упражнение 6.6. Выравнивание

По умолчанию текст в документах Word выравнивается по левому краю. Этот
вариант хорошо подходит для основного текста. Так как основной текст должен
составлять большую часть документов, то и выравнивание по левому краю выби-
рается как основное.

Для изменения выравнивания абзаца можно использовать кнопки на панели ин-
струментов, сочетания клавиш и окно диалога Абзац (Paragraph).

1. Нажмите клавиши Ctrl+Home.

2. Выделите заголовок письма (первые четыре строки абзаца).

3. Щелкните на кнопке По центру (Center) на панели форматирования (на рис. 6. 13
она выделена) или нажмите клавиши Ctrl+E.

__="" -.-

Рис. 6.13, Кнопки для выравнивания абзаца

Текст переместится в центр страницы.

4. Щелкните в абзаце, для которого мы задали отступы справа и слева.

5. Щелкните на кнопке По ширине (Justify) или нажмите клавиши Ctrl+J,

6. Выделите слова Искренне Ваш, Андрей Быстрое Директор магазина «Книги».

7. Щелкните на кнопке По правому краю (Align Right) или нажмите клавиши Ctrl+R.

8. Щелкните в любом месте документа, чтобы снять выделение.
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Чтобы вернуть абзац к первоначальному варианту выравнивания, щелкните на
кнопке По левому краю (Align Left) или нажмите клавиши Ctrl+L

Чтобы вернуть абзац к форматированию по умолчанию, нажмите клавиши
Ctrl+Shift+N.

Упражнение 6.7. Задание интервалов

Теперь давайте привлечем внимание к одному из абзацев, изменив для него меж-
строчный интервал и интервал между абзацами.

1. Выделите последний абзац (цитату).

2. Выберите команду Формат * Абзац (Format > Paragraph).

3. В области Интервал (Spacing) раскройте список Междустрочный (Line spacing) и
выберите значение Двойной (Double).

В области Образец (Preview) вы увидите пример форматирования абзаца.

4. Щелкните на верхней кнопке счетчика поля Перед (Before) в области Интервал
(Spacing), чтобы в поле появилось значение 6 пт.

5. Щелкните на кнопке ОК.

Теперь абзац набран через два интервала, и перед ним установлен интервал
6 пунктов. Давайте сделаем межстрочный интервал полуторным (рис. 6.14).

6. Выберите команду Формат > Абзац (Format » Paragraph). Раскройте список Меж-
дустрочный (Line spacing) и выберите пункт Полуторный (1.5 lines).

7. Сохраните изменения.

сказки». Be е читатели, которые подали свои голоса за эту книгу, «аграждаются ценными
пршами от нашего магазина Вы можете зайти к нам в удобно; для Вас время и получить

свой приз
Кроме того, предъявив зто письмо, вы можете приобрести в нашем магазине любое

количество изданий с 4СР/а скидкой1. Среди изданий, на которые мы особенно хотели бы
обратить Ваше внимание, назовем сборник детская стишков к Шал тай-Болтай и его
друзьям, а также Детскую историческую энциклопедию Надеемся, что Вам понравятся

эти книги.
В этом месяце мы проводим вы ставку-про лажу книг по искусству itKpacora и мири

Журнал «Искусство» посвятил этому событию такие строки1

Б эпоху технологического и информационного бума особенно приятно

видеть неосяабевахяций интерес мыслящей части общества к вечным

ценностям. Мы считаем, что настоящая выставка жи-южет.

заинтересовать и тех аюЬей, которые 6р зтого че уделяли особого

анишния «опросом изящных uc/QVcme,

Искренне Ваш

t -Sec i - ijl - ft 20,6ctp In 3S col 38 = • • ч ' JL ?̂!!5! "

Рис. 6.14. В последнем абзаце полуторный интервал между строками

5 Зак. 481
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Контрольное занятие

На этом занятии мы создадим небольшую служебную записку, чтобы проверить
навыки, которые вы приобрели, работая с данной главой.

1. Создайте новый документ.

2. Задайте все поля страницы равными 2 см.

3. Введите следующий текст, нажимая, где это указано, клавишу Enter.

Начальнику отдела кадров НИИМЕХМАШ.

Нажмите клавишу Enter.

Петрову П.П.

Нажмите Enter четыре раза.

Служебная записка.

Нажмите Enter дважды.

Прошу в срок до 16 июня предоставить сведения о числе сотрудников института,
работающих по контракту.

Нажмите Enter трижды.

Иванов М.М.

Нажмите Enter.

Зам. директора института.

Нажмите Enter.

4. Сохраните файл под именем Записка.doc.

5. Выделите текст Служебная за писка.

6. Сделайте текст полужирным.

6.1. Какое сочетание клавиш используется для задания полужирного начертания?

7. Измените шрифт текста на Courier New.

6.2. Сколько шрифтов теперь использовано в документе?

8. Задайте размер шрифта равным 16 пунктам.

9. Выделите текст работающих по контракту.

10. Примените к нему курсивное начертание.

11. Сделайте первую строку в тексте записки «красной».

6.3. Как изменить отступ только первой строки?

12. Выделите текст Служебная записка.

13. Выровняйте его по центру страницы.

6.4. Какое сочетание клавиш используется для выравнивания по центру?
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14. Выделите текст Начальнику отдела кадров НИИМЕХМАШ Петрову П.П.

15. Выровняйте его по правому краю.

16. Выделите текст Иванов М.М. Зам. директора института.

17. Выровняйте его по правому краю.

18. Выделите весь текст документа.

6.5. Какие существуют способы выделения всего текста документа?

19. Примените к нему двойной межстрочный интервал.

20. Сохраните изменения и закройте документ.

Возможные проблемы

Проблема Решение

Как изменить шрифт, Выберите команду Формат > Шрифт (Format > Font),
применяемый для в открывшемся окне диалога задайте нужный вам
создания всех шрифт, сто размер и другие параметры и щелкните
новых документов на кнопке По умолчанию (Default). Ответьте Да (Yes)

в окне подтверждения. Если Word попросит
у вас разрешения сохранить изменения в шаблоне документа,
тоже ответьте Да (Yes)

Я применил шрифт Выделите текст, для которого вы собираетесь изменить
К тексту, по вместо шрифт. Выберите команду Формат * Шрифт (Format > Font)
букв появились и в открывшемся окне диалога укажите нужный шрифт,
какие-то квадратики Если в поле Образец (Peview) вместо вашего текста

отображаются квадратики, не используйте этот шрифт,
а попробуйте найти похожий

Я вставил в документ Выберите команду Формат > Абзац (Format > Paragraph)
символ, и теперь строки и в открывшемся окне диалога увеличьте межстрочный
налезают друг на друга интервал

Подведение итогов

На этом занятии мы научились использовать полужирное и курсивное начерта-
ния, подчеркивание, изменять тип и размер шрифта, задавать параметры полей
страницы, изменять отступы и интервалы абзацев и изменять выравнивание тек-
ста в абзацах.

На следующем занятии мы познакомимся с такими важными элементами доку-
ментов, как списки и колонтитулы.



Занятие 7

Создание списков
и колонтитулов

Тема занятия

На этом занятии вы научитесь:

• работать с нумерованными списками;

• работать с маркированными списками;

• создавать колонтитулы;

• , вставлять в колонтитулы дату, имя файла и номера страниц;

• форматировать колонтитулы.

Подготовка к занятию

На этом занятии нам понадобится файл Письмо о выставке,с1ас, с которым мы ра-
ботали на предыдущих занятиях.

После окончания занятия мы получим документ, показанный на рис. 7.1.

Списки

Если вы хотите донести до читателей какую-либо информацию, она должна быть
представлена наглядно. Для улучшения наглядности и облегчения восприятия
материала Word предоставляет несколько способов. Среди них — нумерованные
и маркированные списки.
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МАГАЗИН «Книги»
пр, Жемчужниковых, 12
191390, Санкт-Петербург

(§12)554-23-09

26 октября 2003 г

Г-жа Елена Цветаева
Референт-переводчик
НИИМЕХМАШ
Трамвайный пр 2-212
191457, Санкт-Петербург

Уважаемая г-жа Цветкова!

Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книга»,
проведенного нашим магазином, лучшей была признана книга «Русские народные
сказкиы Всечитатюш, которые подали свои голоса за эту книгу, награждаются ценными
призами отнашего магазина Вы можетезантн кнам е удобное для Басвремяи получить
свой приз.

Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине любое
количество изданий с 40% скидкой.

Ниже перечислены некоторые издания, нахоторые мы особенно котели бы
обратить Ваше внимание Надеемся, что Вам понравятся эти книги.

• Сказки народов мира
• Английскийдлядетей (книгам аудиокассета)
• Спокойной ночи. Сборник детских песенок (книга и аудиокассета)

Рис. 7.1. Документ, включающий списки и колонтитулы

Маркированные списки удобны при перечислении каких-либо пунктов или тези-
сов, порядок следования которых не имеет значения. Нумерованные списки луч-
ше подходят для пошаговых инструкций или других перечислений, в которых ва-
жен порядок следования пунктов или их количество.

Средства создания списков Word не только позволяют выбирать тип маркера или
систему нумерации пунктов-списка, но и автоматически реагируют на добавле-
ние или удаление пунктов списка.

Существует три способа создания списков. Во-первых, вы можете ввести в доку-
мент все пункты списка (не вводя нумерацию или маркеры), затем выделить их и
применить к ним нумерацию или маркеры с помощью команды Формат >• Список
(Format > Bullets and Numbering).

Во-вторых, вместо этой команды можно использовать кнопки Маркеры (Bullets) и
Нумерация (Numbering) на панели форматирования. Эти два подхода позволяют
полностью контролировать ситуацию и исключают всякие неожиданности.

В-третьих, можно воспользоваться средствами автоматического форматирования
Word. Если ввести в документ определенный символ, затем пробел или табуля-
цию, ввести текст и нажать клавишу Enter, Word автоматически преобразует вве-
денный символ в маркер или номер. Ниже перечислены символы, которые можно
использовать в качестве маркеров и номеров (вместо номеров также используют-
ся буквы английского алфавита), а также то, что из них получается в результате
автоматического форматирования.
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Вводимый символ Результат форматирования

< -

I I
1. 1.
1- 1-

Чтобы прекратить формирование списка, достаточно дважды нажать клавишу
Enter. Чтобы вообще приостановить автоматическое форматирование списков,
раскройте список Параметры автозамены (Autocorrect Options), который появляется
на экране при операции автоматического форматирования, и выберите пункт Ос-
тановить автоматическое создание списков (Stop Automatically Creating Lists).

Упражнение 7.1. Создание маркированного списка

Для создания маркированного списка можно использовать три способа:

• автоматическое создание списка (с помощью механизма автоформата Word);

ш выбор команды Формат ^ Список (Format > Bullets and Numbering) с последующим
выбором нужного типа маркеров на вкладке Маркированный (Bullets);

• выделение введенного текста списка и щелчок на кнопке Маркеры (Bullets) на
панели форматирования.

Предположим, что в целях повышения информативности документа мы решили
добавить названия некоторых доступных изданий в виде списка.

\. Откройте файл Письмо о выставке.doc.

2. Сохраните его под именем Письмо со списком.doc.

3. Щелкните после слов 40% скидкой. Нажмите клавишу Enter.

4. Выделите слова Среди изданий.

5. Введите текст: Ниже перечислены некоторые издания.

6. Щелкните после слова внимание. Введите точку.

7. Удалите конец предложения (по слово энциклопедию включительно).

8. Установите курсор в конец абзаца (после слова книги). Нажмите Enter дважды.

9. Введите звездочку (*) и нажмите клавишу Tab.

10. Введите следующий текст, нажимая, где это указано, клавишу Enter.

Сказки народов мира.

Нажмите клавишу Enter.

Английский для детей (книга и аудиокассета).
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Нажмите клавишу Enter.

Спокойной ночи. Сборник детских песенок (книга и аудиокассета).

Нажмите клавишу Enter дважды. Word автоматически преобразует звездочку и
символ табуляции в маркер. После того как вы дважды нажмете клавишу Enter,
маркированный список закончится. Теперь давайте изменим отступ этого
списка.

11. Удалите один пустой абзац после списка.

12. Выделите все пункты списка.

13. Нажмите клавишу Tab или щелкните на кнопке Увеличить отступ (Increase
Indent).

Теперь вернем список на прежнее место.

14. Щелкните на кнопке Уменьшить отступ (Decrease Indent) или нажмите клави-
ши Shift+Tab.

Теперь список снова выглядит так, как показано на рис. 7.2.

НШШЕХМАШ
Т]>аывя1шьш пр.

ftjfe"*1, wrM -
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Мы ряды еообнрпь Ван. что го тогам оцмся * Лучшая деккая и
проведенного нашим шгзчиноч. п\"чщ«1"1 был» nvjisHaHs книга ^Русские
iska-jHf> Bie'iiiiineTn. кок^ые дадалнсвон nwiiic»1}* :'1>гиану. ш^
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Рис. 7.2. В документе создан маркированный список

Для изменения отступа в списках можно использовать контекстное меню. Оно
содержит команды Увеличить отступ (Increase Indent) и Уменьшить отступ
(Decrease Indent). Если применить эти команды к первому пункту списка, изме-
нится отступ всех остальных пунктов. Пункты в середине списка изменяются по
отдельности.

Упражнение 7.2. Создание нумерованного списка

Средства создания и настройки нумерованных списков аналогичны соответствую-
щим средствам маркированных списков, но вместо маркеров в них используются
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номера. Как и для маркированных списков, для создания нумерованных списков
существуют три способа:

• автоматическое создание списка (с помощью механизма автоформата Word);

• выбор команды Формат * Список (Format > Bullets and Numbering) с последующим
выбором нужного типа нумерации на вкладке Нумерованный (Numbering);

• выделение введенного текста списка и щелчок на кнопке Нумерация (Numbering)
на панели форматирования.

Сейчас мы создадим список с указанием маршрута проезда до выставочного па-
вильона.

1. Щелкните в конце последнего абзаца (цитаты).

2. Нажмите клавишу Enter.

3. Нажмите клавиши Ctrl+ShiftfN, чтобы восстановить форматирование абзаца
по умолчанию.

4. Введите следующий текст:

Чтобы добраться до нашего магазина «Книги», следуйте по маршруту, предложен-
ному ниже.

5. Щелкните в начале нового абзаца и нажмите клавишу Tab, чтобы создать в
нем красную строку,

6. Щелкните в конце нового абзаца и дважды нажмите клавишу Enter,

7. Введите следующий текст, нажимая, где это указано, клавишу Enter.

От ст. метро «Академическая» по проспекту Науки до улицы Северной.

Нажмите клавишу Enter.

Повернуть направо и ехать до третьего перекрестка.

Нажмите клавишу Enter.

Свернуть налево на проспект Жемчужниковых и ехать до дома № 15.

Дважды нажмите клавишу Enter.

8. Выделите три пункта списка и щелкните на кнопке Нумерация (Numbering) на
панели форматирования. Щелкните в любом месте документа.

Теперь документ выглядит так, как показано на рис. 7.3

Давайте изменим параметры форматирования списка.

9. Выделите три пункта нумерованного списка.

10. Выберите команду Формат > Список (Format > Bullets and Numbering).

11. В открывшемся окне диалога щелкните на вкладке Нумерованный (Numbering).

12. Выберите вариант нумерации со скобками после чисел (рис. 7.4).

13. Щелкните на кнопке ОК.

Теперь при добавлении новых пунктов списка Word будет автоматически пере-
нумеровывать остальные пункты. Чтобы добавить новый пункт в конец или в се-
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редину списка, щелкните в конце предыдущего абзаца и нажмите клавишу Enter.
Чтобы добавить пункт в начало списка, поместите курсор в начало первого абзаца
списка и нажмите клавишу Enter.

Кнопка нумерации

X3* '«Ms VfrOan '„-- р *,. ] ..,

^̂ 4ДЦ1;
&.1; £•!*:.&,«..\;^.i'& ;:'-.;-«•',• :.:•,.',:'„: 'Л1.1-".=.'.

Журнал ^Искусство» пошатни этому событию такт строки

В vtofy /nexHOflOfutec/fojo и ьифорчаццанноге fsyt,

видеть нюсаобнаюаиь ииямрге нисана и часта

№ннос»ам. Мы считаем, что тхтоящол л

внимания вапрася.4 ими^ных ucxycctnt,

Чтобы лсбрпься до нашего uarxiKKa «Кннгн*. следуйте по м |̂Ш|>уту.
предложенному HHSC.

.Ш

Рис. 7.3. Документ с нумерованным списком

gjSated • Cumbered OytlmeNumtefedj List Style

None

-

Рис. 7.4. Окно диалога для создания и настройки списков

Чтобы удалить нумерацию в одном из пунктов, поместите курсор в начало абза-
ца и нажмите клавишу Backspace.

Word автоматически перенумеровывает абзацы при удалении нумерации в час-
ти пунктов списка. В результате могут получиться два и более списков, разде-
ленных абзацем с обычным форматированием.
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Колонтитулы

Колонтитулы — это надписи, помещаемые вверху и внизу каждой страницы до-
кумента. Они не относятся к основному тексту документа и обычно содержат ин-
формацию, которая либо помогает ориентироваться в многостраничных докумен-
тах, либо служит для идентификации самого документа. Например, в этой книге
верхний колонтитул левой (четкой) страницы содержит название занятия и но-
мер страницы, а верхний колонтитул правой (нечетной) страницы — название
раздела и номер страницы. В Word колонтитулами называются также сами обла-
сти страницы, предназначенные для ввода такого текста. В колонтитулы можно
вставлять номера страниц, дату, зремя, имена файлов, фамилии, адреса, рисунки
и многое другое.

Колонтитулы могут быть разными для разных фрагментов документа. Вы можете
создать колонтитулы для четных и нечетных страниц, отдельный колонтитул для
титульного листа, а также разбить документ на разделы, для каждого из которых
можно задать свои колонтитулы.

Раздел документа создается с помощью команды Вставка > Разрыв (Insert >
Break). Разделы отличаются параметрами страницы, которые задаются с по-
мощью команды Файл > Параметры страницы (File > Page Setup).

Упражнение 7.3. Создание колонтитулов и нумерация
страниц

Сейчас мы добавим в документ колонтитул, включающий помер страницы. Чаще
всего колонтитулы используются именно для этого. Обратите внимание на то,
что колонтитулы отображаются на экране только в режимах Разметка страницы
(Print Layout) и Предварительный просмотр (Print Preview).

1. Щелкните перед словами в этом месяце.

2. Нажмите клавиши Ctrl+Enter, чтобы вставить знак разрыва страницы.

3. Выберите команду Вид ^ Колонтитулы (View > Header and Footer). На экране по-
явится панель инструментов Колонтитулы (Header and Footer), показанная на
рис. 7.5.

Давайте сначала вставим в нижний колонтитул номер страницы.

4. Щелкните на кнопке Верхний/нижний колонтитул (Switch Between Header and Footer),

5. Щелкните на кнопке Номер страницы (Insetr Page Number). В документ будет
вставлен номер страницы.

6. Нажмите клавиши Ctrl+E, чтобы выровнять номер страницы по центру.

Номер страницы вставляется в колонтитул как поле, то есть в виде специаль-
ного кода, который позволяет номерам автоматически обновляться при внесе-
нии изменений в документ.

Теперь на двух страницах нашего документа будут располагаться номера.
Сейчас мы вставим дополнительную информацию в верхний колонтитул.
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Предположим, что нам нужно разместить в нем следующие данные: слева —
слово Выставка, по центру — слова «Красота и мир», справа — время проведения
выставки.

Область для ввода текста
в верхний колонтитул

Основной текст документа
отображается серым цветом

Панель
инструментов

Header and Footer

Возможные
варианты

автотекста

Вставка номера страницы —
Вставка числа страниц

Вставка даты
Вставка времени

Параметры страницы
Переключение между верхним

и нижним колонтитулами
Переключение между колонтитулами

разных разделов

Рис. 7.5. Вставка колонтитула в документ

Для вставки номеров страниц в Word также можно использовать команду Встав-
ка > Номера страниц (Insert > Page Numbers}, однако в этом случае вам будет труд-
нее форматировать номера. Работая непосредственно с колонтитулами, вы смо-
жете лучше контролировать размещение и форматирование текста на странице,

7. Щелкните на кнопке Верхний/нижний колонтитул (Switch Between Header and
Footer).

8. Если курсор находится в левой части колонтитула, введите слово Выставка,
если нет, предварительно дважды щелкните в нужном месте.

9. Поместите указатель мыши примерно на середину колонтитула. Он примет
вид вертикального указателя со схематичным изображением абзаца, выров-
ненного по центру (рис. 7,6).

10. Дважды щелкните на колонтитуле — Word поместит курсор в точку щелчка.

11. Введите слова «Красота и мир».

12. Поместите указатель мыши на правый край колонтитула. Он примет вид вер-
тикального указателя со схематичным изображением абзаца, выровненного
по правому краю (рис. 7.7).
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Форма указателя
соответствует типу

выравнивания абзаца

и *.а!»''!зд
р«в г $ос i гц. ': к i,tm

Рис. 7.6. Двойной щелчок в центре страницы позволяет вставить абзац,
выровненный по центру

. . В режимах Разметка страницы (Print Layout), Предварительный просмотр (Print
s/ Preview) и Веб-документ (Web Layout) существует возможность свободного вво-

да. Дважды щелкнув в любом месте страницы, можно начинать ввод текста в
точке щелчка. В зависимости от расположения курсора меняется выравнивание
получающегося абзаца. Доступны четыре варианта выравнивания: по левому
краю, по левому краю с ,<расной строкой, по центру и по правому краю. О теку-
щем варианте выравнивания можно узнать по форме указателя мыши.

Сюда будет
вставлен абзац

Рис. 7.7. Вставка в колонтитул абзаца, выровненного по правому краю
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13. Дважды щелкните на колонтитуле — Word поместит курсор в точку щелчка.

14. Введите слова 1-7 сентября 2004 г.

15. Щелкните на кнопке Закрыть (Close) на панели инструментов Колонтитулы
(Header and Footer).

16. Сохраните документ.

Упражнение 7.4. Форматирование колонтитулов

Так как в колонтитулы обычно входит вспомогательная информация, ее принято
оформлять шрифтом немного меньшего размера, чем основной текст. При форма-
тировании текста в колонтитулах используются все те же приемы, что и при фор-
матировании обычного текста. Сейчас мы изменим форматирование верхнего и
нижнего колонтитулов нашего документа. Убедитесь, что документ находится в
режиме разметки страницы. Для этого выберите команду Вид > Разметка страницы
(View > Print Layout). Колонтитулы должны быть показаны шрифтом серого цвета.

1. Дважды щелкните на колонтитуле, чтобы перейти в режим его редактирова-
ния, либо выберите команду Вид > Колонтитулы (View » Header and Footer).

2. Чтобы выделить весь текст колонтитула, нажмите клавиши Ctrl+A.

3. Выберите значение 9 в списке Размер шрифта (Font Size) на панели форматиро-
вания.

4. Щелкните на кнопке Верхний/нижний колонтитул (Switch Between Header and
Footer).

5. Выделите номер страницы и нажмите клавиши Ctrl+B, чтобы сделать номер
страницы полужирным.

6. Выберите значение 10 в списке Размер шрифта (Font Size) на панели формати-
рования.

7. Щелкните на кнопке Закрыть (Close) на панели инструментов Колонтитулы
(Header and Footer).

8. Сохраните документ.

Упражнение 7.5. Вставка полей даты, имени файла и других

В этом упражнении вы узнаете, какие варианты колонтитулов предлагает про-
грамма Word и как их использовать для создания собственных колонтитулов. Мы
продолжим работать с файлом Письмо со списком.doc, только сохраним его под дру-
гим именем.

1. Сохраните файл Письмо со списком.doc под именем Колонтитулы.йос.

2. Выберите команду Вид * Колонтитулы (View > Header and Footer).
3. Выделите весь текст в верхнем колонтитуле.

4. Нажмите клавишу Delete.

5. Щелкните на кнопке Вставить автотекст (Insert AutoText). На экране появится
список доступных элементов автотекста (рис. 7.8). Для разных языков списки
разные.
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Рис. 7.8. Вставка в колонтитул элемента автотекста

6. Выберите вариант Стр. <№> из <всего> (Page X of Y). Вы увидите, как Word
вставит в документ фразу стр 1 из 2.

Такую фразу очень удобно использовать в многостраничных документах.
В этом случае вы будете точно уверены, что ни одна страница не потерялась.
А что делать, если вам нужно распечатать несколько файлов со схожим со-
держанием, и вы боитесь перепутать листы из разных файлов?

7. Поместите указатель мыши на правый край колонтитула. Он примет вид вер-
тикальной черты со схематичн ым изображением абзаца, выровненного по пра-
вому краю.

8. Дважды щелкните на колонтитуле. Word поместит курсор в точку щелчка.

9. Щелкните на кнопке Вставить автотекст (Insert AutoText). На экране появится
список доступных элементов автотекста. Выберите вариант Полное имя файла
(Filename and path). В колонтитул будут вставлены имя файла и путь к нему.

Для более сложного расположения информации в колонтитулах удобно исполь-
зовать таблицы с невидимым обрамлением. О работе с таблицами мы погово-
рим на одном из следующих занятий.

10. Щелкните на кнопке Верхний/нижний колонтитул (Switch Between Header and
Footer).

11. Выделите весь текст в нижнем колонтитуле.

12. Нажмите клавишу Delete.

13. Щелкните на кнопке Дата (Insert Date). В колонтитул будет вставлена теку-
щая дата.

14. Закройте документ, не сохраняя изменений.
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Чтобы поля, вставленные в текст документа, обновлялись перед печатью, уста-
новите флажок Обновлять поля перед печатью (Update Fields) на вкладке Печать
(Print) в окне диалога Параметры (Options).

Чтобы обновить одно из полей вручную, щелкните на нем правой кнопкой мыши
и выберите в контекстном меню команду Обновить поле (Update Field).

Контрольное занятие

На этом занятии мы создадим инструкцию по пользованию стиральной машиной.

1. Создайте новый документ.

2. Сохраните его под именем Инструкция.doc.

3. Введите следующий текст, нажимая, где это указано, клавишу Enter.

Стиральная машина «Мечта-2»

Нажмите клавишу Enter четыре раза.

Новая модель популярной машины «Мечта» позволяет выполнять следующие
операции:

Нажмите клавишу Enter дважды.

Стирка с кипячением (90° С);

Нажмите клавишу Enter.

обычная стирка (60° С);

Нажмите клавишу Enter.

бережная стирка (40° С);

Нажмите клавишу Enter.

замачивание;

Нажмите клавишу Enter.

отжим (800 об/мин).

Нажмите клавишу Enter дважды.

4. Выделите последние пять строк и оформите их как маркированный список.

7.1. Как изменить отступ списка?

5. Перейдите в конец документа.

6. Вставьте в документ знак разрыва страницы.

7. Введите следующий текст, нажимая, где это указано, клавишу Enter.

Инструкция для пользователя

Нажмите клавишу Enter дважды.

Загрузите белье в машину.
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Нажмите клавишу Enter.

Засыпьте порошок.

Нажмите клавишу Enter.

Установите нужный режим сгирки.

Нажмите клавишу Enter.

Проверьте подключение машины к электросети.

Нажмите клавишу Enter.

Включите таймер.

Нажмите клавишу Enter дважды.

8. Выделите последние пять строк и оформите их как нумерованный список.

9. Добавьте в верхний колонтитул номера страниц, расположив их справа.

10. Добавьте в верхний колонтитул слова Мечта-2 будет вашим лучшим другом!, рас-
положив их слева.

7.2. В каких режимах можно просматривать и редактировать колонтитулы?

11. Оформите верхний колонтитул шрифтом Courier New размером 8 пунктов, по-
лужирный.

12. Добавьте в левый край нижнего колонтитула текущую дату.

7.3. Как перемещаться между Е;ерхним и нижним колонтитулами?

13. Добавьте в правый край нижнего колонтитула текущее время.

14. Закройте панель инструментов Колонтитулы (Header and Footer).

15. Сохраните изменения и закройте файл.

Возможные проблемы

Проблема Решение

Я ввел стрелочку (=*>) и текст, Но забудьте о вводе пробела или табуляции после
нажал клавишу Enter, a Word символа маркера
не преобразовал знак (=>)
в символ маркера

Я удалил нумерацию в одном Щелкните в первом абзаце второго списка правой
из серединных пунктов кнопкой мыши и выберите в появившемся меню
списка, и теперь нумерация команду Начать заново (Restart Numbering)
во втором списке продолжает
нумерацию первого. Как создать
два списка с независимой
нумерацией?
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Проблема Решенне

Я помещаю указатель мыши
на правый край колонтитула
после того, как ввел текст
слева, но указатель
не изменяет форму

Я хочу убрать номера страниц
с первой страницы документа

Word обрезает часть текста,
введенного в колонтитул

Мне нужно разместить
в колонтитуле несколько
отдельных строк текста,
расположенных в правой
и в левой частях колонтитула

Сначала щелкните один раз в нужной точке

Чтобы колонтитул первой страницы отличался
от колонтитулов остальных страниц документа,
выберите команду Файл > Параметры страницы
(File * Page Setup), щелкните на вкладке Макет
(Layout) открывшегося окна диалога и установите
флажок Первой страницы (Different First Page)
в области Различать колонтитулы (Header and Footer)

Увеличьте размер верхнего поля страницы. Для этого
выберите команду Файл > Параметры страницы
(File ^ Page Setup), щелкните на вкладке Поля
(Margins) открывшегося окна диалога и задайте
нужное значение в поле Верхнее (Тор)

Вставьте в колонтитул таблицу 1x2 с помощью
кнопки Вставить таблицу (Insert Table). Щелкните
правой кнопкой мыши па вставленной таблице,
выберите команду Обрамление и заливка (Borders and
Shading) и укажите вариант Нет (None) в области Тип
(Setting) на вкладке Обрамление (Borders). Теперь
в каждую ячейку таблицы можно вводить свой текст,
расположенный в нескольких строках, и выполнять
для него независимое выравнивание

Подведение итогов

На этом занятии мы научились:

• работать с нумерованными и маркированными списками;

• вставлять в документ колонтитулы;

• добавлять в них нужную информацию;

• форматировать колонтитулы.

На следующем занятии мы познакомимся с некоторыми хитростями форматиро-
вания, которые позволяют экономить время оформления документа.
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Тема занятия

На этом занятии мы научимся следующим хитростям:

• применению стиля;

• просмотру параметров стиля;

• созданию стиля;

• использованию клавиши R для повторения последней операции;

• копированию форматов;

• поиску и замене форматов.

Подготовка к занятию

Для этого занятия нам понадобится документ Письмо со списком.doc, который мы
создали на предыдущем занятии.

Когда вы закончите работу над этим документом, он будет выглядеть так, как по-
казано на рис. 8.1.
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МАГАЗИН «Книги»
пр. Жемчужниковых, 12
191390, Санкт-Петербург

(812)554-23-09

октября 2003 г

Уважаемая г-жаЦветкова!

Г-ха Елена Црегюва
Референт-переводчик

НИИМЕХМАШ
Тоэмвайкый л». 2-212

191457, Санкт-ПетерВург

Мы рады сообщить Вам. что по итогам опроса «Лучшая детская книга»,
проведенного нашим магазином, лучшей была признана канта «Русские народные
сказкия. Все читатели, хеторые подали свои голоса за эту книгу, награждаются ценными
призами от нашего магазина. Бы можете зайти к нам а удобное для Бас время и получить
свой приз.

Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине любое
количестве изданий с 40% скидкой

Ниже перечислены некоторые издания, на которые мы особенно хотели бы
обратить Ваше внимание. Надеемся, что Вам понравятся эти книги.

Саисакновчх детских книг
• Сказки народов мира
• Английский для детей (книга и аудиокассета)

• Спокойной ночи. Сборник детских песенок (книга и аудиокассета)

В этом месяце мы проводим вы ставку-продажу книг по искусству кКрасота и мири.
Журнал «Искусство» посвятил этому событию такие строки:

Цитата

В зяаху технологического и информационного бума осс&енно приятно

видеть неослабевающий интерес мъкпящей части общества к вечным

ценностям. Мы считяем, что настоящая выошека поможет

заинтересовать и тех пюдей, которые до этого не уде/шли особого

внимания вопросам изящных искусств.

Чтобы добраться до нашего магазина «Книги», следуйте по маршруту,
предложенному ниже.

1) От ст метро ((Академическая» по проспекту Науки до улицы Северной.
2) Повернуть направо и ехать до третьего перекрестка.
3) Свернуть налево на проспект Жемчужниковык и ехать додома№ 15.

Искренне Ваш

Андрей Быстров
Директор магазина «Книги»

Рис. 8.1. Документ, содержащий стили

Стили

Вы работаете над документом. Можете ли вы определить, из каких элементов со-
стоит этот документ? Скорее всего, в него входят заголовки разной степени важно-
сти (для документа, главы, раздела, подраздела и т. д.), колонтитулы, списки, абза-
цы с разным форматированием (обычный текст, цитаты, сноски и т. д.)- Кроме того,
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в состав самих абзацев могут входить отдельные фрагменты, которые требуется
выделить особым форматированием (курсивом, полужирным начертанием или
подчеркиванием). Теперь вспомьите, что любой из перечисленных элементов до-
кумента (заголовок, абзац основного текста, фрагмент текста в абзаце и т. д.) может
требовать задания сразу нескольких параметров форматирования.

До сих пор вы работали с параметрами форматирования по отдельности, то есть
применяли их к выделенным фрагментам текста по очереди, например с помощью
кнопок на панели форматирования или сочетаний клавиш. Теперь представьте,
что вам нужно выделить какой-то заголовок полужирным начертанием, затем вы-
ровнять его по центру страницы, назначить ему другой шрифт и изменить размер
шрифта. А если в вашем документе два десятка таких заголовков и все должны
быть оформлены одинаково? Чтобы менять несколько параметров форматирова-
ния одновременно, существуют стили. Стили Word позволяют контролировать
параметры форматирования как для символов, так и для абзацев. Для символов
вы можете задавать шрифт, размер шрифта, начертание (полужирный, курсив),
цвет шрифта, межсимвольный интервал, величину пробелов и различные эффек-
ты (все прописные, верхний и нижний индексы, скрытый текст и др.). Для абза-
цев вы можете менять выравнивание, интервал до и после абзаца, добавлять ну-
мерацию и маркеры, менять обрамление и заливку абзаца. Таким образом, для
оформления наших заголовков удобно использовать специальный абзацный
стиль. В этом стиле мы зададим выравнивание, тип, начертание и размеры шриф-
та, а затем просто применим созданный стиль ко всем нужным заголовкам доку-
мента.

t^w

Стили хранятся в шаблоне документа. Шаблон Обычный (Normal.dot) кроме сти-
лей абзаца и символа (знака) также включает стили таблиц и многоуровневых
списков.

Стили позволяют добиться единства оформления разных фрагментов документа.
Кроме того, стили можно копировать между документами. Например, вы можете
создать специальный стиль для красивых надписей на плакатах и затем передать
его коллегам, которые смогут использовать его для создания таких же надписей.

Хотя вы могли этого не заметить, но документ, с которым работаете, уже содержит
стили. Стили хранятся в шаблоне: документа. По умолчанию весь текст новых до-
кументов, созданных на основе шаблона Обычный (Normal.dot), оформляется сти-
лем Обычный (Normal). Этот стиль включает следующие параметры форматирова-
ния: шрифт Times New Roman размером 10 пунктов, русский язык, выравнивание по
левому краю, одинарный межстрочный интервал, контроль висячих строк. Кроме
этого стиля в документе используются стили заголовков Заголовок 1 (Heading 1),
Заголовок 2 (Heading 2) и Заголовок 3 (Heading 3). Стиль Основной шрифт абзаца (De-
fault Paragraph Font) по умолчанию является символьным стилем.

Упражнение 8.1. Применение стиля

Word содержит множество стилей, которые можно применять к тексту докумен-
тов. Например, разными стилями можно оформить заголовок, нумерованный спи-
сок или отдельный абзац, который вы хотите выделить. Кроме того, вы можете
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сначала по очереди применить нужные параметры форматирования, а затем со-
хранить их как стиль. В следующих упражнениях мы будем работать с файлом
Письмо со списком.doc, который мы создали на предыдущем занятии. Давайте вы-
делим одну из строк этого документа и применим к ней стиль.

1. Откройте файл Письмо со списком.doc.

2. Сохраните его под именем Стили.doc.

3. Выделите название магазина в первой строке документа.

Чтобы подготовить абзац к применению абзацного стиля, достаточно просто
установить курсор в любое место абзаца {щелкнуть в абзаце один раз). Этот
абзац будет считаться текущим.

4. Щелкните на кнопке Стили и форматирование (Styles and Formatting) на панели
форматирования. На экране отобразится область задач Стили и форматирова-
ние (Styles and Formatting).

Выделение всех фрагментов,
оформленных с использованием

текущих параметров форматирования

Создание стиля на основе
текущих параметроа
форматирования

(МАГАЗИН «Книги»
lip. JkePNVYHfKObbKS,

(йЬ) 554-23-05

«

Не«Ш1(] 3 »-2

"

Ыьпш! Г 1

-̂ —ii 1 нп*е, I ^

7

Список для выбора
варианта
форматирования

Так выглядит текущий
фрагмент с заданным
форматированием

Абзацный
стиль

Встроенные
стили Word
Символьный
стиль

Варианты форматирования,
доступные только

в текущем документе

Список для выбора
отображаемых вариантов
форматирования

Рис. 8.2. В списке стилей отображаются стили, использованные в документе

Основную часть области задач Стили и форматирование (Styles and Formatting)
занимает список доступных в данном документе вариантов форматирования.
Содержимое этого списка определяется значением, выбранным в списке Пока-
зать (Show), расположенном в нижней части области задач.

Q Доступные форматы (Available Formatting). Включает те варианты форматиро-
вания фрагментов документа, которые были назначены вручную (как мы и
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делали на предыдущих занятиях), а также доступные стили, не обязатель-
но примененные к фрагментам текста. Названия стилей отмечены справа
значком стиля (абзац, буква или таблица); обычные варианты форматиро-
вания не имеют такого значка.

а Используемые форматы (Formatting in use). Включает только те варианты
форматирования, которые используются в текущем документе.

U Доступные стили (Available styles). Краткий список стилей, которые можно
использовать в документе.

а Все стили (АН styles). Полный список стилей, которые можно использовать в
документе. Стили абзаца отмечены значком абзаца (К), стили символа —
буквой а, стили таблицы — миниатюрным значком таблицы, стили много-
уровневых списков — миниатюрным значком списка.

Q Специальные форматы (Custom). Выбор этого пункта позволяет настраивать
списки выводимых стилей.

Если поместить указатель мыши на строку с названием варианта форматирова-
ния в списке, то на экране появится подсказка, в которой будут перечислены
все параметры этого варианта. Если это строка с названием стиля, название
будет располагаться в начале всплывающей подсказки и отделяться двоеточи-
ем от перечня параметров форматирования.

5. В списке Показать (Show) выберите пункт Доступные форматы (Available
formatting).

6. Щелкните на названии стиля Заголовок 2 (Heading 2).

Word применит к выделенному тексту следующие параметры: шрифт Arial раз-
мером 14 пунктов, полужирный курсив, выравнивание по левому краю, интер-
вал перед абзацем 12 пунктов.

Если вы выбрали непраЕМЛЬНЫЙ стиль, выделите нужный фрагмент и выберите
другой стиль в списке С~~иль (Style) на панели форматирования.

Чтобы ввернуться к абзацному стилю Обычный (Normal), щелкните на строке
Очистить формат (Clear Formatting) или нажмите клавиши Ctrl+Shift+N.

7. Щелкните на кнопке Отменить (Undo), чтобы отменить последнюю операцию.

Упражнение 8.2. Просмотр параметров стиля

Любые параметры форматирования, которые вы можете изменить с помощью
окон диалога Шрифт (Font) и Абзац (Paragraph), могут быть включены в стиль. Да-
вайте посмотрим, какие параметры форматирования содержаться в некоторых
стилях.

1. Поместите курсор в первую строку документа.

2. Выберите команду Формат > Показать форматирование (Format > Reveal
Formatting) или нажмите клавиши Shift+Fl. На экране появится область задач
Показать форматирование (Reveal Formatting), показанная на рис. 8.3.
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В этом поле отображается текущий фрагмент
с заданными параметрами форматирования

(МАГАЗИН «Книги»
пр Жемчужниковы*, 12
191390, Санк7-Петербург

(812)554123-09

Ff muting o|»rlcilrd ii

Этот флажок поможет определить,
какие параметры форматирования
вы назначили фрагменту вручную

-Если щелкнуть на этом
значке, можно свернуть
или развернуть список
параметров
форматирования

Если щелкнуть на названиях параметров
форматирования, то их можно будет
изменить в соответствующих
окнах диалога

Рис. 8.3. Область задач Reveal Formatting

3. Установите флажок Сравнить с другим фрагментом (Compare to another selection)
и щелкните в первом текстовом абзаце письма. Вы увидите, как в поле Разли-
чия в форматировании (Formatting differences) будет показано, чем различаются
выделенные абзацы. Два сравниваемых образца будут выведены в верхней ча-
сти области задач.

4. Снимите флажок Сравнить с другим фрагментом (Compare to another selection).

Посмотрите на описание текущего фрагмента в нижней части окна диалога. Здесь
перечислены параметры форматирования, включенные в данный стиль. Сложные
стили могут содержать отформатированные символы, нумерацию, маркеры, об-
рамление и заливку, а также колонки.

Упражнение 8.3. Создание стиля

Вы можете создать стиль самостоятельно и использовать его для работы с буду-
щими документами. Новый стиль можно создать на основе уже отформатирован-
ного фрагмента текста. Для этого выделенный фрагмент текста или абзац оформ-
ляется нужным образом с помощью кнопок панели форматирования, а затем по
образцу данного фрагмента создается стиль. Для создания стилей существует два
способа:

• Можно просто выделить отформатированный фрагмент, щелкнуть в поле спис-
ка Стиль (Style) на панели форматирования, ввести туда имя нового стиля и
нажать клавишу Enter.
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• Другой путь — выделить отформатированный фрагмент, вывести на экран об-
ласть задач Стили и форматирование (Styles and Formatting) и щелкнуть на кноп-
ке Создать стиль (New Style).

Давайте воспользуемся вторым способом, чтобы вы лучше поняли, как нужно ме-
нять параметры форматирования для нового стиля.

1. Щелкните в первой строке адреса.

2. Щелкните сначала на кнопке Стили и форматирование (Style and Formatting) на
панели форматирования, а затем на кнопке Создать стиль (New Style) в области
задач Стили и форматирование (Styles and Formatting).

3. На экране появится одноименное окно диалога, показанное на рис. 8.4.

Paragraph

Properties-

Name; -

j; Style {уре:

i f " Styfe based on:

!: $3* ForftstaHing paragtapn: j H Stylel

II Formatting ••-••> •..• •• -- •• -

| ' >verdana *\ 16 |

И Norma

Ишиин «Кнмк»

Normal + Font: Vercfcna.. ISot ВэИ, &nolt caps,"Centered

Г" fidd to temolata Aytornatlcally update

1 СЖ- 1 - -- Cancel

Рис. 8.4. Окно диалога создания стиля

Если существует другой стиль, содержащий часть параметров форматирования,
которые вы хотите испопьзовать в новом стиле, вы можете выбрать название
этого стиля в списке Основан на стиле (Style based on). Затем можно изменить
некоторые параметры форматирования этого стиля, добавить новые парамет-
ры и оставить те, которые вас устраивают.

4. В списке Основан на стиле (Style based on) оставьте выбранным пункт Обычный
(Normal).

5. Введите название нового стиля в поле Имя (Name). Давайте назовем этот стиль
Адрес.

В списке Стиль (Style type) можно задать стиль символа, выбрав пункт Знака
(Character), стиль абзаца, выбрав пункт Абзаца (Paragraph), стиль таблицы, выб-
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рав пункт Таблицы (Table), и стиль списка, выбрав пункт Списка (List). Сим-
вольный стиль можно применять к отдельным символам (от 1 буквы до цело-
го документа). Абзацный стиль применяется к абзацам целиком (от 1 абзаца
до целого документа). Табличный стиль применяется к таблице и ее отдель-
ным фрагментам. Выбрав соответствующий тип стиля, вы тем самым указыва-
ете его возможную область применения. Для табличных стилей придется ука-
зывать ее более конкретно.

В списке Стиль следующего абзаца (Style for following paragraph) можно выбрать
стиль, который будет автоматически применяться после того, как вы нажмете
клавишу Enter, закончив ввод абзаца, оформленного новым стилем. Например,
для стилей заголовков стилем следующего абзаца удобно выбирать стиль ос-
новного текста. Тогда после ввода заголовка за ним будет автоматически сле-
довать обычный текст.

В окнах диалога для создания и изменения стилей нужные параметры можно
задавать с помощью кнопок, аналогичных кнопкам на панелях инструментов.

6. Выберите пункт Обычный (Normal) в списке Стиль следующего абзаца (Style for
following paragraph).

7. В списке шрифтов выберите шрифт Arial.

8. Задайте размер шрифта 9 пунктов.

9. Щелкните на кнопке Увеличить отступ (Increase indent).

Обратите внимание на описание стиля в нижней части окна диалога (рис. 8.5).
Теперь здесь указаны шрифт A r i a l , его размер (9 пунктов) и значение отступа
слева (1,25 см).

Properties ••• - •-"•

'v^ame:"' •--

! Style ftpe:

;! 5tyla based on;

{Paragraph

Т] Мсчтла!

1 ' - • •

| Formatting

Anaf /.. н.-.Д
»» я ?s

ftotma! + Рог*: Агщ1,9£й:, Indent; Left: l,2Scm

Г flddto template

Рис. 8.5. В окне отображаются новые параметры стиля
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10. Щелкните на кнопке ОК, чтобы закрыть окно диалога Создание стиля (New style).
Обратите внимание на то, что в списке появилось название нового стиля.

Если установить флажск Добавить в шаблон (Add to template), то новый стиль
будет доступен не только в текущем документе, но и во всех документах, соз-
данных на основе данного шаблона, — в нашем примере это шаблон Обычный
(Normal.dot).

Если установить флажок Обновлять автоматически (Automatically update), то при
ручном форматировании фрагмента, оформленного данным стилем, изменения
затронут и все остальные фрагменты.

11. Выделите весь адрес письма.

12. Щелкните на названии стиля Адрес в списке стилей. Вы также можете выбрать
этот пункт в списке Стиль (Style) на панели форматирования.

13. Сохраните изменения в документе.

Выделенные строки будут оформлены новым стилем.

Если какой-то стиль вам больше не нужен, вы можете удалить его из документа
или вообще из шаблоне. Для этого введите на экран область задач Стили и фор-
матирование (Styles and Formatting), щелкните на кнопке со стрелкой рядом с
названием ненужного стиля и выберите пункт Удалить (Delete).

Упражнение 8.4. Изменение стиля

При работе с разными документами вам может понадобиться изменить парамет-
ры созданного вами стиля или стиля, изначально присутствовавшего в докумен-
те. Например, вы можете задать другие параметры для стилей заголовков, сохра-
нить их в шаблоне Обычный (Normal.dot) и затем использовать во всех документах,
создаваемых на основе этого шаблона. Давайте изменим параметры одного из сти-
лей Word.

Обратите внимание на то, что вы можете просто изменять названия стилей, ко-
торые уже существуют в документе.

1. В списке стилей в области задач Стили и форматирование (Styles and Formatting)
поместите указатель мыши на название нового стиля Адрес. Справа появится
изображение стрелки.

2. Щелкните на стрелке, чтобы вывести на экран меню команд для работы с дан-
ным стилем, показанное на рис. 8.6.

3. Выберите команду Изменить (Modify).

С помощью команды Выделить все N экземпляров (Select All N Instance(s)) вы
можете выделять несмежные фрагменты текста, оформленного одинаковым
образом, и форматирсвать их одновременно. Кроме того, можно выполнять с
ними многие другие операции.
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МАГАЗИН «Книги»
пр. Жемчужниковых, 12
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Уважаемая г-жа Цветюва! _i

Мы рады сообщить Вам. что по итогам опроса «Лучшая дето»
проведенного вашим магазином, лучшей Р]ыла признана книга sPjt:
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Этой командой можно выделить
все фрагменты текста, оформленные

данным образом

Рис. 8.6. Выбор команды для изменения стиля
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Рис. 8.7. В нижней части окна диалога показаны новые параметры стиля

В появившемся окне диалога вы можете задать те же параметры форматиро-
вания, что и в окне Создание стиля (New Style).
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4. Щелкните на кнопке Формат (Format) и выберите пункт Абзац (Paragraph).

5. Щелкните на вкладке Положение на странице (Line and Page Breaks). Установите
флажки Запрет висячих строк (Widow/Orphan control) и Не отрывать от следующего
(Keep with next).

6. Щелкните на вкладке Отступы и интервалы (Indents and Spacing). В списке Вы-
равнивание (Alignment) выберите пункт По правому краю (Right).

7. Щелкните на кнопке ОК, чтобы закрыть окно диалога Абзац (Paragraph).

8. Как показано на рис. 8.7, новые параметры стиля появятся в нижней части окна
диалога Изменение стиля (Modify Style). Щелкните на кнопке ОК, чтобы закрыть
окно.

Теперь обратите внимание на то, что текст, к которому мы ранее применили стиль
Адрес, выровнен по правому краю страницы. Это изменение программа сделала
автоматически, сразу после того как мы закрыли окно диалога Изменение стиля
(Modify Style). Теперь новые параметры форматирования будут назначаться всем
абзацам, для которых мы выберем стиль Адрес.

Быстрое форматирование

Итак, новый документ с новыми стилями создай. Теперь представьте, что вам нуж-
но создать другой документ или просто добавить несколько страниц в.текущий
документ. Чтобы быстро и последовательно применять к разным фрагментам до-
кумента одинаковые параметры форматирования, в Word существует несколько
удобных способов. Основные средства Word, предназначенные для этой цели, —
клавиша F4 и клавиши копирования формата.

Упражнение 8.5. Повторение последней операции

Клавиша F4 позволяет повторить выполнение последней операции. Например, ее
можно использовать для последовательного оформления разных фрагментов тек-
ста. Сейчас мы посмотрим, как она работает.

1. Выделите адрес в текущем документе.

2. Примените к нему стиль Адрес.

3. Выделите обращение в письме.

4. Нажмите клавишу F4. К выделенному фрагменту будет применен предыду-
щий стиль.

5. Нажмите клавиши Ctrl+Z.

6. Выделите слово рады в первом предложении первого абзаца.

7. Щелкните на кнопке Подчеркнутый (Underline) на панели форматирования.

8. Щелкните в слове изданий во втором абзаце.

9. Нажмите клавишу F4. Текущее слово будет подчеркнуто.

10. Сохраните изменения.
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Этот прием очень удобно использовать, когда вам нужно, например, оформить
множество слов, разбросанных по всему тексту документа, одинаковым образом.
Одной рукой вы просто выделяете слова с помощью мыши, а другой нажимаете
клавишу F4.

Теперь ваш документ должен выглядеть так, как показано на рис. 8.8.

Уважаемая г-жа Цвегкова

Мы рады сообщить Вак, что по итогам опроса «Лучшая детская книгам,
проведенного нашим магазином, лучшей была признана книга «Русские народные
сказки». Все читатели, которые подали свои голоса за эту книгу, награждаются ценнымн
пртпами от нашего магазина Вы может: зайти к нагл в удобное для Вас время и получить
свой приз

Кроме того, предъявив STO письма, вы можете приобрести в нашем магазине любое
количество иканий cdO% скидкой т

Ниже перечислены некоторые издания, на которые мы особенно хотели бы
обратить Ваше внимание Надеемся, что Вам понравятся зти книги

• Сказки народов мира
• Английский для детей (книга и аудиокассета)
• Спокойной ночи. С6орннкдетскихпесенсрк(кннган аудиокассета)

В этом месяце мы проводин выставку-продажу книг по искусству «Красота и мири
Журнал (.Искусство» посвятил этому событию такие строки

J

В эпоху технологического и инфариационнсго 6j»*a оесбенна приятна

~<ti L, M;l <

Рис. 8.8. Мы повторили операцию подчеркивания с помощью клавиши F4

Упражнение 8.6. Копирование формата

Копируя формат, вы сохраняете в памяти компьютера параметры форматирова-
ния выделенного фрагмента (символа или абзаца). Если вам нужно оформить оди-
наково всего несколько фрагментов и не хочется создавать для этого новый стиль,
можно обойтись копированием формата.

1. Щелкните в конце третьего абзаца текста письма.

2. Нажмите клавишу Enter.

3. Введите текст Список новых детских книг.

4. Выделите строку целиком и примените к ней полужирное и курсивное начер-
тания.

5. Нажмите клавиши Shift+Fl или выберите команду Формат > Показать формати-
рование. На экране появится информация о формате текущего фрагмента.
Щелкните на строке Отступ (Indent).

6. В окне диалога Абзац (Paragraph) щелкните на вкладке Отступы и интервалы
(Indents and Spacing) и выберите интервал перед абзацем равным 12 пунктам.
Щелкните на кнопке ОК.

7. Щелкните в абзаце с введенным текстом,
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8. Нажмите клавиши Ctrl+Shift+C.

9. Щелкните после слова строкл в конце четвертого абзаца текста письма. На-
жмите клавишу Enter.

10. Введите слово Цитата.

11. Щелкните в абзаце, в котором находится слово Цитата.

12. Нажмите клавиши Ctrl+Shift+V. Формат абзаца со словом Цитата станет тем
же, что и формат абзаца со словами Список новых детских книг (рис. 8.9).
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Рис. 8.9. Формат второго подзаголовка был скопирован

Word применяет к выделенному абзацу скопированные параметры формати-
рования.

13. Закройте документ, сохранив изменения.

Для копирования формата можно использовать кнопку Формат по образцу (Format
Painter) на панели форматирования. После щелчка на этой кнопке указатель мыши
примет вид маленькой кисточки. Теперь вы можете «раскрасить» другой фраг-
мент документа форматом фрагмента, в котором находился текстовый курсор на
момент щелчка на кнопке. Для этого нужно щелкнуть на нужном фрагменте ука-
зателем в виде кисточки. При этом символьный стиль применяется к целому
слову, а абзацный — к абзацу. Чтобы назначить символьный стиль только несколь-
ким символам в слове или нескольким словам, просто выделите требуемый фраг-
мент указателем в виде кисточки. Если щелкнуть на кнопке Формат по образцу
(Format Painter) дважды, то она останется нажатой, и вы сможете применять ско-
пированный формат поочередно к нескольким фрагментам (заголовкам, основ-
ному тексту, сноскам, колонтитулам и т. д.). В этом случае двойной щелчок на
кнопке эквивалентен нажатию клавиш Ctrl+Shift+C.
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Я советую вам при копировании формата больше полагаться на сочетания кла-
виш, а не на мышь. Конечно, любую неудачную операцию можно отменить, но
работа с клавишами дает большую уверенность, поскольку вы сначала выделяете
нужный фрагмент и только затем применяете к нему скопированный формат. Та-
кие операции лучше выполнять по очереди, чтобы потом не пришлось отменять
неудачное действие.

Упражнение 8.7. Поиск и замена формата

А что делать, если вам нужно поменять форматирование всего документа? На-
пример, вы хотите заменить весь шрифт размером 10 пунктов на шрифт размером
12 пунктов, уже не обращая внимания на такие тонкости, как соответствие сти-
лей. Шрифты с таким размером могут быть разбросаны по всему документу, мо-
гут содержаться в самых разных стилях и в самых разных элементах документа.
Как быстро выполнить такую замену?

1. Откройте последний документ, с которым вы работали.

2. Выберите команду Правка > Заменить (Edit > Replace).

3. В открывшемся окне диалога щелкните на кнопке Больше (More). На экране
появится скрытая часть окна диалога с дополнительными элементами управ-
ления поиском и заменой (рис. 8.10).
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Рис. 8.10. С помощью этого окна диалога можно выполнять поиск и замену форматов

Щелчок на этой кнопке удаляет
данные о формате из полей
с образцами поиска и замены

4. Щелкните на кнопке Формат (Format) и выберите команду Шрифт (Font).

5. В появившемся окне диалога выберите значение высоты шрифта 10 пунктов.
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6. Щелкните на кнопке ОК.

7. Щелкните в поле Заменить на (Replace with).

8. Щелкните на кнопке Формат (Format). Выберите команду Шрифт (Font).

9. В появившемся окне диалога выберите значение высоты шрифта 12 пунктов.

10. Щелкните на кнопке ОК.

11. Щелкните на кнопке Заменить все (Replace all). Word заменит весь шрифт ука-
занной высоты шрифтом с высотой 12 пунктов.

Этот прием очень удобен, если в документе, с которым вы работаете, много вари-
антов форматирования, разбросанных по всему тексту. Путем поиска и замены
форматов вы сможете добиться единства оформления во всем документе. На прак-
тике чаще всего к этому приему приходится прибегать при обработке докумен-
тов, полученных от других пользователей.

С помощью области задач Стили и форматирование (Styles and Formatting) вы
можете выделять несмежные фрагменты текста, оформленного одинаковым
образом, и форматировать их одновременно, а также выполнять с ними многие
другие операции.

Защита форматов в документе

Форматирование вашего документа завершено. В Word 2003 можно защитить па-
раметры форматирования, если вы не хотите, чтобы кто-нибудь случайно их из-
менил.

Упражнение 8.8. Защита форматов в документе

Область задач Защита документа (Protect Document) позволяет ограничить возмож-
ности других пользователей, которые будут работать с вашим документом. Очень
часто при работе над документами, создаваемыми разными пользователями, бы-
вает сложно сохранить единый вариант форматирования одинаковых фрагмен-
тов, что может значительно увеличить затраты на оформление конечной версии
документа. Сейчас мы познакомимся с этой новой полезной возможностью Word.

1. Сохраните документ под именем Стили-защита^ос.

2. Нажмите клавиши Ctrl+Fi, чтобы вывести на экран область задач.

3. Щелкните на заголовке области задач и выберите строку Защита документа
(Protect Document).

4. Установите флажок Ограничить форматирование набором стилей (Limit formatting
to a selection of styles).

5. Щелкните на строке Параметры (Settings). На экране появится список стилей,
которые можно использовать при форматировании документа (рис. 8.11).

Теперь, устанавливая или снимая флажки, можно ограничивать доступные
варианты форматирования документа.
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Рис. 8.1 1. Ограничение возможностей форматирования в документе

6. Щелкните на кнопке Нет (None), а затем установите флажок для стиля Адрес.
Щелкните на кнопке ОК.

1. В появившемся окне диалога с вопросом об удалении стилей, которые не ука-
заны в списке, щелкните на кнопке Да (Yes). Вы увидите, что все фрагменты
документа, кроме того, к которому применялся стиль Адрес, оказались оформ-
ленными стилем Обычный (Normal), то есть их параметры форматирования вер-
нулись к значениям по умолчанию.

8. Щелкните на строке Да, применить ограничения (Yes, Start Enforcing Protection).
На экране появится окно, в котором можно ввести пароль для защиты сделан-
ных изменений.

После ввода пароля пользователи не смогут применять никаких форматов, кроме
указанных стилей. Возможности форматирования будут блокированы, а соответ-
ствующие кнопки, списки и пункты меню — недоступны.

Контрольное занятие

Теперь, зная о маленьких хитростях форматирования, с которыми вы познакоми-
лись на этом занятии, потренируемся в их применении. Мы будем работать со
служебной запиской, созданой на одном из предыдущих занятий.

1. Откройте файл Записка. doc.

2. Выделите слова Служебная записка.

8.1 . Как называется шаблон, который по умолчанию присоединяется к каждому новому
документу?

S Зак. 481
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3. Откройте область задач Стили и форматирование (Styles and Formatting). Взгля-
ните на описание стиля заголовка в разделе Форматирование текущего фраг-
мента (Formatting of selected text).

8.2. Какие возможности для просмотра параметров форматирования стиля предостав-
ляет область задач Показать форматирование (Reveal Formatting)?

4. Щелкните на кнопке Создать стиль (New Style).

5. Введите название нового стиля Записка_заголовок.

8.3. На какой кнопке нужно щелкнуть в окне диалога Создание стиля (New Style), чтобы
изменить те параметры форматирования стиля, которые невозможно изменить с по-
мощью имеющихся в этом окне кнопок?

6. Измените шрифт стиля на Tahoma размером 14 пунктов, полужирный, все про-
писные.

7. Щелкните на кнопке ОК в окне диалога Создание стиля (New Style), чтобы со-
хранить изменения в стиле.

8.4. Что нужно сделать, чтобы стиль, созданный в текущем документе, был доступен в
других документах Word?

8. Щелкните на названии стиля в области задач, чтобы применить новый стиль
к выделенному абзацу.

9. Выделите слово сотрудников.

10. Примените к этому слову подчеркивание.

11. Щелкните на слове контракту.

12. Повторите последнюю операцию форматирования.

8.5. Какая клавиша используется для повторения последней операции?

13. Выделите слово сотрудников.

14. Скопируйте его формат.

8.6. Какое сочетание клавиш используется для копирования формата?

15. Примените скопированный формат к словам 16 июня.

16. Откройте область задач Стили и форматирование (Styles and Formatting).

17. Выделите все вхождения варианта форматирования Подчеркивание (Underline).

18. Откройте окно диалога Шрифт (Font). Задайте параметры шрифта для замены:
в списке Начертание (Font style) выберите пункт Курсив (Italic), в списке Под-
черкивание (Underline style) — пункт (нет) ((попе)).

19. Щелкните на кнопке ОК. Весь подчеркнутый текст в документе будет заменен
курсивным.

20. Закройте документ, сохранив изменения.
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Возможные проблемы

Проблема Решение

Я изменил параметры
форматирования стиля в окне
диалога Изменение стиля
(Modify Style), по в документе
эти изменения не отразились

Мой коллега подготовил документ
с разметкой, но задал неправильные
стили. Мне придется заново
размечать весь документ?

Я нажимаю клавишу F4, чтобы '
повторить копирование формата,
но вместо этого в документе
появляются какие-то другие
символы

Я скопировал формат слова
с помощью клавиш Ctrl+Shift+C
и попытался применить его к слову
в другом абзаце, но изменился
не только формат слона,
но и формат всего абзаца, что мне
совершенно не нужно

Чтобы при изменении стиля он сразу применялся
к документу, установите флажок Обновлять
автоматически (Automatically update) в окне
диалога Изменение стиля

Если ваш коллега задал неправильные стили,
по назначил их правильно, заново размечать весь
документ не нужно. Используйте кнопку
Выделить все (Select Al l ) и области задач Стили
и форматирование (Styles and Formatting) и затем
примените к выделенным фрагментам новый
стиль. Вы также можете использовать механизм
поиска и замены формата. Поочередно замените
все неправильные стили правильными

Возможно, после операции форматирования вы
«вели какой-то текст в документ, а только потом
нажали клавишу F4. Эта клавиша повторяет любое
последнее действие, а не только копирование
формата. Поэтому се удобно использовать
при последовательном форматировании
нескольких фрагментов

Чтобы при копировании, формата слона
не колировался формат абзаца, в котором
это слово находится, перед копированием слово
нужно выделить. Если просто установить курсор
внутрь слова, будет скопирован не только формат
слова, по и формат всего абзаца

Подведение итогов

На этом занятии мы познакомились со стилями Word и другими средствами бы-
строго форматирования. С помощью стилей удобно оформлять сложные много-
страничные документы, а также добиваться сходного оформления большого чис-

ла однотипных документов.

Копирование формата и команда повторения последней операции помогут при
создании небольших документов либо документов, оформление которых не бу-
дет повторяться в других файлах. Помните, для оформления отдельного доку-
мента умения копировать формат вам будет вполне достаточно, но для долгосроч-
ных задач надежнее использовать стили.

В следующей главе мы узнаем, как работать с графическими объектами Word.



Занятие 9

Графика

Тема занятия

На этом занятии мы попробуем поработать с графическими объектами. Вы на-
учитесь:

• добавлять в документ объекты библиотеки картинок;

• вставлять в документ текст WordArt;
• вставлять автофигуры;

• рисовать фигуры и линии;

• работать с объемными фигурами;

• выделять и перемещать объекты, а также изменять их размеры;

• форматировать графические объекты.

Подготовка к занятию
На этом занятии мы будем работать с новым документом, добавляя в него разного
рода графические объекты. По окончании выполнения контрольного занятия ваш
документ должен выглядеть так, как показано на рис. 9.1.

Вставка в документ графических объектов
Недаром говорят, что лучше один раз увидеть, чем сто раз услышать. И это в са-
мом деле так. Вы можете вставлять графические объекты прямо в текст докумен-
та Word. Эти объекты могут быть эффектными иллюстрациями, красивым фо-
ном, мелкими украшениями типа маркеров, рамок, линий. Вы можете вставить в
документ готовый объект, можете нарисовать его сами с помощью средств рисо-
вания Word. В любом случае не злоупотребляйте графикой. Хотя современные
графические форматы позволяют значительно сократить размеры графики, все
равно документы с большим числом вставленных объектов сильно увеличивают-
ся в размерах и с ними становится трудно работать. Как в любом деле, здесь важ-
но соблюдать меру.
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Начальнику отдела кадров НИИМЕХМАШ

Петрову Д.П

Прошу в срок до 16 июня предоставить сведения о числе сотрудников

института,работающих по KOHfrpaicniy.

Иванов М М.

Зам. директора института

Рис. 9.1. Документ, содержащий графические объекты

Библиотека картинок (Clip Art) содержит тысячи рисунков, фотографий, звуков
и видеоклипов. В ранних версиях Word под объектами библиотеки картинок по-
нимались только рисунки. Сейчас же в коллекцию Clip Art входят файлы муль-
тимедиа — графика, фотографии, звуки и видеоклипы. Они поставляются в ком-
плекте с программой Word, и их можно вставить в документ из соответствующей
коллекции. Более того, вы можете сами создавать свои коллекции картинок.

Объекты WordArt представляют собой текст, оформленный с применением
специальных эффектов. Их очень удобно использовать для создания красивых
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заголовков или крупных надписей. В объектах WordArt вы можете изменять фор-
му букв надписей, сжимать их, растягивать, добавлять тени, рамки и множество
других аффектов.

Сродства рисования Word позволяют нарисовать практически любой объект «с
нуля». Конечно, для создания бессмертного шедевра этих возможностей малова-
то, но для несложных изображений — вполне достаточно.

Упражнение 9,1. Вставка картинки

Вы можете вставлять картинки из библиотеки в документы Word с помощью ко-
манды Вставка > Рисунок > Картинки (Insert > Picture > Clip Art). Например, можно
вставить забавную картинку в текст объявления, чтобы оно выглядело привлека-
тельнее. Сейчас мы попробуем вставить рисунок библиотеки картинок в новый
документ.

1. Создайте новый документ.

2. Выберите команду Вставка > Рисунок * Картинки (Insert > Picture > Clip Art).

На экране появится область задач Вставка картинки (Clip Art), показанная на
рис. 9.2.

Search For:

Поиск клипа
по ключевым словам

Просмотр коллекций -

Щелкните на названии
коллекции,чтобы просмотреть

клипы, которые к ней относятся

Search п:

I All collections Список коллекций

My Collections

Favorites

Unclassified Clips

Office Collections

Web Collections

Поиск клипа -
в Интернете

Справка

Рис. 9.2. Выбор картинки

Для вывода на экран области задач Вставка картинки {Clip Art) ее можно выб-
рать в списке областей задач, щелкнув на заголовке области задач.
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Выбрав команду Организовать картинки (Organize clips) в области задач Встав-
ка картинки (Clip Art), вы сможете просмотреть диски вашего компьютера и орга-
низовать найденные системой файлы мультимедиа в так называемые коллек-
ции картинок.

По умолчанию Word показывает картинки, сгруппированные по коллекциям
и категориям («мини-коллекциям»). Щелкнув на названии категории, вы мо-
жете просмотреть рисунки, которые относятся к этой категории.

Если при установке программы Word вы не установили инструменты для ра-
боты с библиотекой картинок, при выборе команды Вставка (г Рисунок > Картин-
ки (Insert > Picture > C l i p Art) Word предложит их установить.

На рынке можно приобрести компакт-диски с библиотеками профессиональных
фотографических и рисованных изображений. Довольно часто эти библиотеки
организованы по темам, например «Природа», «Хозяйство», «Семья», «Транс-
порт» и т. д. Если вы хотите, чтобы ваш документ выглядел действительно про-
фессионально, воспользуйтесь одной из таких коллекций.

3. В древовидной структуре Поиск (Search In) щелчком раскройте ветвь Коллекции
Office (Office Collections) и щелкните на названии категории Здания (Buildings),

4. Введите слово buildings в поле Поиск (Search for) и щелкните на кнопке Поиск
(Go). Word выведет на экран изображения клипов, подходящих под запрос по
ключевым словам.

5. Щелкните на первом изображении коттеджа на берегу озера. Word вставит
изображение в документ.

| ПРИМСЧШИЕ̂

Если поместить указатель мыши на изображение, на экране появляется под-
J— сказка с его названием, размером, типом графического файла и списком клю-

чевых слов.

Если щелкнуть па рисунке один раз, он будет выделен, и вы сможете выпол-
нять с ним нужные операции. Когда рисунок выделен, вокруг него видны во-
семь черных маркеров (рис. 9.3). Они служат для изменения размеров встав-
ленного объекта.

6. Закройте окно коллекции картинок.

Если графический объект привязан к тексту абзаца, то он будет окружен черны-
ми маркерами и тонкой рамкой. Такой объект может располагаться только внут-
ри текста. Объект, для которого задан режим «обтекания» текстом или который
располагается позади или перед текстом, окружается белыми маркерами без
рамки. В последнем случае графический объект можно перемещать в пределах
страницы.

7. Щелкните в любом месте документа, чтобы снять выделение с рисунка.

8. Нажмите клавишу Enter два раза.

Чтобы удалить графический объект из документа, просто выделите его и нажмите
клавишу Delete.
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Если ввести сюда ключевое слово,
и щелкнуть на кнопке поиска,

можно найти группу клипов с заданными свойствами

Панель настройки изображения
для работы с выделенным объектом

Рис. 9.3. Выделенный рисунок окружен черными маркерами

Упражнение 9.2. Добавление объекта WordArt

Средствами WordArt можно быстро создать красивый заголовок для документа.
Если вам не жалко времени и денег, то можете приобрести настольную издатель-
скую систему и убедиться, что созданные вами с ее помощью заголовки будут не
намного отличаться от предлагаемых Word. В этом упражнении мы создадим эм-
блему для книжного магазина.

1. Нажмите клавиши Ctrl+End, чтобы переместиться в конец документа.

2. Выберите команду Вставка > Рисунок > Объект WordArt (Insert > Picture > WordArt).
Вы увидите окно диалога с доступными вариантами оформления надписей
WordArt (рис. 9.4).

3. Выберите третий образец в четвертом ряду. Щелкните на нем, затем — на кноп-
ке ОК.

На экране появится окно диалога Изменение текста WordArt (Edit WordArt Text).
Введите слово КНИГИ в текстовое поле этого окна. В этом окне диалога вы мо-
жете задать шрифт, размер и начертание для текста надписи.

4. Щелкните на кнопке ОК.

Word вставит надпись в текст документа (рис. 9.5). Как и любой графический
объект, надпись WordArt можно выделять, изменять ее размеры и удалять.
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Рядом со вставленной надписью появляется панель инструментов WordArt
(рис. 9.6). Она содержит инструменты форматирования объектов WordArt.

Рис. 9.4. Окно диалога WordArt позволяет выбрать вариант
оформления надписи

Боковые маркеры
служат для

непропорционального
изменения размеров

объекта I

Угловые маркеры служат
для пропорционального
изменения размеров объекта

Рис. 9.5. В документ вставлен объект WordArt
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Вставка новой надписи
Редактирование текста
Изменение стиля текущей надписи
Формат объекта WordArt
Форма контура текущей надписи

Обтекании текстом-
Выравнивание высоты букв

Вертикальный/горизонтальный текст-
Выравнивание текста внутри надписи

Межсимвольный интервал-

Рис. 9.6. Панель инструментов WordArt

5. Щелкните в любом месте документа, чтобы снять выделение надписи.

6. Сохраните файл под именем А-t.doc и закройте документ.

Упражнение 9.3. Вставка автофигур

Разных фигур существует не так много. Даже сложные рисунки состоят из набо-
ров более простых фигур. Word предоставляет средства для рисования подобных
изображений. Вставив в документ полдесятка разных геометрических фигур, вы
сможете нарисовать, например, вполне приличный домик, который сделает честь
любой выставке детского творчества. Давайте посмотрим, как работать с этим
инструментом Word.

1. Создайте новый документ.

2. Щелкните правой кнопкой мыши на любой панели инструментов и выберите
в контекстном меню команду Рисование (Drawing).

На экране появится панель инструментов Рисование (Drawing), показанная на
рис. 9.7.

3. Щелкните на кнопке Автофигуры (Autoshapes).

Вы увидите меню (рис. 9.8), содержащее названия разных фигур, например,
Стрелки (Block Arrows), Выноски (Callouts), Блок-схема (Flowchart) и т. д.

:~X^>i
/ЛЯ Меню вставки автофигур содержит дополнительную команду для вставки авто-

.. -»х_ фигур из коллекции картинок. При вставке можно проводить поиск нужных фи-
гур по категориям, ключевым словам и формату файлов.

4. Выберите команду Звезды и ленты (Stars and Banners). На экране появится не-
большая панель с кнопками, соответствующими разным фигурам.

5. Щелкните на первой кнопке в четвертом ряду.

На экране появится надпись Создайте рисунок (Create your drawing here). Указа-
тель мыши превратится в небольшой крестик. Перетаскивая указатель, задай-
те размеры и положение новой фигуры. В документ будет вставлено изобра-
жение, напоминающее по форме вертикальный свиток (рис, 9.9).
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Меню команд для действий
над выделенными фигурами
Переключение в режим выделения объектов
Вставка автофигуры
Рисование линии
Рисование стрелки
Рисование прямоугольника (квадрата)
Рисование овала (круга)
Вставка рамки с текстом (надписи)
Вставка объекта WordArt
Вставка диаграммы

Вставка картинки из библиотеки картинок
Вставка рисунка

Заливка выделенных фигур цветом
Изменение цвета выделенных линий

Изменение цвета выделенного текста
Изменение толщины и типа линий

Изменение типа штриха
Изменение типа стрелки

Тень
Объем

Рис. 9.7. Панель инструментов рисования

Если перетащить заголовок
этого подменю, оно останется

на экране как
самостоятельная панель

я*1 Е* «в» ir»a-t tgna 'MB ijbt a

е

Панель
инструментов
рисования

т

Меню вставки автофигур

Эта команда позволяет вставлять
дополнительные автофигуры
из коллекции библиотеки картинок

Рис. 9.8. Вставка автофигуры в документ Word
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Рис. 9.9. Рисование фигуры на «полотне»

• По умолчанию при рисовании любых фигур с помощью мыши положение их гра-
ницы задается «от угла до угла». Если во время рисования удерживать нажатой
клавишу Ctrl, то положение фигуры будет задаваться относительно центра. Если
во время рисования фигуры удерживать нажатой клавишу Shift, она будет впи-
сана в невидимый квадрат, а не в прямоугольник.

Вокруг появившегося изображения вы увидите несколько белых круглых мар-
керов, которые позволяют изменять общие размеры фигуры. Кроме белых круг-
лых маркеров на экране присутствует желтый квадратный маркер. Если пере-
таскивать его мышью, вы увидите, как будут изменяться взаимные пропорции
вставленной фигуры. Вы можете увеличить центральную область свитка, а мо-
жете, наоборот, увеличить размер скрученных областей. Для более сложных
фигур таких желтых маркеров может быть несколько. Зеленый круглый маркер
служит для вращения рисунка. Обычно размеры любого рисунка, вставленного
в документ, приходится изменять, поскольку часто такие рисунки используют-
ся для размещения надписей.

6. Снова щелкните на кнопке Аеггофигуры (Autoshapes) и выберите команду Фи-
гурные стрелки (Block Arrrows).

7. Щелкните на третьей стрелке в последнем (седьмом) ряду. Перетаскивая
мышь, задайте размеры и положение объекта.

8. Поместите указатель мыши на второй вставленный объект и перетащите его
поверх первой фигуры.

9. Щелкните правой кнопкой мыши на этой фигуре и в контекстном меню выбе-
рите команду Order > Send to EJack, как показано на рис. 9.10. Word поменяет
фигуры местами, и второй фигуры больше не будет видно.
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Маркеры изменения
пропорций объекта

Команда размещения объекта
впереди всех остальных

Маркеры
изменения

размера объекта

Команда размещения-
объекта перед текстом

Команда размещения
объекта позади всех
остальных

Команда перемещения
объекта на один
слой вперед

1—Команда перемещения
объекта на один слой назад

— Команда размещения
объекта за текстом

Рис. 9.10. Изменение взаимного расположения графических объектов и текста

Перемешая объекты с переднего плана на задний и наоборот, вы можете органи-
зовывать их в группы и размещать на странице так, как вам угодно. При размеще-
нии нескольких фигур в разных слоях, можно пользоваться командами Перемес-
тить вперед (Bring Forward) и Переместить назад (Sent Backward). Помните, что любое,
даже самое сложное, изображение можно создать из множества простых фигур,
объединяя их нужным образом.

Упражнение 9.4. Рисование фигур и линий

Несмотря на то, что в библиотеках картинок содержится огромное количество
изображений, когда-нибудь вам может потребоваться нарисовать собственный
рисунок. Конечно, вовсе не обязательно заканчивать художественную школу, что-
бы начинать рисование средствами Word, для этого хватит и курса средней шко-
лы. Однако помните, что вы сможете нарисовать только то, что придумаете сами,
поэтому старайтесь развивать свое воображение и не сдерживать возможные твор-
ческие порывы.

1. Нажмите клавиши Ctrl+End, чтобы переместиться в конец документа.

2. Нажмите клавиши Ctrt+Enter, чтобы создать новую страницу. Прокрутите ее,
чтобы на экране было больше места для рисования.
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3. Щелкните на кнопке Прямоугольник (Rectangle) на панели инструментов Рисо-
вание (Drawing).

Указатель мыши превратится в небольшой крестик. Перетаскивая указатель,
задайте размеры и положение новой фигуры.

4. Нажмите кнопку мыши в верхнем левом углу страницы и перетащите указа-
тель мыши вниз и вправо. Вы у зидите, как на экране появится контур будуще-
го прямоугольника. Когда его размеры вас удовлетворят, отпустите кнопку
мыши. Прямоугольник будет вставлен в документ.

Чтобы нарисовать квадрат, во время рисования удерживайте нажатой клавишу
Shift.

5. Щелкните на кнопке Линия (Line). Указатель мыши также превратится в не-
большой крестик.

6. Нажмите кнопку мыши, наведя указатель примерно на два сантиметра выше
нарисованного прямоугольника. Здесь будет находиться начало новой линии.
Если вверху «полотна» вам не хватает места, предварительно щелкните на
кнопке Увеличить рисунок (Expand) на панели инструментов Полотно (Drawing
canvas).

Чтобы вывести на экран панель инструментов Полотно (Drawing canvas), щелк-
ните правой кнопкой мыши на области для рисования и выберите одноименную
команду в контекстном меню.

7. Перетащите указатель мыши в низ и вправо примерно на один сантиметр ниже
и правее верхнего правого угла прямоугольника. Отпустите кнопку мыши.
В документе появится новая линия. Указатель мыши примет свой обычный
вид. Это значит, что в данный момент больше ничего нарисовать нельзя.

8. Дважды щелкните на кнопке Л и н и я (Line). Теперь вы можете нарисовать сразу
несколько линий подряд, и указатель мыши не будет переключаться обратно
в обычный режим.

9. Нарисуйте вторую линию зеркально первой, чтобы они вместе образовали
«крышу» домика.

10. Нарисуйте еще одну линию под прямоугольником, параллельно его нижней
границе.

IFHMTWMf /-*/Л
I - ̂

/-*̂Л/1- Чтобы провести линию под углами, кратными 15 , во время рисования удержи-
вайте нажатой клавишу Shift.

11. Щелкните на кнопке Прямоугольник (Rectangle) и нарисуйте квадрат внутри
прямоугольника.

12. Щелкните правой кнопкой мыши и в контекстном меню выберите команду
Добавить текст (Add Text), как показано на рис. 9.11. Внутри фигуры появится
небольшой курсор.
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Рис. 9.11. Добавление текста в автофигуру
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Рис. 9.12. Рисунок состоит из фигур, линий и текста

13. Введите слова Мой домик. Эта надпись окажется внутри квадрата.

14. Выделите текст и примените к нему полужирное и курсивное начертания, за-
тем измените размер шрифта на 24 пункта.
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15, Щелкните в любом месте документа, чтобы снять выделение текста.

16. Сохраните документ под именем Рисование.doc.

Описанный прием часто используется для создания надписей на рисунках и вы-
носках. Вместо того чтобы вставлять специальную текстовую надпись и затем пы-
таться создать вокруг нее красивое оформление, лучше сначала вставить понра-
вившуюся вам фигуру (звезду, ленту или стрелку), а затем добавить в нее текст.
Работать с фигурами удобнее, так как они предоставляют больше возможностей
для форматирования. Теперь наш домик должен выглядеть примерно так, как
показано на рис. 9.12.

Упражнение 9.5. Создание трехмерных фигур

В Word можно рисовать фигуры с эффектом объема. Существует несколько гото-
вых стилей объемных фигур. Вы можете создать сначала плоскую фигуру и уже
затем сделать ее объемной. Давайте попробуем сделать объемным наш домик.

1. Щелкните на прямоугольнике, чтобы выделить его.

2. Щелкните на кнопке Объем (Volume). На экране появится небольшая панель с
кнопками, соответствующими разным вариантам объемных фигур.

3. Выберите первую фигуру в первом ряду. Выделенный прямоугольник превра-
тится в объемный объект.

4. Аналогичным образом сделайте объемными линии, изображающие крышу до-
мика.

5. Щелкните на изображении одного ската крыши.

6. Удерживая нажатой клавишу Shift, щелкните на втором скате крыши и затем
на самом домике. Все три объекта будут выделены.

7. Снова щелкните на кнопке Объем (Volume) и выберите команду Настройка объе-
ма (3-D Settings).

На экране появится одноименная панель инструментов, показанная на
рис. 9.13. На этой панели есть кнопки которые позволяют вращать выделен-
ный объект, изменять глубину, менять угол освещения объекта, изменять
его цвет.

8. Щелкните на кнопке Глубина (Depth).

—Добавление/удаление эффекта объема
Вращение объекта

Глубина —'
Направление —

Освещение —
Поверхность —

Цвет —

Рис. 9.13. Панель инструментов настройки объема
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9. Выберите значение 144 пункта.

10. Выделите оставшуюся линию под домиком.

11. Щелкните на кнопке Глубина (Depth) и в поле Глубина (Custom) введите значе-
ние 200 пунктов.

12. Щелкните правой кнопкой мыши на этой фигуре и выберите в появившемся
меню команду Порядок * На задний план (Order t Send to Back).

13. Щелкните на кнопке закрытия панели Настройка объема (3-D Settings).

Теперь ваш домик должен выглядеть так, как показано на рис. 9.14.

Рис. 9.14. Недостроенный домик

Работа с графическими объектами

После добавления в документ графического объекта он может потребовать не-
которых изменений. Скорее всего, рисунок получится не того размера, неудачно-
го цвета, неподходящей формы и к тому же окажется в неудобном месте. Чтобы
изменить все эти параметры, сначала нужно выделить объект, а затем применить
к нему нужные действия. В следующих упражнениях мы попробуем «достроить*
наш домик.

Упражнение 9.6. Выделение объектов

Прежде чем изменять объект, его нужно выделить. Вы можете выделить сразу не-
сколько объектов, чтобы одновременно применить к ним одну и ту же операцию.
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1. Щелкните на границе прямоугольника. Вокруг него появятся маркеры.

2. Щелкните в любом месте за пределами прямоугольника, чтобы снять выделе-
ние.

3. Щелкните на квадрате с надписью. Вокруг квадрата также появятся маркеры.

4. Теперь нажмите и удерживайте клавишу Shift. Щелкните на прямоугольнике.

Маркеры появятся как вокруг прямоугольника, так и вокруг квадрата. Вы мо-
жете одновременно удалить оба этих объекта, закрасить их одним и тем же
цветом, переместить в другое место или даже в другой документ.

5. Щелкните в любом месте документа, чтобы снять выделение.

6. Сохраните изменения и закройте документ.

Упражнение 9.7. Перемещение объектов

Вы можете перемещать графические объекты в любое место документа. Сначала
нужно выделить объект, а затем перетащить его в другое место с помощью мыши.
Хотя этот прием довольно практичен, для точных перемещений лучше явно зада-
вать положение рисунка на странице.

1. Откройте документ Art.doc.

2. Выделите эмблему книжного магазина, которую вы создали средствами Word-
Art.

3. Щелкните на надписи правой кнопкой мыши и выберите в контекстном меню
команду Формат объекта WordAr (Format WordArt). На экране появится одноимен-
ное окно диалога.

Такие окна позволяют выполнять форматирование всех графических объек-
тов, вставляемых в документ. Количество и названия вкладок, доступных в
этих окнах, а также элементы управления для разных объектов могут быть
разными. Однако на вкладке Положение (Layout) можно задавать точные коор-
динаты практически для всех типов объектов.

4. Щелкните на вкладке Положение (Layout) в окне диалога Формат объекта Word-
Art (Format WordArt).

На этой вкладке можно задать вид обтекания графического объекта текстом и
вид выравнивания (рис. 9.15). Дополнительные параметры форматирования
объектов спрятаны немного дальше.

5. Щелкните на образце Вокруг рамки (Square).

6. Щелкните на кнопке Дополнительно (Advanced).

7. Щелкните на вкладке Положение рисунка (Picture Position) открывшегося окна
диалога Дополнительная разметка (Advanced Layout), как показано на рис. 9,16.

8. Введите расстояние объекта от края страницы в текстовое поле. Щелкните на
кнопке ОК в обоих окнах диалога, чтобы изменения вступили в силу.

Выделенный объект займет новое положение.
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Объект перемещается
вместе с текстом

Объект располагается
за текстом

Текст Объект располагается
окружает объект перед текстом

Рис. 9.15. В этом окне диалога можно изменять положение графического объекта

Горизонтальное
выравнивание

Наложение
объектов

Выравнивание
объекта

Выравнивание для симметричных
страниц (книга)

Точное положение
объекта на странице

Вертикальное
выравнивание

Перемещение объекта
вместе с текстом абзаца,

в который он вставлен

Фиксация привязки объекта (при перемещении объекта
его координаты будут вычисляться
относительно этой фиксированной точки)

Рис. 9.16. Указание точного положения объекта относительно страницы
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Упражнение 9.8. Изменение размера объектов

Теперь мы изменим размеры вставленного рисунка.

1. Выделите рисунок с коттеджем, который мы вставили в документ ранее.

2. Поместите указатель мыши на верхний правый угловой маркер выделения,
Указатель мыши при этом должен принять вид двунаправленной стрелки.

3. Нажмите левую кнопку мыши и, удерживая нажатой клавишу Ctrl, перетащите
маркер влево и вниз (рис. 9.17). Вы увидите, как контур рисунка начнет умень-
шаться. Немного сжав рисунок, отпустите кнопку мыши.

Если во время изменения размеров рисунка удерживать нажатой клавишу Ctrl,
то изменение будет выполняться относительно центра рисунка. При нажатой
клавише Shift сохраняются пропорции объекта.

Рис. 9.17. Уменьшение размера рисунка

| принейннЕу̂ ,
Размеры всех графических объектов при перемещении угловых маркеров из-
меняются сразу в двух направлениях с сохранением пропорций, а при перетас-
кивании боковых — в одном.

4. Поместите указатель мыши на правый боковой маркер и перетащите его впра-
во. Рисунок будет растянут в горизонтальном направлении.

Так же как и координаты, размеры объекта можно задать вручную; этот спо-
соб более точный и последовательный. Представьте, что в вашем документе
30 однотипных графических объектов, и все они должны быть аккуратно вы-
ровнены. Здесь не обойтись без ручного указания размеров и координат
объекта.
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5. Щелкните на выделенном рисунке правой кнопкой мыши и выберите в кон-
текстном меню команду Формат рисунка (Format Picture).

6. Щелкните на вкладке Размер (Size) открывшегося окна диалога и укажите нуж-
ный размер рисунка (рис. 9.18).

Масштабирование
рисунка в процентах Высота рисунка Ширина рисунка

Сохранение пропорций-
Новые размеры задаются-

относительно исходного
размера
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ĵ . -V^Eh; J6,8c

_iJ
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Рис. Э.18. Изменение размера рисунка вручную

7. Щелкните на кнопке ОК, чтобы изменения вступили в силу,

8. Сохраните изменения и закройте файл.

При изменении размеров обьекта я советую вам задавать их в процентах от ис-
ходного размера. Для возвращения к исходным размерам рисунка пользуйтесь
кнопкой Сброс (Reset).

Кроме координат и размеров объекта важно задать его выравнивание относитель-
но страницы. Вы можете выровнять объект по правому краю, по левому краю и по
центру. Параметры выравнивания доступны также в окне диалога для формати-
рования объекта.

Форматирование графических объектов

Итак, мы научились размещать объекты нужного размера в нужном месте. Те-
перь осталось добиться, чтобы наши объекты действительно выглядели так, как
нам бы хотелось. Обычно для этого приходится изменять формат объектов. Когда
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художник рисует на бумаге или холсте, он может стирать неудачные линии и до-
бавлять новые. Процесс рисования в Word в чем-то похож на работу такого ху-
д о ж н и к а .

Word позволяет изменять тип линий, которыми нарисован объект, то есть выби-
рать их толщину, вид и цвет. Кроме того, вы также можете изменять цвет, кото-
рым закрашены замкнутые объекты. Можно указывать определенные узоры или
даже заполнять их готовыми рисунками. В следующих упражнениях мы попро-
буем поэкспериментировать с этими возможностями.

Упражнение 9.9. Изменение стиля линий

Существуют разные стили линий, которые вы можете использовать для рисова-
ния объектов. Во-первых, линии могут быть одинарными, двойными, тройными,
штриховыми, пунктирными и т. д. Кроме того, они могут иметь разную толщину,
меняющуюся в диапазоне от одной четверти пункта до шести пунктов. Давайте
изменим толщину линий, которые расположены над прямоугольником.

1. Откройте файл Рисование.doc.

2. Щелкните на квадрате с надписью. Вокруг него должны появиться маркеры.

3. Щелкните на кнопке Тип л и н и и (Line Style), На экране появится список доступ-
ных типов линий (рис. 9.19).

-
Е* !$*» Insert Fa-m« Icoli " Tjft»e &irdow beta

; • • п.; - ™.. -
в a iSJ -i Ы. jj

Rage г Sec I

( :

Рис. 9.19. Форматирование выделенных линий

4, Выберите двойную тонкую линию толщиной 3 пункта.

5, Щелкните в любом месте документа, чтобы снять выделение.



Форматирование графических объектов 183

Для изменения типа линий вы можете использовать не только кнопки на панели
инструментов, но и окно диалога Формат автофигуры (Format Autoshape). В этом окне
можно за один прием изменить сразу несколько параметров форматирования,

ПЙМСЦИ f ^

S
Для форматирования графических объектов можно использовать механизм ко-
пирования формата, знакомый нам по предыдущему занятию. Вспомните соче-
тания клавиш Ctrl+Shift+C и Ctrl+Shift+V.

Упражнение 9.10. Задание узора, заливки и цвета

Чтобы ваш документ выглядел интересно и празднично, попробуйте «поиграть»
с цветами графических объектов, которые в него вставлены. Сейчас мы научимся
добавлять к графическим объектам узоры, заливку и цвет.

1. Щелкните на прямоугольнике, чтобы выделить его.

2. Щелкните на кнопке со стрелкой рядом с кнопкой Цвет заливки (Fill Color) на
панели инструментов Рисование (Drawing). На экране появится небольшая па-
литра цветов (рис. 9,20).

Доступные цвета

Команда для выбора
дополнительных
цветов

Варианты заливки

Рис. 9.20. Изменение цвета обьекта

3. Щелкните на ярко-зеленом цветовом образце.

Выделенный прямоугольник будет заполнен ровным зеленым цветом. Обра-
тите внимание на то, что эффект объема сохраняется.

4. Снова разверните палитру Цвет заливки ( F i l l Color) и щелкните на кнопке Спосо-
бы заливки (Fill Effects).
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В окне диалога Способы заливки (Fill Effects) можно выбирать заливку, узоры и
фоновый рисунок для выделенного объекта. Когда у вас будет время, поэкспе-
риментируйте с элементами управления этого окна. Помните, что любой двух-
мерный графический объект, включая элементы графиков, рисунки, фон доку-
мента, можно оформить с; их помощью.

5. Щелкните на вкладке Текстура (Texture).

6. Выберите текстуру Дуб (Oak) — это третья текстура в последнем ряду. Щелкни-
те на кнопке ОК. Выделенный прямоугольник будет закрашен «под дерево!-.

7. Сохраните документ и закройте файл.

Контрольное занятие

На этом занятии мы проверим приобретенные вами навыки. Мы нарисуем не-
большой рисунок и изменим его оформление.

1. Откройте файл Записка.doc и сохраните его под именем Записка с графикой.doc.

2. Перейдите в конец документа.

3. Вставьте еще один абзац,

4. Вставьте в документ изображение тигра из категории Животные (Animals) биб-
лиотеки картинок.

5. Перейдите в начало документа.

6. Добавьте три абзаца после слов Петрову П.П.

7. Удалите из документа текст заголовка (слова Служебная записка).

8. Вставьте в документ объект WordArt (пятый вариант во втором ряду).

9. Введите текст Служебная записка.

10. Переместите объект WordArt на место заголовка.

9.1. Как определить, что рисунок выделен?

11. Увеличьте его размер, удерживая нажатой клавишу Shift.

12. Перейдите в конец документа и создайте новую страницу.

13. Нарисуйте в документе квадрат, используя кнопку Прямоугольник (Rectangle)
и удерживая нажатой клавишу Shift.

9.2. Как нарисовать фигуру «относительно центра»?

14. Введите в фигуру текст Нельзя объять необъятное!.

15. Примените к тексту следующее форматирование: полужирное начертание,
размер 26 пунктов, красный цвет.

9.3. Как изменить цвет шрифта в автофигуре?
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16. Добавьте в документ автофигуру в виде восьмиконечной звезды.

17. Сделайте ее лучи острее с помощью желтого ромбовидного маркера.

18. С помощью вкладки Узор (Pattern) окна диалога Способы заливки (Fill Effects)
заполните звезду узором Шотландка (Plaid).

19. Измените цвет граничной линии звезды на ярко-зеленый.

9.4. Как изменить цвет линии в фигуре?

20. Сохраните изменения и закройте документ,

Возможные проблемы

Проблема Решение

Я вставил в документ рисунок, Выделите рисунок, щелкните на нем правой кнопкой
а затем ввел текст. Рисунок мыши, выберите в контекстном меню команду
начал перемещаться Формат рисунка (Format Picture), в открывшемся
вместе с текстом. Как оставить окне диалога щелкните на вкладке Положение
его на месте? (Layout) и щелчком выберите нужный вариант

обтекания рисунка текстом
Я хочу поместить текст Выделите надпись WordArt, щелкните на ней правой
Word Art позади кнопкой мыши, выберите в контекстном меню
основного текста команду Формат объекта WordArt (Format WordArt),

в открывшемся окне диалога щелкните на вкладке
Положение (Layout) и выберите вариант
Позади текста (Behind Text)

Я добавил текст в автофигуру, Выделите автофигуру, которую нужно заменить,
но потом понял, что лучше и выберите команду Действия » Изменить автофигуру
использовать другую фигуру. (Draw > Change Autoshape) на панели инструментов
Что делать? Рисование (Drawing). Затем выберите нужную

автофигуру для замены

Подведение итогов

На этом занятии мы начали знакомство с миром графических объектов. Они по-
могут сделать ваш документ действительно профессиональным. На следующем
занятии вы узнаете, как экономить время с помощью шаблонов и макросов.



Занятие 10

Экономия времени
с помощью шаблонов
и макросов

Тема занятия

На этом занятии мы научимся:

• создавать документ на основе шаблона;

• применять шаблон к готовом)' документу;

• создавать свой шаблон;

• записывать макросы;

• копировать макросы в другие документы.

Подготовка к занятию

На этом занятии мы поработаем с новыми документами, с помощью которых бу-
дем изучать приемы применения шаблонов и записи макросов. После окончания
занятия один из наших документов будет выглядеть так, как показано на рис. 10.1,
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ТИТУЛЬНЫЙ ЛИСТ ФАКСА

КОНУ- ОТ «ОГО-

Игорь Петров Василий Иванов

ООО «СТРОЙТРЕСТ» 2a.dS.9S)
«ИКС Ч1ЧЛОСТЧЛИНЦ.

(312) 554-12-98 5

(813)554-12-97 AN-12/4S-5

Договор подрианапроведение МКЖ-982/12
ремонтных работ

СРОКИ ЗАКЛЮЧЕНИЯ ДОГОВОРА:
Договор должен быть заключен до 24.07 99.

ОБСУЖДЕНИЕ УСЛОВИЙ:
Предварительная консульгацияс участием юристов обеих сторон иэмеченана 01. 07 .99.

ЧЕРНОВОЙ ВАРИАНТ ДОГОВОРА:
Экземпляр чернового варианта договора на 4 листах прилагается

Рис. 10.1. Этот документ создан на основе шаблона для титульных листов факсов

Шаблоны

Шаблоны Word позволяют применить готовые форматы к документу, содержа-
щему нужный текст. Кроме того, на основе шаблонов можно создавать новые до-
кументы и затем изменять по своему желанию, В шаблонах можно сохранять об-
разцы текста, стили, элементы автотекста, графические объекты, макросы, панели
инструментов и сочетания клавиш. Работая с шаблонами, вы можете добиться
логичной организации всех своих документов. Вы всегда будете уверены, что фор-
мат документов одного типа также будет одинаковым.

По умолчанию Word использует шаблон Обычный (Normal.dot), который содер-
жит стандартные параметры форматирования для всех новых документов. Одна-
ко при создании нового документа вы можете сами выбрать шаблон для него. Сре-
ди доступных групп шаблонов можно назвать шаблоны для отчетов, писем и
факсов, записок, веб-страниц и других документов. Если эти шаблоны недоступ-
ны в вашей копии Word, то вам придется установить их, повторив установку па-
кета Office. Возможно, что при первом обращении к этим шаблонам программа
сама предложит установить их с компакт-диска Office.
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Упражнение 10.1. Применение готового шаблона

Word содержит множество готовых шаблонов. Каждый шаблон соответствует до-
кументам определенного типа. Давайте попробуем создать факс на основе одного
из шаблонов Word.

1. Выберите команду Файл > Создать (File > New).

2. В области задач Создание документа (New Document) щелкните на значке Общие
шаблоны (On my computer).

3. В открывшемся окне диалога щелкните на вкладке Письма и факсы (Letters and
Faxes).

4. Дважды щелкните на значке Стандартный факс (Standard Fax), как показано на
рис. 10.2.

[ш Merge j Мгтю! j etherОвилйпй j-PUtattens-} R*pqrti |

Buane« Fa< Conterrcorary Contimoorary Elegant F
Fax leftи

Elegant Letter Envelope Fa, Wnard Utter Wizard
Wbard

Ma*ng Label Personal Fa* Proressraid Professiooal
'< Wl;ard fat Letter

Cancel
..„̂ ^̂ x,

.--..-.-.---.-- -.- -.- ----- .-.

Рис. 10.2. Выбор шаблона для нового документа

На экране появится новый документ. Вы увидите заголовок, оформленный
крупными буквами, небольшое текстовое поле для ввода названия фирмы и
другие поля. Теперь ваш начальник не сможет не обратить внимания на такой
красивый документ. Давайте наполним этот документ новым содержанием.

5. Щелкните в небольшом поле с надписью Организация.

6. Выделите имеющиеся там слова и введите название Магазин «Книги».

7. Теперь последовательно щелкайте в полях шапки факса, вводя указанный
ниже текст.

Кому: Андрей Быстрое

От: Ирина Строганова

Факс: (812) 432-11-19

Телефон: (812) 432-11-20

На: Новая техника

Копия: Александр Иванов
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8. Щелкните в верхнем левом углу титульной страницы факса, там, где вам пред-
лагают ввести обратный адрес. Введите следующий текст:

пр. Жемчужниковых, 12

191390, Санкт-Петербург

(812) 554-23-09

9. Щелкните правой кнопкой мыши на фамилии Быстров и в контекстном меню
выберите команду Пропустить все.

10. Теперь выделите весь текст в разделе Примечание и введите вместо него сле-
дующие слова:

К нам поступает новая техника, прошу проконтролировать ее справедливое рас-
пределение. Каждому — по потребностям!

После этого ваш документ должен выглядеть так, как показано на рис. 10.3.

Факсимильное
сообщение

Кому* Андрей Еыстрав

.1(812)̂ 33-11-20

At 9,4cm Ln 7 СИ И

A>n> 04.11 20H

К..и.: АпвстДрИ

Рис. 10.3. От вас требуется только ввести содержательную информацию —
все форматирование документа уже готово!

11. Сохраните изменения и закройте документ.

Упражнение 10.2. Создание и сохранение шаблона

Скорее всего, вам не всегда будет хватать готовых шаблонов Word и наверняка
придется изменять параметры документов по своему вкусу. Например, поля пе-
чати у вашего принтера могут не совпадать с полями, предлагаемыми Microsoft,
Кроме того, оформление документов в вашей организации может подчиняться
каким-то специфическим требованиям. Давайте попробуем создать собственный
шаблон для титульной страницы факса. Мы введем в него название организации,
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ее адрес и реквизиты, зададим нужные поля страницы и создадим набор стилей
для оформления текста этого документа.

1. Выберите команду Файл » Создать (File > New).

2. В области задач Создание документа (New Document) щелкните на значке Общие
шаблоны (On my computer).

: A^Ut

/Л/t Обратите внимание на то, что в области задач Создание документа (New Do-
cument) отображаются также имена последних использованных шаблонов.

3. В открывшемся окне диалога щелкните на вкладке Письма и факсы (Letters and
Faxes).

4. Щелкните на значке Изысканный факс (Elegant Fax).

5. В группе Создать (Create New) установите переключатель Шаблон (Template).
Щелкните на кнопке ОК.

Word создаст новый пользовательский шаблон на основе одного из своих
шаблонов. Мы внесем в него изменения и сохраним под другим именем.

6. Щелкните в верхнем поле страницы и введите название вашей компании и
данные о ней, например;

000 «Колокольчик»

пр, Большевиков, 29

190191, Санкт-Петербург

тел./факс (812) 186-49-48

7. Выделите слова ФАКСИМИЛЬНОЕ СООБЩЕНИЕ и введите вместо них слова Ти-
тульный лист факса.

8. Выделите слово На и введите слово Касается.

9. Выделите слова Телефон отправителя и введите слова Исходящий номер.

10. В том же поле щелкните правой кнопкой мыши на сообщении введите сюда
номер телефона и выберите команду Изменить поле (Edit Field) в появившемся
меню.

11. В текстовое поле Сообщение (Display Text) окна диалога Поле (Field) введите
текст введите сюда ваш исходящий номер, как показано на рис. 10.4.

12. Выделите слова Добавочный номер и введите слова В ответ на,

13. В том же поле щелкните правой кнопкой мыши на сообщении введите сюда
номер телефона и выберите команду Изменить поле (Edit Field) в появившемся
меню.

14. В текстовое поле Сообщение (Display Text) окна диалога Поле (Field) введите
текст введите сюда исходящий номер отправителя,

15. Целиком выделите строку с полями Срочно и другими, затем удалите ее.

В шапке титульного листа факса кроме подписи располагаются поля, щелкая
в которых, вы можете вводить туда любой текст. Когда вы будете создавать
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новые факсы на основе этого шаблона, в указанных полях будет размещаться
конкретная информация.

"fidd

; Р1еадвеЬоо«! 3'ftefd.- : ••

• Categories: : i
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Рис. 10.4. Ввод сообщения для отображения в шаблоне. Шаблон должен
быть понятен любому пользователю!

16. Введите несколько пустых строк перед словом Примечание.

17. Выделите весь абзац со словом Примечание, задайте для него шрифт Arial полу-
жирный, размер 12 пунктов.

18. Щелкните на кнопке Стили и форматирование (Styles and Formatting) на панели
форматирования.

19. Щелкните на кнопке Создать стиль (New Style) и введите слово Подзаголовок
сообщения в поле Имя (Name). Нажмите клавишу Enter.

20. В области задач раскройте список Показать (Show) и выберите пункт Доступ-
ные форматы (Available formatting).

21. Прокрутите список доступных вариантов (рорматирования и щелкните на
строке Подзаголовок сообщения.

Наш документ теперь будет выглядеть так, как показано на рис. 10.5.

Создав такой стиль подзаголовка, вы сможете разместить несколько заголов-
ков на одной или нескольких страницах факса. Например, если вам потребу-
ется отправить список каких-то вопросов своим деловым партнерам, вы смо-
жете применить к тексту вопросов новый стиль Подзаголовок сообщения,
а свои комментарии оставить оформленными основным стилем. Конечно, вы
можете не ограничиться изменением только одного стиля в шаблоне. Я сове-
тую вам потратить немного времени на то, чтобы создать свои стили для всех
возможных элементов данного шаблона или проверить наличие и согласован-
ность стилей Word, встроенных в данный шаблон. Тогда у вас не будет про-
блем с каким-то непоследовательным или невыразительным форматировани-
ем документов. Время, потраченное на организацию набора стилей, поможет
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сэкономить значительно больше времени при оформлении различных доку-
ментов. Помните, что стили можно копировать из одного документа в другой.
Поэтому, создав набор стилей в шаблоне для документов одного типа (фак-
са), вы сможете скопировать нужные стили в свой шаблон для документов
другого типа (например, отчета).

^ о о о " к о л о к о л ь 4JK к ••

П Р . Б О Л Ь Ш Е В И К О/В, 2 9
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Текущий абзац оформлен
стилем подзаголовка сообщения

Рис. 10.5. Будущий шаблон титульной страницы факса

Теперь давайте изменим параметры страницы в шаблоне.

22. Выберите команду Файл t Параметры страницы (File > Page Setup). На экране
появится окно диалога Параметры страницы (Page Setup).

23. Щелкните на вкладке Размер бумаги (Paper).

24. В списке Размер бумаги (Paper Size) выберите пункт А4.

25. Щелкните на вкладке Поля (Margins).

26. Задайте следующие поля страницы: Верхнее (Тор) — 2 см, Нижнее (Bottom) —
2 см, Левое (Left) —Зсм, Правое (Right) — 2 см, как показано на рис. 10.6. Щел-
кните на кнопке ОК.

Теперь новые параметры страницы будут применяться ко всем документам,
создаваемым на основе нового шаблона.

27. Щелкните на кнопке Сохранить (Save). Word предложит сохранить документ с
названием Изысканный факс-dot.

28. Введите другое название в поле Имя файла (File name), например OurFax.
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Рис. 10,6. Выбирая поля страницы, учитывайте параметры принтера, на котором
документы будут выводиться на печать

29. В списке Тип файла (Save as type) выберите пункт Шаблон документа. Расшире-
ние .dot вводить не обязательно.

Для названий шаблонов советую использовать латинские символы.

30. Сохраните и закройте документ.

Макросы

Макрос — это сокращенное название макрокоманды, Пусть эти слова вас не пуга-
ют. Считайте, что макрос — это просто набор команд (операций), которые вы мо-
жете записывать и потом выполнять. Макросы очень удобны для выполнения по-
вторяющихся и сложных операций. С помощью макросов вы можете вести поиск
и замену текста, форматировать текст, работать с документами, создавая, откры-
вая и сохраняя их, копировать и перемещать текстовые и графические фрагмен-
ты, вводить любой текст и вообще выполнять все операции, которые доступны в
меню и окнах диалога Word.

Макросы, как и стили, можно копировать из одного шаблона в другой. Написав
удобный макрос, вы можете передать его своим коллегам, чтобы и они оценили
ваш талант. В этом упражнении мы запишем небольшой макрос для последова-
тельного форматирования всех графических объектов в документе.

7 Зак. 481
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Упражнение 10.3. Запись макроса

Макросы пишутся на специальном языке, который представляет собой вариант
языка Visual Basic. Таким образом, макросы — это практически то же самое, что
программы. Однако в отличие от программ макросы можно записывать «вруч-
ную», просто выполняя последовательность нужных операций. Вы включаете
режим записи макроса, затем аккуратно проделываете все операции, которые нуж-
но записать, и выключаете режим записи. После этого можно запускать записан-
ный макрос, и он выполнит все операции, которые были в него записаны. Вам
совершенно не нужно разбираться в конкретных кодах команд и программ, от вас
требуется только внимательность и аккуратность при записи макроса.

1. Создайте новый документ.

2. Нажмите клавишу Print Screen.

3. Нажмите клавиши Ctrl+V. В документ будет вставлено текущее экранное изоб-
ражение.

4. Несколько раз нажмите клавиши Ctrl+V, чтобы создать в документе несколько
страниц со вставленным рисунком экрана.

5. Нажмите клавиши CtrH-Home, чтобы переместиться в начало документа.

Сейчас мы запишем макрос, который будет искать следующий графический
объект в файле и делать его черно-белым.

6. Дважды щелкните на индикаторе ЗАП (REC) в строке состояния, означающем
запись (record). На экране появится окно диалога Запись макроса (Record Macro),
показанное на рис. 10.7. В этом окне диалога вы можете задать имя макроса и
назначить ему либо кнопку на панели инструментов, либо сочетание клавиш.

Назначение макросу команды меню
или кнопки на панели инструментов

Назначение макросу
сочетания клавиш

Рис. 10.7. В этом окне вы определяете, каким способом
будет запускаться макрос
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7. Введите имя макроса Найти_Рисунок. Word не воспринимает имена макросов,
содержащие пробелы, поэтому предпочтительнее вводить имена макросов в
форме НайтиРисунок или Найти_Рисунок. Давайте назначим макросу сочетание
клавиш.

В поле Описание (Description) следует ввести краткую информацию о назначе-
нии макроса. При использовании большого числа сложных макросов эти описа-
ния помогут без труда в них разобраться.

8. Щелкните на кнопке Клавиатура (Keyboard). На экране появится новое окно
диалога (рис. 10.8).

I
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Рис. 10.8. В этом окне диалога можно назначать макросам сочетания клавиш

9. Нажмите клавиши Alt+G. В поле Новое сочетание клавиш (Press new shortcut key)
появится это сочетание.

10. Щелкните на кнопке Назначить (Assign), затем — на кнопке Закрыть (Close).

Обратите внимание на то, что в нижней части окна диалога можно выбрать,
в каком шаблоне будут сохраняться изменения данного макроса.

На экране документа появится маленькая панель инструментов Остановить за-
пись (Stop Recording). На ней всего две кнопки: Остановить запись (Stop Recording)
и Пауза (Pause). Обозначения кнопок совпадают с типичными обозначениями
на аудио-, видео-, DVD- и прочей технике. Указатель мыши примет вид стрел-
ки с небольшой кассетой. Эта кассета показывает, что в данный момент идет за-
пись макроса.

11. Нажмите клавиши Ctrl+F. На экране появится окно диалога Найти и Заменить
(Find and Replace). Щелкните на кнопке Больше (More).

12. Щелкните на кнопке Специальный (Special) и выберите команду Графический
объект (Graphic), как показано на рис 10.9.
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Рис. 10.9. Поиск графического обьекта — одна из операций, записываемых в макрос

13. Щелкните на кнопке Найти далее (Find Next), затем — на кнопке Отмена (Cancel).

Найденный графический объект будет выделен маркерами.

Во время записи макроса некоторые операции с помощью мыши выполнять
нельзя. Например, вы не можете вызвать контекстное меню правой кнопкой
мыши. Чтобы вывести на экран окно форматирования объекта, придется вос-
пользоваться меню Формат (Format).

Для вызова контекстного меню можно использовать также клавишу КОНТЕКСТ
(если она есть на клавиатуре) или сочетание клавиш Shift+F10.

14. Выберите команду Формат ^ Рисунок (Format > Picture).

15. В открывшемся окне диалога щелкните на вкладке Рисунок (Picture).

16. В списке Цвет (Color) выберите пункт Оттенки серого (Grayscale).

17. Щелкните на кнопке ОК.

18. Нажмите клавишу ->, чтобы поместить курсор после рисунка.

19. Щелкните на кнопке Остановить запись (Stop recording) на одноименной пане-
ли инструментов.

20. Указатель мыши примет свой обычный вид, а панель инструментов Остановить
запись (Stop recording) исчезнет с экрана. Теперь давайте выполним наш макрос.
Просто нажмите клавиши Alt+G и вы увидите,-как Word повторит все операции,
которые вы только что выполняли. Программа найдет следующий рисунок, вы-
делит его и сделает черно-белым. Нажав это сочетание клавиш несколько раз,
вы найдете и измените все рисунки в данном документе.
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21. Удерживая нажатой клавишу Shift, выберите команду Файл > Сохранить все
(File > Save All). Данная команда сохраняет изменения в текущем шаблоне до-
кумента и во всех открытых документах.

Контрольное занятие

На этом занятии мы создадим документ на основе готового шаблона, отредакти-
руем его и запишем макрос, необходимый для последовательной замены опреде-
ленных форматов в документе.

1. Выберите команду Файл > Создать (File > New).

2. В области задач Создание документа (New Document) щелкните на значке Общие
шаблоны (On my computer), а затем в открывшемся окне диалога — на вкладке
Записки (Memos).

10.1. Как создать новый шаблон на основе готового шаблона Word?

3. Дважды щелкните на значке Современная записка (Elegant memo).

4. Введите имя адресата в поле Кому.

5. Введите свое имя в поле От.

6. Просмотрите список готовых стилей в документе.

7. Создайте стиль для подзаголовка в новом документе. Примените к нему
шрифт Arial размером 12 пунктов, полужирный курсив, отступ слева — 2 см,
отступ до абзаца — 12 пунктов, после абзаца — 3 пункта.

10.2. Как создать новый стиль на основе существующего фрагмента текста?

8. Сохраните изменения и закройте документ.

9. Запишите макрос, который должен выполнять следующие операции:

1) изменение полей страницы (верхнее, правое и нижнее — 2 см, левое —
3 см);

2) изменение размера бумаги на формат А4;

3) вставка колонтитулов с названием вашей организации (верхний колонти-
тул) и номеров страниц (нижний колонтитул).

10.3. Как прервать запись макроса?

10. Сохраните макрос в шаблоне Обычный (Normal.dot).

11. Создайте новый документ.

12. Выполните в нем созданный макрос.

13. Сохраните изменения и закройте все документы.
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Возможные проблемы

Проблема Решение

Я не могу найти шсладку
Письма и факсы (Letters
and Faxes) n окно диалога
Создание документа
(New Document)

Как сохранить документ
с расширением .dot?

Я не могу найти ria l псу.
в которой хранятся
все шаблоны Word

Я сохранил документ
как шаблон и теперь
не могу изменить его тип,
поскольку поле Тип
файла (Save as file)
.в окне диалога
Сохранение документа
(Save As) недоступно

Я допустил ошибку
в записи макроса,
что мне делать?

Как изменить
имя макроса?

Повторите установку Office XP и добавьте компонент
Шаблоны документов (Document templates)

Выберите пункт Шаблон документа (Document template)
в списке Тип файла (Save as file) окна диалога Сохранение
документа (Save As)

Создайте документ на основе того шаблона, файл которого
вы хотите найти. Выберите команду Сервис > Шаблоны
и надстройки (Tools > Templates and Add-ins). В поле
Шаблон документа (Document Template) вы увидите
название текущего шаблона и путь к нему. Щелкните
на кнопке Присоединить (Attach), и вы увидите содержимое
папки, и которой хранится текущий шаблон

Создайте документ на основе этого шаблона, а не открывайте
сам шаблон для редактирования. После этого вы сможете
сохранить документ в любом формате

Остановите запись, начните ее снова, введите то же самое
имя макроса и замените существующий макрос

Откройте окно Организатор (Organizer), выбрав команду
Сервис > Макрос > Макросы К Организатор
(Tools > Macro » Macros > Organizer), выделите имя нужного
макроса, щелкните на кнопке Переименовать (Rename)
и введите новое имя

Подведение итогов

На этом занятии мы познакомились с двумя важными средствами Word, предназ-
наченными для экономии сил и времени при работе над большим числом схожих
или однотипных документов. Использование шаблонов и макросов позволяет со-
кратить время подготовки типовых документов настолько, что вам практически
не придется решать задачи оформления, и вы сможете посвятить все рабочее вре-
мя доработке содержательной части документов. Помните, как шаблоны, так и
макросы являются универсальными средствами и могут применяться в любых
документах.
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Колонки, рамки и фон

Тема занятия

На этом занятии мы научимся:

• располагать текст в несколько колонок;

• изменять параметры колонок;

• добавлять и удалять разрывы раздела;

• добавлять к абзацам заливку и обрамление;

• работать с фоном документа.

Подготовка к занятию

На этом занятии мы создадим небольшой бюллетень. Законченный документ бу-
дет выглядеть так, как показано на рис. 11.1.

.

Колонки

Создавать колонки в Word очень просто. Вы вводите нужный текст и используе-
те команду Формат > Колонки (Format > Columns). Word автоматически разобьет вы-
деленный текст на заданное число колонок. Текст, расположенный в колонках,
легче читать, поэтому его часто можно встретить в газетах, научных журналах,
бюллетенях и т. д.
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Книжное
Выпуск 1. том 1

Вы ХОТИТЕ самостоятельно стоить
новую версию операционной системы,
популярный программный продукт или
просто научиться работать на
компьютере' Вам помогут книги серии
«Саиоучнтельо — лучший выбор ^ля
польэоваггдя!

Вы хотите самостоятельно освоите
новую версию операционной системы,
популярный программный продут или
просто научиться работать на

• я [д з и. jy
а 1 Sec 2 № Al 6.6ПП 1Г1 SO- (W 7

просто научиться работать на
компьютере? Вам помогут ванги серии
в Самоучитель я —лучший выбор для
пользователя!

Вы хотите самостоятельна освоить
новую версию операционной системы,
популярный программный продукт или
просто научиться работать на
компьютере? Вам помогут книги серии
иСаиоучнтель» — лучший выбор для
пользователя!

Вы хотите самостоятельно освоить
новую БСОСНЮ опеоаиионной системы.

Рис. 11.1. В этом документе использованы колонки, заливка абзаца цветом
и разного рода варианты обрамления

После того как текст размещен в колонках, его можно вводить заново, добавлять
и удалять. Вы можете изменять не только число колонок в документе, но и шири-
ну колонок, расстояние от границы колонок до текста, добавлять разделители
между колонками, создавать колонки разной ширины и форматировать текст в
колонках так же, как вы форматировали его до сих пор.

При работе с колонками вам не обойтись без знакомства с понятием «раздел до-
кумента*. В одном документе могут соседствовать фрагменты текста, размещен-
ного в одну колонку и в несколько. Части документа, различающиеся таким «гло-
бальным» форматированием, называются разделами. Каждый раздел может иметь
собственные поля страниц, размер бумаги, ориентацию страниц, колонтитулы,
расположение и формат номеров страниц, а также некоторые другие параметры,
Обычно разделы используют при работе с большими документами, однако если
вам, например, нужно оформить небольшую часть документа в несколько коло-
нок, Word автоматически вставит разрыв раздела до и после этого фрагмента. Кро-
не того, символы разрыва раздела можно вставлять в документ вручную.

Упражнение 11.1. Создание колонок

Сейчас мы создадим документ, в котором весь текст, кроме заголовка и выходных
данных, будет размещен в колонках.

1. Создайте новый документ и перейдите в режим разметки страницы.

2. Введите слова Книжное обозрение. Нажмите клавишу Enter.

3. Введите текст Выпуск 1, том 1.

4. Дважды щелкните в правом конце введенной строки, чтобы начать печатать в
новой точке, и вставьте в документ текущую дату. Нажмите Enter трижды.
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5. Введите текст: Что такое «Самоучитель»?. Нажмите клавишу Enter.

6. Введите в документ следующий текст:

Вы хотите самостоятельно освоить новую версию операционной системы, попу-
лярный программный продукт или просто научиться работать на компьютере?
Вам помогут книги серии «Самоучитель» —лучший выбор для пользователя!

Чтобы ввести длинное типографское тире (—}, нажмите клавиши Alt+Ctrl+Минус
(на цифровой клавиатуре). Перед типографским тире лучше ставить неразрыв-
ный пробел (Ctrl+Shift+nробел), чтобы тире случайно не оказалось в начале сле-
дующей строки текста.

7. Нажмите клавишу Enter.

8. Щелкните в начале абзаца и передвиньте маркер отступа первой строки на
линейке на отметку 1 см, чтобы создать в абзаце красную строку.

9. Выделите абзац и скопируйте его в буфер обмена.

10. Нажмите клавиши Ctrl+V десять раз, чтобы создать десять одинаковых абзацев.

11. Выделите весь текст, кроме названия бюллетеня и выходных данных.

12. Выберите команду Формат ^ Колонки (Format > Columns). На экране появится
окно диалога Колонки (Columns), показанное на рис. 11.2.

Width end spaca-ifl - -

tol#. Wipiih ^ а>̂ Г-- -
• 1: . |-t 67 cm ̂  {1,25 on ̂

I

v еще) coluw WK№

Рис. 1 1 .2. В этом окне диалога задаются параметры колонок

В верхней части окна диалога в области Тип (Presets) вы можете выбрать один
из готовых вариантов оформления колонок. Вы можете задать число колонок
вручную. Флажок Разделитель (Line between) позволяет вставить разделитель-
ную линию между колонками. В области Образец (Preview) видно, как будут
выглядеть колонки в документе. В списке Применить (Apply to) можно указать
область применения колонок. Показанный на рисунке вариант означает раз-
мещение в колонках выделенного текста.

13. Выберите вариант две колонки и установите флажок Разделитель (Line bet-
ween).

14. Щелкните на кнопке ОК. Документ будет оформлен в две колонки.
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15. Нажмите клавиши Ctrl+Shift+8, чтобы вывести на экран непечатаемые симво-
лы. Обратите внимание на то, что перед колонками теперь стоит символ раз-
рыва раздела, как показано на рис. 11.3.

16. Уменьшите масштаб документа до 75%.

17. Сохраните документ под именем Книжное обозрение.

Символ разрыва
раздела перед

фрагментом,
оформленным
в две колонки
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Разделитель между колонками

Рис. 11.3. Документ с колонками

Разделы могут начинаться как на новой странице, так и на текущей. Именно сим-
вол разрыва раздела последнего типа сейчас вставлен в наш документ. Он обо-
значен словами На текущей странице (Continuous). Символ разрыва раздела,
начинающегося со следующей страницы, обозначается словами Со следующей
страницы (Next Page).

Сейчас мы изменим некоторые параметры форматирования колонок.

Упражнение 11.2. Правка колонок

После вставки в документ символа разрыва раздела параметры раздела можно
изменять. При изменении параметров колонтитулов, полей страницы, колонок
и т. д. вы сможете выбрать область применения этих параметров. Например, вы
можете изменить форматирование колонок или параметров страницы только в
одном разделе или во всем документе. Сейчас мы изменим параметры формати-
рования текущего раздела.

1. Щелкните в любой колонке.

2. Выберите команду Формат > Колонки (Format > Columns).

3. Щелкните на образце Три (Three) в области Тип (Presets) окна диалога Колонки
(Columns).
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4. Снимите флажок Колонки одинаковой ширины (Equal column width).

Теперь ширину колонок можно менять независимо друг от друга. Давайте из-
меним интервал между колонками.

5. Введите число 1 в поля Промежуток (Spacing) и щелкните на кнопке ОК. Вы уви-
дите, как в документе появятся три колонки (рис, 11.4).
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Рис. 11.4. Текст расположен в трех колонках

Разделы

При вставке колонок символы разрыва раздела добавляются автоматически. Од-
нако вы можете вставить такой символ вручную и самостоятельно организовать в
документе совершенно независимый раздел.

Упражнение 11.3. Добавление символа разрыва раздела

1. Выберите команду Вид > Обычный (View > Normal) или нажмите клавиши
Alt+Ctrl+N, Обратите внимание на то, что в этом режиме колонки на экране не
отображаются.

2. Нажмите клавиши Ctrl+End.

3. Выберите команду Вставка * Разрыв (Insert > Break).

Для переключения в режим разметки страницы {print layout) используются кла-
виши Alt+Ctrl+P, а в режим предварительного просмотра (print preview) — клави-
ши A!t+Ctrl+l.
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На экране появится окно диалога Разрыв (Break), показанное на рис. 11.5. Су-
ществует четыре варианта разрыва раздела, которым соответствуют четыре
переключателя в группе Новый раздел (Section break types):

Q Со следующей страницы (Next page) — раздел начинается с начала следую-
щей страницы;

а На текущей странице (Continuous) — новый раздел начинается в текущей по-
зиции курсора;

а С четной страницы (Even page) — новый раздел начинается со следующей
четной страницы;

Q С нечетной страницы (Odd page) — новый раздел начинается со следующей
нечетной страницы.

f* Spluiin break

:- t 'Text wrappng break

Section break types.

" '" &axl page

. ..' Conlnuous
, С f^eit page

Г Qdd page

Рис. 11.5. Окно диалога Break
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Это предыдущий
символ разрыва
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Следующий раздел
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страницы

Рис. 11 .6. В новом разделе текст располагается в одной колонке

L В группе Новый раздел (Section break types) установите переключатель Со следу-
ющей страницы (Next page) и щелкните на кнопке ОК.
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Word разделяет документ на разделы с помощью символов разрыва раздела.
Эти символы похожи на символы разрыва страницы, только обозначаются
двойной чертой, а не одинарной. В левом конце строки состояния Word пока-
зывает номер текущего раздела. Например, Разд 2 (Sec 2) означает второй раз-
дел документа.

5. Поместите курсор в раздел 4 и выберите команду Формат > Колонки (Format >
Columns).

6. В области Тип (Presets) выберите вариант Одна (One) и щелкните на кнопке ОК.

7. Введите текст Бюллетень выходит еженедельно по вторникам.

Введенный текст окажется во втором разделе (рис. И.6). Чтобы удалить сим-
вол разрыва раздела, просто выделите его и удалите так же, как вы удаляете
символ разрыва страницы. Эту операцию удобно делать в обычном режиме
просмотра документа (рис. 11.7).
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Рис. 11.7. В обычном режиме просмотра видны все символы разрыва
раздела с соответствующими подписями

Границы и заливка

Чтобы отдельный заголовок или фрагмент документа визуально выделялся, мож-
но обвести его рамкой или добавить к нему какой-нибудь фон. Путем обрамления
и заливки вы можете добавлять рамки, границы, фоновые рисунки, узоры и цвета
к отдельным абзацам, разделам и даже ко всему документу.

С помощью средств автоматического форматирования Word можно добавлять в
документ горизонтальные линии, вводя простые символы типа дефисов, знаков
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равенства, звездочек и т. д. Если вы введете несколько таких символов в одну строч-
ку и нажмете клавишу Enter, Word автоматически преобразует эти символы в гори-
зонтальную черту соответствующего типа. Дефисы образуют тонкую черту, знаки
равенства — двойную тонкую черту, знаки подчеркивания — толстую черту, знаки
тильды — волнистую линию, звездочки — толстую пунктирную линию.

Упражнение 11.4. Добавление границ к абзацу

Сейчас мы добавим горизонтальную черту под заголовком бюллетеня и нарисуем
рамку вокруг одного из абзацев текста.

1. Выделите заголовок бюллетеня.

2. Сделайте его полужирным, задайте размер шрифта 16 пунктов и выровняйте
его по центру страницы. Добавьте пустой абзац.

3. Введите семь знаков равенства подряд. Нажмите клавишу Enter.

Word преобразует введенные символы в двойную черту.

4. Выделите первый абзац основного текста документа.

5. Щелкните на кнопке Границы (Borders), чтобы вывести на экран палитру Гра-
ницы (Borders), показанную на рис. 11.8.

™™~^ 1LJ Crag to

1
Кннжное-обозрекие!
Выпуск-1, -том- 1Ц
1, „„„,„,„„ „ ,. ,„,„«,.
Что-такое-
«Ca

топулярнын?
программный- продую

Вы-яотитс-
^ СТОЯГСЛЬН О 'О СЕ

1 5« г

ра£ тата' нажоипьютере?1

Е а н-п о могут1 кннги-сгрии'
«С-1моучнт?лья~-
лучший-выбор-дпя-
поньэотателя!!

с амос го ятель н о- о сво ить •
к окую -вер сию •
операционной-системы.'

популярный-
программяый-пр йдукт-
ил 11 • п ро сто-н ауч нтъ ся1

ра^тать-на-компьютере'-
В а к- по мо гут- кн нгн • с ери и -
я Сниоуч итыш в—

популярный1

профаммный-пр одукт-
ил и • просто -н ауч н тъся-
рабтатъ-на-компыотер!?1

Вам- п оыогут- кннгн-сврин
кСамоучительи
л '/ч ши н -в и бор-дяя-
пользователя!!

Бы-хотите-
самосгоятель но-освоить-
вовую-версию1

операцнонной'СистЕмы,-
популярный-
программный1 продукт1

илн-просто-н ауч и ть ся-
рабтать-на-ко мпьютгре ?•

.-,.,

>
<

,'

Рис. 11.8. Палитра Borders помогает создавать рамки вокруг абзацев

Вид и название кнопки Границы (Borders) соответствуют виду и названию пос-
ледней использованной кнопке в палитре.

Если поместить указатель мыши на заголовок палитры и немного задержать его
там, вы увидите подсказку о том, что эту палитру можно перетащить в любое
место экрана.
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6. Перетащите палитру на свободное место экрана. Она примет вид обычной па-
нели инструментов (рис. 11.9).

Внешняя граница
Все границы (внешние и внутренние)
Граница сверху
Граница слева
Внутренняя горизонтальная граница
(между абзацами или ячейками таблицы)
Диагональ сверху слева
(только в ячейках таблицы)
Горизонтальная линия

Внутренние границы
Нет границ

Граница снизу
Граница справа

Внутренняя вертикальная
граница

(между ячейками таблицы)
Диагональ сверху справа

(только в ячейках таблицы)

Рис. 11.9. Панель инструментов Borders

С помощью палитры/панели инструментов Границы (Borders) вы можете до-
бавлять границы с любой стороны абзаца, внутри абзаца, добавлять горизон-
тальную линию между абзацами и изменять параметры этих линий.

В Word 2003 вы можете рисовать границы не только в вертикальном и горизон-
тальном направлении, но и по диагонали. Эта возможность применима только к
таблицам. Кроме того, вы можете вставлять несложные горизонтальные линии
между абзацами и изменять их параметры с помощью окна диалога Формат го-
ризонтальной линии (Format Horizontal Line).

7. Щелкните на кнопке Внешние границы (Outside Border). Word добавит рамку
вокруг выделенного абзаца.

8. Выберите команду Формат > Границы и заливка (Format > Borders and Shading).
На экране появится одноименное окно диалога, показанное на рис. 11.10.

В этом окне диалога вы можете менять вид границы, рамку вокруг страницы,
а также заливку для указанных фрагментов текста.

9. Щелкните на вкладке Границы (Borders).

10. В области Тип (Setting) выберите вариант Тень (Shadow). В области Образец
(Preview) вы сможете увидеть, как будет выглядеть абзац с выбранными пара-
метрами обрамления.

На этой вкладке можно указать цвет рамки, тип линии, ее толщину, выбрать,
с каких сторон будут нарисованы линии, и указать к чему следует применить
данное обрамление (к абзацу или к выделенному тексту).
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Нет-
грзниц
Рамка -

с четырех
сторон
Рамка

с тенью
Объемная

рамка
Выбор-
границ

Щелкайте на кнопках,
чтобы добавить
соответствующие границы

Выбор
типа линии

Здесь показано, как будет
выглядеть абзац с границами

Вывод на экран
панели инструментов

Borders

Если щелкнуть
на крае абзаца,
к нему будет
добавлена
граница

Щелкнув
на этой кнопке,
можно изменить
интервал между
обрамлением
и текстом

Выбор Область
цвета линии применения

Выбор обрамления

Вставка горизонтальной ширины линии
линии из коллекции картинок

Рис. 11.10. Окно диалога Borders and Shading
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Рис. 11.11. Абзац с обрамлением
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Вы также можете вставить в документ горизонтальные линии. Эти графические
обьекты часто используются для оформления веб-страниц, которые не могут
быть разделены на обычные страницы и представляют собой как бы одну не-
прерывную страницу. Для выбора горизонтальной линии щелкните на кнопке
Горизонтальная линия (Horizontal Line) в окне диалога Обрамление и заливка
(Borders and Shading).

11. Выберите двойную линию во втором списке Тип (Style) и щелкните на кнопке
ОК. Выделенный абзац будет окружен объемной рамкой (рис. 11.11).

12. Щелкните за пределами абзаца, чтобы снять выделение.

Чтобы удалить обрамление абзаца, щелкните сначала в этом абзаце, затем —
на кнопке Нет границы (No Border) на панели инструментов Границы (Borders).

Упражнение 11.5. Заливка абзаца

Если добавить фон к отдельным абзацам, они будут заметны на общем фоне доку-
мента. Если вы хотите, чтобы пользователи работали с вашим документом только
в электронном виде, вы можете использовать цвета и рисунки для оформления
таких абзацев. Если же вы предполагаете вывод документа на печать в черно-бе-
лом виде, старайтесь выбирать такие узоры и цвета, которые хорошо смотрятся
именно в черно-белом варианте. Сейчас мы добавим заливку к абзацу, окружен-
ному рамкой.

I. Выделите один из абзацев во второй колонке.

Здесь отображается
текущий цвет

&1>к1н'Г'. аи t Mti.liiu;

age Border.

Mo Fill

ГГТГГПЩР

тттттттт

шггггггшг
ГГГГГГГГГ

Пример

Patterns

Тип узора 1—Ш

Цвет узора

Область для выбора узора

Рис. 11.12. Заливка абзаца



210 Занятие 11. Колонки, рамки и фон

2. Выберите команду Формат > Границы и заливка (Format > Borders and Shading).

3. В открывшемся окне диалога щелкните на вкладке Заливка (Shading), показан-
ной на рис. 11.12.

4. В списке Узор (Pattern) выберите пункт Светлый вертикальный (Lt Vertical).

5. В списке Цвет узора (Color) выберите красный цвет.

6. Щелкните на кнопке ОК, чтобы применить изменения.

Теперь ваш абзац будет выглядеть так, как показано на рис. 11.13.
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Рис. 11.13. К абзацам применены заливка цветом и узор

Если вы хотите изменить параметры обрамления или совсем убрать обрамле-
ние абзаца, выберите команду Формат > Обрамление и заливка (Format > Borders
and Shading) и в списке Узор (Pattern) выберите другой вариант обрамления или,
если ни один из вариантов вам не нравится, выберите пункт Нет (Clear).

7. Отмените последнее действие.

Фон документа

Сейчас программу Word можно использовать не только для создания докумен-
тов, предназначенных для вывода на печать, но и для документов, которые можно
просматривать в электронном виде. Новая версия Word работает с форматами
файлов для Интернета, как со своими внутренними форматами. Одной из отли-
чительных особенностей файлов для Интернета является наличие красивого фона
страниц. Этот фон обычно не выводится на печать, но на экране компьютера смот-
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рится очень неплохо. Вы можете добавить фон ко всему документу целиком. Сей-
час мы превратим наш бюллетень в электронное издание.

Упражнение 11.6. Добавление фона к документу

1. Щелкните в любом месте документа, чтобы снять выделение (если оно было).

2. Выберите команду Формат > Фон (Format > Background). На экране появится па-
литра доступных фоновых цветов.

3. Щелкните на светло-зеленом цвете. Фон всего документа станет светло-зеле-
ным.

4. Снова выберите эту команду, но на этот раз щелкайте не на цветовом образце,
а на кнопке Способы заливки (Fill Effects).

На экране появится одноименное окно диалога (рис. 11.14), в котором вы може-
те выбрать один из видов красивой заливки для фона документа. Окно содер-
жит четыре вкладки: Градиент (Gradient), Текстура (Texture), Узор (Pattern) и Рису-
нок (Рисунок).

j Terture [-Fbtterri ( . Picture.

•Colors-

. , '"' Two «tor*

• Г P«Mt =

: Transparency

-' rtxijcntal

: Г Vatcd
1 С Ыацвги! up

^ '" WawnaliJ
; '" Ггс-Ч W*Dff

: Г: ' '

Рис. 11.14. Окно диалога Fill Effects

5. Щелкните на вкладке Текстура (Texture). Выберите текстуру Белый мрамор
(White marble) и щелкните на кнопке ОК. Теперь посмотрите, что у вас получи-
лось.

6. Сохраните изменения и закройте документ.

Для фона страницы можно использовать любые рисунки. Например, вы можете
оформить красивое объявление или разместить в фоне страницы фирменный
бланк предприятия с реквизитами.
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Контрольное занятие

На этом занятии мы закрепим полученные навыки.

1. Откройте документ, над которым вы работали.

2. Выделите весь текст документа, кроме заголовка и выходных данных.

3. Оформите этот текст в две колонки одинаковой ширины.

11.1. Как изменить ширину колонки в окне диалога Колонки (Columns)?

4. Вставьте вертикальную линию между колонками,

5. Выделите последний абзац текста.

6. Создайте рамку вокруг абзаца.

- 11.2. Как удалить обрамление абзаца?

7. Выберите для абзаца заливку серым цветом насыщенностью 20%.

11.3. Почему при заливке серым цветом нужно выбирать небольшие значения насы-
щенности в процентах?

8. Переключитесь на обычный режим просмотра.

9. Вставьте символ разрыва раздела с переходом на следующую страницу.

11.4. Как удалить символ разрыва раздела из документа?

10. Закройте файл, сохранив изменения.

Возможные проблемы

Проблема Решение

Я создал в документе две Выделите весь текст в двух колонках, выберите команду
колонки и теперь хочу Формат > Колонки (Format > Columns) и в открывшемся
добавить третью окне диалога в области Тип (Presets) выберите вариант

Три (Three)

Мне нужно создать Выберите команду Формат > Колонки (Format > Columns)
колонку слева с шириной, и в открывшемся окне диалога задайте нужную ширину
в два раза меньшей колонок в области Ширина и промежуток
ширины колонки справа (Width and spacing)

Я добавил темную Измените цвет текста на более светлый или цвет заливки
заливку в абзац и теперь также на более светлый. Цвета залиь^и и текста должны
не могу увидеть быть по возможности контрастными
свой текст



Подведение итогов 213

Проблема Решение

Я случайно ввел
в документ несколько
минусов, и программа
Word преобразовала
их в горизонтальную
лилию. Как мне от нее
избавиться?

Я создал в документе
две колонки и затем
сделал фон документа
другим, но при этом
форматирование в виде
колонок исчезло

Нажмите клавиши Ctrl+2, чтобы отменить последнее
действие (автоформат)

Форматирование колонок не поддерживается для режима
просмотра веб-страниц, а создание фона документа
возможно именно для таких страниц. Можно сказать,
что фон документа и колонки исключают друг друга

Подведение итогов

На этом занятии вы научились работать с колонками, познакомились с раздела-
ми документов Word, а также с параметрами обрамления и заливки отдельных
фрагментов документа. Чтобы укрепить эти навыки, попробуйте начать издавать
свой собственный, пусть и небольшой, бюллетень.

На следующем занятии мы познакомимся с очень важным средством Word — таб-
лицами. Для организации данных таблицы иногда просто незаменимы.



Занятие 12

Организация
информации
в таблицах

Тема занятия

На этом занятии мы научимся:

• вставлять в документ таблицы;
•

• рисовать таблицы;

• вводить текст в ячейки таблицы;

• выравнивать и форматировать текст в ячейках;

• добавлять и удалять строки и столбцы таблицы;

• менять параметры ячеек таблицы;

• преобразовывать текст в таблицу и наоборот.

Подготовка к занятию

На этом занятии мы создадим небольшую таблицу, предназначенную для сравне-
ния свойств разных продуктов.

Готовый документ будет выглядеть так, как показано на рис. 12.1.
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^^^Ш КрупаГреча
Пшено
Геркулес

"Узтводы: .- •:-;.-:
70%
75%
65%

' Вшпэмины ^̂ В̂
3%
2%
2%

Рис. 12.1. Информация в таблице

Создание таблиц

Таблицы незаменимы для организации текста и других данных. Как правило ин-
формация, помещенная в таблицу, воспринимается лучше, чем просто текст. Таб-
лицы удобны еще и тем, что упрощают решение многочисленных проблем вырав-
нивания текста. Они служат хорошей альтернативой размещению текста в
колонках, поскольку внутри каждой ячейки позволяют выровнять текст по любо-
му краю или по центру.

Таблицы также удобно использовать в колонтитулах. Если вставить в колонтиту-
лы таблицу из трех столбцов и одной строки, то текст в левой ячейке таблицы мож-
но выровнять по левому краю, текст в средней ячейке — по центру, а в правой — по
правому краю. Такой подход избавляет вас от необходимости точно наводить ука-
затель мыши на место вставки текста. По возможности старайтесь оформлять свои
документы так, чтобы все параметры в них вы задавали самостоятельно. Тогда при
изменении этих параметров у вас не возникнет никаких неожиданностей.

Таблицы можно создавать не только в программе Word. Безусловно, наиболее
мощным средством пакета Office 2003 для создания больших и сложных таблиц
являются электронные таблицы Excel, которые используются экономистами, на-
учными работниками и другими людьми для организации трудоемких вычисле-
ний непосредственно в таблицах. А поскольку все приложения пакета Office 2003
позволяют легко обмениваться данными между собой, вы можете выполнять рас-
четы в таблицах Excel, а затем вставлять эти таблицы в документы Word. При
этом вставленные данные можно организовать так, чтобы редактировать их в ис-
ходном приложении, или, если не предполагается существенных изменений в дан-
ных для расчетов, можно полностью перенести их в документ Word, создав таким
образом таблицу Word.

Начиная с версии 97, программа Word позволяет не только вставлять таблицы с
фиксированным числом строк и столбцов, но и рисовать таблицы, располагая в
них ячейки так, как вам угодно. Некоторые мои знакомые даже считают, что не-
сложные рисунки с обилием прямых линий удобнее рисовать в виде таблицы и
только потом добавлять к ним другие элементы.

Для добавления таблицы в документ существует три способа.

• Вставка таблиц. Вы можете вставить таблицу с помощью соответствующей
кнопки на стандартной панели инструментов. При этом в документ вставляет-
ся обычная таблица с указанным числом столбцов равной ширины и указан-
ным числом строк. Все ячейки таблицы пустые, и вы можете вводить в них
текст, перемещаясь между ячейками с помощью клавиши Tab. В дальнейшем
параметры вставленной таблицы можно изменить.
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• Рисование таблиц, В этом режиме с помощью специального «карандаша» снача-
ла рисуется внешний контур таблицы, а затем все внутренние границы между
ячейками. Эти границы могут располагаться произвольно. Вы можете не только
рисовать границы между ячейками, но и стирать их. В этом режиме можно нари-
совать даже сразу несколько расположенных рядом таблиц.

• Преобразование текста в таблицу. Для такого преобразования между текстом,
который должен попасть в разные ячейки таблицы, должны стоять какие-то
разделители. Например, часто для разделения текстовых фрагментов, которые
должны оказаться в соседних ячейках таблицы, используется символ табуля-
ции, а для разделения строк — символ конца абзаца. В принципе, для преобра-
зования текста в таблицу допустимы любые символы, например точка с запя-
той, звездочка и т. д.

В упражнениях 1 и 2 этого занятия мы рассмотрим первые два способа, а затем,
когда познакомимся с.таблицами получше, освоим третий способ в упражнении 9.

Упражнение 12.1. Вставка таблицы

1. Создайте новый документ.

2. Перейдите в режим разметки страницы.

3. Поместите указатель мыши на кнопку Вставить таблицу (Insert Table) на стан-
дартной панели инструментов.

4. Нажмите левую кнопку мыши и, удерживая ее нажатой, перетащите указатель
по появившейся на экране палитре. Обратите внимание на то, что в процессе
перетаскивания в нижней части палитры отображается число строк и столб-
цон, из которых будет состоять будущая таблица (рис. 12.2).

Рис. 12.2. Вставка в документ таблицы 3x3



Создание таблиц 217

5. Отпустите кнопку мыши, когда размер таблицы будет равен 3x3. В документе
появится таблица с тремя строками и тремя столбцами. Границы ячеек табли-
цы будут показаны одинарными черными линиями.

Чтобы удалить таблицу, выделите ее и нажмите клавиши Ctrl+X. Таблица будет
удалена в буфер обмена.

'

Упражнение 12.2. Рисование таблицы

Рисование таблицы предоставляет вам большую свободу выбора ее параметров,
Сейчас мы нарисуем таблицу, создание которой с помощью обычных средств было
бы затруднительно.

1. Нажмите клавиши Ctrl+End, чтобы переместиться в конец документа. Дважды
нажмите клавишу Enter.

2. Выберите команду Таблица У Нарисовать таблицу (Таблица > Draw Table).

3. На экране появится панель.инструментов Таблицы и границы (Tables and Bor-
ders), показанная на рис. 12,3- Указатель мыши примет вид небольшого каран-
даша.

Рисование линий таблицы
Стирание линий
Тип линии
Толщина линии
Цвет линии
Границы
Цвет заливки
Вставка таблицы или отдельных ячеек
Объединение ячеек

Разбиение ячеек
Выравнивание текста в ячейках

Выравнивание высоты строк
Выравнивание ширины столбцов

Автоформат таблицы
Вращение текста в ячейке

Сортировка по возрастанию
Сортировка по убыванию

Суммирование (учитываются только числовые значения)

Рис. 12.3. Панель инструментов Tables and Borders

i. Удерживая нажатой левую кнопку мыши, перетащите карандаш, чтобы задать
контур будущей таблицы. Нарисуйте небольшую таблицу, примерно 3 см в
высоту и 4 см в ширину.

На экране появится черный прямоугольник, представляющий собой одну
большую ячейку таблицы.

В Word 2003 можно рисовать таблицы внутри таблиц. Для этого также перетас-
кивайте карандаш, чтобы задать контур будущей таблицы.
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5. Теперь проведите карандашом по большой ячейке слева направо. Вы увидите,
как ячейка разделится надвое.

6. Проведите карандашом сверху вниз от верхней границы верхней ячейки до ее
нижней границы. Вы увидите, как верхняя ячейка разделится надвое (рис. 12.4).

Рис. 12.4. Рисование линий в таблице

Маркер выделения таблицы

Маркер изменения размера таблицы

Рис. 12.5, Выделение таблицы
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Такую операцию рисования границ ячеек таблицы можно повторять практи-
чески сколько угодно раз.

Если вы хотите нарисовать какую-то линию другим цветом или другой тол-
щины, задайте соответствующие параметры на панели инструментов Таблицы
и границы (Tables and Borders).

7. Теперь нарисуйте аналогичную таблицу в правой части страницы рядом с пер-
вой. Вы можете форматировать эти таблицы независимо друг от друга.

8. Щелкните на кнопке Нарисовать таблицу (Draw Table) на панели инструментов
Таблицы и границы (Tables and Borders), чтобы получить возможность редакти-
ровать документ.

9. Поместите указатель мыши на второй из нарисованных таблиц. Вверху слева
появится маркер выделения таблицы. Щелкните на нем, чтобы выделить всю
таблицу (рис. 12.5).

10. Нажмите клавиши Ctrl+X, чтобы удалить таблицу.

11. Точно так же удалите вторую нарисованную таблицу.

Заполнение таблиц

Обычно в ячейках таблицы размещают текст. Кроме этого в ячейки можно встав-
лять числа (и даже выполнять над ними арифметические действия). Таблицы так-
же можно использовать для аккуратного размещения графических объектов на
странице. Сейчас мы заполним таблицу, созданную в упражнении 1.

Упражнение 12.3. Ввод текста в ячейку

1. Нажмите клавиши Ctrl+Home, чтобы переместиться в начало документа. Кур-
сор окажется в первой ячейке таблицы.

2. Введите слово Крупа. Нажмите клавишу Tab.

3. Введите слово Углеводы. Нажмите клавишу Tab.

4. Введите слово Витамины. Заголовок таблицы готов.

5. Нажмите клавишу Tab. Курсор переместится в следующую строку.

6. Заполните ячейки таблицы следующим текстом, нажимая, где указано, клави-
шу Tab:

Греча

Нажмите клавишу Tab.

70%

Нажмите клавишу Tab.

3%

Нажмите клавишу Tab.

Геркулес
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Нажмите клавишу Tab.

65%

Нажмите клавишу Tab.

2%

Нажмите клавишу Tab. Обратите внимание на то, что программа Word доба-
вила в таблицу новую строку, после того как вы последний раз нажали клави-
шу Tab. Таким образом, для продолжения ввода данных можно добавлять в
таблицу любое количество строк.

7. Нажмите клавиши Ctrl+Z, чтобы отменить последнее действие. Наша таблица
будет выглядеть так, как показано на рис. 12.6.

ЦюЬ"- 1*Ые йШОм* Ofto

Круп Л
ГречаО

Геркулеса

Углеводно
7И4П
654to

ВитаМНВЫП

ЗИс
2Чф

Рис. 12.6. Таблица с введенным текстом

Текст в таблицах можно изменять так же, как обычный текст документа. Сначала
вы выделяете нужный фрагмент, а затем применяете к нему выбранные парамет-
ры форматирования. Обратите внимание на то, что нажатие клавиши Enter не пе-
ремещает вас на следующую строку, а просто добавляет новую строку в ячейке.
Для перехода между ячейками используются клавиши Tab и Shift+Tab.

Упражнение 12.4. Выделение и выравнивание текста

Обычно числа в ячейках таблицы выравниваются по правому краю ячейки, кро-
ме того, существует вертикальное выравнивание текста. Текст можно выравни-
вать по верхней и нижней границам ячейки, а также по центру ячейки. Если объе-
динить эти варианты с вариантами горизонтального выравнивания (по левому и
правому краям ячейки и по ее центру), то получится целых девять вариантов вы-
равнивания. В этом упражнении мы выровняем текст в ячейках.
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Этот столбец
уже выделен

Черная вертикальная стрелка
служит для выделения
столбца целиком

Варианты выравнивания
текста в ячейке

Рис. 12.7. Доступные варианты выравнивания текста в ячейках

Insert Fymar. £ооЬ Table

jCpyna
Греча
Геркулес

е я [и; ч ЕВ .у

Углеводы
70°/с

Витамины

l " ui at «Моя Ln 6 cdi ' : - Fne K*I (U.5 Ш_

Рис. 12.8. Текст в двух столбцах выровнен по правому краю

--- ^ :

!'
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1. Поместите указатель мыши чуть выше второго столбца ячейки, чтобы указа-
тель превратился в маленькую черную стрелку. Щелкните на верхней границе
столбца. Столбец будет выделен.

2. Щелкните на кнопке со стрелкой рядом с кнопкой Выравнивание (Cell Alignment)
на панели инструментов Таблицы и границы (Tables and Borders). На экране по-
явится небольшая палитра вариантов выравнивания.

Если перетащить эту палитру, ухватившись за ее верхний край, она останется
«плавать» на экране, как самостоятельная панель инструментов {рис. 12.7),

3. Выберите вариант выравнивания по центру и по правому краю. Текст в выде-
ленных ячейках будет выровнен по правому краю ячейки (в горизонтальном
направлении) и по центру (в вертикальном направлении).

4. Повторите шаги 1-3 для третьего столбца.

Теперь ваша таблица должна выглядеть так, как показано на рис. 12.8.

Упражнение 12.5. Изменение шрифта для текста в таблице

Давайте изменим шрифт и размер шрифта для текста таблицы. Обычно заголов-
ки столбцов требуется как-то выделять.

1. Поместите указатель мыши чуть выше таблицы. В левом верхнем углу табли-
цы должен появиться маркер выделения таблицы. Щелкните на нем, чтобы
выделить таблицу.

2. Выберите шрифт Arial в списке Шрифт (Font) на панели форматирования.

3. Выберите значение 14 в списке Размер шрифта (Font Size) на этой же панели.

4. Щелкните в любом месте таблицы, чтобы снять выделение.

Вид указателя мыши
означает возможность

выделения
одной строки

Рис. 12.9. Выделение одной строки таблицы
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5. Поместите указатель мыши чуть левее первой строки таблицы. Указатель
мыши должен превратиться в белую стрелку, направленную вправо (рис. 12.9).
Щелкните один раз. Вся первая строка таблицы будет выделена.

6. Нажмите клавиши Ctrl+B, чтобы сделать текст полужирным.

7. Выберите значение 16 в списке Размер шрифта (Font Size).

8. Щелкните в любом месте таблицы, чтобы снять выделение.

Теперь таблица должна выглядеть так, как показано на рис. 12.10.

Крупа
Греча
Геркулес

Углеводы
70%
65%

Витамины
3%
12%

Рис. 12.10. Параметры текста в ячейках изменены

9. Сохраните документ под именем Таблицы.doc.

Упражнение 12.6. Вращение текста в ячейках

Новые версии Word позволяют менять направление размещения текста в ячей-
ках таблицы. Давайте повернем текст в одной из ячеек.

1. Дважды щелкните на слове Крупа.

2. Щелкните правой кнопкой мыши на слове и выберите команду Направление
текста (Text Direction).

Для изменения направления размещения текста можно воспользоваться также
кнопкой Изменить направление текста (Change Text Direction) на панели инстру-
ментов Таблицы и границы (Tables and Borders).

3. В появившемся окне диалога (рис. 12.11) дважды щелкните на одном из об-
разцов размещения текста. Текст в выделенной ячейке развернется в соответ-
ствии с выбранным вариантом.
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Рис. 12.11. В этом окне диалога можно задать
направление вращения текста

Если развернутый текст не помещается в ячейку, перетащите указателем
мыши нижнюю границу ячейки так, чтобы текст поместился в ячейке. Ука-
затель мыши при этом должен превратиться в двойную линию с двойной
стрелкой.

4. Дважды нажмите клавиши Ctrl+Z, чтобы отменить последние операции (вра-
щение текста и изменение высоты строки).

Упражнение 12.7. Вставка и удаление строк и столбцов

Довольно часто уже в процессе работы над таблицами возникает необходимость
изменения их содержания или оформления. Основными операциями при изме-
нении таблиц являются вставка и удаление строк и столбцов. Вы уже знаете, что
для вставки строки в конец таблицы нужно поместить курсор в последнюю ячей-
ку и нажать клавишу Tab. Однако довольно часто приходится вставлять столбцы
и строки в середину таблицы.

1. Выделите последнюю строку таблицы.

2. Щелкните правой кнопкой мыши на выделенной строке и выберите команду
Добавить строки (Insert Rows). Word добавит в таблицу новую строку над выде-
ленной.

Все команды, применимые к таблицам, собраны в меню Таблица (Table). Одна-
ко практически все эти команды можно выполнить и с помощью контекстного
меню. Работая с контекстными меню, вы всегда будете уверены, что операция
действительно применяется к выделенному объекту.

Обратите внимание на то, что при выделении строки в таблице кнопка Добавить
таблицу (Insert Table) превращается в кнопку Добавить строки (Insert Rows).
При выделении столбца таблицы та же кнопка превращается в кнопку Добавить
столбцы (Insert Columns).

3. Щелкните в первой ячейке новой строки и введите слово Пшено. Нажмите кла-
вишу Tab.

4. Введите следующий текст, нажимая, где указано, клавишу Tab:

75%
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Нажмите клавишу Tab.

2%

Нажмите клавишу Tab.

5. Поместите указатель мыши чуть выше второго столбца и выделите его.

6. Выберите команду Таблица > Вставить > Столбцы слева (Table > Insert * Columns
to the Left), как показано на рис. 1 2. 1 2. В таблицу будет вставлен новый столбец
слева от выделенного.

Вставка таблицы в ячейку

Вставка столбцов

Вставка строк

Вставка ячеек

Рис. 12.12. Меню для вставки элементов таблицы

Обратите внимание на то, что ширина всех столбцов таблицы изменилась так,
чтобы в таблицу поместился новый столбец. Его ширина равна ширине выде-
ленного столбца. Можно задать точку вставки столбцов и строк. С помощью
команд подменю Вставить (Insert) меню Таблица (Table) вы можете вставлять
строки выше или ниже выделенной ячейки либо вставить столбцы слева или
справа от текущей ячейки.

| ЦРНМЕЧИЧЕу̂ ,

Чтобы вставить в таблицу сразу несколько строк или столбцов, сначала выделите
такое же число строк или столбцов, а затем выберите нужную команду вставки.

Можно вставлять одну таблицу в другую. Для этого используется команда Таб-
лица > Вставить > Таблица (Table * Insert > Table). Вставленная таблица может
поместиться всего в одну ячейку и вести себя одновременно как таблица и как
ячейка большей таблицы.

7. Щелкните во втором столбце таблицы. Выберите команду Таблица V Удалить >
Столбцы (Table > Delete > Columns). Текущий столбец будет удален.

8. Два раза нажмите клавиши Ctrl+Z, чтобы отменить удаление и вставку столбца.
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Упражнение 12.8. Изменение ширины и высоты ячейки

После ввода текста в ячейку ее размеры можно изменить. Чаще всего приходится
изменять ширину столбцов, поскольку высота строк меняется автоматически в
зависимости от объема введенного в ячейку текста. Сейчас мы изменим ширину
столбцов в нашей таблице.

1. Щелкните в первой ячейке второго столбца.

2. Поместите указатель мыши на правую границу ячейки, он должен превратить-
ся в двойную линию с двойной стрелкой.

3. Удерживая нажатой левую кнопку мыши, перетащите границу столбца влево.
Обратите внимание на то, как перемещается пунктирная линия, обозначаю-
щая границу столбца. Ее положение отмечается также на горизонтальной ли-
нейке (рис. 12.13). Перетащите границу столбца до отметки 9 на линейке и от-
пустите кнопку мыши.

Маркер изменения
ширины столбца

Пунктир показывает
текущее положение
границы столбца

Рис. 12.13. Изменение ширины столбца

Теперь давайте изменим ширину только одной ячейки.

4. Поместите указатель мыши в левый нижний угол второй ячейки первой стро-
ки. Указатель мыши примет вид черной стрелки, направленной вверх и вправо
(рис. 12.14). Щелкните на ячейке, чтобы выделить ее.

Если теперь перетаскивать границу ячейки, то изменится размер только выде-
ленной ячейки, а размеры других ячеек останутся неизменными.

5. Перетащите левую границу ячейки влево до отметки 4.

6. Щелкните в любом месте таблицы, чтобы снять выделение.
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Крупа
Греча
Пшено
Геркулес

„ Углеводы
170%
75%
65%

Витамины
3%
2%
2%

W -J

Рис. 12.14. Выделение второй ячейки первой строки

7. Нажмите клавиши Ctrl+Z, чтобы отменить последнюю операцию.

Аналогичный прием используется для изменения высоты строки. Перетаскивая
нижнюю границу строки, вы можете увеличить ее высоту. Однако высоту отдель-
но взятой ячейки изменить нельзя.

На панели инструментов Таблицы и границы (Tavles and Borders) есть кнопки
Выровнять ширину столбцов (Distribute Columns Evenly) и Выровнять высоту строк
(Distribute Rows Evenly). Если щелкнуть на одной из этих кнопок, предваритель-
но выделив часть таблицы или всю таблицу, то для выделенного фрагмента бу-
дет выбрана одинаковая ширина или одинаковая высота ячеек.

Упражнение 12.9. Преобразование текста
в таблицу и наоборот

Давайте потренируемся в преобразовании таблицы в текст и наоборот. Для пре-
образования таблицы ее сначала нужно выделить.

1. Выделите всю таблицу. Для этого выберите команду Таблица У Выделить > Таб-
лица (Table > Select > Table).

2. Выберите команду Таблица * Преобразовать > Таблицу в текст (Table > Convert >
Table to Text). На экране появится окно преобразования (рис. 12,15).

3. Выберите символы табуляции в качестве разделителей текста. Щелкните на
кнопке ОК. Таблица будет преобразована в текст.

Если теперь вы сохраните документ Word в текстовом формате, то эта таблица
преобразуется без потерь и ее сможет прочитать любая другая программа.

Теперь преобразуем текст обратно в таблицу.
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Separate text with
t С fieragraph marks

: '":•<? fge] ; : .

f êricolons

<~ Other: !™

Cancel

Рис. 12.15. Преобразование таблицы в текст

4. Щелкните в любом месте таблицы, чтобы снять выделение. Нажмите клави-
ши Ctrl+Shift+8, чтобы вывести на экран непечатаемые символы. Обратите вни-
мание на символы табуляции, разделяющие бывшие ячейки.

5. Нажмите клавиши Ctrl+H, чтобы вывести на экран окно диалога Найти и заме-
нить (Find and Replace). Вы также можете выбрать команду Правка > Заменить
(Edit > Replace).

6. Щелкните на кнопке Больше (More).

7. Щелкните на кнопке Специальный (Special) и в раскрывшемся меню выберите
пункт Знак табуляции (Tab character).

8. Щелкните в поле Заменить на (Replace with) и введите туда точку с запятой (;).

9. Щелкните на кнопке Заменить все (Replace All). Закройте окно диалога Найти и
заменить (Find and Replace).

Теперь наша таблица превратилась в компактный текстовый фрагмент
(рис, 12.16). Сейчас мы увидим, как Word распознает наши новые символы-
разделители.

Крупа;Углеводы; Витамины^
Греча;70%;3%Ц
Пшено;75%;2%Ц
Геркулес ;65%2%Ц

Рис. 12.16. Данные, которые можно преобразовать в таблицу

10. Выделите все строки с текстом будущей таблицы.

11. Выберите команду Таблица > Преобразовать > Текст в таблицу (Table > Convert f
Text to Table). В появившемся окне диалога укажите в качестве символа разде-
лителя точку с запятой, как показано на рис. 12.17.

В окне диалога Преобразовать в таблицу (Convert Text to Table) Word сразу пока-
зывает, сколько столбцов и строк будет содержать получившаяся таблица.

12. Щелкните на кнопке ОК. Word преобразует текст в таблицу.
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Число столбцов и строк

CiSBV%ifT*xt to Table

table are

• Number of columns:

^ Fwed edumn width

«"' AutoFt la contents

-'' AutoFil Ь Н1гфи

ebte stytei CnoneJ

spw«elext at •.--:-'•;

>'~ £.»a(raphs !•

•'"labs Г

Автоподбор
ширины

Выбор готового варианта
форматирования таблицы

Выбор символа разделителя

Рис. 12.17. Преобразование текста в таблицу (в качестве символа-разделителя
используется точка с запятой)

Форматирование таблиц

По умолчанию Word окружает ячейки таблицы одинарной линией толщиной
в 0,5 пункта. Эта граница выводится на печать. Если вы не хотите выводить на
печать эти линии, но в то же время вам нужно видеть структуру таблицы, можно
удалить границы ячеек и оставить на экране только сетку таблицы. Сетка табли-
цы не выводится па печать. Чтобы просмотреть, как будет выглядеть на печати
таблица без рамок вокруг ячеек, можно также отключить вывод сетки на экран.
Для этого служит команда Таблица > Скрыть/Отображать сетку (Table t Hide/Show
Gridlines). При отключенной сетке таблица отображается на экране именно так,
как она будет выведена на печать.

Для форматирования таблиц можно использовать все те же возможности, что и
для форматирования любого текста или графических объектов. Вы можете изме-
нять шрифт, размер шрифта, его цвет, выравнивание, менять заливку ячеек и об-
рамление. От грамотного форматирования таблицы зависит легкость восприятия
информации, которая в ней располагается. Конечно, самому придумать варианты
грамотного оформления таблицы бывает довольно сложно, поэтому я советую на
первых порах пользоваться средствами автоматического форматирования таблиц
Word. Немного поработав с этими средствами и «почувствовав» общие принци-
пы оформления таблиц, вы сможете приступать к самостоятельным опытам.

В программе Word существуют специальные стили таблиц, которые можно ис-
пользовать для их оформления. Это творчески переработанная и давно извест-
ная модель автоформата таблиц. Список доступных вариантов форматирова-
ния таблиц можно увидеть в области задач Стили и форматирование (Styles and
Formatting). Для вывода на экран всех доступных стилей таблиц выберите пункт
Все {All styles) в списке Показать (Show) области задач.
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Упражнение 12.10. Отображение сетки таблицы

Сетка, окружающая ячейки таблиц, отображается на экране в виде блеклых се-
рых линий и не выводится на печать. С ней удобно работать, если вам нужно вста-
вить в документ невидимую таблицу, где она будет использоваться лишь для вы-
равнивания текста, а не как таблица сама по себе. Невидимые таблицы также
удобны для выравнивания таких объектов, как рисунки, реквизиты организаций,
адреса, подписи и т. д. Сейчас мы посмотрим, как убрать все обрамление из таб-
лицы, оставив на экране только сетку.

1. Наведите указатель мыши на таблицу в нашем документе. В верхнем левом
углу таблицы должен появиться маркер выделения таблицы.

2. Щелкните на маркере выделения. Таблица будет выделена целиком.

3. Щелкните правой кнопкой мыши на таблице и выберите в контекстном меню
команду Границы и заливка (Borders and Shading). На экране появится одноимен-
ное окно диалога.

4. На вкладке Границы (Borders) выберите вариант Нет (None).

5. Щелкните на кнопке (Ж, чтобы изменения вступили в силу.

6. Щелкните в любом месте таблицы, чтобы снять выделение.

Вы увидите, что ячейки нашей таблицы окружены блеклыми серыми линия-
ми. Это и есть сетка (рис. 12.18).

Крупа
Греча
Пшено
Геркулес

oSsj-з а _< j

о.з и : Vr 1 « S.3cm

Рис. 12.18. На экране отображается сетка

7. Выберите команду Таблица > Скрыть сетку (Таблица > Hide Gridlines), чтобы спря-
тать сетку. Если теперь вы выведете документ на печать, таблица будет напе-
чатана именно в таком виде.
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8. Снова выведите сетку на экран, выбрав команду Таблица > Отображать сетку
(Table > Show Gridlines).

Упражнение 12.11. Автоматическое форматирование
таблицы

Word предлагает вам набор готовых форматов таблиц. В эти форматы включают-
ся оформление заголовков строк и столбцов таблицы, цветовые выделения, раз-
личные рамки и шрифты. Вы всегда сможете выбрать подходящий вариант из
обилия готовых форматов.

1. Выделите всю таблицу.

2. Выберите команду Таблица > Автоформат таблицы (Table > Table Autoformat).

На экране появится окно автоматического форматирования таблицы, пока-
занное на рис. 12.19. Названия доступных форматов отображаются в верхней
части окна, образец выбранного формата — в нижней части. Там же с по-
мощью флажков вы можете самостоятельно задать набор элементов таблицы,
которые будут автоматически отформатированы. Попробуйте выбрать такую
комбинацию этих параметров, которая вас устроит.

Apply special formats to

~f? КеафпдщтО .-

"-*•' Frstigluron

JEsLLliI

Рис. 12.19. Выбор готовых параметров форматирования таблицы

3. Выберите вариант Классическая таблица 4 (Table Classic 4).

4. Снимите флажок Последней строки (Last Row) в нижней части окна диалога.

5. Щелкните на кнопке ОК.
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6. Щелкните в любом месте таблицы, чтобы снять выделение.

Теперь таблица будет выглядеть так, как показано на рис. 12.20. Чтобы оформить
эту таблицу по-иномуг можно либо менять формат ее отдельных элементов, либо
повторно воспользоваться окном диалога Автоформат таблицы (Table Autoformat) и
выбрать другой вариант оформления.

ЬИ Ще« Inwt Fymt Jocfc "' Т*» ffindo

-и- i -is • i • it

Рис. 12.20. Автоматически отформатированная таблица

Для оформления таблиц вы также можете пользоваться областью задач Стили и
форматирование (Style;; and Formatting). Единственное неудобство — в ней ко-
нечный вариант форматирования таблицы представлен только частично.

Контрольное занятие

На этом занятии мы закрепим приобретенные вами навыки работы с таблицами,
Мы создадим бланк заказа и заполним его данными.

1. Создайте новый документ.

2. Введите текст Магазин «Книги». Нажмите клавишу Enter.

3. Введите несколько символов подчеркивания и нажмите клавишу Enter.

4. Задайте для первой строки документа шрифт Verdana, 16 пунктов, полужир-
ный.

5. Выровняйте первую строку по центру страницы.

6. Нажмите клавиши Ctrl+End, чтобы перейти в конец документа.

7. Создайте таблицу из пяти столбцов и четырех строк.
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12.1. Как выглядит указатель мыши в режиме рисования таблицы?

8. Введите следующие заголовки столбцов в первую строку таблицы, нажимая,
где указано, клавишу Tab:

Название книги

Нажмите клавишу Tab.

Номер ISBN

Нажмите клавишу Tab.

Число страниц

Нажмите клавишу Tab.

Переплет

Нажмите клавишу Tab.

Цена

Нажмите клавишу Tab.

12.2. Какое сочетание клавиш используется для перемещения в ячейках таблицы в об-
ратном направлении?

9. Заполните остальные ячейки таблицы следующей информацией, нажимая, где
указано, клавишу Tab:

Детские сказки

Нажмите клавишу Tab.

0952

Нажмите клавишу Tab.

750

Нажмите клавишу Tab.

Твердый, суперобложка

Нажмите клавишу Tab.

50

Нажмите клавишу Tab.

Английский для детей

Нажмите клавишу Tab.

1319

Нажмите клавишу Tab.

100

Нажмите клавишу Tab.

Твердый
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Нажмите клавишу Tab.
J

35

Нажмите клавишу Tab.

Я познаю мир

Нажмите клавишу Tab.

0812

Нажмите клавишу Tab.

430

Нажмите клавишу Tab.

Твердый

Нажмите клавишу Tab.

40.

10. Выровняйте по правому краю содержимое столбцов 3 и 5.

11. Вставьте новую строку перед второй строкой.

12.3. С помощью каких команд можно вставить строку в таблицу?

12. Вставьте новый столбец между вторым и третьим столбцами.

12.4. Какой вид принимает указатель мыши при выделении целого столбца?

13. Отмените последнюю операцию вставки столбца.

14. Выделите все ячейки первой строки.

12.5. Какой вид принимает указатель мыши при выделении отдельной ячейки?

15. Выровняйте текст в выделенных ячейках по центру.

12.6. С помощью какой кнопки можно сменить вариант выравнивания текста в ячейках
таблицы и сколько существует вариантов такого выравнивания?

16. Сделайте текст в выделенных ячейках полужирным и задайте его размер рав-
ным 14 пунктам.

17. Выделите всю таблицу.

12.7. Как выделить всю таблицу?

18. Примените вариант автоформатирования таблицы Цветной 1 (Table Colorful I).

19. Вручную измените ширину первого столбца, чтобы в нем поместился длин-
ный текст.
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12.8. Как выглядит указатель мыши при изменении ширины столбца или высоты строки?

20. Сохраните изменения и закройте файл.

Возможные проблемы

Проблема

При рисовании таблицы
я случайно добавил лишнюю
линию

Все команды в меню Таблица
(Table) недоступны (показаны
блеклыми буквами),
а мне нужно выполнить
команду, что делать?

Я хотел изменить ширину
столбца в таблице,
но передвинулась граница
только одной ячейки

Я щелкнул в ячейке таблицы
и хотел вставить строку
с помощью контекстного меню,
но не увидел в нем команду
Вставить строки (Insert Rows)

Как очистить все содержимое
таблицы, не изменяя
ее формата?

Щелкните па кнопке Ластик (Eraser) на панели
инструментов Таблицы и границы (Tables and
Borders). Указатель мыши превратится в небольшую
стирательиую резинку. Перетащите указатель мыши
по ненужной линии, и она будет удалена из таблицы

Сначала выделите таблицу или поместите
в нес курсор, а затем выбирайте нужную команду

Чтобы изменить ширину целого столбца, нужно либо
выделить его целиком, либо щелкнуть в ячейке этого
столбца, не выделяя ее. Если выделить только одну
ячейку, при попытке изменения ширины столбца
будет меняться ширина только выделенной ячейки

Состав команд контекстного меню меняется
в зависимости от выделенного объекта. Чтобы в меню
появилась команда для вставки строк или столбцов,
вы должны сначала ныделить нужное число строк
или столбцов

Выделите всю таблицу с помощью маркера выделения
в верхнем левом углу таблицы и нажмите
клавишу Delete

Подведение итогов

На этом занятии мы познакомились с некоторыми возможностями таблиц Word.
Мы научились вставлять таблицы в документ, рисовать их, добавлять строки и
столбцы, изменять ширину столбцов и высоту строк, форматировать содержимое
ячеек, преобразовывать текст в таблицу и наоборот, изменять некоторые пара-
метры таблиц. Чтобы создавать более сложные таблицы и выполнять в них мате-
матические действия, сложную сортировку и прочие операции, удобнее пользо-
ваться другим приложением пакета Office — программой подготовки электронных
таблиц Excel.

На следующем занятии мы познакомимся с некоторыми способами вывода доку-

мента на печать.



Занятие 13

Печать документов Word

Тема занятия

На этом занятии мы научимся:

• просматривать документ на экране перед выводом на печать;

• печатать документ;

• печатать конверты и почтовые наклейки,

Подготовка к занятию

На этом занятии мы познакомимся с режимами печати документов Word и воз-
можными задачами, с которыми вы столкнетесь при выводе документа на печать.
Нам понадобится файл Письмо со списком.doc, созданный на одном из предыду-
щих занятий. В конце занятия мы распечатаем документ, показанный на рис. 13.1.

Подготовка к печати

В Word вы можете распечатать документ со всеми параметрами, заданными по
умолчанию, а можете изменить эти параметры по своему вкусу. При выводе доку-
ментов на печать следует учитывать следующие характеристики документа: поля
страницы, размер бумаги, ориентацию бумаги, источник подачи бумаги в прин-
тер, настройки принтера, порядок печати страниц, необходимость обновления
полей документа, наличие титульного листа и рисунков. Некоторые из этих ха-
рактеристик мы рассматривали на предыдущих занятиях.
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МАГАЗИН «Книги»
пр. Жемчужниковых, 12
191390, Санкт-Петербург

(812)554-23-09

26 октября 2003 г.

Г-жа Елена Цветаева
Ре ф ер ент-п ер ев о дчик
НИИМЕХМАШ
Трамвайный пр. 2-212
191457. Санкт-Петербург

Уважаемая г-жа Цветкова!

Мы рады сообщить Баи что по итогам опроса «Лучшая детскаякнига», проведенного
нашим магазином, лучшей была признанакнигаиРусскиенфсдные сказки». Все читатели,
которье подали свои голоса за эту книгу, насаждаются ценньмипрюамнотнашего магазина.
Вы можете зайти к нам в удобное для Вас время л получить свой приз.

Кроме тоге, предъявив это письмо, вы можете приобрести внаием шгазнне любсе
количество изданий с 40% скидкой

Ниже перечислены некоторые издания, на которые мы особенно хотели бы обратить Ваше
внимание. Надеемся что Вам понравятся эти книги.

• Сказки народов мира
• Английский для детей (княгаи аудиокассета)
• Спокойнойночи Сборник детских песенок (книга и аудиокассета)

В этом месяце мы проводим выставку-продажу книг по искусству «Красота и мири.
Журнал «Искусств о я посвятил этом/ событию такие строки.

В эпоху технологического и инфармафюннаго бума особенна приятно видеть

неослабевающий интерес миспящей части абиралва к вечным ценностям Мы.

считаем, что настоящая выставка яоиожет заинтересовать и тех людей,

которые до этого не удепяли occSo^i внимания еопросамшящных искусств.

Чтобы добраться до нашего ьвгжина «Книги», следуйте по маршруту, предложенному

1) Отст метро «Академическая) по проспекту Науки до улицы Северной.
2) Повернуть налраво и екать до третьего перекрестка
3) Свернуть налево на проспект Жемчужниковын и ехать до дома№ 15.

Искренне Ваш

Андрей Быстрое
Директор маггшнакКнигин

Рис. 13.1. Так выглядит распечатанный документ

Размер полей страницы, размер бумаги и ее ориентация задаются в окне диалога
Параметры страницы (Page Setup). В России обычно используется формат бумаги
А4 (210x297). Здесь же можно указать размер бумаги, пригодный для печати кон-
вертов или почтовых наклеек. Доступные источники подачи бумаги в принтер
зависят от модели принтера, установленного в вашей системе. Обычно современ-
ные принтеры позволяют подавать бумагу как вручную, так и из одного или не-
скольких лотков. Кроме того, некоторые принтеры имеют специальные лотки для
конвертов.

Перед выводом документа на печать его обязательно нужно просмотреть на экране
и убедиться, что все объекты документа размещены в нем правильно. В режиме
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предварительного просмотра вы можете найти ошибки, которые незаметны в дру-
гих режимах. Например, номера страниц и основной текст колонтитула могут ока-
заться оформленными разными шрифтами или шрифтами разных размеров. Вы
можете увидеть неудачное расположение некоторых абзацев или неудачную раз-
бивку на страницы. Так, заголовок, оказавшийся на последней строке страницы,
всегда выглядит очень плохо. В таких случаях перед заголовком вставляют сим-
вол принудительного разрыва страницы. Иногда при автоматической разбивке
на страницы таблицы могут оказываться «разрезанными». Перед длинными таб-
лицами также обычно добавляют символ разрыва страницы.

В режиме предварительного просмотра документ можно сократить на одну стра-
ницу. Обычно такая операция требуется, если небольшой фрагмент текста оказы-
вается на последней странице. Несколько строк в этом фрагменте будут выгля-
деть довольно сиротливо, поэтому, сократив документ на одну страницу, вы
одновременно сэкономите бумагу и получите в результате более эффектный до-
кумент. В этом же режиме вы можете отобразить на экране очень большое число
страниц. Это поможет вам быстро найти такие ошибки, как неправильное разме-
щение графических объектов, неправильная ориентация страниц и наличие пус-
тых страниц.

Упражнение 13.1. Просмотр параметров страницы

Для очень многих документов требуется титульный лист. Студенты помещают на
него имя научного руководителя своей работы (а также его ученую степень), на-
учно-технические работники оставляют на нем места для резолюций начальства,
а творческие работники обязательно должны поставить свое имя и название про-
изведения.

Перед выводом документа на печать не забудьте проверить орфографию в до-
кументе.

Титульные листы документов Won! обычно оформляются в отдельном разделе. Это
нужно для того, чтобы форматирование титульного листа отличалось от формати-
рования остального документа. Например, для титульного листа часто задаются
отдельные колонтитулы. Кроме того, параметры страницы этого листа могут отли-
чаться от соответствующих параметров остального документа. В этом упражнении
мы просмотрим параметры страницы документа, выводимого на печать.

1. Откройте файл Письмо со списком.doc.

2. Сохраните его под именем Печать.doc

3. Поместите указатель мыши на символ принудительного разрыва страницы и
щелкните мышью, чтобы выделить его.

4. Нажмите клавишу Delete, чтобы удалить символ разрыва страницы.

5. Выберите команду Файл > Параметры страницы (File > Page Setup).

6. Щелкните на вкладке Источник бумаги (Layout), показанной на рис. 13.2.

7. Щелкните на вкладке Размер бумаги (Paper) и проверьте, что выбранный раз-
мер соответствует тому, на который настроен ваш принтер.
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Добавление нового раздела

sndfooters -* .-•

Г" DHrrentftdd smf е**г
Of f went first oage -:

Разные колонтитулы
для четных и нечетных страниц

Отдельный колонтитул
для первой страницы

Вертикальное выравнивание
текста на странице

Область применения измененных
параметров страницы

Добавление номеров строк

Щелкните на этой кнопке, Границы
чтобы внесенные

изменения сохранились
в текущем шаблоне документа

Рис. 13.2. На вкладке Layout можно изменять параметры страницы документа,
важные при выводе на печать

На вкладке Источник бумаги (Layout) вы можете увидеть список Вертикальное
выравнивание (Vertical Alignment). Этот список применяется для выравнивания
текста страницы относительно ее верхнего и нижнего краев.

8. Щелкните на вкладке Поля (Margins), обратите внимание на размеры и распо-
ложение полей, а также на ориентацию страницы.

9. Щелкните на кнопке ОК.

Упражнение 13.2. Предварительный просмотр документа

В окне предварительного просмотра документ отображается точно в том виде,
в котором он будет выводиться на печать. Давайте взглянем на наше письмо в
режиме предварительного просмотра.

1. Щелкните на кнопке Предварительный просмотр (Print Preview) на стандартной
панели инструментов.

Ваш документ появится на экране и будет выглядеть как небольшая печатная
страница (рис. 13.3). Обратите внимание на то, что указатель мыши теперь
принимает вид небольшого увеличительного стекла. Если щелкнуть этим ука-
зателем на странице, то изображение увеличится. В масштабе 100% текст
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документа будет отображаться на экране так же, как и на бумаге. Для измене-
ния масштаба страницы можно выбрать нужное значение в списке Масштаб
(Zoom) на панели предварительного просмотра. В этом же списке можно выб-
рать, сколько страниц, одна или две, должны отображаться на экране целиком.

Печать документа
Переключение между режимами просмотра и редактирования
Просмотр одной страницы
Просмотр нескольких страниц
Масштаб
Отображение линеек
Подгонка страниц
Режим полноэкранного просмотра

— Выход из режима предварительного просмотра

Рис. 13.3. Документ в режиме предварительного просмотра

Изменяя масштаб просмотра документа, вы не меняете реальный размер сим-
волов текста. Для изменения размера символов нужно выбирать другой раз-
мер шрифта.

2. Щелкните указателем мыши в ниде увеличительного стекла на одном из пунк-
тов маркированного списка в середине документа.

Word увеличит изображение документа, и вы сможете точно увидеть текст
письма. Обратите внимание на то, что в указателе мыши теперь находится не-
большой знак «минус». Если теперь щелкнуть на странице таким указателем,
масштаб просмотра снова будет уменьшен.

3. Еще раз щелкните на тексте письма. На экране снова будет видна целая стра-
ница.

4. Щелкните на кнопке Увеличение (Magnifier).
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Теперь указатель мыши примет вид вертикальной черты. Это означает, что в
режиме предварительного просмотра вы можете вносить изменения в доку-
мент, как в обычном режиме. Конечно, для внесения объемной правки в доку-
мент этот режим не очень удобен, но для добавления новых страниц или изме-
нения полей страницы он подходит довольно хорошо. Для переключения
между режимами просмотра и редактирования используется кнопка Увеличе-
ние (Magnifier).

5. Щелкните после шапки документа и перед датой письма.

6. Несколько раз нажмите клавиши Ctrl+Enter, чтобы вставить в документ не-
сколько символов разрыва страницы. Вы увидите, как вместо одной страницы
на экране появится несколько.

В режиме предварительного просмотра вы можете разместить на экране сразу
несколько страниц. Их можно просматривать в разных масштабах, чтобы оце-
нить те особенности документа, которые видны либо при близком, либо при
общем рассмотрении.

7. Щелкните на кнопке Несколько страниц (Multiple Pages) на панели предваритель-
ного просмотра. Перетащите указатель мыши вниз и вправо. На экране появит-
ся палитра с изображением доступных страниц, и вы сможете указать, сколько
страниц должно отображаться на экране одновременно (рис. 13.4).

•

Рис. 13.4. Вывод на экран нескольких страниц документа

Выведите на экран шесть страниц документа.

Теперь вы можете щелкать на разных страницах, увеличивая или уменьшая
их масштаб. Если перейти в режим редактирования, то напротив активной
страницы будут располагаться вертикальная и горизонтальная линейки.
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9. Отмените вставку символов разрыва страницы в документ. Обратите внима-
ние на то, что сокращение числа страниц сразу обнаружится.

10. Щелкните на последней странице документа. Заметьте, что на ней осталось
совсем немного текста. Сейчас мы сократим документ на одну страницу.

11. Щелкните на кнопке Подгонка страниц (Shrink to Fit). Эта кнопка сокращает
документ Word на одну страницу, если это возможно. При этом Word изменя-
ет размер шрифта, либо межстрочные интервалы, либо поля страницы так,
чтобы перенести небольшое количество текста с последней страницы доку-
мента на предыдущую.

12. Просмотрите результаты. Для этого щелкните на кнопке Увеличение (Magnifier)
и еще раз щелкните на странице.

Команда Вид > Миниатюры (View > Thumbnails) позволяет выводить на экран ми-
ниатюрные копии страниц одновременно с общим текстом документа. Эти ми-
ниатюрные копии служат для просмотра страниц, например, с точки зрения ком-
поновки материала, а также для облегчения перемещения в документе.

Печать документа

Для печати документов можно использовать;

• команду Файл » Печать (File » Print);

• сочетание клавиш Ctrl+P;

• кнопку Печать (Print) на стандартной панели инструментов.

При выборе команды Файл > Печать (File > Print) или при нажатии клавиш Ctrl+P
Word выводит на экран окно диалога Печать (Print). В этом окне диалога вы може-
те выбрать текущий принтер, изменить его свойства, указать диапазон печатае-
мых страниц, задать число копий документа и выбрать способ печати (например,
напечатать сразу несколько страниц на одном листе бумаги, соответственно
уменьшив их размер).

Если вы уже задали все параметры печати в этом окне диалога, то можете вос-
пользоваться кнопкой Печать (Print) на стандартной панели инструментов. При
этом окно диалога Печать (Print) на экран выводиться не будет, а документ сразу
отправится на печать на текущем принтере с текущими параметрами. Эта кнопка
удобна при выводе на печать нескольких документов со сходными параметрами
печати.

Упражнение 13.3. Печать из окна диалога печати

В этом упражнении вы познакомитесь с параметрами окна диалога Печать (Print).
Если вы или ваш системный администратор («главный по компьютерам*) уже
задали параметры своего принтера и не хотите их менять, то можете просто щелк-
нуть на кнопке Печать (Print).
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Прежде чем начинать печать из программы Word, проверьте настройки своего
принтера. Для этого выберите команду Файл > Печать (File »• Print) и щелкните на
кнопке Свойства (Properties) в верхней части окна диалога рядом с названием прин-
тера. Главное, на что следует обращать внимание при настройке принтера, это ре-
жим печати (цветной или черно-белый) и качество печати (оптимальное, нор-
мальное или экономичное). Коллеги не скажут вам спасибо, если вы выведете на
единственном в организации цветном струйном принтере сто страниц черно-бе-
лого текста с максимальным качеством печати. Во многих струйных принтерах
черный цвет образуется путем смешения трех цветов краски (голубого, пурпур-
ного и желтого), поэтому на черный цвет расходуется больше всего материалов.
При выводе на печать черно-белого документа не забывайте выбирать черно-бе-
лый режим печати.

1. Выберите команду Файл » Печать (File > Print).

На экране появится окно диалога Печать (Print), показанное на рис. 13.5. На-
звание текущего принтера отображается в списке в верхней части окна диа-
лога.
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Команда Вид > Чтение (View > Reading Layout) и кнопка Чтение (Read) позволяют
выводить на экран документ в виде набора страниц, пригодного для чтения с
экрана компьютера. Это представление документа содержит все необходимое
для работы с документом Word как с электронной «книжкой».

На вашем компьютере может быть установлено несколько разных принтеров.
Некоторые факс-аппараты также воспринимаются системой как принтеры,
и вы можете отправлять документы по факсу, просто «печатая» их на соответ-
ствующем принтере. Для выбора нужного принтера его название выбирается в
списке принтеров окна диалога Печать (Print). Выбранный принтер будет счи-
таться текущим либо до выбора другого принтера, либо до окончания сеанса
работы в Word. После закрытия и повторного запуска программы Word в спис-
ке принтеров первым снова будет стоять принтер, используемый системой по
умолчанию.

Для изменения принтера, который используется в системе по умолчанию,
выберите команду Пуск ь Насгройка > Принтеры, щелкните правой кнопкой
мыши на значке нужного принтера и выберите команду Использовать по
умолчанию. Этот принтер будет располагаться первым в списке принтеров в
окне диалога печати.

Сейчас мы выберем диапазон страниц для печати. Доступны следующие вари-
анты:

а Все (АН) — этот вариант выбран по умолчанию, печатаются все страницы
документа;

а Текущая (Currect page) — на печать выводится страница, в которой находит-
ся курсор;

а Выделенный фрагмент (Selection) — Word печатает только выделенный фраг-
мент (если в документе ничего не выделено, этот переключатель будет не-
доступен);

а Номера (Pages) — в этом поле вы можете явно ввести номера страниц, кото-
рые будут выводиться на печать; например, для печати первой, второй,
третьей и шестой страниц документа в текстовое поле можно ввести значе-
ния 1-3, 6.

В списке Включить (Print) можно выбрать вариант печати только четных или
только нечетных страниц. Эта возможность удобна, если вам нужно распеча-
тать документ на листах с двух сторон. В этом случае сначала печатаются
только нечетные страницы, а затем на той же бумаге — разложенные в обрат-
ном порядке четные страницы.

2. В группе Страницы (Page Range) установите переключатель Текущая (Current
Page) для печати текущей страницы.

3. В поле Число копий (Number of copies) введите значение 2. Word выведет на пе-
чать две копии текущего документа.

Флажок Разобрать по копиям (Collate) позволяет проводить сортировку несколь-
ких копий многостраничных документов при печати. Если этот флажок не уста-
новлен, то сначала печатаются несколько копий первой страницы, затем — не-
сколько копий второй и т. д. Если этот флажок установлен, сначала на печать
выводится одна копия целиком, затем вторая и т. д.
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В Word 2003 имеется возможность изменять масштаб страниц, выводимых на
печать. Вы можете, во-первых, выводить от одной до 16 страниц на одном листе
бумаги, уменьшая их размер, а во-вторых, масштабировать изображение на
странице по размерам доступной бумаги. Для задания этих параметров служит
область Масштаб {Zoom) в окне диалога Печать (Print).

4. Щелкните на кнопке ОК.

Советую вам всегда сохранять документ перед выводом на печать. В этом слу-
чае вы не потеряете свою работу, если при печати случится та или иная ошибка.

Чтобы отменить печать документа, достаточно выбрать команду Пуск > Настрой-
ка > Принтеры, в открывшемся окне дважды щелкнуть на значке нужного прин-
тера, в следующем окне (окне принтера) выделить название документа, отправ-
ленного в печать, и нажать клавишу Esc. Имейте в виду, что делать это нужно
быстро, пока принтер не успел приступить к печати документа. Если снять зада-
ние не удается, а печатать документ ни в коем случае нельзя, можете просто вы-
ключить принтер или вытащить из него бумагу (если это несложно). В этом слу-
чае принтер выдает сообщение об отсутствии бумаги, и в большинстве случаев
вы сможете спокойно отменить печать. Вытаскивая бумагу из принтера, не жад-
ничайте. Один или два потерянных листа бумаги не стоят ремонта сломанных
частей принтера.

Печать конвертов и наклеек

Все чаще можно встретить корреспонденцию, адреса на которой не написаны от
руки, а аккуратно отпечатаны. Многие принтеры позволяют выполнять печать на
конвертах, используя либо подачу их из специального лотка, либо ручную подачу.
Множество конвертов бесславно гибнет в недрах принтеров, которые очень любят
«жевать» их, но пользователи продолжают надеяться, что когда-нибудь печать кон-
вертов будет такой же удобной операцией, как печать обычных документов.

Хорошей альтернативой конвертам являются почтовые наклейки. Они выпуска-
ются в виде листов стандартного формата и имеют практически такую же толщи-
ну. Принтеры обычно гораздо лучше воспринимают не конверты, а именно
наклейки. Распечатав набор почтовых наклеек с одинаковыми или разными адре-
сами, вы можете отделить эти наклейки от пластикового основания и приклеить
на нужное место конверта. Более того, наклейки можно применять не только для
конвертов, но и для посылок и бандеролей. Word предоставляет много способов
работы с конвертами и наклейками.

Упражнение 13.4. Печать конвертов

Команда Сервис t Письма и рассылки * Конверты и наклейки (Tools > Letters and
Mailings > Envelopes and Labels) позволяет выполнять печать конвертов и наклеек,
а также задавать их параметры. Сейчас мы напечатаем конверт для нашего письма.

1. Выделите адрес получателя письма (начиная с его имени и фамилии).
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2. Выберите команду Сервис f Письма и рассылки > Конверты и наклейки (Tools >
Letters and Mailings > Envelopes and Labels).

На экране появится окно диалога Конверты и наклейки (Envelopes and Labels),
показанное на рис. 13.6. Выделенный адрес будет стоять в поле Адрес получате-
ля (Recepients Address), а в поле Обратный адрес (Sender's Address) размещаются
текущие данные о пользователе Word.

Адрес получателя

Адрес-
отправителя

i -жа Елена Цветков^
Референт-переводу
НИИМЕХМАШ
Трамвайный лр 2-21
1191457 Сэннт-Петег

When prompted by tbe (*>*«, frwert

Щелчок на этом поле открывает
окно диалога параметров конверта

на вкладке параметров конверта

Щелчок на этом поле открывает
окно диалога параметров конверта
на вкладке параметров печати

Рис. 13.6. Окно диалога Envelopes and Labels

Чтобы изменить данные о пользователе, выберите команду Сервис > Парамет-
ры (Tools > Options) и в открывшемся окне диалога щелкните на вкладке Пользо-
ватель {User Information). Здесь вы можете указать имя пользователя, его ини-
циалы и почтовый адрес.

3. Щелкните правой кнопкой мыши на выделенном адресе и в контекстном меню
выберите команду Шрифт (Font).

4. В открывшемся окне диалога можно изменить текущий шрифт адреса. Выбе-
рите шрифт Arial размером 11 пунктов.

5. Щелкните на кнопке ОК.

6. Установите флажок Не печатать (Omit) рядом с полем Обратный адрес (Return
address). Такой прием часто используется при печати конвертов на фирмен-
ных бланках, уже содержащих адрес отправителя.

7. Щелкните в области Образец (Preview). На экране появится окно диалога Пара-
метры конверта (Envelope Options), показанное на рис. 13.7.

В этом окне диалога вы должны выбрать формат конверта. Изучите список раз-
меров конвертов, предлагаемый Word. Если конверта требуемого размера в нем
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не окажется, выберите пункт Нестандартный размер (Custom size). В появившемся
окне диалога укажите точные размеры конверта (перед этим вам придется вос-
пользоваться линейкой). Здесь же вы можете указать точные координаты адре-
сов получателя и отправителя. На вкладке Параметры печати (Printing Options)
вам нужно будет указать способ подачи конвертов в принтер.

Шрифт и координаты адресов

Выбор размера
конверта

Рис. 13.7. Настройка параметров конверта

Обратите внимание на то, что не все из предложенных вариантов подачи кон-
вертов подойдут для вашего принтера. Сначала выясните, может ли ваш
принтер выполнять печать на конвертах, а если может, как следует вставлять
в него конверт. После этого выберите нужный вариант на вкладке Параметры
печати (Printing Options).

8. Выберите размер Сб.

9. Щелкните на кнопке ОК.

10. Вставьте конверт в принтер.

11. Щелкните на кнопке Печать (Print).

Упражнение 13.5. Печать наклеек

Наклейки создаются с помощью той же команды, что и конверты. Вы можете рас-
печатать как одну наклейку, оставив остальные наклейки на листе чистыми, так и
целую страницу одинаковых наклеек. Наклейки выпускаются самых разных фор-
матов. Наиболее известная марка наклеек— Avery. Если вам в руки попали на-
клейки какой-то неизвестной фирмы, то потрудитесь взять линейку и аккуратно
измерить все расстояния на листе с наклейкой. Если в списке доступных наклеек
вы не найдете своих, то сможете вручную указать параметры листа наклеек в окне
настройки их размеров.
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1. Выделите адрес получателя письма,

2. Выберите команду Сервис > Письма и рассылки » Конверты и наклейки (Tools >

Letters and Mailings K Envelopes and Labels).

3. В открывшемся окне диалога щелкните на вкладке Наклейки (Labels), показан-
ной на рис. 13.8. Выделенный адрес будет располагаться в текстовом поле. Вы
можете изменить его так же, как и для конвертов.

Печать листа одинаковых наклеек

Печать одной
наклейки

Щелчок на этом поле открывает
окно диалога параметров наклейки

Рис. 13.8. На этой вкладке можно настраивать параметры печати наклеек

Выбрав вариант Отдельная наклейка (Single Label), вы можете напечатать адрес
только на одной заданной ячейке листа. Кнопка Параметры (Options) позволя-
ет вам просмотреть доступные типы наклеек для матричных и лазерных
принтеров. Обратите внимание на то, что наклейки используются не только
для конвертов, но и для множества других вещей.

Наклейки для матричных принтеров должны обладать некоторыми особенными
свойствами. В частности, листы наклеек для принтеров такого типа часто снаб-
жаются перфорацией. Наклейки для лазерных и струйных принтеров не отлича-
ются друг от друга.

4. Щелкните на кнопке Параметры (Options).

5. В списке Сорт (Label products) открывшегося окна диалога (рис. 13.9) выбери-
те пункт Avery (А4 и А5).

6. В списке Тип (Product numbers) выберите пункт L7560.

7. Щелкните на кнопке ОК.

8. Вставьте в принтер лист с наклейками.

9. Щелкните на кнопке Печать (Print).

10. Сохраните изменения и закройте документ.
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Для матричных и лазерных
принтеров используются Для лазерных и струйных принтеров
различные типы наклеек можно выбирать лоток для подачи наклеек

Laser and ir>K jet Iray; jРучная подача бумаги

Label informaaon

Label 0-oducts; JAvery A-t and A5 &zes

- Product number! ; ;' .;

C2160- Sticker
C2163 - Sticker
C2166 - Sticker
C2 180 - Sticker

—7 -r Labd nf or

d - ТУИ:

Haght:

; ; Width:

C2212 - Sticker
C2243 - Sticker

Stater - '••'

3,1? cm f
7.62cm -

m<2J3=29.?cm3

В этом поле отображаются
параметры наклеек
текущего типа

Щелкните на этой кнопке, чтобы
создать новый тип наклеек на основе текущего

Щелкните на этой кнопке, чтобы изменить
параметры наклеек текущего типа

Рис. 13.9. Настройка параметров наклеек

Контрольное занятие

На этом занятии мы закрепим навыки предварительного просмотра документа и
его вывода на печать.

1. Выберите команду Файл > Создать (File t New).

2. В открывшемся окне диалога щелкните на вкладке Отчеты (Reports) и дважды
щелкните на значке Современный отчет (Contemporary report).

3. Щелкните на кнопке Предварительный просмотр (Print Preview).

4. Выведите на экран сразу все страницы получившегося документа.

13.1. Как можно изменить масштаб предварительного просмотра документа?

5. Увеличьте масштаб отображения второй страницы документа.

13.2. Как увидеть документ, максимально похожий на печатную копию?

6. Перейдите в режим редактирования.

13.3. Как определить, что документ находится в режиме редактирования?
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7. Вставьте символ разрыва страницы перед последним абзацем второй стра-
ницы.

8. Выполните подгонку страниц в документе.

Э. Выберите команду Файл > Печать (File > Print).

13.4. Как распечатать документ с текущими параметрами?

10. Выведите на печать текущую страницу документа.

11. Выйдите из режима предварительного просмотра.

12. Выведите на печать одну наклейку с вашим домашним адресом.

13.5. Как изменить параметры листа наклеек?

13. Закройте документ, не сохраняя изменений.

Возможные проблемы

Проблемы Решение

Мой документ Прежде ксего проверьте, подключен ли принтер
не печатается к компьютеру и включен ли он в сеть. Выберите нужный

принтер в окне диалога Печать (Print)

Я применил вертикальное Чтобы изменить выравнивание только для первой страницы,
выравнивание на первой вставьте после нее символ разрыва раздела, затем щелкните
странице, но теперь весь на ней, выберите команду Файл > Параметры страницы
текст моего документа (File » Page Setup) и примените вертикальное выравнивание
выровнялся таким к текущему разделу, а не ко всему документу
же образом

Я выполнил в документе Если вам не нравится результат подгонки страниц, нажмите
подгонку страниц, клавиши Ctrl+Z, чтобы отменить последнюю операцию.
но после этого Советую вам сначала сохранить документ, а потом
документ выглядит выполнить подгонку страниц, вывести документ на печать
просто ужасно и закрыть, не сохраняя изменений

Подведение итогов

На этом занятии вы научились выводить на печать документы, конверты и почто-
вые наклейки. На следующем занятии мы рассмотрим альтернативный способ
представления документов пользователям — их публикацию в World Wide Web
(WWW) или корпоративной сети.



Занятие 14

Работа с веб-страницами в Word

Тема занятия

На этом занятии вы научитесь:

• сохранять документы Word как веб-страницы;

• просматривать веб-страницы в режиме веб-документа;

• создавать гиперссылки;

• оформлять веб-страницы с помощью тем.

Подготовка к занятию

Для этого занятия вам понадобится доступ в Интернет, а также адрес на одном из
веб-узлов, предназначенных для хранения веб-страниц. По поводу получения ад-
реса вам потребуется связаться с веб-мастером или системным администратором.

К окончанию занятия вы создадите документ, показанный на рис. 14.1.

Word и World Wide Web

Как известно, World Wide Web — это система документов, связанных между со-
бой гиперссылками. Гиперссылки позволяют переходить от одного документа к
другому. Документы могут вгслючать текст, рисунки, аудио- и видеофайлы. Для
форматирования документов в формате HTML (основной формат файлов World
Wide Web) существуют некоторые ограничения. Например, в этих документах
без специальных ухищрений обычно не удается разместить текст в нескольких
колонках, а также не удается выровнять его по обоим краям страницы.
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'»еи -Insert Ffinnat locfe Tjble (Jflndow

Уважаемая г-жа Елена Цветкова!

. 1 Мы рады сообщить Вам, что по итогам опроса «Лучшая детская книга», проведенного нашим
мзга-эинбм, лучшей была признана кни-з «Русские народные сказки». Все читатели, которые подали

;СВ5>и голоса за эту книгу, награждаются ценными приими от нашего магазина. Вы можете зайти к
нам в удобное для Вас время и получить свой приз.

. Кроме того, предъявив это письмо, вы можете приобрести в нашем магазине любое
изданий с 4Ш скидкой.

.Ниже перечислены некоторые издания, на которые мы особенно хотели бы обратить Ваше
. Надеемся, что Вам понравягся эти к1чиги.

^ Сказки народов мира
* Английский дтд детей (книга и аудиокассета)
& Спокойной ночи. Сборник детских песенок (книга и аудиокассета)

Щ

Рис. 14.1. Веб-документ

Каждая веб-страница представляет собой обычный текстовый файл с указанны-
ми в виде команд параметрами форматирования для текста, графики и гиперссы-
лок. Этот файл называется источником HTML, поскольку соответствующие ко-
манды записаны в формате языка разметки гипертекста (Hypertext Markup
Language, HTML). Браузер (программа, позволяющая читать информацию в до-
кументах World Wide Web) распознает веб-страницу и отображает ее на экране
так же, как в режиме веб-документа это делает Word.

На этом занятии мы увидим, что в режиме веб-документа текст удобно читать,
так как он отображается крупными буквами и строки автоматически переносят-
ся, адаптируясь к ширине страницы. В этом режиме просмотра текст можно ре-
дактировать и форматировать.

Вы также можете вставлять аудио- и видеофайлы в свои веб-страницы в Word.
Затем читатель при просмотре вашей веб-страницы сможет воспроизвести звуко-
вой файл или просмотреть видеоклип.

После преобразования документа Word в веб-страницу вы должны опубликовать
ее в Интернете, отправив на FTP-узел или сохранив ее на сервере корпоративной
сети. FTP (File Transfer Protocol) — это протокол (набор команд), который ис-
пользуется в Интернете для передачи файлов между компьютерами. Для просмот-
ра файлов удобнее другой протокол — HTTP (Hypertext Transfer Protocol). Эти
протоколы позволяют передавать созданные вами файлы на удаленные компью-
теры, где их смогут просматривать другие пользователи.

После публикации документа в Интернете вы можете просмотреть его в веб-бра-
узере с помощью команды Файл > Предварительный просмотр веб-страницы
(File > Web Page Preview). Иногда бывает полезно также установить соединение с
Интернетом с какого-либо другого компьютера и просмотреть свою страницу.
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Если вам это удастся, значит, подавляющее большинство остальных пользовате-
лей тоже смогут ее увидеть.

Упражнение 14.1. Сохранение документа Word
как веб-страницы

В версии Word 2003 формат файлов Интернета (HTML) используется как один
из форматов Word. Это значит, что вам может и не потребоваться специальное
преобразование документов Word в формат Web. Если вы открываете уже гото-
вую веб-страницу, то Word автоматически будет сохранять ее в этом же формате.
Если вы начинаете работу с документом в Word, то для преобразования его в фор-
мат, пригодный для Интернета, вам понадобится специальная команда сохране-
ния. Сейчас мы создадим документ, внесем в него некоторые изменения и сохра-
ним как веб-страницу.

1. Откройте файл Книжное обозрение.doc, который мы создали на одном из пре-
дыдущих занятий.

2. Выберите команду Вид > Разметка страницы (View > Print Layout).

Вы увидите документ, оформленный в несколько колонок (рис. 14.2).

Aai -Шг-mWl Wr

F£rmat look Ij

S-i NornsltfTstlti^. Tirres New Rornsi £ 11 &1Я- №
^р^аиаю»Ьл,-.-ч-"':̂ .«.=.о»..>-в.4;. ..-
Т- •"• г'- ' : э " i : i • ' < • i ". • 6 • i • 7 • essWi'l*1" -;

Вы хотите сампстолтельно освоить
новую версию операционной системы,
популярный программный продукт или
просто научиться рабтать на
компьютере? Вам помогут книги серии
к Самоучите ль в — лучший выбор для
пользователя!

Выкотите самостоятельно освоить
новую версию операционной снсгеми.
популярный программный продукт или

Д1 В,5оП 1Л ̂  flol И

просто научиться рабтать на
компьютере? Вам помогут книги серии
«Самоучитель» — лучший выбор для
пользователя!

Вы хотите самостоятельно освоить
новую версию операционной системы,
популярный программный продукт или
просто научиться рабтать на
компьютере? Вам помогут книги серия
«Самоучителем —лучший выбор для
пользователя!]

Вы хотите самостоятельно освоить

Иогааг <йи Ш '

Рис. 14.2. Документ до преобразования в веб-страницу

3. Выберите команду Файл > Сохранить как. веб-страницу (File t Save as Web Page).

На экране появится окно диалога Сохранение документа (Save As), показанное
на рис. 14.3. В нем вы можете выбрать компьютер, диск или папку для сохра-
нения документа. Кроме того, вы можете указать имя файла и его формат. Для
задания заголовков веб-страниц служит кнопка Изменить заголовок (Change
Title), Давайте сохраним веб-страницу в нашей рабочей папке.
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Заголовок — это имя документа, под которым он будет опубликован в Интерне-
те. Различные поисковые системы используют содержание таких заголовков для
первоочередного поиска. Если вы хотите, чтобы ваши документы легко можно
было найти в огромном количестве опубликованных в Интернете материалов,
старайтесь давать им содержательные заголовки.

Имя файла
Кнопка для изменения
заголовка веб-страницы

V,v.' Л-.

I - Savf'fi; j]. \ Мэпдокуиент

: uJ - ^
: My Recent
, Documents

l:; "-Ш* .
Oes&cp |

-J .
: My Documents '•

-"Qj$* ':• -- i
| . МУ СОтриЕвГ " U ••-.,". v. ..----.-.;--

; , Pag^tlfc Кип

: ~^f Filename . JKHH
• M*Net*uork - - ] .

'

^ ;̂ g - '2i i 4 -

*ное обозрение ^. , .

_i ĵ] - Tools-

•• : :--- -- --••: .•••!••'•- ---:.-----.- ..:

[Mi -
иное обозрение. rrht jj: " : j. ; ;-§№№;̂ __' |

Places Savi;a5&pei IsngteFile Web Page (*.mht; *,mhtml) *lv Cancel^" i
•'--- ': :-: ' . . . '"'-

Чтобы сохранить документ как веб-страницу,
в качестве типа файла должна быть указана веб-страница

Рис. 14.3. Сохранение веб-страницы

4. Щелкните на кнопке Мои документы (My Documents). На экране отобразится
содержимое папки Мои документы.

5. Дважды щелкните на значке Работа.

6. Выделите имя файла в поле Имя файла (File name).

7. Введите имя Мой веб-документ.

8. Щелкните на кнопке Сохранить (Save).

Word преобразует документ в формат HTML, чтобы его можно было просматри-
вать в Интернете (рис. 14.4).

Обратите внимание на то, что теперь документ отображается на экране без коло-
нок. Они могут выводиться на экран в режиме разметки страницы, но при про-
смотре в окне браузера они отображаться не будут (рис, 14.5).

При сохранении документов в формате обычной веб-страницы (HTML, HTM) Word
сохраняет графику и другие объекты из этого документа в отдельных файлах.
При сохранении документов в формате веб-архива— единой веб-страницы
(МНТ, MHTML) — Word сохраняет графику и другие объекты из этого документа
в том же файле.
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Рис. 14.5. Наша страница в окне браузера

Упражнение 14.2. Просмотр веб-страницы в Word

Режим веб-документа позволяет выводить на экран документы Word в том виде,
в котором они будут отображаться на экранах компьютеров пользователей в окне
программы просмотра. Вид страницы в окне программы просмотра (браузера) мо-
жет зависеть от типа этой программы.
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В настоящее время активно ведется работа по стандартизации команд языка
HTML. Это делается для того, чтобы обычные пользователи не страдали от по-
следствий конкурентной борьбы между производителями браузеров.

Word отображает веб-страницу так, как она будет отображаться в браузере ком-
пании Microsoft, так как сама программа Word создана этой компанией. Некото-
рые отличия могут наблюдаться для отдельных параметров форматирования, на-
пример, горизонтальных линий или таблиц. Предпочтительнее вставлять в
веб-документы горизонтальные линии из коллекции картинок.

Чтобы протестировать совместимость вашей веб-страницы с другими браузера-
ми, вам потребуется закрыть ее после сохранения и затем открыть в нужном бра-
узере. Если внешний вид страницы будет вас удовлетворять, то никаких допол-
нительных изменений в документ вносить не нужно. Сейчас мы посмотрим на
текущий документ в режиме веб-документа.

1. Если ваш документ еще не отображается в этом режиме, щелкните на кнопке
Режим веб-документа (Web Layout View).

Легко заметить, что в этом режиме документ отображается символами более
крупного размера и длинные строки переносятся автоматически, как показано
на рис. 14.6 (на экране бегунок горизонтальной полосы прокрутки занимает
всю полосу).

такое
Вы хотите самостоятельно освоить

системы, популярныП программный продукт плн просто
компьютере? Вам помогут книги серии <<0шоучйт«ль>* -~:лушшП выбор для
пользователя!".
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системы, популярный программный продукт н.Чп'просто няу^шться рай-тать т
компьютере'* Вам помогут книги серии <*Само>гштель» — луюшй"выбор'-для
лошловатегтя1 » - '.' ' « - * - ; " -/ . .: -
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— Обычный режим
Режим веб-документа
Режим разметки страницы

—Режим структуры

Рис. 14.6. Кнопки для переключения режимов просмотра
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2. С помощью вертикальной полосы прокрутки просмотрите весь документ.

3. Выберите команду Вид > Обычный (View > Normal).

4. Закройте документ.

Теперь ваш документ готов к отправке на удаленный компьютер. При этом кроме
самого документа па компьютер нужно отправить все вспомогательные файлы
(графические или звуковые). Для выполнения этой операции обратитесь к сис-
темному администратору. От вас потребуется только ясно сформулировать, чего
вы хотите. Среди готовых фраз можно назвать следующие: «Я хочу сделать свои
документы доступными в локальной сети»; «Я хочу опубликовать свои докумен-
ты в Интернете».

Гиперссылки

Гипсрссылкой называется текстовый фрагмент или другой объект, который свя-
зывает текущий документ с другими веб-документами. Для создания гиперссы-
лок вы можете использовать мастер создания веб-страниц или расставить ги-
перссылки в документе вручную. Гиперссылки могут понадобиться для перехода
между документами Word, Excel, Access и PowerPoint, Кроме того, гиперссылка
позволяет перейти к конкретному месту в том же документе. Формат гипер-
ссылки включает адрес объекта перехода. Это может быть путь к документу на
локальном диске (с:\Мои документы\Работа\Файл.doc), путь к документу в локаль-
ной сети (\\our_server\users\my_folder\my_docyment.doc) или адрес документа в
Интернете (http://www.my_server.com\web_folder\web_document,html). Когда вы
щелкаете на гиперссылке в документе, соответствующая программа открывает
документ, на который указывает эта гиперссылка. При работе с документами из
пакета Office 2003 Word будет открывать эти документы в собственном окне.
Если гилерссылка указывает на документ другого тина, он будет открыт в своей
программе.

Гипертекстовые документы составляют подавляющее число всех документов
в World Wide Web. Это происходит потому, что гиперссылки значительно об-
легчают переход между связанными документами для пользователей- Пред-
ставьте себе, что вы опубликовали в Интернете один из рекламных проспек-
тов своей компании. На первой странице этого документа можно поместить
только краткое введение и оглавление документа. Элементы оглавления бу-
дут служить гиперссылками для перехода к соответствующим разделам про-
спекта. Пользователь сможет щелкать на названиях интересующих его разде-
лов, и программа просмотра будет отображать на экране связанные части
документа. Вернувшись назад к оглавлению, пользователь сможет выбрать
другой раздел для просмотра.

Для перехода между веб-документами Word предлагает несколько полезных ин-
струментов. На панели Веб-узел (Web) отображается список адресов нескольких
последних просмотренных документов. Кроме того, для перехода между докумен-
тами можно использовать кнопки Вперед (Forward) п Назад (Back).

9 Зак. 481
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Упражнение 14.3. Создание гиперссылок

В этом упражнении мы создадим страницу с несколькими гиперссылками.

1. Создайте новый документ и сохраните его под именем Гиперссылки.

2. Введите текст Адрес в Интернет издательства «Питер» приведен ниже: и нажмите
клавишу Enter.

3. Выберите команду Вставка > Гиперссылка (Insert > Hyperlink).

4. В открывшемся окне диалога Добавление гиперссылки (Insert Hyperlink) в поле
Адрес (Address) введите http://www.piter.com, как показано на рис. 14.7.

Ссылка на существующий
файл или веб-страницу

Ссылка на — .
определенный

объект в текущем
документе (начало

документа,
заголовок

или закладку)

Ссылка на
новый документ

Ссылка на адрес —
электронной почты

iir*

Щелкните на этой кнопке,
чтобы ввести текст всплывающей
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на экране при наведении указателя

мыши на гиперссылку
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-: Twi Моидолуийнты *1 ftTlj 1̂ QgjJ

S'̂ &j Aft.ooc •#> .. feoMidf t- • i \ •
JflE ¥£j Eleganf Fa^.doc , .: , ~""r;"~' - - -:

: ite Elffganf Fax. dot . . TargetFfarw.,. \

•'**&
growiatf :̂ J Книжное o6owenn*.doc
Pagts '- ]̂ Кононт i4yrbi.doc
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f
.-. ^ - Addtg

- :'-£
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Список недавне

"!-_??n^S~ . I —:-.::. ,..-.. ,^_ :.У - ...: ^
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Адрес Список
открывавшихся файлов для гиперссылки вставленных

гиперссылок

Рис. 14.7. Окно диалога добавления гиперссылки

5. Щелкните на кнопке ОК.

Теперь после введенного вами текста в документе появился адрес сервера Ин-
тернета.

6. Удерживая нажатой клавишу Ctrl, поместите указатель мыши на гиперссылку.
Указатель примет вид руки с вытянутом указательным пальцем.

7. Повторив шаги 3-5, создайте еще несколько гиперссылок на знакомые вам веб-
узлы.

8. С новой строки введите текст Ссылка на документ Word: и нажмите клавишу
Enter.
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9. Выделите введенное вами предложение.

10. Выберите команду Вставка > Гиперссылка (Insert > Hyperlink).

11. Щелкните на кнопке Файл (Existing File or Web Page) в окне диалога Добавление
гиперссылки (Insert Hyperlink), На экране появится окно, содержащее список
файлов, доступных на вашем компьютере или в локальной сети.

12. Перейдите в папку Работа, расположенную в папке Мои документы.

13. Дважды щелкните на значке файла Книжное обозрение.doc,

14. Щелкните на кнопке ОК.

15. Удерживая нажатой клавишу Ctrl, наведите указатель мыши на последнюю
созданную вами гиперссылку.

16. Один раз щелкните на гнперссылке (рис. 14.8).

Адрес в Интернет издательства «Питер» приведен ниже

examptesWOH лСкучепты1Кн>1*ное
Ш?.: Ji WW sv jriiii ̂  nj.:. с боэрение. doc

CTRL + dick to follow link

Ссылка кадокукевтЛ

-

Ш Ъ ВД Ji j _j

AlPrTB»tsam2003

Рис. 14.8. Для перехода по гиперссылке достаточно щелкнуть на ней один раз

Word откроет файл Книжное обозрение.doc в своем окне.

17. Закройте оба открытых файла, сохранив изменения.

По умолчанию для перехода по гиперссылке нужно щелкнуть на ней, удерживая
нажатой клавишу Ctrl. Это удобно, так как теперь с текстом гиперссылок можно
работать так же, как и с остальными текстовыми фрагментами Word. В раних
версиях приходилось применять специальные ухищрения, чтобы, например,
выделить текст гиперссылки с помощью мыши. Если вы все же хотите обойтись
без этой клавиши, выберите команду Сервис > Параметры (Tools * Options),
щелкните на вкладке Правка (Edit) и снимите флажок Ctrl + щелчок для выбора
гиперссылки (Use Ctrl + click to follow hyperlink).
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; Если щелкнуть на гиперссылке правой кнопкой мыши, вы увидите список дос-
тупных команд для работы с гиперссылкой.

Упражнение 14.4. Применение темы к веб-документу

Вы сможете выбрать тему оформления веб-страниц. В тему входят параметры
форматирования различных элементов страниц. Тема включает не только набор
стилей, применяемых для оформления документа, но и необходимые графиче-
ские файлы, которые часто можно встретить на просматриваемых веб-страницах.

1. Для применения темы выберите команду Формат > Тема (Format t Theme).

2. В появившемся окне диалога вы увидите список доступных тем. Выбирая тему
в списке слева, вы сможете видеть образцы оформления различных элементов
веб-страниц в области предварительного просмотра справа (рис. 14.9).
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Рис. 14.9. Выбор темы ДЛР веб-страницы

3. Выберите понравившуюся вам тему и щелкните на кнопке ОК.

Если при выборе темы в окне не появляется примера оформления документа,
то, возможно, вам придется установить дополнительные темы для веб-страниц
с компакт-диска Office 2003.
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Контрольное занятие

На этом занятии мы создадим документ для публикации в Интернете и отправим
его в одну из веб-папок.

1. Откройте файл Письмо со списком.doc.

2. Сохраните его как веб-страницу с заголовком Веб-письмо.

14.1. Как определить, что документ сохраняется в формате файлов для Интернета?

3. Просмотрите получившийся документ в режиме веб-документа.

14.2. Как переключаться между режимами просмотра документов в Word?

4. Перейдите в обычный режим просмотра.

5. Примените к документу тему Перетекание (Blends).

6. Выделите слова Красота и мир.

7. Создайте гиперссылку на файл Мой первый пример.doc.

8. Сохраните документ как веб-страницу в форматах МНТ и HTML.

14.3. Какие еще дополнительные документы, кроме основного веб-документа, будут
сохранены в папке?

9. Закройте документ.

Возможные проблемы

Проблема Решение

Я не вижу команды для Эта команда содержится в полной версии меню,
сохранения всб-страииц Чтобы вывести ее на :жран, задержите указатель мыши
в меню Файл (File) на открытом сокращенном варианте меню

При использовании В списке Тип файла (Save as type) окна диалога Сохранение
команды Файл > документа (Save As) выберите пункт Веб-страница
Сохранить как (Web Page)
(File > Save As) Word
предлагает сохранить
мой документ
в формате обычных
документов Word

Я добавил в документ Фон документа можно вывести па экран в режиме
фон, а он веб-документа. Чтобы перейти в этот режим, выберите
не отображается команду Вид * Режим веб-документа (View > Web Layout)
па экране
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Проблема Решение

Как создать гиперссылку В документах Word должны быть созданы закладки или
на конкретное место заголовки, оформленные с помощью стилей, в таблицах
в документе? Excel — диапазоны ячеек, в других документах для таких

гмпсрссылок могут использоваться иные способы выделения
элсмеитовлокумента. При организации гиперссылки
па конкретный объект в текущем документе сначала надо
щелкнут!) на кнопке Разместить в документе (Place in This
Document), а затем выбрать название нужного объекта
(закладки, заголовка или начала документа) в списке справа

Подведение итогов

На этом занятии вы научились преобразовывать созданные ранее в Word доку-
менты в формат веб-страниц, сохранять эти страницы на удаленном компьютере,
работать с гиперссылками, создавать собственные документы для Web с помощью
мастера, а также работать с темами документов.

В приложении А вы найдете практические упражнения по созданию всевозмож-
ных документов со ссылками на соответствующие занятия, на которых мы ра-
ботали над документами подобного типа. Используйте это приложение, чтобы
подобрать необходимый вам тип документа. Прилагаемые рисунки позволят
представить себе конечный результат,

Ответы на вопросы контрольных занятий находятся в приложении Б.



Приложение А

Практические задания

Письмо
Напишите письмо мэру вашего города и изложите в нем свои предложения по
благоустройству городской территории и ее озеленению. Начните письмо со сво-
его имени и адреса, оформленных в виде шапки. Вставьте в документ текущую
дату. Используйте маркированный список для перечисления доводов в пользу
изменения существующей практики работы коммунальных служб. Попробуйте
опубликовать это письмо в Интернете.

Информация о создании писем и списков содержится на занятиях 2 и 7. Заня-
тие 14 поможет вам опубликовать документ Word в Интернете.

Служебная записка

Напечатайте служебную записку, адресованную своему непосредственному на-
чальнику, и сообщите в ней свой новый адрес электронной почты и телефон.

При создании служебной записки воспользуйтесь материалом занятия 6.

Таблица ценностей для страховой
компании

Создайте таблицу со списком своего движимого и недвижимого имущества для
расчета страхового взноса в страховую компанию. Б столбцы таблицы включите
название, описание и страховую стоимость каждого предмета.

При создании таблиц воспользуйтесь навыками, полученными на занятии 12.
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КОЗЬМА ПРУТКОВ
ПР. ЖЕМЧУЖНИКОВЫК, 12, СО ЕСТ В. ДОМ.

С.ПЕТЕРБУРГ, 19» US

Мэру г. Приозерск
В. П. Петрову
уч Централшая. 9
Приозерся, 139873

Басилий Петрович!

7ноя6ря20Мг.

Будучи проездом в вашем городе, обратил вникание на необиодимость бопе*
тщательного ухода sa городсгой территорией Б частности, среди неотложных мер я бы
назвал следукшфе:

• установка мусорных баков на городском пляже,

• очистка территории детсадк площадок от строительного и бытового мусора,

• усиление ответ ственнОсзк хозяев sa поведена t домашних животных (собак) на

Рис. А.1 . Внешний вид письма

I 'i, . ;.> , .-.-, .-; .,

• 55в» frraSft FprinaC" X0?^

'*~*' ""••' '* ' |У1УйЙ
^,:,,-.,V.s.,3.,;4-.

Служебная записка
т*: Дмитрий Сергеев

Ггам: Игорь Иванов

СС: Владимир Иванов, Сергей Петров, Петр Сергеев

Da«: 1Ш2003

FU: Мой новый адрес]

Мой новый домашний адрес электронной почты

Но вый домашний телефон1 327-45-87

1 1Д fit 9,7cm Ln 7 Cd Л ;' -• -.'• ';' • Russian

Рис. А.2. Служебная записка
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Рис, А.З. Опись движимого имущества

Резюме
Создайте свое резюме (краткая информация о вашей трудовой биографии), ис-
пользуя для этого один из шаблонов Word. Введите в него свои данные, а также
добавьте фотографию и другую графику.

Для получения информации об использовании шаблонов обратитесь к заня-
тию 10. Вставка графики рассматривается на занятии 9.

Смета расходов на ремонт
Создайте смету расходов на ремонт своей квартиры. Она понадобится, когда бу-
дете обсуждать с подрядчиком условия оплаты. Если вы поместите в такую таб-
лицу информацию обо всех возможных расходах, то будет легче контролировать
расходование своих средств па ремонт.

Работа с таблицами рассматривается на занятии 12.

Семейный бюллетень

Попробуйте создать собственную семейную газету. Пусть ваши дети играют в жур-
налистов, супруга назначьте главным редактором, а себе отведите скромное место
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спонсора. Не забудьте привлечь бабушек и дедушек в качестве самых активных
читателей.

Для создания бюллетеня вам пригодятся навыки, полученные на занятии 11.

Цетъ
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Найти рвбог/ по душа нсозместлтълювимо! гот ю

Г!решфклтаг аБашмачо»

F^w> води гель г

т ч ; ш •: у •

1 1R АИ 6,5сп> 1л 6 Cut H RuMtmffiu1 ЩГ

Рис. А.4. Резюме
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Смета расходов на ремонт

Вид работы
Вьфавннванне цененгного

nan;i
Наспи пиркета
Покрытие стен
(птсокарюн)

Установка навесных
по&ижов

Оклейка стен обоями
Замена дверных короток

CjlOKJI ВЬШО.т«ГШ1Я

-4 дня

,- днен
5 дней

8 дней

-1 дня
3 дня

Стоимость УСЛУГ
15000руб.

25 000 р\'б.
20 000 руй.

15 000 руб.

5 000 руб.
25 000 руб.

l^jfj -•-.;
речам-.doc": ?73cb*artt»s(anappiK<lrriate'.efcje).

Рис. А.5. Смета расходов на ремонт
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Рис. А.6. Бюллетень

Отчет о проделанной работе
Создайте многостраничный отчет о работе вашего садоводческого товарищества.
Поместите в него информацию о сборе членских взносов, расходовании средств
товарищества, объемах выполненных работ, проведенных мероприятиях и пла-
нах па будущее. Используйте средства проверки орфографии для поиска ошибок
в документе. Сохраните особые элементы форматирования в виде стилей.

На занятии 3 рассматриваются вопросы перемещения в документах и добавле-
ния символов разрывов страниц. Занятие 8 содержит информацию о работе со
стилями. Вопросы проверки орфографии и грамматики освещаются на занятии 5,

Карточки, фанты, визитки

Создайте набор карточек, чтобы раздать их всем гостям, которых вы пригласите
на свой день рождения. Для размещения па странице нескольких карточек не-
большой величины можно использовать таблицу. Если вы хотите создать поздра-
вительные открытки или веселые объявления и сделать их яркими и разнообраз-
ными, задействуйте средства обрамления. Примените декоративный шрифт,
выравнивание по центру страницы и графику из коллекции картинок, чтобы сде-
лать документ интересным.

Информация о форматировании символов и абзацев содержится на занятии 6,
Средства обрамления рассматриваются на занятии 11.
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Рис. А.7. Отчет о проделанной работе
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Рис. А. 8. Открытка

Персональная веб-страница

Создайте собственную веб-страницу, поместите в нее свои личные данные и опуб-
ликуйте в Интернете. В этом случае опубликованная информация станет достоя-
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нием широких кругов компьютерной общественности. Размещая какие-либо све-
дения в Интернете, помните, что па веб-страницах не должно содержаться ничего
такого, чего вы не решились бы опубликовать в обычной газете или даже просто
сказать вслух со сцены перед небольшим собранием. То, что вы не видите конеч-
ного читателя ваших страниц, не означает, что вы можете писать все, что заблаго-
рассудится.

Оформите страницу с помощью тем. Вопросы создания и оформления веб-стра-
ниц мы рассматривали на занятии 14.

'•Моя в*РЩ)«таШШ -wtcieiait W»H
Ffc E* 'tew Inso/'. For^h Inols TiLi

Содержание

т
Где я работаю

Рис. А. 9. Личная веб-страница



Приложение Б

Ответы на вопросы
контрольных занятий

Занятие 1

1.1. Что означают три кнопки в верхнем правом углу окна программы ?

В верхнем правом углу окна программы находятся кнопки Свернуть, Развер-
нуть или Свернуть в окно и Закрыть. Назначение этих кнопок очевидно из их
названий.

1.2. Что делать, если вы забыли назначение какой-либо кнопки на панели инстру-
ментов?

Если вы забыли назначение какой-либо кнопки на панели инструментов,
нужно навести на нее указатель мыши, подождать несколько секунд и затем
прочитать всплывающую подсказку.

1.3. Сколько имеется способов для выхода из программы Word и какие это способы ?

Для выхода из программы Word имеется 7 способов:

а выбор команды Файл > Выход (File > Exit);

Q нажатие сочетания клавиш Alt+F4;

Q щелчок на кнопке Закрыть в окне приложения;

Q щелчок на значке Word в левом конце строки заголовка окна и выбор в
раскрывшемся меню команды Закрыть (Alt+F4);
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Q двойной щелчок на значке Word в левом конце строки заголовка окна;

а щелчок правой кнопкой мыши на строке заголовка окна Word и выбор в
контекстном меню команды Закрыть (Alt+F4);

а щелчок правой кнопкой мыши на кнопке документа Word на панели за-
дач и выбор в контекстном меню команды Закрыть (Alt+F4).

Занятие 2

2.1. В чем разница между клавишами BackSpaceu Delete?

Нажатие клавиши Backspace ведет к удалению символа слева от курсора,
а клавиши Delete — справа.

2.2. Как создать красную строку абзаца?

Чтобы создать в абзаце красную строку, нажмите клавишу Tab в начале пер-
вой строки абзаца.

2.3. Как отображать и скрывать значки абзацев и пробелов?

Отобразить или скрыть значки абзацев и пробелов позволяет кнопка Непе-
чатаемые знаки (Show/Hide) па стандартной панели инструментов или клави-
ши Ctrl+Shift+8.

2.4. Что нужно сделать, чтобы сохранить файл а формате Word 6.0/95?

Чтобы сохранить файл в формате Word 6.0/95, нужно выбрать этот тип
файла в списке Тип файла (Save as type) окна диалога Сохранение документа
(Save As).

2.5. Как быстрее всего закрыть документ?

Быстрее всего закрыть документ можно с помощью клавиш Ctrl+W.

2.6. Как можно открыть документ, с которым вы недавно работали?

Чтобы быстро открыть документ, с которым вы недавно работали, нужно
выбрать его название в списке недавно открывавшихся файлов меню Файл
(File).

2.7. Как отобразить информацию о документе в окне диалога Открытие документа
(Open)?

Чтобы отобразить информацию о документе в окне диалога Открытие доку-
мента (Open), нужно раскрыть список Представления (Views), который имеет-
ся на панели инструментов этого окна диалога, и выбрать пункт Свойства
(Properties).

2.8. Как узнать, в каком режиме ввода в данный момент работает Word?

В режиме замены буквы на индикаторе ЗАМ (OVR) в строке состояния вы-
глядят яркими.
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Занятие 3

3.1. Как увидеть крайнюю правую границу документа?

Чтобы увидеть крайнюю правую границу документа, нужно переместить бе-
гунок на горизонтальной полосе прокрутки в крайнее правое положение.

3.2. Какое сочетание клавиш, используется для перемещения в конец документа?

Для перемещения в конец документа используется сочетание клавиш
Ctrl+End.

3.3. Чем различаются автоматический и принудительный разрывы страницы?

Положение автоматического разрыва страницы может изменяться в зависи-
мости от изменения объема текста в документе. Символ принудительного
разрыва страницы всегда остается на одном и том же месте.

Занятие 4

4.1. Как выделить только одну строку документа?

Чтобы выделить только одну строку документа, щелкните на левом поле
страницы напротив нужной строки.

4.2. Какое сочетание клавиш используется для перемещения фрагмента в буфер
обмена ?

Для перемещения фрагмента в буфер обмена используется сочетание кла-
виш Ctrl+X.

4.3. Как вывести на экран область задач. Буфер обмена (Clipboard)?

Чтобы вывести на экран область задач Буфер обмена (Clipboard), выберите ко-
манду Правка > Буфер обмена Office (Edit > Office Clipboard).

4.4. Какое сочетание клавиш используется для отмены последнего действия?

Для отмены последнего действия используется сочетание клавиш Ctrl+Z.

4.5. Какое сочетание клавиш используется для изменения регистра символов вы-
деленного фрагмента ?

Для изменения регистра символов выделенного фрагмента используется со-
четание клавиш Shift+F3.

Занятие 5

5.1. Как лучше поступить, если система проверки орфографии выделяет имя соб-
ственное?

Если система проверки орфографии выделяет имя собственное, оптималь-
ным решением будет выбор и контекстном меню команды Добавить (Add to
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dictionary), чтобы система внесла это слово в словарь.

5.2. Какможно исправить ошибки сразу во всем документе?

Чтобы инициировать проверку орфографии и грамматики сразу во всем до-
кументе, нажмите клавишу F7.

5.3. Какможно пометить слово, для которого требуется найти синоним?

Чтобы пометить слово, для которого требуется найти синоним, можно выде-
лить все слово либо поместить курсор в начале, в конце или в любом месте
внутри слова, а затем нажать клавиши Shift+F7.

Занятие 6

6.1. Какое сочетание клавиш используется для задания полужирного начертания ?

Для задания полужирного начертания используются клавиши Ctrl+B.

6.2. Сколько шрифтов теперь использовано в документе?

После изменения шрифта слов Служебная записка на Courier New в документе
стало два шрифта: Times New Roman и Courier New.

6.3. Как изменить отступ только первой строки?

Чтобы быстро изменить отступ только первой строки, нужно переместить
на линейке маркер Отступ первой строки (First Line Indent).

6.4. Какое сочетание клавиш используется для выравнивания по центру?

Для выравнивания по центру используются клавиши Ctrl+E.

6.5. Какие существуют способы выделения всего текста документа?

Для выделения всего текста документа можно выбрать один из следующих
способов:

О нажатие клавиш Ctrl+A;

а тройной щелчок на левом поле документа;

а нажатие клавиши Ctrl плюс щелчок на левом поле документа;

а выбор команды Правка > Выделить все (Edit > Select A l l ) .

Занятие 7

7.1. Как изменить отступ списка?

Чтобы изменить отступ списка, выделите пункты списка и нажмите клави-
шу Tab либо используйте кнопки Увеличить отступ (Increase Indent) и Умень-
шить отступ (Decrease Indent) на панели инструментов форматирования.

7.2. В каких режимах можно просматривать и редактировать колонтитулы?

Просматривать и редактировать колонтитулы можно в режимах Разметка
страницы (Print Layout) и Предварительный просмотр (Print Preview).
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7.3. Как перемещаться между верхним и нижним колонтитулами?

Перемещаться между верхним и нижним колонтитулами можно с помощью
кнопки Верхний/нижний колонтитул (Switch Between Header and Footer) панели
инструментов Колонтитулы (Header and Footer).

Занятие 8
i

8.1. Как называется шаблон, который по умолчанию присоединяется к каждому
новому документу?

К каждому новому документу по умолчанию присоединяется шаблон Обыч-
ный (Normal.dot).

8.2. Какие возможности для просмотра элементов форматирования стиля пре-
доставляет область задач Показать форматирование (RevealFormatting)?

В области задач Показать форматирование (Reveal Formatting) есть панели
Шрифт (Font), Абзац (Paragraph) и Раздел (Section), а также панель описания
элементов форматирования.

8.3. На какой кнопке в окне диалога Создание стиля (New Style) нужно щелкнуть,
чтобы изменить те параметры форматирования стиля, которые невозмож-
но изменить с помощью имеющихся в этом окне кнопок?

Для изменения параметров форматирования стиля в окне диалога Создание
стиля (New Style) служит кнопка Формат (Format).

8.4. Что нужно сделать, чтобы стиль, созданный в текущем документе, был дос-
тупен в других документах Word?

Чтобы стиль, созданный в текущем документе, был доступен в других доку-
ментах Word, в окне диалога Изменение стиля (Modify Style) или Создание сти-
ля (New Style) нужно установить флажок Добавить в шаблон (Add to template).

8.5. Какая клавиша используется для повторения последней операции?

Для повторения последней операции используется клавиша F4.

8.6. Какое сочетание клавиш используется для копирования формата?

Для копирования формата используется сочетание клавиш Ctrl+Shift+C.

Занятие 9

9.1. Как определить, что рисунок выделен ?

Вокруг выделенного рисунка видны маркеры выделения.

9.2. Как нарисовать фигуру «относительно центра»?

Чтобы нарисовать фигуру «относительно центра», в процессе рисования
нужно удерживать клавишу Ctrl.

9.3. Как изменить цвет шрифта в автофигуре?
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Чтобы изменить цвет шрифта в автофигуре, нужно выделить текст и вос-
пользоваться кнопкой Цвет шрифта (Fontcolor) на панели инструментов Рисо-
вание (Drawing).

9.4. Как изменить цвет линии в фигуре?

Чтобы изменить цвет линии в фигуре, нужно выделить линию и воспользо-
ваться кнопкой Цвет линии (Line Color) на панели инструментов Рисование
(Drawing).

Занятие 10
10.1. Как создать новый шаблон на основе готового шаблона Word?

Чтобы создать новый шаблон на основе готового шаблона Word, в группе
Создать (Create New) окна диалога Создание документа (New Document) нужно
установить переключатель Шаблон (Template).

10.2. Как создать новый стиль на основе существующего фрагмента текста?

Чтобы создать новый стиль па основе существующего фрагмента текста,
нужно выделить отформатированный фрагмент и ввести название нового
стиля в поле Стиль (Style) панели форматирования.

10.3. Как прервать запись макроса?

Чтобы прервать запись макроса, нужно щелкнуть на кнопке Пауза (Pause) на
панели инструментов Остановить запись (Stop recording).

Занятие 11

11.1. Как изменить ширину колонки в окне диалога Колонки (Columns) ?

Чтобы изменить ширину колонки в окне диалога Колонки (Columns), исполь-
зуйте поле Ширина (Width) в области Ширина и промежуток (Width and spacing).

11.2. Как удалить обрамление абзаца?

Чтобы удалить обрамление абзаца, выберите команду Формат > Границы и за-
ливка (Format > Borders and Shading), в открывшемся окне диалога щелкните
на вкладке Граница (Borders) и выберите вариант Нет (None) в области Тип
(Setting).

11.3. Почему при заливке серым цветом нужно выбирать небольшие значения на-
сыщенности в процентах?

При печати документа заливка областей со значениями насыщенности бо-
лее 25% будет затруднять чтение текста, поэтому для заливки серым цветом
желательно выбирать меньшие значения.

11.4. Как удалить символ разрыва раздела из документа ?

Чтобы удалить символ разрыва раздела из документа, выделите его и на-
жмите клавишу Delete.
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Занятие 12

12.1. Как выглядит указатель мыши в режиме рисования таблицы?

В режиме рисования таблицы указатель мыши напоминает небольшой ка-
рандаш.

12.2. Какое сочетание клавиш используется для перемещения в ячейках таблицы в
обратном направлении?

Для перемещения в ячейках таблицы в обратном направлении используют-
ся клавиши Shift+Tab.

12.3. С помощью каких команд можно вставить строку в таблицу?

Для вставки строки в таблицу служат команды Таблица > Вставить > Строки
выше/Строки ниже (Table * Insert > Rows above/Rows below).

12.4. Какой вид принимает указатель мыши при выделении целого столбца?

При выделении целого столбца указатель мыши превращается в черную
толстую стрелку, направленную вниз.

12.5. Какой вид принимает указатель мыши при выделении отдельной ячейки?

При выделении отдельной ячейки указатель мыши принимает вид черной
толстой стрелки, направленной вверх и вправо.

12.6. С помощью какой кнопки можно сменить вариант выравнивания текста в
ячейках таблицы и сколько существует вариантов такого выравнивания?

Для выравнивания текста в ячейках таблицы предназначена кнопка Вырав-
нивание в ячейке (Cell Alignment), расположенная на панели инструментов
Таблицы и границы (Tables and Borders). Всего существует девять вариантов
выравнивания,

12.7. Как выделить всю таблицу?

Чтобы выделить всю таблицу, нужно щелкнуть на маркере выделения над
верхним левым углом таблицы.

12.8. Как выглядит указатель мыши при изменении ширины столбца или высоты
строки?

При изменении ширины столбца или высоты строки указатель мыши при-
нимает вид двойной черты с двойной стрелкой.

Занятие 13

13.1. Какможно изменить масштаб предварительного просмотра документа?

Для изменения масштаба предварительного просмотра документа использу-
ется список Масштаб (Zoom) на панели инструментов в окне предварительно-
го просмотра.

13.2. Как увидеть документ, максимально похожий на печатную копию?
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Чтобы увидеть документ, максимально похожий на печатную копию, уста-
новите масштаб просмотра документа 100%.

13.3. Как определить, что документ находится в режиме редактирования?

Указатель мыши в режиме редактирования принимает вид вертикальной
черты, а в режиме предварительного просмотра — увеличительного стекла.

13.4. Как распечатать документ с текущими параметрами?

Чтобы распечатать документ с текущими параметрами, нужно щелкнуть на
кнопке Печать (Print) на стандартной панели инструментов.

13.5. Как изменить параметры листа наклеек?

Чтобы изменить параметры листа наклеек, нужно щелкнуть на кнопке Пара-
метры (Options) на вкладке Наклейки (Labels) окна диалога Конверты и наклей-
ки (Envelopes and Labels).

Занятие 14

14.1. Как определить, что документ сохраняется в формате файлов для Интер-
нета?

Чтобы документ сохранился в формате файла для Интернета, в поле Тип
файла (Save as type) окна диалога сохранения документа должен быть выб-
ран пункт Веб-страница (Web Page). Для файлов этого формата используются
расширения mht, mhtml, html или htm.

14.2. Как переключаться между режимами просмотра документов в Word?

Для переключения между режимами просмотра документов в Word служат
команды меню Вид (View) или кнопки в левом конце горизонтальной полосы
прокрутки.

14.3. Какие еще дополнительные документы, кроме основного веб-документа, бу-
дут сохранены в папке?

При сохранении веб-документа сохраняются также графические файлы, ис-
пользованные при его создании.
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В 1 997 году по инициативе генерального директора Издательского дома «Питер»
Валерия Степанова и при поддержке деловых кругов города в Санкт-Петербурге
был основан «Книжный клуб Профессионал». Он собрал под флагом клуба про-
фессионалов своего дела, которых объединяет постоянная тяга к знаниям и любовь
к книгам. Членами клуба являются лучшие студенты и известные практики из раз-
ных сфер деятельности, которые хотят стать или уже стали профессионалами в той
или иной области.
Как и все развивающиеся проекты, с течением времени книжный клуб вырос
в «Клуб Профессионал». Идею клуба сегодня формируют три основные «клубные»
функции:

• неформальное общение и совместный досуг интересных людей;
• участие в подготовке специалистов высокого класса

(семинары, пакеты книг по специальной литературе);
• формирование и высказывание мнений современного профессионала

(при встречах и на страницах журнала).

КАК ВСТУПИТЬ В КЛУБ?

Для вступления в «Клуб Профессионал» вам необходимо:

• ознакомиться с правилами вступления в «Клуб Профессионал»
на страницах журнала или на сайте www.piter.com;

• выразить свое желание вступить в «Клуб Профессионал»
по электронной почте postbook@piter.com или по тел. (81 2) 1 03-73-74;

• заказать книги на сумму не менее 500 рублей в течение любого времени
или приобрести комплект «Библиотека профессионала».

«БИБЛИОТЕКА ПРОФЕССИОНАЛА»

Мы предлагаем вам получить все необходимые знания, подписавшись на «Библио-
теку профессионала». Она для тех, кто экономит не только время, но и деньги.
Покупая комплект - книжную полку «Библиотека профессионала», вы получаете:

• скидку 1 5% от розничной цены издания, без учета почтовых расходов;
• при покупке двух или более комплектов - дополнительную скидку 3%;
• членство в «Клубе Профессионал»;
• подарок -журнал «Клуб Профессионал».

а ом
Закажите бесплатный журнал
«Клуб Профессионал». { w w w . PITER.» ом
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тел ./факс (3912) 27-39-71.
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тел. (3832)36-10-26, факс 36-10-27.
E-mail: office@top-kniga.ru
http://www.top-kniga.ru

Тюмень, «Друг»,
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новостного отдела CNews более 30 тыс. читателей
находятся рынки посещают наш сайт,
телекоммуникаций, Ежемесячная аудитория
компьютерного оборудования, издания - более
программного обеспечения, чем 300 тыс. человек
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Office Word
2003

Эта книга поможет вам:

изучить основные приемы работы с Word: создание, просмотр
и редактирование различных типов документов, добавление
в документ таблиц и графических изображений;

^\ научиться пользоваться стилями, шаблонами и макросами;

СЪ освоить редактирование веб-страниц с помощью Word.

Эта книга — удобный и понятный самоучитель, который позволит
вам стать «на ты» с новой версией самого распространенного
в наши дни текстового редактора Microsoft Word. Если вы
недавно начали работать с компьютером и пока относитесь
к нему с опаской, книга Ю. Леонтьева поможет вам почувствовать
себя увереннее. Вы научитесь красиво и грамотно оформлять
документы, факсы, готовить отчеты, работать с таблицами.
Все основные аспекты работы с Word объяснены доходчиво
и подробно. Легко и быстро усвоить материал позволит множество
примеров и упражнений в виде пошаговых инструкций.
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